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Online Documentation
The latest version of this documentation is available online at http://help.preactor.com.
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About Preactor

Introduction

About Preactor
Preactor APS is a collection of software offerings comprising Advanced Planning (AP) and Advanced Scheduling (AS) products
available in Express, Standard, Professional and Ultimate editions.

Preactor AS allows you to gain greater visibility and understanding of your manufacturing processes, andwith it greater
control of those processes, allowing better machine utilization, on-time delivery, impact analysis of 'what if' scenarios and
identification of bottlenecks to give a few examples. Preactor AS is also suited to non-manufacturing environments, given that
the principles of resources constraints are applicable across many industry sectors.

For companies who are in a volatile, make to stock environment and require a more dependable method to plan capacity and
stock, Preactor AP offers a planning tool that has the convenience of spreadsheets but with interactive graphs to give the user
full control over the results. Unlike spreadsheets and other applications that are relied upon to produce long term MPS data
that in turn dictates purchasing decisions, Preactor is suitable for working with large amounts of data, supports both
constrained and unconstrained production, and provides a tool to perform 'what if' calculations with alternative scenarios that
can deliver true cost reductions where it matters.

Preactor has great flexibility and allows data to be input from existing systems (e.g. BoM and orders) or to be enteredwithin
the application. It can support all types ofmanufacturing processes, either with off-the-shelf capability or, with the Ultimate
editions, rules specific to your processes can be added.

See "Overview" on page 10 for more information on the various editions of Preactor AP and AS.

What's New
This section describes the major new features and enhancements introducedwith this release of Preactor. This is not an
exhaustive description, but covers the most significant changes. For a more complete list, please refer to the detailed change
notes included in the release notes.

Overview Window
The Preactor AS OverviewWindow has been renamed to the Gantt Chart. A new, enhanced OverviewWindow has been
created, allowing for a combination of the Gantt Chart, Plots Window and Utilization Window to be shown on a single timeline.
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What's New

An additional feature to the OverviewWindow having a single timeline is the ability to have synchronized zooming.

Campaigns Added to the Preferred Sequence Rule
The Preferred Sequence Rule has been improved to allow it to be run in two modes - Campaign Mode, and the traditional
Dynamic Timeline mode.

When Campaigns have been enabled, the selection criteria is based on operations that have a Due Date that falls within the
given Look Aheadwindow. The Look AheadWindow is a moving timeline, based on the triggered event time.

Minimize Overall Setup Rule
The Minimize Overall Setup Rule is similar to the Preferred Sequence Rule, however it focuses on minimizing the setup and
changeover times on resources. Improvements have been made to selecting the most suitable resource for the operation.

In order to run this rule in Preactor AS Professional, the Preactor license will require renewal.

Additional Sequencer Options
A number of warning suppression options have been added to the Preactor AS Sequencer.
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What's New

For example, when the Backwards sequence warnings is suppressed, no warnings will be displayedwhen there are
compatibility issues when using a Backwards Sequencing Rule. It may also impact Bi-Directional Sequencing or Schedule Repair.
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Products

Overview

Products

Families and Editions
The Preactor Advanced Planning and Scheduling (APS) solutions offer different features and levels of functionality which take
you from Express through to Ultimate.

All editions of Preactor are compatible. This means that you can purchase a lower cost edition of Preactor initially, but then
upgrade to another edition as your requirements change. this way you only pay for what you need.

The Preactor products are split into the following product families:

l Advanced Scheduling (Preactor AS)
Preactor AS Express, Standard, Professional and Ultimate editions.

l Advanced Planning (Preactor AP)
Preactor AP Ultimate edition.

l Ancillary Products
Preactor AS Standard, Professional and Ultimate Viewers and Preactor AP Viewer.

Advanced Scheduling
All Advanced Scheduling products offer an algorithmic sequencing method of loading work onto the planning board. This is
often referred to as sequential or "order at a time" sequencing. The general philosophy of these rules is to balance the load
across resources whilst meeting due dates.

Each operation is selected in turn and all operations are added to the schedule using the constraints that have been defined. All
operations for the next order are then processed, and so on, until all orders have been scheduled.

The sequence in which the orders are selected can be due date, priority, or schedule sort order. The direction of loading each
operation within an order can be forward from the current time or backward from the due date. In Preactor AS Standard and
above you can also define a 'Delivery Buffer', to ensure the order is completed ahead of the due date when backward
sequencing. In this case backward sequencing schedules the order from the due date minus the delivery buffer. Work may also
be bi-directionally sequenced, whereby up-stream operations for an order are backward sequenced and down-stream
operations are forward sequenced, around the selected operation (which must be placed on the planning board).

You may weight orders to generate a preferred sequence of loading, e.g. weight by due date and then by priority. Many
schedules can be tried and compared before being released to the shop floor for execution.

The basic features listed for the Preactor AS Express product are available to all the other scheduling products, similarly
features listed for the Preactor AS Standard product are also available in all higher level systems, and so on.

Advanced Planning
Available only in Ultimate edition, Preactor AP (Advanced Planning) is a long-term planning tool deigned to assist with high
level planning decisions based on future demand. AP helps with anticipating seasonal demand variations by utilizing the
defined planning resources according to the preferences defined on an item by item basis. Used often in the FMCG (Fast
Moving Consumer Goods) sector, Preactor AP considers not only high level capacity constraints, but also order multiples,
minimum order sizes and shelf life. Target stock levels are defined in terms of days of cover and an array of charts plots the
planned stock level for any given SKU.
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Preactor AP Ultimate
The MPS Problem
Master Production Scheduling (MPS) is a key part of the MRP (Master Requirements Planning) process that runs within an ERP
(Enterprise Resource Planning) system. The input to MPS will be future customer demand, so it will be typically made up of a
mixture of actual sales orders and forecast demand.

There are two main purposes behind the MPS process, which both require MRP to have some visibility of future demand. The
first is that MRP can suggest the manufacturing orders that will need to be made. The second is to suggest the purchase
orders will need to be raised for bought in items.

The fundamental MPS problem is that the process does not take into account manufacturing capacity. It simply works with the
due dates from future demand. This can result in your MRP suggesting orders that cannot be processed in the relevant
timescale.

The common solution to this problem is to pre-process future demand through one or more spread sheets before it is loaded
into the MPS. This process is often called Rough Cut Capacity Planning.

The spread sheets are used to calculate howmuch of andwhen each product should be made taking into account some key
process parameters such as rough cut capacity, desired stock level limits, shelf life, and so on.

The resulting 'smoothed' data is then used to create an accurate MPS in the ERP system.

As with any spread sheet based solution, this can work quite well if data volumes are low and there is little variation in demand,
but if there is a large numbers of products that share the same production capacity and/or highly variable demand, then the
spread sheets become very difficult to manage.

General Features
Planning can be executed in finite or infinite capacity mode and planning time periods can be days, weeks, months or a
combination of all three.

Parameters can be set against each item code, which allows different calculations for each item. For example, some products
are inMake to Stock mode, whilst others are inMake to Ordermode.

If used together with a Preactor scheduling system, detailed production schedule information can be sent back to the planning
system, and this will override planned volume with scheduled volume. MPS can then be recalculated using the production
schedule as the base for new results.

Make to Stock
In the food, drink, consumer goods or similar sectors, it is quite likely that production process is in aMake to Stock mode. If
this is the case, the primary driver in creating the MPS will typically be a forecast of future demand.

Unfortunately, forecast demand can vary over time, due to factors such as seasonality, promotion, weather or special events.
This can cause significant variations in forecast demand, which can result in an unrealistic MPS, where there is not enough
production capacity to meet the peaks in forecast.

Unfortunately, forecast demandmay vary greatly over time because of seasonality, promotions, weather, special events, or
similar factors. However, these significant variations in forecast demand can easily result in an unrealistic MPS, where there is
not enough production capacity to meet the peaks in forecast.

Preactor AP imports current stock levels, plus actual and forecast demand. It then considers rough cut capacity, pack forward
figures, target days of stock cover, manufacturing preferences, minimum/maximum reorder quantities, reorder multiples,
product shelf life, and so on, to propose an accurate and achievable MPS.

Production capacity can be specified as a quantity, duration or weight. Using the Preactor calendar system, capacity can be
varied over time. The capacity available then limits the production volume created in each period.

- 11 -



Products

Once an initial MPS has been created, the data can be displayed as both stock profile graphs, and capacity usage graphs. The
MPS can be changed by simply clicking and dragging a point on the stock or capacity graphs, and the production of a particular
item can be moved from one planning period to another. Any changes made will be reflected in all linked plot and grid
windows.

The planning BoM (Bill of Materials) can also be exploded by Preactor AP, and then the production plan for lower level items is
calculated in the same way. Based on the BoM explosion and the production plan, the proposedmaterial purchase
requirements can be exported to an ERP system, for example Excel, for action.

Make to Order
In aMake to Order environment, the stock levels of finished and/or intermediate items will not be part of the key process
parameters, but there will still be the need to evaluate the effects of future demand changes on the manufacturing process.

For example, for complex assemblies in the aerospace sector, each finished item may have a deep BoM (Bill of Materials) and be
made up of thousands of individual components. Many of those components are manufactured in-house and they share
production capacity, so there is a complex relationship between manufacturing capacity and demand.

When a change in demand occurs, whether that be in terms of quantity or delivery dates, there is a need to be able to quickly
assess if it is possible to meet the new requirements.

It is possible to import demand changes into Preactor AP and create a new 'what if' plan. The planning BoMwill be exploded and
Preactor AP will show if there are any capacity issues. If there are issues, an acceptable MPS can be created by working
interactively.

Ultimate Edition
Preactor AP is available in Ultimate edition only. This means there are no active restrictions on the extent to which AP may be
customized. "Ultimate Configuration" on page 300 for more information on how Preactor can be configured to suit all manner
of applications.

Preactor AS Express
Preactor AS Express is targeted at users with simple scheduling problems, which is usually found in small, make to order
companies. It is for standalone operation only. Database sizes are unlimited. Database tables, fields andmenu structure are
fixed.

As with all members of the family of scheduling products, the Sequencer has an interactive planning boardwhere you can drag
and drop operations from one resource to another, and update the completion times on-screen. It also uses the sequential, or
order at a time scheduling method, allowing you to work with rules such as 'priority' and 'due date' to decide the ranking of
orders.

Features in higher versions of Preactor that are not available in Preactor Express include:

l the Preactor Web Publisher.
l the Preactor Import-Export Script Wizard.
l the Preactor Event Script Processor (PESP).
l the Plots Window.
l Schedule Analysis Reports.
l Customizable data tables andmenu interface.

The principal features found in Preactor Express are sharedwith higher level versions of Preactor.

Additional Information
Resources and Resource Groups

Products
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Order andOrder Relationships

File Import

Table and Field Settings

Preactor AS Standard
Preactor AS Standard edition builds on the features and functionality included in AS Express. The main points of difference are
discussed below.

Process Times
Process Times can be defined in terms of time per batch, rate per hour or time per item. They can be either static times defined
against an operation, or they can be specific to each of the resources on which that operation is valid.

Setup Times
Setup times can be expressed using one or both of the following techniques:

1. A static setup time against each operation.
2. Attribute based setups.

Unlike to unlike setups are appliedwhen particular attributes are different between operations. These are allowed for
table based attributes only. Setup times are defined in the Changeover Groups table which must in turn be referenced
by the resources on which they are effective.

Operation Relationships
A slack time may be defined between operations.

Subsequent resource constraints can be defined per operation per resource group.

Secondary Constraints
While AS Express can be described as a single constraint scheduler, the Standard edition introduces Secondary Constraints.
These can be used to model all manner of constraints on processes, for example, tooling andmanning. There are two ways in
which to define secondary constraints:

l By defining a list of individual constraints against each operation and/or resource, and against each of the three attrib-
ute tables provided.

l By defining Secondary Constraint Groups that can be applied against an operation and/or resource. You can then select
a Secondary Constraint from the group selection. However, in the Sequencer, when generating a schedule Preactor will
automatically select a Secondary Constraint when using Secondary Constraint Groups. This can be overridden post
schedule generation. You are able to select one Secondary Constraint Group for each operation/resource.

Attribute Tables and Fields
AS Standard allows for up to 12 attributes to be defined per operation. Attributes may be defined in one of three attribute
tables, or using one of 9 attribute fields of various types.

Material Constraints
AS Standard allows for modeling ofmaterial constraints, using a FIFO linking rule that is biased to link to stock first. In AS
Standard, materials always link to a consuming order, such as a Sales Order, or the first operation of a works order.
Conversely, materials are always linked from a supply order, such as a purchase order, or from the last operation of a works
order. As such, it is only possible to model the linear flow ofmaterials in AS Standard.

- 13 -



Products

Progress Updates
In AS Standard, progress for operations may be fed into the schedule by importing such information from an available data
source. Progress will be reported, but will not affect the run-rates of operations.

Order Enquiry
AS Standard supports order enquiries for a single level, meaning one level of process and BoM.

Scripting
AS Standard introduces the Preactor Event Script Processor (PESP) for scripting various aspects of Preactor.

Preactor AS Professional
Preactor AS Professional edition builds on the features and functionality included in AS Standard. The main features and
functionality introduced in AS Professional is discussed below.

Full Sequence Dependent Attribute Based Setup Times
Instead of using a fixed setup time, it is possible to define sequence dependent setup/changeover times based on the attributes
of one operation to another on a resource.

Set of Standard Advanced Planning Rules
There are a set of Standard Advanced Planning Rules that Preactor can use to scheduling operations. These are:

l APS Forwards
l APS Backwards
l APS Parallel Loading
l APS Preferred Sequence

Preactor Workflow (PESP) Scheduling Actions for Multi-Pass Rules
PESP functionality is increased, allowing for multi-pass rules to be created and used. A multi-pass rule is, for example, one that
can locate and sequence specific orders based on specific criteria, and then repeat the process for another criteria.

Operation Level Material Consumption and Production
Supply & demand orders are represented, in the Sequencer, as milestones on the Gannt window. Relationship lines can be
drawn between supply orders, works orders and demand orders to show the material relationships. Further analysis of
material consumption is allowed in Professional and Ultimate editions of Preactor AS using the Material Explorer.

In addition, in AS Professional and Ultimate editions, user defined pegging rules are allowed. These rules are fully flexible and
can be defined as rule sets, which can then be applied on an elective basis. In addition, Professional and Ultimate allow the
linking ofmaterials at operation steps other then the first and last operation step. The production of additional materials may
be specified in a co-products table.

Material Explorer
The Material Explorer is available in SMC enabled configurations. It provides an interactive graphical representation of links
between orders, it accommodates easy access to orders and related orders using its drill down navigational facilities, it can be
used to lock or unlock links between orders, highlight shortages and report unused quantities. Material plots relating to the
selected order will also be displayed.

Custom Material Linking Rules
Using a PESP script, it is possible to run material control on order enquiry after the order has been expanded but before it
schedules on the planning board. The extent to which materials are re-evaluated is driven by the PESP script and limited by the
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edition of Preactor. A PESP Action called 'Run SMC on Order Enquiry' exists for light-touch material linking on order enquiry.
This action will always filter the producing and consuming queues to the order in question. AS Professional allows you to fully
reconsider all materials using the Run SMC action. Consideration should be given to the fact that this is a potentially
destructive operation.

Advanced Resource Constraints
It is possible to set up complex resource constraints. These take two forms dependent on whether the resource is set up as an
infinite resource or a finite resource. For both types of resource theMatch Field can be used to define rules about the usage
of other resources when an operation is placed on this resource. For infinite resources it is also possible to set upmatch
criteria in theMatch Required field. This allows the limiting of operations that can be placed on the resource at the same time
to only those with a matching value in the selected field.

Advanced Operation Constraints
There are additional advanced inter-operation constraints in the scheduling process. These can be defined against the
operations in the products table.

Exclude Invalid Resources Based on Attribute
Expanding upon the Attributes functionality available in Preactor AS Standard, for AS Professional and Ultimate editions, it is
possible to exclude resources from scheduling processes based on attributes applied to them.

Preactor AS Ultimate
Preactor AS Ultimate edition builds on the features and functionality included in all other editions of Preactor AS. AS Ultimate
removes all restrictions on how processes are modeled, which allows for an almost limitless set of scheduling possibilities. The
Preactor Package shippedwith AS Ultimate is based on the package available with AS Professional, providing a good starting
point for your modeling processes.

Below are the main features and functionality that is available in AS Ultimate.

Preactor Object API
Preactor Object API creates an interface, primarily, for data and application manipulations. It exposes methods to read and
write data, as well as exposing some application specific behavior. Users can create their own custom actions for use within
Preactor in either C# or VB.

Open Planning Board API
Users have full access to the Open Planning Board API, which allows access andmanipulate of schedule data directly by using
the provided API methods. For example, a user can automate schedule tasks such as inserting operations under defined
conditions.

Database Schema and Menu Structure Editing
In Preactor AS Ultimate, users have access to the Preactor Menu and Table Definition Files, which are available for editing.
These definition files allow for almost limitless configuration editing, from table building to user interaction (for example). And
applicable changes made in this files will be applied to the SQL database

All Preactor Scheduling Features and Classifications
All features and classifications are available in Preactor AS Ultimate, allowing to further configure our Preactor configuration.

For more information on the possibilities with Ultimate editions of Preactor, see Ultimate Configuration.
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Preactor Viewers
Preactor Viewers can be used to view all of the same information that is available in an AS or AP system. Viewers have limited
functionality that, in general, prevents any form of alteration of the underlying data. However, the Ultimate viewers, with
some consideration, can be used to collect information from elsewhere in a business. AS Ultimate viewers have unlimited
sequencing capability, so 'what-if' scenarios can be exercised in an AS Ultimate Viewer, though without the ability to commit
those scenarios back to the database.

AS Standard and Professional Viewers
AS Standard and Professional viewers are designed to be usedwith their corresponding AS Master Scheduling System. These
products allow read-only access to all Preactor scheduling data tables and to the Sequencer. Access to particular tables may still
be restricted using the Security Module.

AS Ultimate Viewers
AS Ultimate Viewers may be used in the same was as AS Standard or AS Professional viewers. These Viewers can also be
configuredwith their own independent database, allowing a subset of information to be shared in an AS Ultimate Viewer
session, or for 'what-if' scenarios to be played out. AS Ultimate Viewers permit the commit operations for all tables when using
the data editor outside the sequencer. This means that AS Ultimate Viewers may also be used to gather information such as
status updates. AS Ultimate viewers also include the Preactor API, so any extensions to Preactor that have been implemented
in AS Ultimate may be replicated in the viewer. This means that, for example, a custom scheduling rule can be used to play out
a 'what-if' scenario in an AS Ultimate Viewer.

AP Ultimate Viewers
AP Ultimate Viewers are configurable in the same way that AS Ultimate Viewers are, but the planning module does not allow
any what-if scenarios to be played out in a viewer.

Classic Products
As of Preactor 17, the products offered are split into two categories; Advanced Scheduling (AS) and Advanced Planning. Within
each category are a number of editions ranging from Express through to Ultimate (though at this time only Ultimate editions
of Advanced Planning are offered).

Prior to this change, the products offeredwere:

l Preactor Express
l Preactor 200 FCS
l Preactor 300 FCS
l Preactor 400 APS
l Preactor 500 APS
l Preactor 400 GMPS
l Preactor Enterprise
l Enterprise Runtimes (APS and GMPS)

While these products are all compatible with this version of Preactor, they are no longer generally available. If you are an
existing user upgrading to Preactor 17, you will find that your Preactor product continues to work as it always has. If you
would like to migrate from your classic product to a generally available product, please talk to your Preactor reseller, or visit
the Preactor website at www.preactor.com.

Note: The upgrade path for users of 400 (and above) classic products such as Preactor 400 APS is to an Ultimate edition of
Advanced Scheduler or Advanced Planner. The feature set for this transition is equivalent or richer. For 200 and 300 classic
products, users should be aware that while an upgrade path exists to either Standard or Professional editions, much of the
customization possible in these classic products is now only available with the Ultimate editions, for which an upgrade path also
exists.
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System Requirements

System Requirements
Your computer shouldmeet the following system requirements for running Preactor.

Operating System

Windows® 71

Windows® 8.11

Windows® 101

Windows Server® 2012
Windows Server® 2012 R2
Windows Server® 2016

Supported Platforms x86, x64

Microsoft® .NET Framework
Version

4.6.22

Microsoft® SQL Server 2008 R2 or later3(any edition including Express)

Microsoft® Visual C++
Runtime

Visual C++ Runtime 20174

Processor 2 GHz or better

Memory 1 GB RAM (2 GB recommended)

Disk Space

Aminimum of 1 GB free disk space is required for Preactor Installation

Aminimum of 2 GB free disk space is required for .NET Framework version 4 installation on a
64 bit platform.

1. Preactor can be installed on any edition ofWindows, but an SQL Server Reporting Services (SSRS) server may only be
installed on editions where Internet Information Services (IIS) is supported.
On editions that do not support IIS, only local reporting is possible.

2. Microsoft® .NET Framework Version 4.6.2 will be installed by the Preactor installation program if it is not already
installed.

3. SQL Server 2012 is the version supplied on the Preactor distribution media.
4. Microsoft® Visual C++ Runtime will be installed by the Preactor installation program if it is not already installed.

Language Support
Preactor has built-in support for multilingual operation. The default language is English. Siemens have translated Preactor into
the following languages: 

l French
l German
l Spanish (Mexican, Spanish, Colombian and Argentinian)
l Portuguese (Brazilian and Iberian)
l Russian
l Dutch
l Simplified Chinese
l Japanese
l Polish
l Hungarian
l Italian
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l Korean
l Czech

Some additional translations have been provided by 3rd parties, which have been included in the product as a courtesy.

Although Siemens does not certify any other language translations, issues with any translations can be reported and the 3rd
party will be informed, so improvements can be made.

The language text is displayed in is dependent on 2 aspects:

l The installation language of the platform.
l The configured language of Preactor.

Some 3rd party applications use the installed language to determine the language to display text, in particular standard
settings in dialog boxes (e.g. Yes/No/Cancel).

To get a consistent experience, the installed language and the configured language should be the same. However, it is not
necessary to have both installed and configured languages the same (e.g. in locations where more than one language is
spoken).

Please note that only the Preactor software is available in multiple languages, and the Help Documentation is only available in
English.

Installation

Introduction
This guide provides information on the process for installing and running Preactor.

Whether you are evaluating Preactor, or you have purchased a license, the installation package will be the same. Without
activating a license, Preactor will only run in trial mode for 30 days after it is first run. When you purchase a license, that
license will have to be activated.

Installing a full version of Preactor for the first time, the following steps are taken:

1. Ensure prerequisite SQL Server instance is available (the version provided on the Preactor distribution
media is Microsoft SQL Server 2012 Express (Database Only) Edition.

2. Install Preactor by opening the installation package and following the on-screen instructions.

At this point Preactor can be run in trial mode for up to 30 days.

3. Order and obtain an Activation Code.
This can be for a single user/system, or a multi-user network license.

4. If a Network License has been purchased, download and install the Preactor License Manager software.
5. Use the license utility to enter the activation code. If you are using a trial, you will be prompted by the

license utility every time Preactor is run. Alternatively you can enter the activation code by opening the
license utility from the start menu. For network license servers, the activation code should be entered on
the server using the network license utility.

At this point Preactor can be run in activatedmode.

Installation Options
This installation guide will walk you through the simplest deployment scenario where Preactor andMicrosoft SQL Server 2012
Express (Database Only) Edition are installed locally. No knowledge ofMicrosoft SQL Server is required in this scenario.
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For deployment scenarios where the SQL Server and/or SQL Server Reporting Services are to be accessed over the network,
please contact your IT department.

Installing SQL Express
Preactor requires a connection to a SQL Server instance in order to deploy databases and to use as a persistent store. You may
use a pre-existing instance of SQL Server either locally or on the network. If there is no pre-existing instance to use, a copy of
SQL Express is included on the installation media.

To install Microsoft SQL Server 2012 Express (Database Only) Edition from the Preactor installation disk.

1. Place the installation media into your drive. If the launcher application does not automatically start, then you will need
to browse to the drive using Windows Explorer and double click on the 'setup.hta' file.

2. Follow the on-screen instructions.

If you have downloaded a stand-alone installation of Preactor, or if you prefer to use a later version of SQL Express, you may
download it from http://www.microsoft.com/express/database.

Tip: Detailed guidance on installing and configuring SQL Express can be found at:
http://msdn.microsoft.com/en-us/library/ms143219.aspx

Local Instance
The default deployment case for Preactor is a local instance of SQL Server Express Edition. For this type of deployment, the
default server configuration options are suitable.

Remote Instance
Any supported edition of SQL Server may be used and can also be deployed remotely. Remote deployment of SQL Server
should be performed according to best practices and should only be done where compliant with network and organization
policy.

Note: When deploying SQL Server for use with Preactor on a remote server, in order to ensure integrity of data and deny any
possibility of data being compromised or tamperedwith, due care and consideration should be taken to ensure that all
communications between the Preactor application and the SQL server are encrypted.

Installing Preactor
Preactor can be installed from ether the Preactor Installation CD or it can be downloaded from the web site. The web install
does not include any prerequisite software, which must be downloaded separately if required.

l Installing from the Preactor Installation disk

1. Place the Preactor Installation disk into your CD-ROMDrive. If the CD launcher application does not auto-
matically load, then you will need to browse to your CD drive using Windows Explorer and double click on
the setup.hta file.

2. Follow the on screen instructions.

l Installing from the Web Installer

1. In Windows Explorer, double click the .exe file.
2. Follow the on screen instructions.

If upgrading, the upgrade is recognizedwhen Preactor is run and some additional options are available to the user at that
point.

When (re)installing or upgrading, any existing configuration will be maintained. Upgrading the configuration is done by
Preactor when it is run. See Running an Upgraded Version of Preactor.
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Upgrading
The procedure for upgrading Preactor is the same as for an initial install. "Installing Preactor" on the previous page.

Any Preactor configuration that works with Preactor 10.0 or later can be upgraded to this release.

Note: It is strongly advised that you take a backup of your configuration before upgrading (i.e. create a configuration package).

Once Preactor is installed, any existing Preactor configuration may be opened. To do so, start Preactor in the normal way,
selecting the required configuration.

At this point, it is likely that a set of upgrade tasks need to be performed. The greater the difference between the version of
Preactor last usedwith the configuration selected and the version being used now, the greater the number of upgrade steps
that will be performed. Before the upgrade steps are executed the following options are offered:

l Backup and Upgrade
Opens the Preactor Configuration Package Manager, allowing a configuration backup to be taken before the upgrade
steps are performed.

l Upgrade
Performs the upgrade steps without taking a backup of the configuration.

l Exit
Close Preactor without performing any upgrade steps.

Warning: Once an upgrade step has been performed, it may not be undone. Taking a backup of a configuration prior to
performing any upgrade steps is recommended for this reason.

Customization Upgrades
Where additional work may be required due to customization, refer to your Preactor partner for support.

Repairing Preactor
If the files installedwith an application have been altered in some way, it is possible that the application will be rendered
inoperable or will exhibit unexpected behavior. For this reason many applications, including Preactor, include a repair facility to
return the installed application to its expected state.

To repair an existing installation of Preactor, either re-run the installation wizard from the installation media and choose the
Repair option or select the repair option presentedwhen selecting Preactor from the list of installed programs in the 'Programs
and Features' control panel application.

Repairing an existing installation will replace any missing or corrupt files and re-create any shortcuts.

Uninstalling Preactor
Preactor is uninstalled using the Windows utility, found under Start ►Control Panel ► Program and Features, or by running the
Preactor executable downloaded from the Preactor web site, selecting the option to remove the software.

Uninstalling Preactor does not removed any of the configuration files.
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No configuration files will be overwritten by the (re)installation of Preactor.

Be sure to take a back-up copy of any configurations you wish to keep.

Preactor Environment
Configuration Folder

When Preactor is installed, a set of configurations are also installed in the folder 'Preactor Configurations', as indicated in the
installation script. A number of configurations are provided, each in their own folder.

When expanded (either by double clicking on the file, or from the Configuration Package Manager), a number of files are
created. Of particular interest are:

Preactor Command Definition File (.prcdf)

This is a text file reflecting the main configuration items of the system, but Preactor provides an intelligent editor
to help with its editing (right click and select ‘Modify with Preactor [VERSION]’, with the Version being the
Preactor version installed). In the distributed configurations, the name given to this file is indicative of the
Preactor product selected to be executed – e.g. Preactor AS Ultimate.prcdf and Preactor AS Professional.prcdf.

Preactor Menu Definition File (.prmdf)

This is a text file, normally editedwith Notepad. It allows customization of the Preactor menus.

Preactor Table Definition File (.prtdf)

This is a text file, normally editedwith Notepad. It allows customization of the Preactor tables and fields.

SQL Database

Preactor holds its working data in an SQL Database.

Licensing

Licenses
Introduction
Preactor uses FlexNet Software Licensing for managing access to its products, and is offeredwith either:

l A local license.
If Preactor is going to be resident on a single machine, then a local license will suffice.

l A floating multi-user Network License.
If Preactor is going to be used by a number of users on their machines, even if the users are only running Preactor 1 at
a time, a floating network license is required.

A license manager, installed on a server common to a number of systems, can be loadedwith one or multiple licenses
which enables that number of concurrent users of Preactor.

The Network License Service needs to be installed, licenses added, and Preactor configured to use that network license.

There are two different Run modes that Preactor can be launched in:
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l Trial mode

This allows Preactor to be tried over a trial period of 30 days. The time period begins as soon as Preactor is opened in
this mode. Preactor can be used until the 30 days have expired.

l Activated mode

This allows Preactor to run in a fully activated state with no time constraints. An Activation Code must be entered to set
Preactor to run in this mode.

Licensing is on a product basis, e.g.

l Preactor 300 FCS
l Preactor 500 APS
l Preactor Viewer

Activation Codes are obtained through your Preactor Partner, and it will generally be provided in an email and can be
copied/pasted into Preactor.

Activation can be performed:

l Online
Preactor Licensing operations are optimized for systems with internet access,

l Offline
For installations that do not have or allow internet access, a manual procedure is offeredwhereby files are transferred
manually between the system and the license activation service.
See Offline License Management in conjunction with the description for the different Licensing operations to under-
stand how the user accomplishes each operation in an offline installation.

There are a number of operations associatedwith Licensing Preactor:

l Initialization of the Licensing Area.
l Activating a License.
l Selecting a License.
l Upgrading an existing license.
l Returning an existing license.
l Repairing an existing license.
l Network license manager installation and Setup, and configuring Preactor to use the network license.

License Checks when Starting Preactor
Whenever Preactor starts, a number of license checks take place. The user will be advised and/or offered options based on
those checks.

l If there is no license installed and selected, and no evaluation license has previously been used on the host system, the
user is offered the opportunity to Use the Evaluation license.
If selected, this will Initialize the licensing area and activate an evaluation license for a limited period of time.

l If there is no license installed and selected, but an evaluation license is installed, the system will advise the user of the
time remaining on the evaluation license before continuing.

l If there is no license installed and selected, the user is offered the opportunity to activate a license, or to select an
already activated license.

l If there is a license installed and selected, but it is within 7 days of renewal, the user is promptedwith this information
before being allowed to continue using Preactor.

l If there is a license installed and selected, and not within 7 days of renewal, Preactor will continue through to the Pre-
actor Desktop.

l A license is automatically selected if present for the configuration being run.
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l If a license is not available for the level of configuration selected, but an evaluation license is still available, the eval-
uation license will be auto selected.

The example below shows an Evaluation license activated:

Executing License Operations
All operations (except selecting the license to run Preactor with) can be exercised through the Licensing Utility software
available from the Start menu - Siemens folder, either for the Local License or Network License:

When running the License Utility, valid options are active, invalid options are grayed out.

License Warning
Preactor is licensed using a system that entitles the user to execute the software. While every effort has been made to ensure
the continued operation of your Preactor software, it is the case that certain operations may compromise the integrity of the
license entitlement and render the system inoperable.

Such operations include, but are not limited to, amending system or installation files, deleting or moving those files or
imposing policies that restrict access to those files and / or the system registry.

In order to avoid such issues, you must perform all operations on your license entitlement using the included License Utility,
or Server License Utility for network licenses. Under no circumstances should you attempt to duplicate, move or remove a
license entitlement by any other means, and any attempt to tamper with license entitlements is strictly prohibited. Any such
attempts will render the system inoperable.
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In the event that the integrity of the license entitlement is compromised, a manual administrative procedure must be
performed. For customers not under current maintenance there is an administrative charge associatedwith this service.

For instructions on the correct procedures for removing and returning licenses, consult the included documentation.

Activating Preactor
The first time Preactor runs, you will need to specify what license to use.

Activating a Trial
You can activate Preactor for a trial period of 30 days. The time period begins as soon as the trial license is activated.

To activate trial mode, start Preactor and choose the 'Use evaluation.' option presented on the opening screen.

Activating a License
To activate a commercial license select 'Activate Now' and follow the on-screen instructions. An activation code is required in
order to complete the activation process. Activation can be performed over the internet or off-line.

Once Preactor is activated, you will no longer be prompted at start-up.

License Initialization
When operating Online, Initialization of the Licensing Area is performed as part of the License first Activation - either for a Trial
or a normal Activation license - almost invisible to the user. Observing the pop up dialog when activating a license for the first
time will see 2 requests being sent and responded to.

When operating Offline, since each request and response is performed by manually transferring files to/from Preactor, these
separate operations become plainly visible as a request and response file needs to transferred for each operation.

Selecting a License
Selecting a license to use is be done from within Preactor.

Whenever starting, where no license is Activated and Selected, the user is offered the opportunity to Select a previously
activated license.
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When selecting to Select a license, the user is led through a series of dialogs to select the required license, starting with:

Select the Local license (single user) option.

The user is prompted to select the required product.

At this point, the user can chose to save the selection for later use. Hit Save Selection, and the selection will be saved in the
Command File as the specific License Number to use:

If the user does not select to save the selection, the selection will have to be made again the next time Preactor is started.
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Node Locked Licenses
Node Locked Licenses
Activating a New License
Activating a license can be done from within Preactor or from the license utility, which utilizes similar screens.

Whenever starting, where no license is Activated and Selected, the user is offered the opportunity to Activate a new license.

When selecting to Activate now, the user is led through a series of dialogs to configure the Licensing required, starting with:

Select the Local license (single user) option.

The user is prompted for Internet or Offline activation.

See Offline License Management for guidance for the offline activation.

Activation Over the Internet
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After selecting Activate over the internet, the user is prompted to enter the Activation Code:

Enter the Activation code, and Preactor will perform all actions and checks without further user intervention.

Network Licenses
Network License (Multi-user)
Introduction
The Preactor Network License Manager is used to serve concurrent (floating) licenses for the Preactor application. This
document describes how to install and use the Preactor Network License Manager and how to deal with some of the more
common issues that occur.

The licenses that Preactor uses are stored in a secure location in an encrypted form. Preactor can either use a ‘local’ license, in
which case the Network License Manager is not required, or the license can reside on a server and be used by multiple
computers or users. These server based licenses are called concurrent or floating licenses and are served over a TCP/IP network
by the Network License Manager.

The basic components of the Network License Manager are:

l License server manager
This application (lmadmin.exe) is installed as a service and provides a webmanagement frontend for licenses and allows
users to view the status of the server, restart the server, and change the configuration for other services.

l Vendor daemon
This application serves licenses for Preactor over the network. This daemon is automatically started by the license
server manager and is critical for clients to be able to run Preactor.BoM

Selecting A Server for the Network License Manager
When selecting a machine on which to install a license server select a stable system; do not choose systems that are
frequently rebooted or shut down. For this reason, installing the Network License Manager on a user’s desktopmachine is not
recommended and an ‘always on’ server is preferred. However, there is no technical limitation to installing the Network
License Manager on the same machine that will run the Preactor application.

The resources required for the Network License Manager are typically very low:

l Memory
The Network License Manager uses roughly 10MB of RAM.

l CPU
Very little CPU time is required and, for fewer than 100 concurrent users, the service may only consume a few seconds
of CPU time over many days

l Disk space
A full install of the Network License Manager will consume around 40MB of disk space. By default the Network License
Manager writes out log files to aid with creating usage reports or diagnosing problems. For a small numbers of clients
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these log files will grow at a small rate but it is worth checking these files occasionally and rotating and archiving them.
Logging can be turned off in the license server manager if space is at a premium. It is recommended that logging is
always to a local disk and never to a remote network share.

l Network bandwidth
Relatively little data is sent across the network and typically a check-out or check-in of a license uses about 1KB of band-
width. It is possible for clients to connect over dial-up or slower connections to a central server. The web based frontend
for managing licenses uses HTTP and significantly more bandwidth may be used depending on the frequency with which
pages are loaded. For day-to-day use of Preactor this web based frontend is not required so users do not necessarily
require access to this if network bandwidth is a bottleneck.

Installing the Preactor Network License Manager
The Preactor Network License Manager can be downloaded from the Preactor website. The software can be downloaded from
the GTAC website.

The install is packaged as a self-extracting executable and all that is needed to install it is to double click it to run.
Administrator permissions are required to do the install as the installation includes adding a Windows service as well as
installing some licensing components to the system. After the Network License Manager has been installed administrator
permissions are not required and the service should run at start-up and be available to all users.

The Preactor Network License Manager should be installed to the default location that is suggested by the installer. After
installation, the service will automatically be started and, unless specifically told to by the installer, no restart is necessary.

Accessing the Preactor Network License Manager
The Network License Manager can:

l Monitor license counts andwho is using licenses.
l Monitor alerts from the license server (out of licenses/errors etc).
l Restart the license service.
l Configure logging on the licensing.

It can be opened from the Help and Support menu option, or from:

    Start ►All Programs ► Siemens ► Preactor Network License Manager ►Network License Manager

It can also be accessed via a web interface by using a supportedweb browser. This is useful if the Network License Manager is
being opened from a system which does not have Preactor installed.
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All versions of Internet Explorer from Internet Explorer 6.0 upwards are currently supported. Most other browsers shouldwork
correctly though there may be small layout issues. The web interface can be accessed in two ways:

1. In Standardmode. This is the standard license server management interface, at:
http://<server>:2188

where <server> is the system name where the license server is running.

2. Section 508 mode. This mode provides access to people with disabilities and has the same capabilities as the standard
mode, at:

http://<server>:2188/login508
where <server> is the system name where the license server is running.
The term “Section 508 mode” comes from Section 508, 36 CFR 1194.21, “Requirements for Software Applications and
Operating Systems” of the 1998 amendment to the Federal Rehabilitation Act.

Managing the License Operations in Preactor
All license operations are managed by the Network License Utility:

Start ► All Programs ► Siemens ► Network License Utility

From here, the following operations are available:

l Activate a new license.
l Upgrade an existing license.
l Return an existing license.
l Repair an existing license.

Performing these operations for a network is exactly the same as for a local single user license.

Managing the Network License Service
There are two sections to the web interface – the Dashboard and Administration sections.

The dashboard provides information for users about available licenses, who is using licenses, and alerts about the status of the
license server.

The administration section allows the server administrator to change parameters for logging and ports used by the vendor
daemon.
To log in to the administration section the default username and password are both ‘admin’. This should be changed to
prevent non-administrative users logging in.

There is full help for the web interface available from within it.
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Using a Network License
From the prompt when starting Preactor, select to Activate now, then the Activate a Network license option.

At the next prompt, enter the server address, and the port number if the default is not being used.
This will not succeed unless a License has previously been activated using the Network License Utility.

The server address can be:

l an IP address.
l a computer name
l a fully qualified domain

TCP/IP Ports
The Preactor Network License Manager uses three different TCP/IP ports for serving licenses over the network:

1. The license server manager web interface comes preconfigured to use port 2188. It is recommended that you leave this
at its default value but, if it needs to be changed due to a conflict, it can be changed by editing the ‘server.xml’ file which
resides in the ‘conf’ subdirectory of the installation folder. This file contains a <webserver> element with the port spe-
cified as an attribute. Alternatively, the port can be changed by using the web interface itself but this would require that
the web interface is accessible, at least for a short period of time.

2. The License Server Manager is a service which provides details about the vendor daemon to connecting clients. This
service enables the Preactor application to discover the port number that the vendor daemon uses. This means the user
need not specify the port number when activating the Preactor application. By default this service runs on a port in the
range 27000-27009. It is recommended that this is not changed unless there is a conflict. It can be changed through
the web interface.
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3. The vendor daemon, which serves licenses, is the most important part of the Preactor Network License Manager. By
default it will choose a port to run on and this port can be any one it finds free (often it will choose one near port
50000). It is recommended that this is changed to be a fixed port which the server administrator knows is free.

To change the port, enter the ‘Administration’ section of the web interface, select ‘Vendor Daemon Configuration’ and
then select ‘Administer’ next to the ‘PREACTOR’ daemon.

License Troubleshooting
General Troubleshooting
The first thing to check when the Preactor application is unable to find a network license is whether the required services are
running on server. This can be found under Services in theWindows Control Panel. There are two services which need to be
running – the FLEXnet Licensing Service and the Preactor License Manager.

Preactor will not be able to use licenses if either of these services are not running.

To diagnose this issue, open a command prompt and change to the installation directory for the Network License Manager.

Running the command lmadmin –foregroundwill start the Preactor License Manager and should provide information on why
the service is not starting correctly.

If the output from running lmadmin from the command prompt is similar to the following, the problem is likely to be port
conflicts between the Preactor Network License Manager and another program:

<OS 10048> Only one usage of each socket address <protocol/network address/port> is
normally permitted. : make_sock: could not bind to address 0.0.0.0:8080 no listening
sockets available, shutting down. Unable to open logs

If there is a port conflict, the ports can be temporarily reconfigured to allow access to the Network License Manager and the
administrative options to allow a permanent change:
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l Use the -licPort argument for the license server port.
l Use the -webPort argument for the HTTP port.

The following command reconfigures the HTTP port to 8081:

lmadmin -webPort 8081

When you have reconfigured the HTTP port, you access the license server management interface using the new port number.
So for the example above, connect to the URL, http://<server>:8081.

Firewalls
One of the more common issues when deploying the Preactor Network License Manager to a server is that most operating
systems ship with an in-built firewall. For network licenses to be served over the network, ports need to be opened up to allow
for this communication.

1. The vendor daemon needs to be accessible from the local network. By default the vendor daemon does not run on a
fixed port so it is recommended that this is changed through the web interface. Any free port is acceptable and a high
one is preferred to help prevent any conflicts with other applications. This is the minimum requirement and at least this
port must be open.

2. The license server manager can be opened to the local network which allows users to activate Preactor without having
to specify a port. By default, this service runs in a port range between 27000 and 27009 and it is recommended that
this port range is opened to TCP traffic.

3. The Preactor Network License Manager web interface can also be opened to the local network. By default this service
runs on port 2188 and listens for TCP traffic. This web interface is useful for users to see the status of the license
manager but is in no way required for the correct running of the Preactor application.

Some firewalls allow you to specify an application to be allowed through the firewall rather than explicitly specifying ports.
There are two applications which do network communications – lmadmin.exe which is in the installation folder, and
preactor.exe which is in the Preactor subfolder of the Network License Manager installation.

Log Files
There are a number of log files created using the default configuration shippedwith the Preactor Network License Manager.
These logs files should be sent to your technical support provider in the event of having problems with network licenses. The
log files are stored in a directory called ‘logs’ under the installation folder for the Network License Manager.

l access.log - Contains information recorded about access to the license server management interface.

l lmadmin.log - Contains information recorded by the license server.

l web.log - Contains information recorded by the license server management interface. This file does not contain
information about login events. See the access.log file for that information.

l Preactor.log - This file contains information recorded by the corresponding vendor daemons

Move a License
A license may be moved to a new system by Returning the license, then using that license (same activation code) to activate
Preactor on the other system.

Return a License
A license may be returned for a number of reasons, most commonly to re-use the license on a different machine.
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This is done from the Preactor License Utility – by selecting Return an existing license option.

At the next prompt, the user is askedwhether the license is being returned over the internet, or is it an offline return.

See Offline License Management for guidance for the offline returning of a license.

Returning a License Over the Internet

At the next prompt, the user is asked to select the license to return:

Select the required license, then Next. The user is then askedwhy the license is being returned.

Select the appropriate reason and hit Next.
The licensing utility will perform all actions and checks without further user intervention.

Upgrade a License
A license may be Upgraded to:

l Renew the license (timeout or maintenance date changed).
l Extend capability (The product or number of licenses changed).

The new license is obtained from your supplier.

Upgrading the license is done from the Preactor License Utility – by selecting the Upgrade the existing license option.

At the next prompt, the user is askedwhether the license is being upgraded over the internet, or is it an offline upgrade.
See Offline License Management for guidance for the offline upgrading of a license.
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Upgrade a License Over the Internet
At the next prompt, the user is asked to select the license to upgrade:

After selecting the license to upgrade, enter the newActivation Code:

The user is then prompted to select the reason for Upgrade:

Select the appropriate reason and hit Next.

The licensing utility will perform all actions and checks without further user intervention.

The user can upgrade the license to both renew the license and to add capability at the same time. In this case, the user selects
to change the product - any change to the maintenance dates will be taken into account at the same time.

Repair a License
A license may need Repairing for a number of reasons, for example forced use of newH/W.
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This is done from the Preactor License Utility, andwhen a repair is necessary the repair option is active (when not, it is grayed
out).

Preactor attempts the repair andwill report the success or failure of the repair. If it failed, the user should contact Preactor
Support.

Offline License Management
Although licensing Preactor is optimized for systems with internet access, a capability is available to support the case where
the Preactor system is offline – i.e. not connected to the internet.

Preactor must have a data exchange with the licensing servers for most activities, e.g. for:

l Activation* – When the Activation Code is entered, to ensure it is valid and to record its use.
l Upgrade – When the Activation Code is entered, to ensure it is valid and to record its use.
l Return – to return the Activation Code.

This section can be read in conjunction with the description of each License Operation to see how the procedure is modified in
an offline environment.

Offline Data Exchange procedure
There is a common procedure to support the Offline data exchange.
Whenever Preactor has a 'dialog' with the licensing server:

1. A Request file must first be generated and sent to preactorsupport.plm@siemens.com, to obtain a file that is used to
enable Preactor to perform the requested operation.

2. A Response file is returned to the user.
3. The Response file is then applied to Preactor to complete the required operation.

It is generally possible to continue operating Preactor with it's existing capabilities after sending the request file to support and
while awaiting the response (though not for returning a license). When a response file is to be applied, simply restart Preactor
or the License Utility, and the option to enter the response file is offeredwhen going through the screen progression shown
below.

Activation/Initialization*

As explained in the Introduction, the step to Initialize the Licensing Area which is part of the first Activation operation
performed on Preactor, andwhich is integral to the Activation request for online activation, involves an additional explicit step
for offline activation. This is again done by a data exchange with the licensing servers. So, activating a license for the first time
will require 2 data exchange dialogs with the licensing server.

Offline License Activation Example

The following example of an offline procedure shows an activation. The upgrade is the same, and the return differs only in that
no Activation Code needs to be provided.

This example starts with the Activation already initiated, either when running Preactor in response to the Trial license expiring;
or from the License Utility (in the case of a Network License installation, this must be initiated from the Utility).
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1. After selecting the operation, the user is prompted to indicate whether this is an offline operation.

2. Selecting the offline operation, the user is prompted to generate the request file or to apply the response file.

3. First, you must generate the request file.

For the activation and upgrade operations, an Activation Code will be prompted for:

4. A Request file is generated:
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5. These contents can be saved into a file, or copied/pasted as required. The file must now be sent to preactorsup-
port.plm@siemens.com.

At this point, for activation and upgrade, the licensing activity can be canceled and Preactor can continue to run
normally as before while the user is waiting for the response. The product however goes to an unlicensed state if
returning a license.

6. When the Response file is returned to the user, it must be placed on the Preactor system.

The licensing activity is restarted again if necessary and returned to the prompt where the Response file can be applied.

Selecting to apply the Response file, or when continuing after generating the Request file, will lead to the prompt to enter the
Response file name:

1. Enter or browse to the file.

Selecting next will enable Preactor to complete the operation without further user intervention.

- 37 -

mailto:preactorsupport.plm@siemens.com
mailto:preactorsupport.plm@siemens.com


Configuration Packages

Remember - if Activating for the first time, there will be a second Data Exchange (another request file being generated
to be sent to Preactor, another response file to be entered), the first one having been for Initializing the License area,
the second for Activating the license.

Configuration Packages

Configuration Package Manager
Overview
Preactor requires a configuration consisting of a database, some configuration files and, optionally, report definitions.
Preactor configurations are distributed packaged in a .prpkg file. It is also possible to create these files as a backup for an
existing configuration.

The Configuration Package Manager is a tool for managing package files. It takes care of restoring the database to a SQL
Server and extracting the configuration files needed to run Preactor.

A set of example package files is distributedwith Preactor. Other example Preactor packages can be downloaded from the
Preactor web site. The configurations distributedwith Preactor are installed into a 'Preactor Configurations' folder by default in
the shared documents folder.

Extracting a Preactor Package
The default settings when extracting a package file are appropriate given the following assumptions:

l The database server you are running is using SQL Server Express Edition 2008R2 or later.
l The server has the default instance name of 'SQLExpress'.
l The user has the appropriate permissions for the database server. Using Windows authentication when connecting to
the SQL server, the user needs to have 'create' or 'overwrite' permissions. In most cases, a user with Administrator priv-
ileges will have appropriate permissions.

l The folder name into which the package is installedwill be used to name the database. For example, if your package is
placed in a folder called 'My Configuration' then the database will be named 'My Configuration'.

All of these assumptions may be changed by selecting the appropriate options within the Package Manager wizard.

A package file can be opened in one of two ways:

1. Simply browse to the configuration folder and double click on the desired configuration package or right click on the
configuration and select Install.

1. Select Start ►All Programs, Select Siemens ► Preactor 17 ► Preactor 17.
This displays the Preactor Configuration Selector.

1. A list of folders is displayed, containing the various packages available for you to install. All of the packages
contain example data.
Additional packages are available for download from the Preactor web site some of which do not contain
example data and are ready for you to enter your own data. Click the 'Web Browse' button on the 'Preactor
Configuration Selector' dialog to access these packages - you will need to log-in to the Preactor web site to
download these packages.

2. Open an example configuration folder.
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3. Open the Preactor package file, for example 'Preactor AS Ultimate.prpkg' to install the package.

Once a configuration has been opened, the Package Manager wizardwill take you through installing the package.

Wizard
Progress through the wizard in the normal way, selecting from the Options offered in a series of dialogs.

Basic Operation Dialog

Normally you should not need to change these options, if you want to install the complete package.

Only select the Overwrite check boxes if you know of a reason why the installation might otherwise fail.
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Warning: The Overwrite option will destroy existing data. There is no way to undo this once it is done. Please ensure you have a
backup before overwriting any of these items.

Configuration Files and Local Reports

l By default, the unpacked files are deposited in the same folder as the package. This can be overwritten.

l By default, existing files are not overwritten. This protects the user from input error – the unpacking will fail and an
error will be reported if unpacking is attemptedwhen files already exist – unless Overwrite any existing files is selected.

Database

l By default, the DB is named from the name of the folder the package is located in.

This can be overwritten.

l By default, an existing DBwill not overwritten. This protects the user from input error – the unpacking will fail and an
error will be reported if unpacking is attemptedwhen a DB already exists – unless Overwrite existing database is selec-
ted.

Server Reports

l If the package contains server reports, the ‘Server Reports’ section must be enabled.

By default Server Reports will not be installed as all example packages contain both local reports and server reports. If
you wish to upload the reports in the package to a report server, check the Install server reports to Reporting Services
server option.

l Existing reports will cause the installation to fail, unless Overwrite existing reports is selected.

l The name of the Report Folder is taken from the name of the folder in which the package is located.

This can be overwritten.
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Database Options Dialog

Here you have the choice whether to install the database on the local machine or on a remote server location.

To install the database on the local machine, you must enter the instance name of your local database server in the
connection section. By default this is set to 'SQLEXPRESS'. If you selected an alternative instance name when you installed SQL
Server, enter it here, select if from the drop down list, or clear the instance name field to use the default instance (no instance
name).

To install the database to a remote server, the name of that server must be specified along with a file share from which the
database can be restored. In order for the restore process to succeed, permission to write to the specified file share is required
for the user running the package manager and read permission is required for the account under which the SQL Server
process is running.
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Installation Summary Dialog

This screen shows you the details of what will be installed andwhere it will be installed.

It is important to check that these options are correct and if necessary, click the Back button to amend the options.
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The installer will now do all the work of installing the package for you. This involves creating the database, and copying
configuration and local report files.

These tasks can sometimes take a significant amount of time but should be left to run to completion. Although there is a
‘Stop’ button on the form which can be used to abort the installation process, using this may leave the configuration in an
unusable state.

Warning: Any warnings or errors that occur during the installation will be listed in the above 'Package Management Progress'
dialog (a normal installation will not have any warnings or errors). Clicking on the ‘Details…’ link in the message column will
give more information about what has gone wrong with the installation process. For example, awarning will occur if a
database with the same name already exists and the installation process is warning that it has skipped some items because it
was not told to overwrite anything. If any warnings have occurred, A ‘Report…’ button appears on the 'Package Management
Progress' dialog, clicking on this button allows you to see a report of all warnings and errors from the installation.

The installer is now finished and, if no errors occurred, you will be able to run the configuration by opening the .prcdf file from
the extracted package. The Package Manager automatically modifies any .prcdf files that it installs so that the database
connection strings in them are correct.
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Configuration Selector
Preactor must be run with an installed configuration. Configurations are defined in a Preactor Command Definition (.prcdf) file.

Preactor can be run simply by browsing to the configuration folder and double clicking on the desired configuration, or right
clicking on the configuration and selecting Run.

Alternatively the Configuration Selector provides a means of running different examples of the Scheduler from a single
location. Each of the configuration folders displayed in the Configuration Selector contains a Configuration File (.prcdf) which
points to the appropriate example.

Configuration Selector is started via the start menu:

     Start ►All Programs, Select Siemens ► Preactor 17 ► Preactor 17.

The Configuration Selector will open:

The Configuration Selector offers the following capabilities:

l The normal folder navigation (back, up, new folder, menu).

l Select a configuration folder and run Preactor by selecting the required Preactor Command Definition File and selecting
'Open'.

l Run the Configuration Package Manager by selecting a Preactor Package Manager.

l To browse the Preactor web site for new example configurations:
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l And from the other tabs:

l get a list of Recent Configurations to run.

l get a list of Favorites to run.

A configuration is added to the favorites by right clicking on the configuration to be added, selecting modify, and
in the Advance tab select Add to Favorites.

Running Preactor for the First Time
Preactor must be run with an installed configuration, i.e. a set of provisioned data and system configuration settings
applicable to the planning/scheduling activity being managed by Preactor. A configuration is stored in a number of files and the
contents of the database.

Preactor is distributedwith a number of configurations, with others available from the Preactor web site. Each configuration is
containedwithin a Configuration Package. "Configuration Packages" on page 38.

These configurations are set up so that Preactor runs in the year 2000. This setting can be changed by the user."Preactor
Command File Editor" on page 48.

When running Preactor, a configuration must be selected. "Configuration Selector" on the previous page.

In this description of running Preactor for the first time, a simple approach is described for selecting and loading a
configuration distributedwith Preactor, using a local SQL server.

Preactor can be run in two Configuration modes:

l Preactor Express (Demo)
l Preactor Express (Live)

Preactor Express (Demo) is set upwith example data. The system is fixed to run in the year 2000.

Preactor Express (Live) is ready to be used in live mode. Tables have been cleared and the system is ready for data entry. Data
tables in Preactor can be populated by using the user friendly spreadsheets and importing the data from these sheets or it can
be enteredmanually.

Launching Preactor

1. Select: Start ►All Programs, select Siemens ► Preactor 17 ► Preactor 17. If using Windows Server 2012, navigate to the
Start Screen, swipe or click to show the all Apps view and then select Preactor 17. This displays the Preactor Con-
figuration Selector, where a list of folders is displayed, containing the various Preactor packages available for you to
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install.Choose either the 'Preactor Express (Demo)' or 'Preactor Express' option.

2. Open a configuration example, in this case a Preactor AS Ultimate.
The Configuration Package will be shown for the selected example.

3. Select and Open to install the Package.
The Package Installation Wizard now runs. Run through the wizard hitting Next/Finish to install the configuration.

1. At the first prompt, if the Preactor package is being installed for the first time, the default options can be
selected. However, if the Preactor package has previously been installed, certain files and databases may
already exist. In this case, only select the option to overwrite existing files and database if you wish the
database and files to be overwritten with the contents of the package.

2. At the next prompt, the default option is to use the SQL server that has been installed on the local
machine.
When the package has been installed successfully, the unpacked configuration can then be seen:
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4. Select the Preactor Command Definition File for the Product you wish to run, in this case Preactor AS Ultimate and open
it.
After going through some warning and Licensing windows if necessary, Preactor is started and the main window can be
seen.

Note: In order to prevent unauthorized access to Preactor’s programming interfaces, User Account Control (UAC) should be
enabled and Preactor should be run using the least privileges, i.e. a standard user account and not an administrator account.

To install a License, obtain the Activation code from your Preactor Partner or from your normal source, and follow the License
Installation dialog when starting Preactor (selecting Activate Now from the dialog).

See Licenses in the User Guide or Help for details regarding off-line license installation; Network Licenses; or other issues.

See Licenses in the User Guide or Help for details regarding off-line license installation; Network Licenses; or other issues.
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Using Preactor

Preactor Command File Editor

Introduction
Every Preactor configuration includes a Preactor Command Definition file. Many of the parameters that define how Preactor
should run, from what license to use to how to connect to the database, are stored in this file. The file itself is a text file, and
may be edited using a simple text editor. For convenience though the Preactor Command File Editor encapsulates the
parameters that may be specified andmakes editing a Command Definition File more intuitive and less error-prone.

The default action for a Command Definition File is to open Preactor. To open the file in the Command File Editor instead, click
Modify from the file context menu in Windows explorer.

When selecting a Command Definition file from the Preactor Configuration Selector, hold down the 'shift' key while opening the
file to open it in the Command File Editor.

General Tab
Field Description

File Name The name of the file currently being edited. This field is read-only.

Configuration Description A description that is displayed in the Configuration Selector when the
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Field Description

command file is selected.

Licenses Tab
Field Description

Override default license settings

Setting this check box will enable the license setting controls. Once
checked ‘Use network license’ or ‘Use local license’ should be selected from
the drop-down list.

Server Address
When using a network license the address of the server can be specified
here. The address may be a fully qualified domain name, local network
name or IP-address.

Server Port
If the network license server has been configured to use a port other than
the default port, then that port number may be specified here.

Use Classic Product

A classic product may be selected from the drop-down list when this option
is checked. Selecting a product is only necessary for classic products such as
Preactor 400 APS. Current products are selected according to the license in
use.

Use specific license
When checked a seven digit Preactor license number may be entered. Only
the license specifiedwill then be usedwhen running this configuration.

Configuration Tab
Field Description

Preactor Menu Definition File
Here the menu definition file to use for this configuration is specified. Only
applicable to Ultimate editions of Preactor.

Preactor Table Definition File
Here the table definition file to use for this configuration is specified. Only
applicable to Ultimate editions of Preactor.

Working Directory
An alternative working directory may be specified here. Usually left blank,
meaning the directory the configuration file is in will be the working
directory.

Startup Tab
Field Description

Fix Time

When checked, the Fix Time Options panel will become active and an
absolute time and date or an expression may be specified to set the date
and time for Preactor. Once set, time in Preactor will not progress. Fix Time
is useful in scenarios where a repeatable, predictable behavior in Preactor is
preferred. For example, when running Preactor with a sample data set. For
this reason most Preactor configurations containing sample data have a
time set using the Fix Time option. Fix Time can also be useful when trying
to repeat a behavior in Preactor as so many of the decision points in
Preactor change with the passing of time.
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Field Description

Fix time expressions can be useful for adjusting the date/time of Preactor
relative to the current date/time.

System Time Offset
Similar to Fix Time expressions, but with a simpler +/- offset measured in
decimal days.

PCO When checked the Preactor Communication Object is enabled.

Runtime Tab
Field Description

SQL Connection String

The connection string used by this configuration to connect to the data-
base. This is usually populatedwhen a Preactor Package is installed using
the Configuration Package Manager. Be aware that this parameter, like all
other parameters in the Command Definition File, is stored in plain text and
therefore any user names or passwords included in the connection string
will be visible to anyone with read permissions on the configuration file.

Debug Options

Debug Mode and Debug Plus
When debug mode is enabled, Preactor will create a log file called
"preactor.log" in the current user’s temporary directory. For fully expansive
logging, Debug Plusmay also be checked. Both debug options will
negatively impact the performance of Preactor, "Debug Plus" especially so.
Neither option should be routinely enabled.

Log
When checked a file called Audit.log is created in the working directory
when Preactor starts. Any alterations to any value in any table will be
recorded in this file, along with the user-name of the user who made the
change and the date / time at which the change was made.

Memory Edit Mode
When memory edit mode is enabled, Preactor will inhibit write operations
on the database. This is the same mode that Preactor will adopt when a
configuration is already in use on start-up.

Compiled Configurations

A compiled file is a fixed configuration file for Preactor containing the same
information that can be specified in a Preactor Menu Definition and
Preactor Table Definition file. Compiled configurations are used for a
number of different reasons. Sometimes they are used as a form of control
over the configuration of Preactor, preventing changes to configuration
files by end-users. Usually they are used because not all license types allow
the configuration features required to have full control over the
configuration contents. Such comparability is reserved for the Ultimate
editions of Preactor. See "Ultimate Configuration" on page 300 for more
information.

File
Use this option to specify a compiled configuration file. Usually this will be a
file compiled using pcompile.exe. For more information, see "Command
Line Options" on page 328.

Built-In
A number of built-in configurations exist for the Express, Standard and
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Field Description

Professional products. These may be selected by picking from this drop-
down list. Only the configuration appropriate to the license being usedwill
be usable.

Default
A compiled file will be selected if appropriate given the license type. For
example, if you are using a Classic Preactor Enterprise Run-time license, the
Enterprise Run-time compiled configuration will be used.

Language Settings
To override the default language selection, you may specify a language
here. For more information, see "Language Support" on page 17.

Appearance Tab
Field Description

Display Seconds in Time Fields
When checked, all time fields in Preactor will show a seconds element as
well as hours andminutes.

Disable Anti-Aliased Fonts

Disabled advanced font rendering in Preactor, such as True Type font ren-
dering. Historically some hardware and driver implementations have exhib-
ited poor performance with respect to Anti-Aliased fonts. This option may
be checked in order to circumvent such performance issues.

Advanced Tab
Field Description

Create Enterprise Run-time
When using the Classic Preactor Enterprise product, this option will gen-
erate a new Enterprise run-time file for use with an Enterprise run-time
license when Preactor starts.

Add to Favorites

Use this button to create a short-cut to the Command Definition File cur-
rently being edited in the Favorites folder in the Preactor Configurations dir-
ectory. Shortcuts created in this folder appear in the Configuration Selector
when the Favorites tab is selected.

Other Text
Additional commands that are not recognized by the Command File Editor
may be entered here.

Performance Tab
Field Description

No Costing When checked, Costing will not be involved in calculations.

No Make Span When checked, Make Span data will not be involved in calculations.

No Critical Ratio When checked, Critical Ratio data will not be involved in calculations.

Preactor Desktop
The Preactor desktop is the user interface screen that provides access to all of the Preactor modules such as the sequencer,
editor, data transfer options etc. This section describes the organization of the Preactor window and the associated options.

The window is divided into 3 regions:
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l The Navigation Pane.
l The Active Pane.
l The Work Pane.

Navigation Panes

The Navigation Pane contains a number of options.
Selecting an item from the Navigation Pane opening up a list of options in the Active pane associatedwith that item.
Typically, the Navigation items include Data Maintenance, Configuration, Help and Support, etc.

Active Panes

The Active pane contains a number of options associatedwith the Navigation Item associatedwith it.

Of particular interest is the Workspace pane. This typically offers all the day to day activities expected in Preactor, including:

l A General sub category that provides entry to the Preactor Sequencer and/or Planner.
l A Data Transfer category for Importing/Exporting Orders.

Work Panes

This area typically displays the data selected in the Navigation/Active Pane for editing, or a set of tasks associatedwith the
function selected from the Navigation/Active Pane.

When editing data, the Work Pane has a set ofmenu options available appropriate to the data being edited.

These include options (where appropriate) to:

l Save the changed data.
l Undo any edits made.
l Redo any edits made.
l Edit (Change, Insert, Delete, and Duplicate a record).
Edit ►Global Assign allows for changes to data covering all the records on display.

l View options (e.g. sort order).
l Hide options (e.g. child records).
l Filter drop down menu, allowing to enable/disable filters applied to the table.
l Maintain advanced filters opens the Manage Expressions windows, where creation andmaintenance of user created fil-
ters can be managed.

l More Actions (appropriate to the data on display).

Actionable Item
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An Actionable Item on the Preactor Desktop can be:

l A task - generally presented in the Work Pane
For example: Launching the Sequencer; Running an Export, Creating a configuration package.

l Running the Editor for provisioning data, e.g. selecting:
- Data Maintenance from the Navigation pane, and
- Resources from the Active pane.

It is possible for Tasks to be located in the Active pane, but it is not typical in shipped configurations.

Preactor Data
Preactor holds andmaintains different types of data. Data can generally be classed as:

l Provisioning Data
This is semi-permanent data which impacts the results of the scheduling or planning.
Examples would be the Resources, Resource Groups and Planning Resource Groups, and the data directly associated
with those items (name, cost, type, constraints, etc).
This data is often entered from the GUI,usually from the Data Maintenance pane on the Preactor Desktop, but can also
be imported.
Modification to this type of data is called 'Provisioning'.

l Configuration Data
This is semi-permanent data which impacts the presentation of the results or data. Things such as colors of items on
the GUI.
It also includes 'fixed' provisioning data, for example: Planning Horizon, Default Earliest Start Date Offset, or when defin-
ing behavior (Calculate Costs During Sequence).
This data is often entered from the GUI,usually from the Configuration pane on the Preactor Desktop, but can also be
entered in the same windowwhere provisioning on an item takes place, or from outside Preactor.
Modification to this type of data is called 'Configuring'.

l Transaction Data
This is dynamic or working data, the data that the Planner or Scheduler works on.
It is generally imported, but can be also be 'Edited' from the GUI.

Editor

The Editor
Introduction
Throughout Preactor data is presented and editedwith the use of a common component known as the Editor. The following
are examples of where the editor is used:

l All data modified through the Preactor Desktop (Resources, Constraints etc.).
l Orders from within the Sequencer in Advanced Scheduling.
l Planning items from within the Planner in Advanced Planning.

Additionally, script list information (event and import/export) is presented using the Editor, albeit with some constraints on
the capabilities. For example, sorting is not permittedwhen editing PESP scripts.

If the Sequencer or Planner is open, any editor open on the Preactor Desktop is read-only.
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Multiple records can be selected using the standardWindows behavior: hold Ctrl to select individual records, Ctrl-Shift to select
a range or Ctrl-A to select all.

Whether using the editor on the Preactor Desktop, in the Sequencer in Advanced Scheduling, or in the Planner in Advanced
Planning, the following common features are available:

Edit/Insert/Delete

l To edit a record, double click on the row, or select Edit from the context or topmenu. This shows a dialog for editing a
record. Note that only one record dialog can be open at any one time.

l To delete a selected record, press the Delete key, or select Delete from the context or top edit menu. If more than one
record is selected, all selected records will be deleted. For tables that have a parent / child relationship defined, you can
delete a family at a time my selecting Hide Children and deleting the parent record. Alternatively simply highlight all
records in the family and press delete.

l To insert a record you can either scroll to the bottom of the table and double click the last (blank) rowOR select a row
and press the Insert key, or select Insert from the context or topmenu. In the latter case the recordwill be inserted
above the selected row.

Field Select and Move

l To select a field, right-click on the header row and select Field Chooser from the pop-upmenu. The Field Chooser is also
available from the Viewmenus.
Any field required can be dragged from the field chooser list onto the editor. To remove a field from the editor you can
drag it back into the Field Chooser, or to any area of the screen where the mouse cursor shows an X.

l Fields in the editor can be moved to any position by clicking and dragging the field header. It is also possible to stack a
number of fields in a single column.

Sorting

l Clicking on the header of a column will sort the entries in the table by the contents of that column. The editor will sort
into lexicographic order for string fields, or by value for date, duration and number fields.

l Some fields, such as color fields, have no defined natural sort order. In these cases, when sorted, like values will appear
together for these columns.

l To reverse a sort order, simply click on the header again.
l Sorting can also be done by right clicking on the header of a column and selecting Sort Ascending or Sort Descending
from the context menu.

l To perform a composite sort (e.g. sort by Column A then Columns B), hold down Control while clicking on the head-
ers.

l Sorting is not possible on Matrix fields.
l Sorting is not possible on the added Status column in the sequencer or planner.
l Sorting is not possible on the PESP event scripts or PIO import scripts tables.
l For tables that have a parent / child relationship defined, sorting on a field can be done within the family, or over the
whole table. This choice is selected from the context menu when right clicking on the column header.
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Filtering

l The line below the column header is where filters are defined.
l A filter may be defined for any column.
l A filter consists of an operator (as selected from the drop-down list) and a value.
l Filter operands may include:

l Standard operands like: '<', '=', 'Starts with', 'Contains'.
l 'IN' - where an item is included if the field value matches one of a set described as a comma separated list in value.
e.g. 'IN [Sprocket,Spindle,Gear]'.

l Depending on the column type, different operators are available.
For example, a string field will allow ‘Contains’ whereas a number field will not.

l Multiple filters can be defined at the same time. Where this is the case, each filter will AND with the next. For example:
Order Status = ‘Complete’ AND Quantity > 100.

l The Filter Row can be switched between Show and not Show from the context menu when right clicking on a column
header.

Group By

l Clicking the bar above the header row opens or closes the group-by area. Dragging a field from the header row to the
group-by area creates a group. The rows in the table are now grouped by that field, with the number of items asso-
ciatedwith that group indicated. Dragging a second field after the first in the group area creates sub groups, etc. To
remove a grouping, drag the corresponding field out of the group-by area to an area of the screen where the mouse
cursor shows an X.

l Group By is not possible on Matrix of Status fields.
l The Group By area can be switched between Show and not Show from the context menu when right clicking on a
column header.

In-line Editing

l Within the planner it is possible to make in-line edits on all fields that are editable (for example not read-only or eval-
uated).

l Within the sequencer, in-line edits are possible for check-boxes that are editable.
l Edits are done on a record (row) basis, and are not completed until the row is deselected (another row selected) and all
the changes made to the record are committed. The undo stack will have a single entry for all the changes to that
record.

Printing
The contents of the current editor window can be printed, by going to the Filemenu in the Sequencer/Planner, and theMore
Optionsmenu from the Preactor Desktop.

Note: Printing while items are groupedwill print the collapsed groups only, regardless of whether or not the groups are
expanded in the editor.

Copying
The content of an editor window can be copied and pasted, e.g. into an excel spreadsheet. The selected rows will be copied,
along with the header rowwhich is always included.

Non Text Based Fields

l Color fields are displayed by a colored icon.
l Browser fields are displayed as hyperlinks.
l Icon fields are displayed as an icon.
l Matrix fields are displayed as 'x' items.
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Within the Sequencer and the Planner an additional column showing the status for each row is includedwithin the editor.

Status Column – Sequencer

l The Sequencer Status column indicates the status of an operation or order.
l The left hand side of the icon represents the status for the start of the operation, the right hand side for the completion
of the operation.

l  The following states can be represented.
l Green: Scheduledwithin set time constraints.
l Orange: Scheduledwithin the delivery buffer.
l Red: Scheduled before the earliest start date or after the due date.

l If child records are hidden, a roll-up status is given indicating the worst case status for any given operation within the
order.

Status Column - Planner

l The planner status column indicates the Demand Color.
l The status allows expressions to be passed to them for evaluation, and the colors are configurable by the user, from:

Preactor Desktop ►Data Maintenance ► Planning Parameters ► Set Planner Threshold.

Matrix Editor
When adding or modifying most data in Preactor the Editor is used, however data held in matrices is different in that records
are added or changed using theMatrix Editor.

Sequence Dependent Setup Time fields are an example of this.

When the sequence in which products are manufactured changes the amount of productive time lost to changeovers, this can
be reflected in the To/From sequence dependent setup time matrix.

Experience has shown that components frequently belong to product families and that setup values relate to changes
between product families as easily as product to product. Grouping products into families reduces matrix sizes and enhances
processing speed.

The Matrix Editor supports the following features:

l All cells in the table can be edited and set to a common value using the Edit All button.

l All cells can be reset to the default value for their type using the Reset All button.

l A range of cells can be selected and either reset or edited by using the context menu.
The F2 key can also be used to edit a range of selected cells.

l It is possible to highlight andmirror opposing cells.

To enter or modify a cell in the matrix:

1. Double click with the left mouse button on the cell to be modified.
An Edit Value dialog is presented.

2. Type in the new value using the format h:mm, e.g. :25.
3. Click OK.

The cell value changes to 0 Hours 25 mins.

Setup Persistence
Changing which fields are displayed in the editor and their order, and the sorting preference for each field, persists when the
editor is closed and re-opened. Filtering options do not persist, however note that the Orders Editor in the Sequencer is not
closed until the Sequencer is closed.
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Configuration Classifications
The following classifications control the behavior of the Editor:

l DISPLAY SEQUENCE – Determines whether the sort is just visual, or whether the "memory" is sorted.

Editor Window
Manual data entry/editing, for example, of the Orders can be performed in the Sequencer's Editor window, which can be
opened from View ► Editor Window.

For help in using the editor see "Editor" on page 53.

Configuration

Configuration
The 'Configuration' category provides access to all of the tables and settings that are specific to configuring Preactor.

AS Desktop Configuration Menu
The 'Configuration' category provides access to the 'Sequencer Configuration' settings.

The 'Sequencer Configuration' settings control various display and offset options. Specifically, they define where the Sequencer
horizon begins and ends, the visual display start and end boundaries of the Sequencer Gannt chart, the presence of the
'Sequencer Operation Thumb' enabling easy drag of operations in the sequencer and offsets for the default earliest start, due
date, and terminator position.

The Default Event Scripts that run from push buttons in the Data Transfer menu are also specified here, by selecting options
from drop down lists.

These Event Scripts are the:
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Order Import Event Script1

Product Import Event Script2

Order Export Event Script3

Release Schedule Event Script4

APS Event Script5

Configuring Menus, Toolbars, and Keyboard Shortcuts
Introduction
Extensive configuration is available for "Menu Configuration" on page 64, "Configuring Toolbars" on the next page, and
"Configuring Keyboard Shortcut Settings" on page 63. Right-clicking in the toolbar area of the Sequencer or Planner will display
a menu, where it is possible to display/hide toolbars, lock all toolbars, and access the Customize dialog. The image below is the
default menu in the Sequencer: 

In the Sequencer there is one other way to access the Customize dialog, which is by navigating to Tools ►Customize....

The Customize dialog provides option to configure menus, toolbars and keyboard shortcuts.

1The PESP event script that runs when importing orders using the 'Import Orders' push-button in the Data Transfer Menu.
2The PESP event script that runs when importing products using the 'Import Products' push-button in the Data Transfer Menu.
3The PESP event script that runs when exporting orders using the 'Export Orders' push-button.
4The PESP event script that runs when a schedule is released using the 'Release Schedule' push-button.
5Specifies the default PESP event script that should run when allocating operations in the Sequencer with the APS Rules option
activated.
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Configuring Toolbars
Introduction
Toolbar customization, in both the Planner and the Sequencer, is done via the Toolbar tab of the Customize dialog.

The toolbar list contains all of the default toolbars available in the Planner or Sequencer. It is also possible to create new
toolbars in this dialog. Renaming and deleting toolbars is only available to user created toolbars. Resetting toolbars is available
to all toolbars in the application.

Configuring Toolbars On/Off, and Locking Toolbars
Some quick configuration can be done by right-clicking in the toolbar area. This results in a pop-upmenu, where it is possible
to:

l Enable or disable the display of toolbars. Toolbars that are displayedwill have a tick next to the toolbar name.
l Lock toolbars in their current location in the toolbar area. This will affect all toolbars displayed.
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All other configuration is done from the dialog openedwhen selecting the Customizemenu option.

Creating, Deleting, Renaming, and Positioning New Toolbars
From the Toolbar tab of the Customize dialog, the user can:

l Enable or disable the display of toolbars.
l Creating a new toolbar and assigning a position to it.

l Delete a user created toolbar.
l Rename a user created toolbar.

It is not possible to delete or rename a default toolbar, e.g. Main Menu, Standard etc.

Modifying Toolbars
You may place additional buttons on a toolbar or remove existing buttons from the Commands tab of the Customize dialog.
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The Commands tab provides categories of actions, based on the menus (e.g. View) or submenus (e.g. Calendars).
Dragging the Command icon associatedwith an action to a displayed toolbar will add that icon to that toolbar. Dragging an
icon from a displayed toolbar will remove it.

Modifying Icons
With the Customize dialog open, right-click on an icon in a visible toolbar and a drop down menu will appear with a list of
available modifications.

Available modifications include: 

l Edit Button Image, which opens an Icon Editor where the icon image can be modified.
l Display options, such as whether to display the icon image in the toolbar and/or the text of the action.
l Create a groupwithin a toolbar. Each groupwill have a set of dividers at the beginning and end. Only be start of a group
is assigned, using the Begin a Groupmenu option. The end of a group is dictated by which options have the Begin a
Group option enabled.

l Removing an Icon from the toolbar, by selecting and dragging it out of the toolbar, or by clicking Delete.
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These options are also be available via the Customize dialog ►Commands tab ►Rearrange Commands ► Modify Selection
drop down with a toolbar item selected.

Moving Toolbars
A toolbar can be moved by grabbing it at the right hand size and dragging it to the required location on the Sequencer or
Planner window.

It can be placed on the frame of the window at the top, bottom, left or right hand side. It can also be a floating toolbar, so it is
not attached to the Sequencer or Planner window. When floated, the toolbar is subject to fading after a delay, as specified in
the Options tab of the Customize dialog.

Moving toolbars can be prevented by clicking Lock the Toolbars.

Other Configurable Items
The Options tab of the Customize dialog has additional features that can be used to customize the toolbar display. These are:

l Displaying full menus for personalizedmenus and toolbars.
l Whether to use enable the use of large icons in menus and/or toolbars instead of the default size.
l Whether there is a toolbar fade delay for floating toolbars, and a time value expressed in milliseconds.

Creating Toolbars for Predefined Workspaces
When creating a new toolbar for these options, this can be simply done by opening the menu item normally, grabbing the top
of the drop down list (the thicker gray bar), and dragging it into the toolbar area.

Then, drag the 'dragged' set of icons somewhere different in the toolbar area, and the toolbar will be created. Additions to the
toolbar when a newworkspace is created and configured is automatic, though renaming is not.
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These toolbars can be turned on or off from the toolbar menu, but cannot be deleted from there. They can only be deleted by
resetting all the toolbars.

Resetting Toolbars
Resetting toolbars is done either by:

l Clicking the Reset... button in the Customize dialog, with the toolbar that is to be reset highlighted, or
l With the Customize dialog open, right-clicking on the toolbar that is to be reset, and clicking Reset from the right-click
menu.

These options will only reset one toolbar. It is possible to globally reset toolbars by double right-clicking in the Status bar at the
bottom of the Sequencer.

Configuring Keyboard Shortcut Settings
There are two ways to access the Customize dialog:

l Navigate to Tools ►Customize..., and then click on Keyboard....
l Click on an empty space in the toolbar area, and click Customize... from the drop down menu, and then click on Key-
board....

Commands can be assigned to a keyboard shortcut from within the dialog. When a shortcut has been assigned, they will be
displayed in the relevant menu, next to the command.
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The image above shows that the Plots window can be opened using the Ctrl + Shift + P combination shortcut, and the
Calendar States using Ctrl+Shift+S combination shortcut.

Menu Configuration
Introduction
Menu customization, in both the Planner and Sequencer, is done via the Commands tab of the Customize dialog.

Actions are grouped into Categories. These include the main menu options (File, Edit etc.) and larger sub-groups of actions
(e.g. Calendars and Highlight). There a number of ways that menus can be modified and configured.

Creating a Menu
It is NOT possible to created a completely new menu item in the Planner or the Sequencer.

Existing items in a menu can be moved up to the main menu level, if quicker access is required. To move an item to the main
menu level, select the top level item from the Commands section of the Commands tab, and drag it to the desired position in
the menu.
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If an item that is dragged is a part of thatmenu, amenu item will be created instead of a new menu. The identifier between a
menu "header" and amenu item is if the following symbol is next to the menu item: ►

Deleting, Renaming or Resetting a Menu
If a menu needs to be renamed or deleted, with the Customize dialog open, right-click on the menu item that is to be edited,
and a drop down menu will be displayed. This menu has the options to:

l Reset the menu to it's default set up.
l Delete a menu.
l Rename a menu.
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Adding Items to a Menu
A menu item can be added to an existing menu by dragging the item into the desiredmenu, with the Customize dialog open,
displaying the Commands tab. It is possible to position the menu item within the menu.

The other method to add an item to a menu is to click Rearrange Commands.... The pop upwindowwill allow for the addition
of a menu item in either a menu or toolbar. This is done by selecting the menu that an item is to be added to, and then clicking
Add. A list of all of the commands available will be displayed for selection. Only one menu item can be added at a time.
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Deleting, Renaming or Modifying a Menu Item
There are two way in which a menu item. The first method is to right-click on the menu item that is to be modified, while the
Customize dialog is open.

The drop down menu will give all of the available modifications available to that menu item, including:

l Resetting a menu item to its default state.
l Deleting a menu item.
l Renaming a menu item.
l Editing/copying/pasting/resetting the button image.
l Setting the display of a menu item. It is possible to display a menu item as either text only, or text and image. If set to
Text Only (Always), then if that menu item is used in a toolbar (for example), it will also be displayed as text instead of
an image.

It is also possible to Begin a Groupwithin a menu. A group created by clicking Begin a Group. A groupwill then only be ended
when Begin a Group is enabled for a menu item that is either to start a new group, or show that is it not part of the group.

These modifications are also possible to do from theModify Selection drop down of the Rearrange Commands dialog, found
by clicking Rearrange Commands... in the Command tab of the Customize dialog.
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Menu Presentation
The Options tab of the Customize dialog has a number of additional modifications available for menus, including howmenus
are to be presented in Preactor. Menu modifications are:

l Always show full menus, along with whether the full menus are displayed after a short delay.
l Resetting usage data, which will delete the record of the commands used in the Sequencer/Planner, and restores the
default set of visible commands to the menus and toolbars. This does not undo any explicit customizations. If a rest is
performed, this action is undoable.

l Large icons displayed in menu. If this is unchecked, icons will be displayed at it's default size.
l Set menu animations to one of the follow:

l None
l Random
l Unfold
l Slide
l Fade
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Quick Reference Configuration Guide for Look and Feel
Quick Reference Configuration Guide - Common
What How

Fonts - Disable Anti Aliased fonts Command File Editor ►Appearance tab

Fonts - Menus (in Sequencer or Planner)

For the Sequencer:
  Tools ►Options
For the Planner:
  Settings ►Application Settings

Fonts - Use Small fonts
Fonts - Use System fonts

Command File Editor ►Appearance

Keyboard Shortcuts - Create/Change
Right click on Toolbar Area:
Customize... ► Keyboard...

Language Settings Command File Editor ► Runtime

Menus
- Change contents and orders ofMenus
- Menu animation to open drop down list
- Show all items, or reduced set for a period
or time.

Right click on Toolbar Area:

Customize... ►Commands tab ► Rearrange Commands...

Menus - Show Large/Normal Icons on Menus
Right click on Toolbar Area:

Customize... ►Options tab

PCO Configuration: Show icon in Taskbar Preactor Desktop ►Configuration ►Communications ►Configuration

Time - Display seconds in time fields Command File Editor ►Appearance

Toolbars - Enable/Disable

Right click on Toolbar Area.
General Toolbars can be enabled/disabled.
Select a specific window first (e.g. Gannt Chart) to enable/disable toolbar for
that specific window, where available.

Toolbars - Global Lock or Unlock (can be
moved)

Right click on Toolbar Area:

Check or uncheck Lock the Toolbars

Toolbars - Create, Rename, Delete new Tool-
bars

Right click on Toolbar Area:

Customize... ► Select New/Rename/Delete

Toolbars - Modify Toolbar contents and order
(of enabled Toolbars)

Right click on Toolbar Area:

Customize... ►Commands tab ►Drag Command to desired toolbar

Toolbars- Show Large/Normal Toolbars
Right click on Toolbar Area:

Customize... ►Options tab

Toolbars - Floating Toolbar Fade time

Right click on Toolbar Area:

Customize... ►Options tab ► define the Floating Toolbar Fade Delay in
milliseconds
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Window Management

Dockable Windows
Dockable windows give users more control over the way in which information is presented. It allows them to choose where a
window is placed on the screen and to adjust the size of windows to suit their requirements. This can be particularly useful if
available screen space is limited or if you are using multiple monitors.

Dockable windows (when ‘Dockable’ is selected) can also be:

l Docked – fixed to the left, right, top or bottom of the sequencer window.
l Floating – located anywhere in the Sequencer window. 

To position the window in a floating position:

l Grab the dockedwindow and pull it to the center of the sequencer - then locate it to the desired position using the Dock-
ing Cues.

OR

l Right click on the window head or select the menu option on the head, and select ‘Floating’.

e.g. the Primary Resource Calendars window below.

To position a floating window to a docked position:

l Right click on the window head or select the menu option on the head, and deselect ‘floating’.

OR

l Grab the window by its head (e.g. the Primary Resources) and drag it to the center of the sequencer - then locate it to
the desired position using the Docking Cues.
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To PIN or Auto Hide a dockedwindow, right click on the window head or select the menu option on the head and select Auto
Hide, or select the Pin icon to its top RHS.

This will cause a tab to be created for the windowwhere that window is docked (Left, Right or Bottom). Clicking on that tabwill
open the window, clicking outside the windowwill make it hide. The screen shot below show 2 of the 3 dockedwindows in the
previous example hidden but all with Auto Hide selected.

Dockable windows can be treated as tabbedwindows simply by right clicking on the window header and deselecting ‘Dockable’.

Docking Cues
These cues or guides appear on screen when you attempt to move a floating dockable window, they appear either singly or as
clusters. If, when moving a window, you hover the mouse over a particular cue, a shadow appears on screen showing the
position that the windowwill occupy if this cue is selected.
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Cues can also be usedwhen you want to arrange several windows in a single group. In
any window you can see a cluster of cues and in the center of the cluster is the image of a tab.

Dropping a window in the center of the cluster will add the window as an additional tab to this existing group of windows or
single window.

Windows
All windows can be accessed through their ‘tab’.

Certain windows are also able to be ‘Docked’. These are windows that, when right clicking on their tab include a ‘Dockable’
option, andwhich will be by default:

1. Be set to Dockable.

and

2. Open Docked

Window Tabs
All windows (including Dockable windows with ‘Dockable’ not selected) can be:

l Accessible through tabs in a single Tab Group at the top of the Sequencer.
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This is how a window is initially displayed by default if it is not ‘Dockable’.

l In separate Vertical Tab Groups of the sequencer.

This is achieved by dragging the tab to the left or right hand side of the Sequencer window, or by right clicking on the tab and
selecting ‘New Vertical Tab Group’.

l In separate Horizontal Tab Group of the sequence:
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This is achieved by dragging the tab to the top or bottom of the Sequencer window, or by right clicking on the tab and
selecting ‘NewHorizontal Tab Group’.

Toolbars and Icons
To utilize the screen area efficiently and to provide a quick method of selecting an action: Icons are used to represent action,
and a functionally associated set of Icons are grouped into Toolbars, each associatedwith one or more windows.

By default in shipped configurations, the Sequencer and the Planner each have a number of Toolbars appropriate to that
application, some available for all windows, and some associatedwith specific windows.

The toolbar shown here is the Standard toolbar for the Sequencer:

Some toolbars are only visible, and only configurable on/off, when the window to which they relate is opened. An example of
this is the toolbar associatedwith Calendar States window in the Sequencer.

The Toolbars can be configured to be turned on (displayed) or off, and new Toolbars can be created.

Workspaces
Once you have created a layout of different windows in your workspace it can be saved so that you do not have to rearrange it
every time you open the Sequencer (not currently available for the Planner).

Table & Field Settings

Editor
The 'Table & Field Settings' editor allow users to modify a set of features to change how tables and fields are displayed. This
allows a degree of customization of the definition of tables and fields for Standard or Professional editions of Preactor. For
Ultimate editions the Table & Field Settings provide a more user friendly option for applying certain types of customization
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without having to edit the Preactor Table Definition (.prtdf) file, though this is also an option.

Tools

Save
The save button will save all customizations made in the editor. To abandon changes without saving, the user should navigate
away to a different item in the workspace and close the module.

Show System Tables
System tables can be shown by clicking the button on the menu bar which says 'Show System Tables' or can be hidden by
clicking the 'Hide System Tables' button which becomes visible when system tables are shown.

Restore Defaults
The ‘Restore Defaults’ button will delete all customizations that have previously been saved. It works at a global level andwill
remove the customization for every table/field, not just the table or field currently being edited.

Table Properties
The 'Table & Fields Settings' editor is split into 3 panels. The panel of the left hand side shows a list of user defined tables and,
optionally, system tables.
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To edit any settings a table needs to be selected from the list. A table can be found either by scrolling through the list or by
using the filter box above the table list.

When a table is selected, the properties editor at the bottom of the 'Tables' column becomes enabled. The properties editor
allows the user to change the display name of the table. This is the name displayed in the editor andwhen navigating in the
workspace.

Field Properties
The central 'Fields' column allows the user to select a field from selected table. It becomes enabled as soon as a table is picked
from the left hand column.

There is a filter box at the top of the column which allows a case insensitive filter. There are also three tabs at the bottom of
the column which allow the user to switch between the fields displayed on dialogs, fields displayed on tool tips, and a list of all
fields.

Selecting a field populates the final right hand column with the properties for that field.

There are some properties that are common to all fields, and some properties that are displayed depending on the field type.
The table below shows which properties are supported for each field type.
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Null String Integer Toggle Real Duration

Display Name X X X X X X

Hidden X X X X X X

Read-Only X X X X X

Number Format X X

Display Seconds X

Display Name
Setting the display name here overrides the name that is displayed on edit dialogs and on the column headers in the editor.

Read-Only
Read-only fields cannot be edited through the UI, though the underlying field values may still be altered in other ways (using a
PESP script, for example).

Hidden
The field is hidden so is not possible to modify or view the data. Selecting this toggle will remove the field from any dialogs it is
on, so it will disappear from the list of fields in the ‘Dialog Fields’ tab.

Number Format
Defines the format in which numbers or durations are displayed. For details, "Number and Duration Formats" on the next
page.

Display Seconds
Shows the seconds element of a duration field when selected.

Reordering Fields
Users can use the ‘Dialog Fields’ and ‘Tooltip Fields’ tabs to reorder fields. A field can be ‘picked up’ by clicking on it with the left
mouse button and then, whilst still holding the mouse button down, dragging it into another location. This changes the
position of the field within either the dialog or tooltip.

Adding and Removing Dialog Fields
The ‘Dialog Fields’ tab allows the user to add or remove fields on editor dialogs. Fields can be removed from the ‘Default’ dialog
(the one initially shown when editing a record) or the sub dialogs. For example, the ‘Attributes…’ button belowwould show
fields listed in the ‘Attributes’ section of the ‘Dialog Fields’ list.

To add a field, the user clicks on the 'Dialog Fields' tab at the bottom of the central 'Fields' column and then presses the 'Choose
Fields...' button.
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This will display a list of 'Hidden' and 'Unassigned' fields. The user can drag a field from either of these two categories into the
list of fields. If a field is dragged from the ‘Hidden’ section of fields then it will automatically become not hidden when added to a
dialog.

Similarly, it is possible to remove fields from a dialog either by right clicking on a field in the list and using the ‘Remove’ option
from the context menu, or by dragging a field into the ‘Field Chooser’. Dragging a field into the ‘Hidden’ section of the ‘Field
Chooser’ will remove a field from the dialog and also set it to be hidden.

It is not possible to add or remove fields from matrix fields (‘List Fields’), but the fields within them can be reordered just like any
other dialog.

Hidden fields are displayed in the ‘All Fields’ tab as disabled but will not be displayed in either the ‘Dialog Fields’ or ‘Tooltip Fields’.

Number and Duration Formats
Format strings are used to determine how a value is displayed. They are applicable to both REAL fields and DURATION fields,
though they are interpreted slightly differently for both.

REAL Fields
A format string for a number field takes the following form:

[MAX] length.precision

The length element defines the overall length of the value in digits (including the decimal separator). If the length is prefixed
with a zero character (e.g. 06), then the formatted number will be paddedwith zeros, otherwise it is paddedwith spaces.

The precision element defines the number of digits displayed after the decimal separator (the fractional part).

The optional 'MAX' keyword affects how the precision is interpreted for whole integer values. With the 'MAX' keyword, the
precision element defines number of digits used for the fractional part only when the number has a fractional part.

Examples
Value Format String Formatted Value

10.55 3.1 '10.6'

10.5 6.2 ' 10.50'

10.5 06.2 '010.50'

10 MAX 6.2 '    10'

10.555 MAX 6.2 ' 10.56'

DURATION Fields
For DURATION fields, the format determines the number of digits displayed after the decimal point for the minutes part. The
default is .2 if the number ofminutes is not an integer. The format must be specified as .x. For example, '.4' will cause a
duration of 1 hour 5.5 minutes to be displayed as '1 Hours 05.5000 mins'. Integer minutes will always be displayed
without any digits after the decimal point.

Import & Export

Import/Export Overview
Much of the information used by Preactor is typically available in other systems and therefore Preactor includes a number of
import features for extracting data from other sources, as well as export features for extracting data from Preactor to file.
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Import, in particular, is a feature of Preactor with a broad range of functions to accommodate a wide range of integration
scenarios. Once defined, import scripts can be invoked from PESP scripts, so more complex integration scenarios can be
composed of several import scripts (maybe coming from different sources).

The following sections describe in detail the import and export features in Preactor, how their use is defined by means of an
import script, and how those scripts can be easily defined using the in-built Import/Export Wizard.

Data Providers
Preactor supports importing from a predefined Data Provider into any table defined in the UserData schema. Executing a query
against the Data Provider returns a result set, which becomes the source for the import.

Note: Importing from data providers is a feature that is not available in Express editions of Preactor. If you are using an Express
edition, all imports must be from a file source.

Data Providers are a component of the .NET Framework and as such, their availability is dependent upon your operating
system. By default, the .NET framework installs four main providers, which allow you to connect to almost any data source. If
a requirement exists for a particular 3rd party provider this can sometime be achieved by means of a provider developed by a
third-party.

Some Data Providers are only available in either 32-bit or 64-bit versions although most are suitable for any CPU. For example,
the OLEDB Jet provider is only available on 32-bit platforms at the time of writing.

Note: Check that your required provider is available for your target platform. You may need to consider whether the 32-bit or
64-bit versions of the required provider are available and select the appropriate installation of Preactor.

.NET Framework Data Providers
A number of data providers are include with the Microsoft .NET Framework. Each is described below:

Data Provider Description

Data Provider for SQL Server Provides data access for Microsoft SQL Server version 7.0 or later.

Data Provider for OLE DB For data sources exposed by using OLE DB.

Data Provider for ODBC For data sources exposed by using ODBC.

Data Provider for Oracle For Oracle data sources.

Data Provider for SQL Server
The .NET Data Provider for SQL Server allows you to connect to SQL Server instance running on Microsoft SQL Server 7.0 and
later.

Although it is possible to connect to SQL Server databases with both OLE DB andODBC providers, you should always use the
dedicated SQL provider where possible.

Using this provider allows you to create queries over multiple tables and views or even over multiple databases.

Note: Executing a query over multiple databases is only possible if those databases reside on the same instance or on a linked
server.

For more information on linking server instances, please visit http://technet.microsoft.com/en-us/library/ff772782.aspx

Data Provider for OLE DB
The .NET Data Provider for OLE DB uses a native inter-op layer for data access and provides an extensive selection of providers.
OLE DB allows you to connect to Databases and files as well as services such as Network Directory services andmuch more.
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Data Provider for ODBC
The .NET Data Provider for ODBC enables access to system defined ODBC data sources such as dBase, Paradox, SYBASE and
Oracle services as well as Microsoft Office applications such as Visio, MS Project and Excel. Typically, these data sources are
defined in the ODBC Data Source Administration control panel in Windows.

Data Provider for Oracle
The .NET Data Provider for Oracle enables access to Oracle Data Sources by using the Oracle Client connectivity software.

Managing Data Providers
Choose Configuration ► Import/Export ►Manage Data Providers to add, edit or delete data providers you wish to define as
import sources.

You can create as many providers as required but an import script can only use one data provider.

Note: A data provider named 'Preactor Default' always exists. This provider cannot be deleted or edited and exists as a
convenient way to access the database to which Preactor is connected. This is typically used to import sample data.

Creating a New Data Provider

1. In theManage Data Providers dialog, click Add.
2. In the Add Data Provider dialog, give the provider a name.
3. In the Choose Data Source dialog, select a data source from one of the listed available data sources.
4. At this point you will be shown a Connection Properties dialog. Complete the connection properties dialog, providing

all the details required to connect to your chosen data source. Once complete, the connection properties dialog should
look similar to this:

5. If available, it is a good idea at this point to click Test Connection to verify that the connection properties provided are
working as expected.
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Some of the connection properties may affect the validity of queries executed against the data source. For example, in the
above dialog it is possible to select a database or you can leave the database blank. If no database is specified, it will need to be
specified it explicitly within any queries.

Note: For information and guidance on the configuration of Data Providers, please visit http://msdn.microsoft.com/en-
us/library/s7ee2dwt%28v=vs.71%29.aspx

Edit an Existing Data Provider
An existing data provider can be edited by selecting the data provider and choosing the Edit button from the toolbar above.

Delete a Data Provider
To delete a data provider, select the provider and choose Delete from the toolbar above.

Connection Strings
When you create a data provider, the connection string is stored in plain text. This means any user names or passwords
specified in the connection string are not encrypted.

To avoid any issues it is recommend that you use integrated authentication if possible.

Import/Export Scripts
Both imports and exports are defined as scripts. Each script stores all the information about an import or export process - what
the update method is, any queries involved, how the fields are mapped etc. While it is not important to know the detail of what
is included in the scripts (this is managed using the Import/Export Wizard), it is useful to understand how these scripts are
managed, maintained an ultimately invoked.

Import and export scripts are stored in the Import-Export Scripts (PIO Scripts) table.

Configuration ► Integration ► Import/Export Scripts.

To run an existing script, select the script and choose Run from the tool bar.

To create a new script, insert a record into the table as you would for any table in Preactor. On insert the Import/Export Wizard
appears. Follow the steps in the wizard to create an import or export script.
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Edit a script in the same way as you would edit any data row in Preactor. Again, the Import/Export Wizardwill appear to walk
you through editing the script.

Scripts can be saved to or loaded from a file. This is useful when transferring scripts between different configurations. To save a
script select the script and selectMore Actions ► Save Script. To load a script, selectMore Actions ► Load Script.

Import/Export Wizard
Import/Export Wizard Overview
The Import/Export Wizard provides a simple interface to define the options for your import or export script. It will allow you to
define an import or export script for any table within the "UserData" schema. You can also import directly into any AUTO
LIST or AUTO DIMENSION matrix using the matrix import features.

For import scripts, the Import/Export Wizard can connect to a large range of data sources using either a connection through a
Data Provider or by using the File connection type. Export scripts target file based outputs only.

When you create a new script, you will first be prompted to select the type of script you wish to create.

Script Information
After selecting either import or export for the type of script you want to define, you are required to enter some basic
information about the script. This includes a name and description as well as the table that is the subject of your script. For
import scripts, you will need to define some additional information such as the connection type andwhether you are
importing into the selected table or into one of its associatedmatrix tables.

Note: Not all tables have matrices defined and the matrix import functions are dependent on what fields are defined in the
selected table.

Supported Connection Types
For import scripts Preactor supports two connection types, each of which is detailed below.

File

The File connection type allows you to select a locally accessible .csv file as the import source. If you are importing data from a
local .csv file then select this connection type.

Data Provider

The Data Provider connection type allows you to select a predefined data provider as the import source. The source data is
determined by the execution of a query against that source. Select this connection type if you are importing from a database
or other data source.
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Once you have entered the basic script information, you may progress with the wizard. The options presented to you in the
subsequent pages of the wizardwill vary depending on the options you have selected.

File Import
Importing from a file is an option across all editions of Preactor. There are fewer steps in importing from a file. So long as the
required file is in an accessible location, all that is required is a path to the file.

Import files must be .csv (Comma Separated Value) files. Contrary to the name, a number of delimiters are supported, as well
as the standard comma delimiter.

To select a file, click the Browse... button and use the Open File dialog to select the file you wish to import. The file path will
be populatedwith the full path to the file. If required, this path can be specified as a relative path (relative to the configuration
directory). For example:

Import-Export Files\Import-Products-Initial.csv

In addition to the file path, you can also specify the file encoding using by expanding the File encoding section. By default the
file encoding is set to Unicode (UTF-8). For Unicode files, several forms of encoding are supported. If the file is ANSI or Windows
encoded, selectingWindows Encodingwith the default code page is typically correct. If you are importing a file that includes
characters that are not native to the computer on which you are running Preactor (for example, a file including Chinese
characters on a US-English computer) it will be necessary to explicitly select the required code page from the list of those
available.

If the first row in the file is a header row, select File Includes Header. By default, the expected separator is a comma, but other
supported separators can be selected from the list of separators.

Data Provider Import
In all but the Express editions of Preactor, it is possible to import data from a data provider.

When importing from a data provider, select Data Provider from the Connection Type drop-down on the script information
page of the Import / Export Wizard.

On the following page, you will be asked to select a data provider and enter a query. This query will be executed against the
selected data provider and the resulting data set is imported into Preactor when the script is run.

An example of a SQL query:

SELECT Name FROM SampleData.ColorData
WHERE SampleData.ColorData.Dataset = 1

On the same page, a preview of the resulting data set is shown. Click Preview, or press F5 to refresh the data preview.
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Note: The data Preview pane is populatedwith a subset of the query result to show you the shape and format of the data you
will be importing.

Data Provider Queries
When you use a data provider to import data, you have to define a query that will be executed against your data source.

The syntax of that query may change depending on the data provider that you use, and the performance of your import script
can be influenced greatly by the design of your query as well as the source, size and shape of your import data.

In order to design effective and efficient import scripts careful consideration must be given to the design of your query.

The secret to designing an efficient query is to limit its scope. Where possible, only select columns that you need andmake use
of clauses such as WHERE when available and appropriate to do so.

The topic of query languages, their nuances and best practices is vast and generally outside the scope of this documentation.
For more specific information on queries you should refer to the documentation for the query language you are using.
However, some general guidance applicable to most Simple Query Language (SQL) derived query languages is given below.

SELECT Statements
The SELECT statement is used to select data from a data source. It returns an object known as a result set. This result set is
used as the source for the import.

While the syntax remains similar, arguments can differ between different data sources as can be seen by the following
examples:

SQL SELECT

SELECT [Column(s)]
FROM [Table]
WHERE [Condition]

EXCEL SELECT

SELECT [Column(s)]
FROM [SHEET One$]
WHERE [Condition]
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Text File SELECT

SELECT [Column(s)]
FROM [File Path]
WHERE [Condition]

JOIN Statements
A JOIN combines records from two or more tables to create a single set of data. There are typically 3 types of join. INNER, LEFT
OUTER and RIGHT OUTER but this may vary by provider.

An INNER JOIN returns only those rows from the LEFT table that have a matching row in the RIGHT table, based on the join
criteria.

SELECT column_name(s)
FROM table1,
INNER JOIN table 2
On table1_column_name = table2.column_name

A LEFT OUTER JOIN returns all rows from the LEFT table even if no matching rows were found in the RIGHT table. Any values
selected out of the right table will be NULL for those rows returnedwhere no matching row is found in the Right Table.

SELECT column_name(s)
FROM table1
LEFT OUTER JOIN table 2
On table1_column_name = table2.column_name

A RIGHT OUTER JOIN is the opposite of a LEFT OUTER JOIN in that it returns all values from the RIGHT TABLE regardless of
matching rows in the LEFT table.

SELECT column_name(s)
FROM table1
RIGHT OUTER JOIN table 2
On table1_column_name = table2.column_name

Note: Best practice suggests that you not use a RIGHT OUTER JOIN because these can always be rewritten as a LEFT OUTER JOIN,
which is consideredmore portable and easier to read.

You can execute a join against .csv files and Excel files by applying the same basic syntax.

SELECT [Column (s)]
FROM [filePath] as table1
INNER JOIN [filePath] as table2
ON table1.column = table2.column
WHERE condition

Open Data Import
In all but Express editions of Preactor, it is possible to import data from an Open Data Protocol (OData) data stream.
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Preactor supports OData V3 and V4, both atom and json based streams.

Where data is exposed using OData, all that is required in order to import that data into Preactor is a URL.

Authentication
Some services may require authentication. By default, Preactor will use the current user's credentials to access a service. If
other credentials are required, then a user name / passwordmay be provided. Preactor will store any passwords in an
encrypted field. See "Encryption " on page 119 for more information.

SIMATIC IT Authorization
When connecting to SIMATIC IT Unified Architecture (UA) service layer, an authorization token must be provided in order to
make the request on the server. Preactor supports X509 certificate based authentication for SIMATIC IT UA. An X509 certificate
may be stored on disk, or added to the local certificate store. Certificates should be added to Preactor through Configuration ►

Security ►Certificates.

Entities
Preactor will use the OData meta-data to list the entities exposed by the service. To query for all instances of a particular
entity, simply select the entity you require from the list.

Complex Queries
As well as allowing for simple queries, Preactor allows for more complex queries using OData query syntax. Open the
Advanced section in order to enter OData syntax. Bear in mind that Preactor will only support queries returning "plain old
data", any complex types or collections should be simplified in the query in order to be used by Preactor.

Importing Hierarchical Data

OData Import supports the flattening of hierarchical data to a format that can be consumed by Preactor. This is achieved by
writing an Expand clause in the Override Query field, which is found in the Advanced section of the Query Details page of the
Import Wizard.

A hierarchical data depth of 5 levels is supported by Preactor, and the diagram below illustrates what is meant by levels.

If importing data that contain more than five levels, Preactor will import down to the fifth level, and then will stop looking for
data.

Here is an example of a query that can be used to import data from one table that has a child table associatedwith it. This
query would be used in the Override Query Field:
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[Parent Table]?$expand=[Child Table1]

Where [Parent Table] is the name of the Parent Table, and [ChildTable1] is the name of
the table that is the child of the Parent Table.

Import Settings
Once your source data has been defined, whether from file or from a data provider, the remaining pages in the Import/Export
wizard from this point on are the same.

There are some general import settings that mandate how the import data will be processed. Each option is explained below.

Clear Preactor Table
The target table will be cleared of all its existing data. Generally, clearing the contents of a table should be avoided as
references to items in a table will not be consideredwhen clearing a table and this could compromise the integrity of your
data. If a table has no references to it, it is generally safe to use this option.

Update Current Records
When a row in the target table is matchedwith a row in the import data, its contents will be updated from the import data
(according to the mapping defined) if this option is selected.

Append New Record
When a row in the import data does not match with any of the existing rows in the target table, a new row is appended to the
target table when this option is selected.

Delete Old Records
With this option selected, any rows that exist in the target table but are not matchedwith any rows in the import data are
deleted.

Rebuild Family
Once all the import data has been imported, any broken family relationships (e.g. parents rows with the same identifier value)
are repaired.

Expand New Orders
Specifically for when importing into a table with an expand relationship (such as the expand relationship between an Orders
table and a Products table), this option will expand a single row into n rows as specified by the source of the expansion. This is
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useful when importing order header information and then expanding the routing information from a Products or Routes
table. For more information on how expandworks, see "Auto Expand" on page 197.

Additional Options
A number of advanced features are enabled using commands that can be defined in the in the Additional Options field.

Mapping Import Fields
Import data and the target fields in a Preactor table need to be mapped from one to the other. The mapping identifies not only
the fields for which data should be imported, but also the type of the data being imported, any supported transforms that
should be applied and also fields that make up the identifiers for an import.

Mapping Tools
Certain fields can be filtered and sorted using the tool bars at the top of each field list. Each tool is described in the table below:

Hides unmapped fields

Sort fields alphabetically

Sort the fields by mapping. (only available for Import mappings)

The search box can be used to filter the field list based upon a search term.

Clear

This button will clear all of the existing fieldmappings.

Auto Map

Based on the names of the columns in the import data and in the target table, Preactor will attempt to map fields
automatically when this button is pressed. When a new script is defined, this automatic mapping is invokedwhen the mapping
page is first shown.

Mapping Menu

To show the mapping menu, hover the mouse pointer over the mapping relationship an click on the drop-down menu when
the icon appears.
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Mapping Properties
Data Type

The first four options are associatedwith the type of the data that is being imported.

String The value is a string value.

Number The value is a numerical value.

JDate
The value is a date represented as the number of days since midnight on the 31/12/1899, otherwise
known as an OLE Automation date.

Date
The value is a date. The date format must me specified by selecting from the predefined options or by
entering a custom format string.

Duration
The value is a representation of timespan data in various formats including ticks, which are displayed
as decimal days.

The normal reference point used for JDate mappings is midnight on 31/12/1899. You can however apply an offset which adds
a number of decimal days to the normal reference point.

Note: Preactor supports the full range of Date Time formats within the Microsoft .NET Framework. For more information on
Date Time formats and Custom formats, please visit: http://msdn.microsoft.com/en-us/library/az4se3k1(v=vs.100).aspx

Import Identifiers

At least one mapping should be marked as an import identifier in order for an import script to be valid. An import identifier is a
field or one of a set of fields that can be used to identify a row in a table. For most import scenarios, this set of fields should
identify a single, unique row. There are some cases where you may want to match a broader category of records, so the
uniqueness of the rows identified is not enforced.

Import identifiers are markedwith an "id" symbol to the right of their field name on the right-hand side of the mapping. To set
a mapped field as an import identifier select the 'Import Identifier' item from the mapping menu.

Note: Mapped fields should not be marked as import identifiers unnecessarily, as doing so can have a negative impact on import
performance.

Ignore Blank Strings

With this option selected, blank strings will not be imported. Any other value will be treated as it would otherwise be treated
according to the options specified.

Delete
If you select delete from the mapping menu, the individual mapping relationship will be deleted.

Default Import Values
On occasion fields that are not mapped in an import script may not carry an appropriate default value. Rather than accepting
the default value as defined against the field (shown in the first column for reference), we can specify a default value for a field
within the import script . The value specified can be different for difference scenarios, identified by the On Create, On Update
andOn Delete column headers on the default values page.
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Note: Only fields that have not been mapped are displayed on the default values page.

On Create

This value will be written to the unmapped field whenever a new row is created.

On Update

This value will be written to the unmapped field whenever an existing row is updated.

No Change

This value will be written to the unmapped field when a row exists prior to importing data, but that row is not updated.

Replaced Values
There are some key words that are may be specifiedwithin the default values. These key words will be replaced during
import. Each is detailed below:

Keyword Description

{DATE} A string representing the current date. Only valid for string fields.

{TIME} A string representing the current time. Only valid for string fields.

{JDATE} A number representing the current date. Valid for string, number and date fields.

{JTIME} A number representing the current date/time. Valid for string, number and date fields.

Matrix Imports
Preactor supports two different types ofmatrices that can be imported.

The first type ofmatrix is a list of items. These lists appear throughout Preactor and are usedwhen creating groups of items,
or assigning multiple items to one record. These lists grow and shrink as you add and remove items. A typical list is shown
below:
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The second type ofmatrix that Preactor supports is a 2 dimensional matrix. These matrices define a from/to relationship
between two tables. A typical 2 dimensional matrix is shown below:

Both of these matrices are defined as fields in Preactor, and normally each row in a table will have an instance of a matrix. That
is, a table with 10 rows will normally have 10 different matrices. It is therefore important when importing a matrix that you
not only have the data for the matrix, but also a way of identifying the correct row in which the list exists.

Importing a List

Importing a list into Preactor uses the same Import/Export Wizard that is used to import into tables. The main difference is that
there are multiple "mapping" screens in order to allow the mapping of each piece of information required. For a list, you will be
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presentedwith either 2 or 3 mapping screens depending on how the list is defined (whether you just have a list of items, or
whether you have a list of items which have additional data defined against them).

This exercise will take you through importing secondary constraint data for a resources table.

l Step 1: Open the PIO Scripts pane.

1. From the Preactor Desktop, click Configuration and then click Import/Export.
2. In the Import/Export pane, click Import-Export Scripts.

l Step 2: Create a new Import Script.

1. In the PIO Scripts pane, click Edit and then click Insert.
2. In the Import/Export wizard, ensure Import is selected and then click Next.

3. In the Enter Script Information window, enter the values from the following table:

Field Value

Script Name Import Resources Secondary Constraints

Description Import secondary constraint information for resources

Preactor Table Name Resources

Matrix Import Secondary Constraints

Connection Type File

Note: To import data from a data provider you can use the Data Provider connection type.

4. Click Next.

5. In the Import Script Information window browse and choose either the file above, or use the standard
‘Import-Resources-InitialSecondaryConstraintMatrix.csv’ file which ships with the configuration in the
‘Import-Export Files’ folder. Click Next once this file is selected.

6. On the Import Settings page select the Clear All Matrix Records option and the Append New Records
option. The other options should be left unchecked.

7. Click Next to continue.

8. You are now presentedwith a mapping screen. It is important to note that the current mapping and table
name are shown in the upper left corner of the screen:

9. This mapping page is to decide howwhich row the matrix belongs to. The upper left corner shows that
you need to map one or more fields to uniquely identify a row in the ‘Resources’ table. In this the ‘Name’
row from the ‘Fields to Import’ column uniquely identifies a "resource" by its Name field.

1. In the Import FieldMappings window, select Resource in the Fields to Import list.

2. Whilst holding the left mouse button, select the Name field in the Preactor Fields list.

3. Click Next to continue.

10. This mapping page should show that it is an X Axis mapping page. Refer to the diagram of the list import if
you need to understandwhat this is. The Secondary Constraints on the Fields to Import column
uniquely identifies the item which should be added/updated/deleted from the list.
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1. In the Import FieldMappings window, select ‘Secondary Constraint in the Fields to Import list.

2. Whilst holding the left mouse button, select the Name field in the Preactor Fields list.

3. Click Next to continue.

11. This mapping page is called the DataMapping page. This is additional data which is attached to the item in
the list (usage type and quantity). In cases where there is no additional data, this page will not appear.
Similarly, you could continue without mapping any fields if you decided you didn’t want the additional
data.

1. In the Import FieldMappings window, select Constraint Usage in the Fields to Import list.

2. Whilst holding the left mouse button, select the Constraint Usage field in the Preactor Fields list.

3. Repeat the process for the Constraint Quantity field.

4. Click Next to continue.

12. The script has now been created. You can run it here or click Finish and run it from within the IO Scripts
table. Try changing some data in the import text file (change a constraint quantity from 1 to 5 for
example) and verify that, after the script is run again, that the data has changed in the Resources table.

2D Matrix Import
Importing a 2 dimensional matrix into Preactor uses the same Import/Export Wizard that is used to import into
tables. There will be 4 mapping screens, where details will be collected about which row the matrix belongs to,
what the x axis is, what the y axis is, andwhat the data is.

The process for creating a script is similar to importing a list. The main difference is that there is an additional Y-
Axis Mapping Page and that the "Data Mapping" page can only ever have a single fieldmapping.

Export to File
Preactor supports exporting data to either a .csv file or an Excel spreadsheet. When defining an export script using the Import
Export wizard it is possible to export data from any table within the UserData schema.
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Once the basic script information is defined (name, description, source table), it is then necessary to start defining field
mappings. Export filedmappings differ from import fieldmappings in that the fields to export are not defined until the mapping
is created. It is also possible to export the same fieldmore than once (for example, with different formatting).

Extract Expression
This is an expression that will be evaluated for every row in the source table. Only rows where the expression evaluates to true
will be present in the export file.

Example:

Numeric field comparison: {#Resource Group}==2
String field comparison: ~{$Resource Group}~==~Welders~
Date field comparison: {#Order End} > -1 && {#Due Date} > -1 && {#Order End} < {#Due
Date}

Additional Options
A number of advanced features are enabled using commands that can be defined in the in the Additional Options field.

Mapping Export Fields
Mapping export fields is a case of selecting a field in the 'Preactor Fields' list on the left of the mapping page and including it in
the Exported Fields on the right. This can be achieved in a number of ways. A field can be dragged from the left list to the
right list. If you double-click on a field in the left list, it will appear in the right list. Finally, if you click the Export All button, all
the fields in the left list will be added to the right list.

The order that fields appear in the Exported Fields list dictates the order the fields appear as columns in the exported file. You
may reorder the fields in the right hand list by dragging a field up or down the list.

Once a field is listed in the right-list it can be removed by deleting the map from the mapping menu or by clicking the Clear
button, which will remove all fields from the right list.

Also from the mapping menu are a limited set of formatting options, equivalent to those available for import mapping.

Default Import and Export Scripts
Import/export scripts can be run with a single button hit from the Workspace Data Transfer and General menus, for example
to:

- 94 -



Import & Export

l Import Orders, Forecasts, Sales data.
l Export the Release Schedule.

Each of these functions may have a number of scripts available to address different situations.

For example, one Import Order script may populate Preactor with a set of orders, overwriting anything that is already in the
database, while another script may add to existing orders.

Which particular script to run is configured via:

Configuration Pane ► Settings ►Menu Button Mapping (Preactor AS)
Configuration Pane ► Settings ►Configuration Data (for Preactor AP)
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As can be seen in this Preactor AS example, a drop down menu will offer the scripts available for each of the standard data
Transfer buttons.

There would normally be no need to change these for Preactor AP, however alternative scripts could be predefined for different
circumstances allowing rapid changes between configurations without needing to manipulate script files.

Importing And Exporting Calendars
Overview
A separate mechanism exists for exporting and importing all Preactor calendar data using SQL stored procedures and XML files.
One of the primary reasons for providing this mechanism is to support the transfer of calendar data between a master
scheduling system (MSS) and a viewer. This is only necessary when a viewer license is usedwith an independent database and
therefore only applies to Ultimate viewers. When a viewer is connected to the same database as the MSS the transfer of
calendar information is not required.

Using Calendar Import/Export
The import or export of calendar data can be achieved using one of two PESP actions. These actions are called Export
Calendars and Import Calendars. Each of these actions takes one parameter called Filename. This parameter is where you can
specify the name of the file to which the data will be written or from which it will be read. It is usual to give these files a .xml
extension. When executed these PESP actions will export or import all calendar data. There is no way to select a subset of the
data to export or import. If there is a requirement to do so (for example, only transferring calendar exceptions between
configurations) then it is recommended that the system implementer look into the calendar related Preactor API methods (see
the API documentation for more details). Generally calendar information should only be importedwhile the sequencer is not
open.
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Note: While it is possible to edit .xml files, it is recommended that the calendar related Preactor API methods are used in
preference. Certain elements reference other elements using an Id. If these relationships are broken, then the file will fail to
import.

External Data Mapping
Overview
External Data Mapping is a feature within Preactor that allows information from an external source to be ‘mapped’ into the
tables defined in Preactor.

This approach differs from conventional import scripts, in that external data is not considered as information that is owned by
Preactor. Mapped external data is considered to be owned by the source from which it is mapped. For this reason, it is not
possible to perform all of the usual insert, update and delete operations that can be performed on a standard Preactor table.

In addition, when data is mapped in this way, fields into which data has been mapped are removed from the Preactor database.
This happens on start-up, in much the same way as would happen were a field deleted from a Preactor Table Definition file in an
Ultimate edition of Preactor.

Defining an External Data Map
To create a new external data map, from the Configuration category on the Preactor desktop, select ‘Integration then
External Data Mapping. Enter a new row in the table to begin defining the data map.

Data maps are defined in a similar way to import scripts, with the omission of some details that are not required.

In the first step the data mapmust be named and the target table specified. At this point you must select the type of data
source you would like to map data from.

The next part of the process differs depending on the type of data source chose. "File Import" on page 83, "Open Data Import"
on page 85 and "Data Providers" on page 79 give more information about the data source types available in Preactor.

Once the source data has been defined, the final step is to map the fields from the source data into the target table. Each field
that is mappedwill be removed from the database when Preactor is restarted, unless a mapped field is marked as an ID field. ID
fields are used as a key on which to join the external data. More than one ID fieldmay be defined.
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Applying Changes on Startup
When Preactor is restarted, fields that are mapped and are not used as IDs will be removed from the Preactor database. In
addition, evaluated field that reference a mapped field will also be removed.

The list of changes affecting the database will be displayed on start-up.

Working with Mapped Tables
When external data is mapped into a table, there are a number of behavioral changes that become evident when working with
that table in the Preactor Editor.

Firstly, operations such as insert and delete are disabled. Any such activity should be performed in the external data. Another
difference is that any field that is mapped becomes read-only. Again, any alteration to this information should be performed in
the external source.

Unreachable Sources
When a data source becomes unreachable or the retrieval of external data fails for any reason, Preactor will raise an error. If an
error is ignored, Preactor will continue with rows in mapped tables consistent with the ID values stored in the Preactor
database. All mapped fields will have their default values. Depending on what data is mapped and the fields it is mapped to, this
could have a significant impact on the behavior of Preactor.
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Reports
Introduction
To be competitive in today's market conditions, organizations require immediate access to relevant up to date information
and to extend its use beyond the confines of their own business, to interact with partners, suppliers and customers.

To facilitate this, a collection of standardMicrosoft Reporting Services based reports - see Microsoft Report Services.

A selection of reports that ship with Preactor are summarized here. Certain reports are only available based on the Preactor
product and configuration that is being used.

The reports are generated from the Reports window in the Sequencer or Planner:

      View ► Reports                            in the Sequencer
      View ► Reports ► Report List      in the Planner

The Reports List will appear down the right hand side of the screen by default.

The report generation is initiated by double clicking on the required report. Drill Down from one report to initiate another is
supported.

Reports are generated on Saved data, not on data ‘in memory’.

Reports are often provided as lists, tables, and in graphical form (e.g. graphs and charts). They are generally divided into:

l Reports that show the provisioning of Preactor.
l Reports that show Transaction data
l Reports that show different aspects and consequences of the Sequencing or Planning.
l Reports that show a comparison of different aspects and consequence between two Schedules or Plans – using the cur-
rent Schedule/Plan and a previously stored one, or two previously stored Schedules/Plans.

Reports can be seen on screen, and also exported to a PDF, Word or Excel file.

Examples:

1. The Sequencer report Orders By Customers provides a list of all the orders for each customer, one page per customer.
This example shows page 1 of a multi-page screen output.

2. The report Order Late Or Early Bar Chart shows an overview of the scheduled Completion times against due dates. On
the screen output, the user can click in one of the bars on the bar chart to Drill Down to get another report detailing the
orders which are represented by that bar.
This report is taken from the exported Excel output.
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3. This report shows a comparison between 2 schedules and their effect on Orders. Note the criteria used for the report
can be specified.

Supported Reports
Sequencer Reports
See also Report Generation for help in generating the reports, and Report Reading on how to read and navigate the report
output. Note - many reports have Drill Down reports available. Authoring Reports contains information about how to author
reports, if there is a requirement to author them.
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Most of the shipped reports are self-described in the title of the report. However, there are a selection of reports that require a
more detailed explanation of what the report is showing, or a specific feature available in that report. This selection of reports
is detailed below.

Order Reports

l At Risk Orders – Reports on Orders that are at risk of not meeting due dates.
See At Risk Orders for more information on what orders are deemed ‘At Risk’.

l BoM Shortages Summary – Reports on the material shortages expected on a daily or weekly basis.
The user must specify the Scale of the report (Daily or Weekly).
From this report, the user can click a quantity on the report to Drill Down to details on that shortage, opening up the
Linked BoM Shortages Report.

l Late Operations by Reference Date – Reports on the Operations that would be late if the Reference time were changed.
The user modifies the Reference Time field in the report and generates a report to see what state the Orders will be at
that time.

l Linked BoM Shortages - Provides a detailed view by order of what BoM items that order is short of.
l Operations by Progress – Provides a report of the Operations listed in order of what progress state they are in, as
defined by the Operation Progress field against that operation.

Other Reports

l Address Book – Displays the addresses held in the PCO Address Book table.
These will be the addresses of the current system and any system that it communicates with.

Report Reading
There are common structures/formats used for displaying multi-page reports.

Where a multi-page report has one page per entity (e.g. one page per customer), that report will often have a Document Map
on the left hand side of the report. Users can use the map to go to the page for that particular entity, or navigate through
normal next/last page toolbar icons.

The Document Map can be turned On/Off by toggling the Toolbar Icon  .

Export Report Data
You can export any data displayed on a report to an Excel spreadsheet or PDF file. To do so from a generated report: click on
the Export toolbar option and select the export format and continue with selecting the filename and destination.

Multi-page outputs will result in multi-worksheet spreadsheets to maintain the report formatting.
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Configuring Preactor for Local Reports
If reports have been installed successfully, you should see a list of the reports displayed in the 'Reports' pane in the sequencer. If
the Reports pane is not visible, it can be opened by choosing View ►Reports from the menu.

You can check the report settings by selecting Tools and then Options...menu option, click on the Reports node in the tree
view on the left-hand side. The right-hand side of the dialog displays the settings for both Remote and Local Reports. To display
local reports in the Reports pane, make sure that the Enable Local Reports check box is checked, the Local Reports Folder
specifies the location of the folder that contains the report definition files (RDL) files. If you wish to retrieve the local reports
from a different location to the current folder that is specified, simply browse to the folder that includes the report files that
you wish to be displayed.

Preactor Reports using Microsoft Reporting Services
Reporting facilities are provided by integrating Microsoft Reporting Services within both the sequencer and planner modules.
Report RDL files are provided in each shipped configuration package and stored locally on disk. It is also possible to upload
reports to a reporting server and view these reports in the sequencer.

Overview
Microsoft SQL Server Reporting Services (SSRS) comprises of a range of tools and services for creating, publishing and
managing reports. Preactor renders SSRS reports both locally, or with a connection to an SSRS server. For an overview of
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Microsoft Reporting Services, visit:
http://msdn.microsoft.com/en-us/library/ms159106.aspx

Configuring Preactor for Reporting Services
When a configuration is unpackaged using the Package Manager, the report settings specified in the Package Manager wizard
are written to Preactor's report setting for you.

If you need to change these settings for any reason, you can do so from within the sequencer or planner. You are able to
select Local or Remote reporting services, and define the reporting server URL (for Remote Reports) or the Reports Folder (for
Local Reports) from:

Sequencer ►Tools ►Options ► Reports ►General.

or

Planner ► Settings ► Report Options.

If using Remote Reports, the Server Report options selectedwhen unpackaging the Preactor Configuration become valid.

If the reports that are to be displayed are local reports, then the 'Enable Local Reports' option should be selected and the name
of the folder containing the local reports should be specified.

If remote reports stored on a report server are to be displayed then the 'Enable Remote Reports' option should be selected.
Specify the URL for your reporting server and a folder name where the reports are held.

By default the URL is: http://localhost/ReportServer$SQLExpress.

For local reports, if everything is configured correctly, you should see a list of the reports under the 'Local Reports' Node in the
'Reports' panel. For server reports, you should see a list of the reports that have been uploaded to the report server in the
'Reports' pane, under the 'Server Reports' Node. If the Reports pane is not visible, it can be opened by choosing 'View' then
'Reports' from the menu.
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Report Generation
When a report generation is initiated, a windowwill be opened.

l If the report does not require any options to be entered by the user, the windowwill contain the required report.
These tend to include those reporting on the current provisioning, e.g. Calendar States.

l If the report does require options to be entered by the user (usually selecting which saved Dataset(s) are to be used),
the top of the openedwindowwill prompt for that data to be entered, and the 'View Report' button only becomes active
when all required information is entered.

This example shows the Total Days Cover report requires the data set to be selected, the Capacity Group to be selected and the
From and To Dates to be selected before the View Report button can be used to generate the report.

Some reports require the user to define the type of data to be reported on, and/or the format of the output. The following
example requires the Criteria to be selected from a drop down list, and the output format (scale and Bars per Page) to be
defined.

Comparison reports require the user to select the Schedules to compare between. The comparison is done between two
schedules – one can be the current Schedule or a stored Schedule, one must be a stored Schedule.

Schedules are stored from Sequencer File menu – Save Schedule As…
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Drill Down
Some reports provide detail information of data presented in another report. These reports can be initiated from that higher
level report. This action is called Drill Down.

Typically, andwhere available, a report indicates that Drill Down information is available by coloring the text as a link, as in this
example:

Here we see that Drill Down is available for: Order No.; Customer; Product/Part No.; and Resource – each Drilled Down report
providing information relevant to that item.

And in this example, the Schedule Comparison Bar Chart results in the following report:

Clicking on the bar representing Orders that are 4 days early opens up the following report detailing those Orders that are 4
days early (actually obtained from the Schedule Comparison Bar Chart Details report):

Notice that when in the Drilled Down report, the Back navigation toolbar icon becomes active, so the user can get back to
the originating report.
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Authoring Reports
Preactor reports are defined using the Report Definition Language (RDL) as used by SQL Server Reporting Services. Reports can
be authored using Report Builder.

Microsoft SSRS Report Builder 3.0 can be downloaded from http://www.microsoft.com/en-us/download

Reports can be authored locally or remotely from a server. There are a fewminor differences to the way reports are defined,
depending on which mode the report shouldwork in.

Data Sources
A data source includes the data source type, connection information, and the type of credentials to use. There are two types of
data sources; embedded and shared. An embedded data source is defined in the report and used only by that report. A shared
data source is defined independently from a report and can be used by multiple reports.

Shared data sources are useful when there are data sources that are used often. It is recommended to use shared data sources
for server reports, as they make reports and report access easier to manage, and help to keep reports and the data sources
they access more secure.

An embedded data source is a data connection that is saved in the report definition. Embedded data source connection
information can be used only by the report in which it is embedded. Embedded data sources are used in local reports so that
Preactor can amend the data source at run time to provide the connection information for the database Preactor is connected
to. The first data source defined in the report will be given the connection information for Preactor.

Datasets
Not to be confusedwith datasets for identifying a set of data associatedwith a loadable table, datasets in the context of
reports represent a collection of data used to populate the report. Each dataset has a query associatedwith it and is linked to a
data source. Report Builder will show each defined dataset, allowing controls in the report to be linked to the fields in the
dataset.

Parameters
Reports opened from within Preactor may be passed DatasetId parameter. This is a reserved parameter and is provided for
convenience so that a report can show results for the currently selected dataset. This parameter is optional for a report,
however it is recommended that the parameter is usedwhen viewing Orders in AS or Demand in AP reports. The DatasetId
parameter must have the name 'DatasetId', must be an integer andmay be hidden.

It is possible to define multiple parameters for a report. Report parameters can be used to alter the behavior of a report.
Preactor will allow the end user to specify values for the report parameters. For more information on report parameters see:
https://msdn.microsoft.com/en-us/library/dd220464.aspx.

Preactor Reports using Microsoft Reporting Services
Reporting facilities are provided by integrating Microsoft Reporting Services within both the sequencer and planner modules.
Report RDL files are provided in each shipped configuration package and stored locally on disk. It is also possible to upload
reports to a reporting server and view these reports in the sequencer.

Overview
Microsoft SQL Server Reporting Services (SSRS) comprises of a range of tools and services for creating, publishing and
managing reports. Preactor renders SSRS reports both locally, or with a connection to an SSRS server. For an overview of
Microsoft Reporting Services, visit:
http://msdn.microsoft.com/en-us/library/ms159106.aspx
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Configuring Preactor for Reporting Services
When a configuration is unpackaged using the Package Manager, the report settings specified in the Package Manager wizard
are written to Preactor's report setting for you.

If you need to change these settings for any reason, you can do so from within the sequencer or planner. You are able to
select Local or Remote reporting services, and define the reporting server URL (for Remote Reports) or the Reports Folder (for
Local Reports) from:

Sequencer ►Tools ►Options ► Reports ►General.

or

Planner ► Settings ► Report Options.

If using Remote Reports, the Server Report options selectedwhen unpackaging the Preactor Configuration become valid.

If the reports that are to be displayed are local reports, then the 'Enable Local Reports' option should be selected and the name
of the folder containing the local reports should be specified.

If remote reports stored on a report server are to be displayed then the 'Enable Remote Reports' option should be selected.
Specify the URL for your reporting server and a folder name where the reports are held.

By default the URL is: http://localhost/ReportServer$SQLExpress.

For local reports, if everything is configured correctly, you should see a list of the reports under the 'Local Reports' Node in the
'Reports' panel. For server reports, you should see a list of the reports that have been uploaded to the report server in the
'Reports' pane, under the 'Server Reports' Node. If the Reports pane is not visible, it can be opened by choosing 'View' then
'Reports' from the menu.
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Calendars

Calendar Overview
Calendars are used throughout Preactor AS and Preactor AP in a variety of ways. Although some of the specifics aroundwhat
properties may be set and how the details of a calendar are interpretedmay vary depending on the context in which they are
used, general concepts such as states and templates and their application are common to all cases. This section describes
these concepts and gives some examples of how these concepts might be applied. For more specific information on how
calendars are used in Preactor AS, see "Calendars" on page 213.

States
Calendar states are the entity on which all calendars are based. A state may have different properties depending on what it is
used for. For example, in Preactor AS a Primary Resource state includes an efficiency which affects the run rate of operations
processed on a resource.

A number of states are typically defined in Preactor covering common use cases - on shift, off shift etc. Additional states can be
added by the user andmay represent all manner of conditions, often purely for information purposes.

Templates
Calendar templates define a repeatable pattern of periods, each period having a duration and other properties depending on
the context in which it is used. The template itself also has a duration. The periods within the template may have a cumulative
duration as long as but no longer than the duration of the template itself. When applied, templates will repeat in accordance
with their duration and any reference date set.

Name
Templates are assigned names in order to easily identify them. They may be given any name.

Color
A color assigned to a template may be usedwhen rendering any view that includes the calendar detail. For example, the Gannt
Window in the sequencer in Preactor AS shows the individual calendar states that result when a template is applied to a
resource and underneath those states a single colored line shows the color of the template applied at that time.

Duration
When templates are applied, they repeat according to their duration. If a template is not entirely full with periods then still the
template duration governs the repeat process. Templates without periods defined for the entire duration will have gaps when
applied. How these gaps are treated depends on the template type and how that template is applied.

Reference Date
When a template is applied, its reference date is used as a point from which to repeat the template. For a template that is
designed to apply from 8:00 AM on a Monday morning, a reference date should be set on a Monday morning at 08:00 AM.
The date chosen is not relevant in this case. Where a template has a non-weekly repeat cycle, it is important to choose a
reference date that represents the intended repeat cycle for that template. Reference dates can be overridden when a template
is applied.

Calendar Instances
When a calendar is applied to an entity in Preactor it can be referred to as a calendar instance. Calendar instances detail periods
for which templates and states are applied.
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Default Periods
A calendar instance must have a default period. The default period for a new calendar instance will be based on defaults set in
the application. A default template may run indefinitely, or it may change at a given point in time. For example, some
equipment may not come online until a given date. In this case that equipment may be definedwith a default period using the
Off Shift calendar state up until the equipment becomes operational, at which point its default periodwill be set to use the
Normal Working Week template indefinitely.

Exception Periods
Exception periods are for shorter term deviations from the default template period. As per their name, exceptions should be
used for exceptional cases. Examples of this might include running unplanned overtime or simulating the breakdown of a
piece of equipment.

Common Datasets

Common Datasets
Common Datasets allows ASSOCIATE tables to load from a shared (common) dataset, e.g. allowing Supply tables to be loaded
from a common Orders table. This is useful when there is a need to switch between multiple schedules while maintaining a
single Supply/Demand/Bill of Materials table. Configuring Common Dataset functionality is done by adding a
COMMON classification to an ASSOCIATE table, either in theMaterialControl_prtdf.inc file for AS Ultimate or the .prtdf file for
AP. Once configured, it can be enabled at runtime via theManage Common Datasetswindow, from the Configuration
section of the Preactor Desktop.

When a dataset is requested, e.g. the Orders table upon entering the Sequencer, Preactor will check the dataset settings and
load the data into the memory based on the settings. A similar process will be followedwhen saving a dataset, so that a single
set of data is kept against a single ASSOCIATE table (when enabled).
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TheManage Common Datasets dialog displayed all of the tables associatedwith the Orders table. The associated tables that
have had the COMMON classification applied to them will have a check box that can be toggled. When checked, these tables
will have data loaded from their common dataset.

Example
The example below shows the Supply table having the COMMON classification applied to it.
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...
Supply,ASSOCIATE (Orders) COMMON:
Number,-1,INTEGER,
PRIMARY KEY
HIDDEN
SUPPLY TABLE:
Order No.,"",STRING,
HELPPOPUPID (25400)
FREE FORMAT
MATERIAL CONTROL ORDER NO:
Order Type,1,STRING,
HELPPOPUPID (25410)
DATABASE(Order Types(Name))
EXCLUDE "(({#Number}==0)||({#Number}==2))"
LOCATE
...

Preactor Filtering

Filtering in the Preactor Desktop
Introduction
Preactor's filtering feature within the Desktop is extensive and allows the user to filter items/records within any Desktop
editor. Users are able to use filters already existing in Preactor, or by creating custom filters. The filters available in the Desktop
are known as Expression Filters. See Creating andManaging Expression Filters for more information.

Creating Expression Filters
Creating and Applying Filters
Filtering is available in both Preactor AP and AS Desktops and in the Sequencer. Filtering functionality is not available in the
Planner.
Any Expressions Filters that you create in the Orders table of the AS Desktopwill be available in the Sequencer. Any Expression
Filters created in the Sequencer will be available in the Orders table.

In the Preactor Desktop
There is a drop down menu and a button that are related to filtering.

The drop down menu will display any filters that have been created for that editor, and theMaintain Advanced Filters button,

, opens up theManage Filters Dialog.

In the Sequencer
In the sequencer, the Advanced Filters toolbar has all the features required for filtering.

The Filter Highlight Mode button opens a drop down menu that gives options available to highlight filtered operations.
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The Highlight Enablement button, , is a toggle button that will enable or disable highlighting in the Gannt, Trace Chart

and/or Editor windows. The Filter Drop downwill display all the filters available. TheManage Filters button, , opens up the
Manage Filters Dialog.

Manage Filters Dialog

In some Desktop editors, there can be existing filters that are shippedwith Preactor. For example, the PESP Event Scripts has
one filter packagedwith Preactor, Hide Child Records. This filter, when selectedwill hide any child records for a PESP Script.
The buttons in theManage Filterswindow are:

l Add Expression
This will open the Expression Viewer dialog, where a filter can be created for this editor.

l Edit
When a filter is selected, clicking the Edit button will open the Expression Viewer dialog, and the filter can be edited.

l Delete
When a filter is selected, clicking the Delete button will prompt the user as to whether the filter should be permanently
deleted or not.

In the Sequencer, the Manage Filters dialog has an additional button, Add Composite. For more information on Composite
Filters, see Creating Composite Filters.

The Expression Viewer
The Expression Viewerwindow is where an expression filter can be created or edited. There are two ways of creating a filter in
this dialog; either by using the drop down menus, or by clicking the Advanced button and inputting the expression manually.

The fields in this dialog are:
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l Filter Name
This field is contains the name of the filter. The name must be unique, if it isn't Preactor will display a warning dialog
upon clicking OK.

l Field
This drop down menu contains all the fields that can be filtered for that table. This drop down menu is table sensitive, so
the contents of this drop down will vary depending which table is being filtered.

l Operator Drop Down Menu
This drop down displays all the operators available for the expression. If the field selected is a number field, there will be
6 operators available. If it is a string field, there will be 7 operators available, the 6 available for a number field and an
additional one, "@ Contains". The image below shows all the operators available, including the additional operator for a
string field.

l Value
This field will be populated by a value that the filter should evaluate. For example, if a PESP Event Script is to be filtered to
those containing the word "Import", import would be in this field.

If the Advanced button is clicked, the dialog will be changed, replacing the filter name, Operator drop down menu and value
fields with an expression field, where the expression can be manually inputted.

Applying a Filter
With a filter created, it will be available in the toolbar drop down menu.

It is possible to select multiple filters to apply to the table, which is done by clicking on the checkbox. Any filters created and
selected in that table editor will be saved automatically when leaving that table. Any filters created are saved to the database
and are only removedwhen clicking the Delete button in theManage Expressions dialog.

There is a keyboard shortcut available, which is Esc. This will clear any filters applied to a table, and the table reverts to
displaying all records.

Security

Security
Introduction
Access by a user (Login) to certain navigation options from the Preactor Desktop can be restricted.
This is managed from the Manage Security Settings task:

Preactor Desktop ► Configuration ► Security
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Access to Preactor is managed by the Login
Access to Workflows is controlled by the definition of Roles that are assigned to Logins

l AWorkflow is an Actionable Item

Enabling any Workflow results in all the options in the Navigation, Active andWork panes that are required to
access that Workflow to become available.

In the diagram below, the workflows for 3 roles are shown: Generate Schedule, Import Orders, andManage
Security Settings.

l A Role is created by the user and associated to one or more workflows.
In the example below, Roles have been created to Administer the System, to Issue Orders, and a Super User role to
access a number ofWorkflows.

l A Login is assigned one or more Roles.
In the example below: Admin can only administer Security; User 1 has access to specific tasks for his job, but the Man-
ager can access the whole system.

Notes:

l Only access to menu items on the Preactor Desktop are managed. Access to menu items within the Sequencer or Plan-
ner are not individually managed.

l The configured Security settings are valid for the database a configuration connects to. It will not apply to con-
figurations using a different database.

l Initialization of the Security Settings takes place when starting Preactor. Changes to the Security setting will not be
seen until Preactor is restarted.

l When Security is activated, login is necessary, and it is not permitted to log out and to login as a newUser.
Preactor must be restarted for a different user to login.
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l Items added to the menus (by customization) will automatically become Workflows, available for assigning to Roles.
Such Workflows will not automatically be assigned to any existing Role however.
Items removed from menus will be removed from the Workflow lists and the Roles they were assigned to.

l When configuring Security, there must always be a login configured that can administrate the Security options.
Preactor can never get into a state whereby the Security cannot be configured because of lack of access permissions.
Of course, loss of password information can result in the inability to manage Security.

Security Guidance
SQL Server
Server Setup
It is recommended that SQL Server is installed and configured by following the latest documentation from the Microsoft, which
gives guidance on creating and implementing an effective security plan.

Communications between Preactor and SQL Server
Although securing SQL Server is outside the scope of this documentation, it is recommended that Preactor is configured to
use secure communications. SQL Server supports Secure Sockets Layer (SSL) to enable the encryption of data transfers.

Enabling SSL encryption requires modification of the connection string stored in the Preactor Command Definition (.prcdf) file,
as well as installing a trusted certificate on the SQL Server host. The .prcdf file can be modified using the ‘Command File Editor’.
Please refer to the documentation for SQL Server for more information on configuring SSL.

Preactor Configurations
Access to Preactor
Preactor contains an authentication and security module. It is recommended that this mechanism is used to help prevent
unauthorized access to Preactor. See "Enable Security Authentication" on the next page for more information on using and
configuring this module.

Preactor Configuration Files
Preactor uses a number of configuration files which are stored on disk. These files include the menu and table definition files,
workspace information files, and the Preactor Command Definition File. It is recommended that access to these files is
restricted to only those users which require access to them. That is, only the users who will run Preactor. Permissions on files
can be set using standardWindows file or folder permission sets.

Importing or Exporting of Data
Communications Protocols
The Import/Export Wizard provides a simple interface to define an import or export script for any table within the 'UserData'
schema. Preactor can import from both files on disk, and a number of different data providers.

Where Preactor is importing from a disk based file, it is recommended that the permissions are adjusted to prevent
unauthorised reading or writing of that file. This can be done using the standardWindows file or folder permission sets.

Where Preactor is importing from a data provider, consideration should be given to securing both the data and the
communication mechanism. For example, imports using a SQL data provider should use SSL to encrypt communications.
Imports from Open Data sources should consider using HTTPS where possible, and also implement authentication on the data
source to prevent unauthorized access. In all cases it is recommended that secure communication protocols are usedwhere
possible.

Credential Storage
Preactor supports the encryption of fields. It is recommended that this feature is enabledwhen storing sensitive information.
See "Encryption " on page 119 for more information.
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Preactor Communications Object (PCO)
Multiple Preactor systems can communicate using the Preactor Communications Object. PCO allows transport ofmessages
through a variety ofmechanisms using "Connectors", such as the FSO (File System Object) connector providedwith the
Preactor.

Where the FSO connector is used, it is not uncommon to have Preactor read andwrite to a shared folder on a network. It is
recommended that access to any shared folders is restricted to only the users that require permission. Permissions on files can
be set using standardWindows file or folder permission sets.

Setting Up Security
To setup Security, the following must be done:

l Create and/or Identify Logins
l Create Roles, and assign Workflows to those Roles
l Assign one or more Roles to a Login
l Enable Security Authentication

Enable Security Authentication
Enabling Security Authentication, and choosing which types of Authentication are used, is selected from the General option of
the Manage Security Settings window, obtained from:

Preactor Desktop ►Configuration ► Security

There are 2 authentication modes supported; Basic andWindows.

Basic

Enabling Basic Authentication will allow access to Preactor for any Basic Login created and enabled.

Windows
Enabling Windows Authentication will allow access to Preactor for any Windows Login or Group specified and enabled.

Either, both, or no authentication mode can be selected.

Logins
A Login provides access to Preactor when Security Authentication is enabled.

A Login can be:

l A Basic Login ('JDoe' and 'Manager' in the screenshot below).
This type of Login is defined and used only in Preactor.
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Login names and passwords are stored securely within Preactor.
l AWindows Login ('PreactorUser' in the screenshot below).
The Login and password is administered by Windows. Only the Windows Identities (SIDs) are stored.

l AWindows Group Login ('ScheduleGroup' in the screenshot below)
Any Windows Login which is part of the group can access Preactor.

In the Logins windows, the current Logins can be seen, together with their type andwhether they are individually enabled:

From the Logins selection, the user can Add, Edit or Remove a Login.

Add and Edit opens a similar dialog, the Logins Editor.

Logins Editor

The user must:

l Select the type of login (Basic or Windows).
l Enter the Login name.
If using a Windows login, that name must be an existing Windows Login or a work group.

l A Password (for Basic types only)
l Select whether to enable the login (this can also be set from the Manage Security Settings/Logins dialog.

Once created, a Login name and type cannot be changed.

Roles and Workflows
Roles andWorkflows controls the access to Preactor navigation when Security Authentication is enabled.

A Role is created and associatedwith the workflows necessary to execute that role.

From the Roles selection the user can see existing Roles, and Add, Edit or Remove a Role.
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Above we see that 4 Roles have been created, an Admin Role (which can enable Security administration), a Scheduling Role, a
Provisioning Role, and a SuperUser Role.

When Adding or Editing a Role, a similar dialog is opened, the Role Editor.

The Role Editor

There are 2 tabs in this dialog,

l one for assigning Logins to the Role (Role Members).
l one for assigning Workflows to the Role (Workflows).

Creating a Role, and Adding a Login to the Role Members (assigning a Role to a Login)

l A new Role must be given a name.
l Selecting Addwill result in a list being displayed of possible Logins that can be associatedwith this Role.
l Logins can be Removed from the Role Members.

Assigning Workflows to the Role

l The list shows which Workflows are currently assigned to this Role.
l Selecting Addwill result in a list being displayed of additional possible Workflows that can be associatedwith this Role.
l Workflows can also be removed from this Role.

The lists can be filtered and/or sorted for ease of reading. To filter:

l Expand the filter
l Enter the desired string in the Name or Label field
l Check the Enable Filter box
l Select Filter
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Associating Workflows to a Role is simply a matter of selecting one or more Workflows and selecting OK.

To select items in the lists, it is possible to:

l Add one workflow at a time.
l Use multiple individual selections (Ctrl + Left Mouse click on each item)
l Use group selection (Left mouse click on first item, then Shift + Left Mouse click on last item),
or Ctrl A to get all items in the list.

l Use any of the above on the Filtered list.

Logging In
If Security Authentication is enabled, starting Preactor will result in the Login screen being displayed:

If both Basic andWindows Authentication methods are enabled, the option for which type of Login to be used is offered.

If a Windows method is being used, the current user's login is filled in. No password is needed. Access will be granted if that
Login has been enabled, or is part of a Windows group that has been enabled in the Security configuration.

If a Basic method is being used, the user must enter their Login and Password.

Changing Password
A user logged in using Basic Authentication is able to change their password (if that Workflow is allowed).
This is done via the 'Change Password' option in:

Configuration ► Security

Encryption
Overview
Some fields in Preactor carry potentially sensitive information. This information needs to be discoverable by authorized users,
but should not be discoverable with access to the database only. The encryption feature in Preactor allows for this.
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Behavior
Encryption is enabled and disabled on a global basis. If encryption is disabled, encrypted fields will be stored in plain text. When
enabled, a master passwordmust be set to read andwrite the encrypted data. If encryption has been enabled, and then
subsequently disabled, all encrypted information will remain in the database until it is overwritten. Encrypted data is kept in
memory, and is only decryptedwhen it is required.

To enable or disable encryption, or to enter the master password, select 'Encryption Settings' from the 'Security' configuration
category within Preactor.

Master Password
When encryption is enabled in Preactor, a master password should be set by the enabling user. This master passwordwill be
used as the basis for encryption. It is also salted by a cryptographically resilient algorithm, providing greater security.

When a new user (or an existing user on a different computer) tries to access the encrypted data they too will need to provide
the master password. Once the master password is verified, the new user will be able to access the encrypted information from
then on.

Note: If the master password is forgotten, the encrypted data is only recoverable by those users who already have access. New
users cannot be granted access to the encrypted datawithout the master password.

Evaluate Fields and Encryption
Encryption Strength
Preactor encrypts all information using the AES-256 cipher.

Alternative Methods of Application Delivery
Preactor is a desktop application and typically requires installation on each client machine, client access to the database, and
client access to configuration files. Where there are security demands which do not allow this traditional model of application
deployment, deployment of the software as a virtual application can be considered. Virtual deployment generally allows the
application and its resources to be isolated or sandboxed to some extent.

One of the simpler forms of deploying virtual applications is via presentation virtualization. This allows users to access
applications and data on a remote computer using a remote display protocol. The user can view this application via a dedicated
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client, or through a web browser. When Preactor is deployed in this manner, only the remote machine requires access to the
SQL database or to Preactor’s configuration files. All data is therefore retained in a central location, and the user’s client is
purely communicating mouse, keyboard and display information.

There are alternate forms of deployment of virtual applications, and each should be consideredwhilst taking into account the
security demands of the organization.

Scripting

Preactor Event Script Processor (PESP)
Introduction
Preactor's Event Script Processor allows users to create their own custom functionality as a sequence of Actions, and for that
script to be executed in response to an event. It provides a friendly user interface to define the script, and in many cases
eliminates the need for the custom feature to be written in code. See the Product Based Feature Lists to determine which
products the PESP feature is available in, and note that some specific actions are only available in appropriate products, e.g.
APS Rules are not appropriate to the lower functionality products.

An event script is a series of Actions which are processed in sequence until all steps are completed, initiated by an Event.

PESP provides a scripting language, used to define what happens when events occur within Preactor.

The Events that can result in the execution of a script can be:

l One of a predetermined set of possible discrete events that have occurred in Preactor, e.g. dropping an operation onto
the Gannt window (Discrete Event).

l A PCO message is receivedwhich indicates a PESP script is to be executed (Message Event).
l A selection on the Preactor Desktop associatedwith a script has been made (MANIP Event).
l A Timed Event has occurred – an event setup to occur after a predetermined period of time (Timed Event).
l Additionally, a PESP script is available on shipped configurations that manage the presentation and execution of APS
Scheduling Rules in the Scheduler.

A script can be executed by any or all of these events, e.g. a script could be executed as a result of a received PCO message, or
when a selection on the Preactor Desktop is made, or when a discrete action in Preactor takes place.

There is a predetermined set of possible actions that can be executed by the event script. In addition to the predefined list of
actions, there is also the option to include a ‘Custom Action’. The ‘Custom Action’ can be used to call any custom feature
written in code.

An action could be:

l To perform some action in Preactor (e.g. schedule, or display a message).
l To obtain information (e.g. get the current time).
l To jump to another action (identified by the label field) in the script, based on a decision (e.g. IF true, go to this label of
the script).

Information can be passed between the actions in the script with the use of variables.

Viewing the Event Scripts
From the Preactor Desktop, select Configuration ► Event Script ► Event Scripts.
A table of the available event scripts will be displayed, from which scripts can be created, deleted, and edited.
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Check the box in the 'Show' column to switch between an expanded or collapsed view of the script. Likewise, check the box in
the 'Action Enabled' column to enable and action, uncheck to disable.

Creating and Editing Event Scripts
Event Scripts are created and edited in the PESP Event Scripts data table. From the Preactor Desktop, select:
    Customization ► Event Scripts ► Event Scripts

l To create a new script, double click beneath the last entry in the data table.
l To edit the action of an existing script, double click on that action – else right click and edit.
l To add actions to an existing script, click on the row after the location the action is to be added, right click and Insert.

A dialog window opens:

It is possible to delete an action, or the complete script by right clicking and selecting Delete.

The following fields aremandatory to have filled in:

l PARENT
As with all Preactor data tables with family relationships between records, the first action entered in the script is referred
to as the PARENT, and that is the option entered in this field. All additional actions in the script are children of the Parent
Action and have the name of that parent in this field.

l Name (if a Parent Record)
l Action, or Use Custom Action / Custom Action
An action must be selected, either from the drop down list or by checking the Use Custom Action box and selecting a
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custom action. Custom Actions can, for example, be created using the Preactor Software Development Kit (SDK).
To add a custom action, you can either choose the NEW PESP Custom Actions option from the drop down list on the
Custom Action field in the Event Scripts table and enter the appropriate information identifying the Project, Class,
Method and Parameters of the code that you wish to run. Or you can open up the Custom Actions table and add the
entry in there first and then select it from the Custom Action field in the Event Scripts table.

l Parameters
These need to be filled in as appropriate for the selected Action.
Only valid parameters for the selected action are presented to the user to fill in.

The following fields are also available:

l For Event
The For Event is used in the PARENT action of a PESP script to define if the script is to be run in response to a discrete
event in Preactor.
If this field is left Unspecified, the event can only be triggered by:

l a Menu User Interface option (MANIP Event Script).
l a tool.
l right clicking on a record in the sequencer to bring up a pop upmenu.
l an APS Rule.
l a Message (Message Event Script).

l Script Type
There are a number of Script Types that can be associatedwith the script. They allow you to view in the table only those
types that you are interested in by using the drop down filter list box.
Additionally, a Script Type of APS Rule causes that PESP script to be listed in the APS Rules selection dialog in the sequen-
cer. See APS Scheduling Rules

l Script Category
A Category, as defined in the PESP Script Category table (managed from the desktop) allows scripts to further manage
the presentation of the scripts in the PESP Event Script table.

l Label
The Label can be used for jump actions based on a Conditional test within an Event Script (e.g. IF True, jump to this
label).

l Description
Allows the user to describe the action. When used for the first action of a script, it typically describes the whole script.
This description is visible when the script is displayed in contracted form in the table.

l Action Enabled
A checkbox to individually enable/disable the action in the script.
This can also be set from the table view, using ctrl + shift select in the Action Enabled column.

l Use Custom Action / Custom Action
Checking the Use Custom Action check box alters the Action field name to Custom Action, allowing you to use your
own Custom Actions created using the Preactor Software Development Kit (SDK) for example.
To add a custom action, you can either choose the NEW PESP Custom Actions option from the drop down list on the
Custom Action field in the Event Scripts table and enter the appropriate information identifying the Project, Class,
Method and Parameters of the code that you wish to run. Or you can open up the Custom Actions table and add the
entry in there first and then select it from the Custom Action field in the Event Scripts table.

l Advanced
This provides the ability for the script to be executed in the sequencer from the right click menu for the operation in a
number of windows in the sequencer, or using a shortcut in combination with a mouse click.
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The settings shown in the dialog above add a newmenu item to the operation context menu in the sequencer, as
shown below.

Custom Actions
Custom actions created by the user can be executed by a PESP script. It should be noted though that:

l The return value of a Custom Action cannot be used by PESP (e.g. to modify the flow of the PESP).
l PESP Script Variables need to be used to return values to PESP by the Custom Action.

Script Variables
Data is transferred between actions in a script using Script Variables.

To create a script variable, just start using it by name (e.g. My Variable) in one action, and it becomes available for use in
subsequent actions.

Some predefined script variables are provided:

l TimedEventActualTime
The date/time at which the currently running script was started.

l TimedEventRequestedTime
The date/time at which the event requested is to be fired. This may be earlier than the actual time, if Preactor had been
shut down or if the event calendar had been disabled.

l TimedEventPrimaryKey
The Primary Key of the record in the event calendar that fired the currently running PESP script. This value can be used
to reference custom data in a configuration specific table. See the section on strategies for a discussion of how to use
this mechanism to associate custom information with individual events.

Event Types
Message Events
Messages are passed between systems using the PCO. The message has within it the name of any PESP script to be executed.
Typically the message will come from an external source, e.g. from a Shop-floor viewer, with data associatedwith it (could be a
file or XML data within the message).

The data is processed (e.g. by an Import script), a reply sent, and then deleted by the Communications Object (PCO).

See Example Scripts for further guidance.
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Discrete Events
There are many Discrete Events that occur in Preactor and you may want to customize what happens on the occurrence of
such with an Event Script.

Typically, actions associatedwith these PESP Events may:

l Perform data validation or error checking, when the user clicks on 'OK' in a dialog box.
l Force the user to complete all of the dialog boxes in the editor and validate the data they have entered.
l Populate other parts of the database according to values they have just entered.
l Perform an evaluate statement on the figures they have used for operation times.
l Run a script when an operation is dropped on the sequence Gannt window, or when the user attempts to drag an oper-
ation in the Sequencer Gannt window.

l Run a custom action.

See also APS Scheduling Rules for a specific application of Discrete Events.

MANIP Event
A 'MANIP' command can be used to run an Event script, using the switch /RunEventScript.

This is defined in the menu definition file (.prmdf) as shown in the example below for Import Orders:

Import_Orders: MANIP.DLL
/RunEventScript {FIND RELATED DB VALUE("Import Export Mapping" "Number" "1" "Order

Import Event Script")},
Import Orders Event Script,
Import Orders,
Foreground,ALWAYS:{RETURN};

;

It is an easy way of assigning scripts to Work Pane items on the Preactor Desktop. An Ultimate edition of Preactor is required in
order to be able to make changes to the .prmdf file.

Timed Events
The PESP Timed Events module provides Preactor with the concept of executing tasks at some time in the future. An event
calendar is used to associate a task with the date and time at which the task is to execute.

Timed Events are useful in a number of scenarios, for example:

To support order promising.

When an order promise is made, an entry can be added to the event calendar to delete the order promise at
some time in the future if a firm order has not subsequently been received.

The event calendar is implemented as a standard editable table, managed from:
Preactor Desktop ►Configuration ► Event Scripts ► Timed Event Calendar.

A timed event can be added to the system by creating an entry in the table, and defining the PESP script to run, andwhen.

PESP actions are also provided that allow timed events to be created in a PESP script.

When the event calendar is enabled, an event calendar processor polls this table at regular intervals and runs any tasks that
are overdue. Tasks are deleted from the calendar as soon as they are executed.

The Timed Event module is enabled/disabled and the table scan period is configured, from:

    Desktop ►Configuration ► Event Script ► Timed Event Settings.
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Changes to the configuration take place when Preactor is next started.

Event Calendar Processor Overview
The event calendar processor runs in the background and is responsible for polling the event calendar, running PESP scripts on
demand, and creating/deleting events from the event calendar as needed.

Most of these tasks are designed to run silently in the background so as to disturb Preactor’s primary processing as little as
possible.

This is achieved by running these processes on separate threads. Although the event calendar performs its polling and script
launching logic on a separate thread, the PESP scripts themselves still run on the primary thread.

As shown in the diagram, the PESP action to create a new timed event causes a further thread to be spun up to perform the
insert. This temporary thread is destroyed once the insert operation is complete. This approach enables synchronized access
to the event calendar table to avoid possible corruption. Thread synchronization is provided through a mutex class which
effectively places a software lock over the event calendar table. Writes to the table will only be preformed by a thread if it can
obtain the mutex. If another thread is currently holding the mutex, the second thread enters a wait state until the mutex
becomes available.

Event Parameters and Return Values
The PESP processor is logically located between the part of Preactor that detects an Event, and that which processes that
Event. Each event is sent with parameters, and a return status set to 'passed'. That data is stored in as set of variables,
identified by the Event Parameters Mapping table, at:
    Customization ► Event Scripts ► Event Parameter Mapping

Custom Check Parameters for Discrete Events

There are 2 parameters passed by all events, but they are not always filledwith useful information.

l Parameter 1 is usually the Format Number, which maps to the Format Number and Format Name in the table.
l Parameter 2 is usually the Record Number, which maps to the Record Number and the Custom Check number in the
table.

Some Events do not use these parameters, so the data is meaningless.

Some Events put other information in these Parameters, appropriate to the Event.

These Parameters are available in the PESP script, but should not be changed.
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Return Values
A PESP script can modify that return value which may impact the continued processing of that Event by Preactor. For example,
if the event of dropping (but not yet dropped) an Operation on the Gannt window triggers a PESP script, and that script (after
some other tests) sets the return value Failed, Preactor would not complete the processing to drop that operation. See
actions Return …. (e.g Return Fail).

Not all processing of events by Preactor is dependent on the return status of the event.

Example Scripts
Message Event Script

An example of a Message Event script, found in the shipped Job Shop configuration, is the Receive Updated Record script.

The flow of this script is:

Action # Action Parameters

1: Is Module PrShell Returns TRUE if is PrShell. Puts return value in variable

2: IF FALSE, GOTO End variable to check, and go to label.

3: Display Message ‘New Schedule received’. Message to be displayed.

4: Suspend UI

5: Copy attachment to file File used for Import script

6: Run Import/Export Script ID which script to run.

7: Send PESP Message Schedule Update to Viewer 1 Message type, destination

8: Send PESP Message Schedule Update to Viewer 2 Message type, destination

9: Set PESP Message as Processed

0: Resume UI

11: END End Script

Simple APS Scheduling Script

All of the shipped configurations contain examples of APS Scheduling scripts such as the APS Forward Rule (the system must
run as 400 APS or above for the APS Rule option to be available in the Sequencer). This script simply performs an APS Forward
Schedule.

AMulti-Pass Scheduling Rule.

Here is shown a possible flow for a multi-pass scheduling rule facilitated by PESP.

# Description Action

1: Find orders for Customer A
Locate By Expression – e.g.
((~{$Customer}~==~ABC Engineers~)||({#Priority}==1))

2: Backward sequence from Due Date. APS Backwards

3: Find orders for Customer B.
Locate By Expression – e.g.
(~{$Customer}~==~MDN Gearboxes~)

4: Forwards Sequence APS Forwards

5: Find remaining orders Locate By Expression This time provide expression, so all remaining jobs are located.

6: Schedule with preferred rules APS Preferred Sequence.

Search Records in a Table And Perform Action on Those Matching Criteria.
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Here is an example script that loops around all of the records in a table to perform actions on records that match a certain
criteria. In this case the PESP script will write ‘Complete’ to the ‘Operation Progress’ field for all records that have the ‘Use Actual
Times’ toggle field set.

Action Name Description Parameters Parameter Content

Suspend UI
Suspends user interface whilst processing of PESP
script is occurring

Set Script Variable
(Number)

Initializes script variable by assigning its value as 0

Script Vari-
able

Script Vari-
able

RecordNo

Number

Use Script
Variable

No

Numeric
Value

0.000000

START: (Label)

FindMatching Record
By Expression

Searches Orders table for all records that have the
‘Use Actual Times’ toggle field set

Format
Name

Use Script
Variable

No

String
Value

Orders

Expression*

Use Script
Variable

No

String
Value

({Use Actual Times}-
}==1)

Starting
Record

Use Script
Variable

Yes

String
Value

RecordNo

Direction

Use Script
Variable

No

Constant PrObjSearchForwards

Result Script
Variable

RecordNo

Evaluate Shell Expres-
sion

Tests to see if a matching record has been found

Expression

Use Script
Variable

No

String
Value

({#PESP_
RecordNo}>0)

Script Vari-
able

Script Vari-
able

MatchFound

If False
If no matching record has been found, jump to END
label name

Condition

Use Script
Variable

Yes

Script Vari-
able

MatchFound

Goto

Use Script
Variable

No

String
Value

END

Write Field (String)
Write ‘Complete’ to ‘Operation Progress’ field in
‘Orders’ table

Format
Name

Use Script
Variable

No
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String
Value

Orders

Field Name

Use Script
Variable

No

String
Value

Operation Progress

Record Num-
ber

Use Script
Variable

Yes

Script Vari-
able

RecordNo

String

Use Script
Variable

No

String
Value

Complete

GoTo Jump to START label name Goto

Use Script
Variable

No

String
Value

START

END: (Label)

Resume UI
Restore the user interface

End Script Terminates the script

* If all records need to be included in the subsequent actions, an expression that includes all records such as 1==1 should be
entered, rather than an expression that would only include a limited number of records.

APS Scheduling Rules
A PESP script called APS Select Scheduling Rule is provided that facilitates the presentation and execution in the Sequencer of all
the APS scheduling rules available. This is executedwhen the user selects APS Rules from the Sequence menu in the
Sequencer, and opens a dialog that allows the user to select the required scheduling rule to run.

This script presents to the user all the scripts of type APS Rule. PESP scripts created to apply a new scheduling rule, given the
type APS Rule, will be automatically presented to the user in the APS Rule drop down as shown.

Rule Building
In APS products, customized scheduling rules may be built using the Event Script Processor and/or a custom rule.

Rule building using PESP Actions

1. Highlight all orders with attribute Customer = ABC
2. Backward Schedule
3. Highlight all orders with attribute Customer = XYZ
4. Forward Schedule
5. Highlight all orders that remain unscheduled
6. Schedule Remaining Orders forward by due date

Another example would be to create a campaigning rule, which might contain the following actions:-
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1. Highlight orders with Due Date in the next week
2. Schedule using Preferred Sequence
3. Highlight orders with Due Date in the next week +1
4. Schedule using Preferred Sequence
5. Highlight orders with Due Date in the next week +2
6. Schedule using Preferred Sequence

Building Custom Rules

You can use standard actions held in the actions table or create your own Custom Actions using the Software Development Kit
(SDK).

You can also create customized parallel loading rules and ASCL rules using the SDK. Preactor 400 APS has a library of rule
building functions or macros that can be used for this task but you can also use the SDK if the functions do not do everything
that is required.

Communications

Communications
Preactor offers the ability to communicate between other Preactor systems using a feature called PCO (Preactor
Communications Object). This feature is used for example, when sending a schedule from the Master Scheduling System to a
Shop Floor Viewer.

The capability is enabled from the Startup tab of the Command File Editor

There are various options available for configuring PCO, these are discussed below:

l Address Book
l Configuration
l SendMessage
l ReadMessage

Communications Object
The Communication Object is a stand-alone application that runs side by side with one or more scheduling products and
services messages passed to and from these systems as well as other applications, such as ERP.

The object allows transport ofmessages through a variety ofmechanisms using "Connectors", such as the FSO (File System
Object) connector providedwith the Preactor.

Two communication/integration concepts are supported by Preactor:

l Batch file transfer.
Traditional method of importing and exporting data using ASCII files. It is activated by a manual process of clicking on a
button which then imports the data in batches.
Preactor assumes that the data is current and correct.

l Event-driven messaging.
Any configuration of Preactor can use either or both.
It is only possible to use event driven messaging between Preactor and an ERP system if the system has the capability to
trapmessages from the MSS and act upon them, as well as being able to generate messages when certain activities are
completed in ERP.
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Configuration
The Edit PCO Configuration dialog is used to specify the default handler for incoming messages to the current system. It
should be completed after the Address Book is established.

Access to the Edit PCO Configuration dialog is via:

Configuration Pane ► Communications ► Configuration

Click Configuration in the Work Pane to display the Edit PCO Configuration dialog.

l System Name - a unique identifier for the system. It specifies the default handler for incoming messages to the current
system. It is associatedwith the Inbound Address in the Address Book.

l Show Taskbar Icon - A check box which determines whether the PCO icon is displayed in the Windows Task bar.

Click OK to save any changes made.

Using PCO with 3rd Party Systems
Preactor's Communication Object (PCO) can be run without Preactor and can be attached directly to another system.

How do I configure PCO in this case?
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l Aminimal Preactor configuration can be suppliedwhich installs the basic data tables required (Address Book, Con-
nectors etc.).

l PCO can be installed on its own from the Install CD.
l PCO can be setupwithout this using the Preactor API.
l Example code can be supplied for a program which communicates via PCO.

Address Book
In order for Preactor systems to communicate with one another the address book must specify addresses of the systems
involved in communication. The Address Book is used to specify the locations where PCO messages are to be
created/processed for the currently loaded system and other Preactor systems involved in communication.

The Address Book contains Inbound andOutbound addresses for the systems that will be communicating with each
other. One PCO is available for each Preactor system that runs (even when running multiple Preactor systems on the same
computer). The address book should be configuredwith one inbound address for the current Preactor system, and then an
outbound address for each Preactor system that it will be communicating with.

Access to the Address Book is via:

Configuration ►Communications ►Address Book

A newAddress can be entered by double clicking on an empty row in the Address Book, or by right clicking an Address and
selecting Insert or Duplicate to enter a newAddress above that selected in the list.

An existing address can be viewed and edited by double clicking on that address in the work pane, or by right clicking and
clicking Edit.

Each Address has a number of characteristics and options, viewed from the PCO Address Bookwindow.

PCO Address Book Window

Name Description

Name A unique identifier for the system.

Description Message textual description.

Location Textual description of the location.

Connection Data Button that opens the Connection Datawindow.

Message Direction Specifies whether the message is to be Inbound or Out-
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Name Description

bound.
Inbound is used for the address of the computer that will
process messages received.
Outbound is used for the address of the computer that
will be sent messages generated by this system.

Connection Data Window

Name Description

Use Connector
Type of connection, though FSO (File System
Object) Connector is the only available connection.

UNC Folder Name
Specifies the path to the common folder where messages will
be sent or received.

Command Line Switches

Optional parameters that can be passed for each address that
may be required. /CreatePath will create the specified folder
path as defined in the UNC Folder Name field. Example con-
figurations specify the path in the UNC Folder Name field is
{TEMP}\PCO. The {TEMP} keyword represents the local tem-
porary directory.

Password Required?
When checked, the Password field is activated. Allows a pass-
word to be enteredwhich may be required by receiving sys-
tems. It is NOT required for FSO Connectors.

Establish a common UNC Folder
The system needs to recognize a single common folder through which all messages will pass and a decision has to be made as
to where this is to be located.

To establish a common UNC Folder:

1. Decide which networkedmachine is to hold the 'UNC Folder' andwhere it is to be located on the machine.

This is the common folder through which all messages will pass.

2. On the appropriate machine use Windows Explorer to create the UNC Folder and identify the path to it.

e.g. C:\PCO

3. Right click on this folder and select Properties from the list of options.

This opens the Properties dialog.

4. Share the folder by selecting the Sharing tab and clicking on the Share this folder radio button.
5. Click OK to close the dialog.
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Unless installed on the same machine as the UNC Folder, each networked scheduling system must access this folder using a
Mapped Network Drive or access it as a Network Place. To add a new network place all machines must be connected to the
network.

Add a Network Place
On machines that are remote from the common UNC Folder, the folder may be accesses as a Network Place.

To add a network place:

1. In Windows click Start, thenMy Computer. Under Other Places clickMy Network Places.
2. In the subsequent dialog select Add a network place.

The Add Network Place Wizard opens.

3. Click Next.
4. In the following dialog select Choose another network location, then click on Next.
5. A the subsequent dialog will open, click Browse to locate the UNC Folder, previously established one of the networked

machines. Click OK to close the Browse for Folder dialog, then click Next in the Network Place dialog.

The Internet or Network Address field will now contain the name of the networked computer and the location of the UNC
folder, e.g. \\3001\C\PCO.

6. In the newNetwork Place dialog provide a name for the new network place.
7. Click Next then Finish to close the wizard.

Networking Viewers
Used in data sharing mode Viewers require a LAN/WAN connection between them and the Master Scheduling System (MSS).
The Communications Object (PCO) distributes any updates to all viewers that have been set up to receive them. Thus Viewers
can receive schedules released by the MSS, and return schedule updates to it.

Preactor has a real-time messaging system that is used to communicate between the MSS and Viewers on a PC network. The
messaging system has the advantages of providing asynchronous communications that can be used over intermittently
available links.

To set up these communications:

1. Install the Viewers andMSS as a networked licensed version of Preactor.

2. Establish and share a common UNC Folder.

3. Set up the Address Book for each networked system.

4. Test the system.

Send Message
The SendMessage feature allows messages to be sent between different Preactor systems. The Communications Address
Book and Configuration must already be set up in order to send a message:

Access to the SendMessage feature is via:

Configuration Pane ►Communications ► Send Message.
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To send a message, click on Send Message in the Work Pane. The 'Edit PCO Send Text Message' dialog is displayed.

l Message To - Recipient of the message.
l Message From - Automatically populatedwith the current System Name as specified in the Communications Con-
figuration topic.

l Message - Text to be included in the message.

Read Messages
Messages can be sent between different Preactor systems, such as a Master Scheduling System sending a Shop Floor Viewer
configuration a message. Messages can only be sent and read after the Communications Address Book and Configuration
have been set up.

Access to the ReadMessage feature is via:

Configuration Pane ►Communications ►Read Messages
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To read a message, click on the ReadMessages option in the Active Pane. The PCO ReceivedMessage table is displayed listing
all receivedmessages. To view a specific message, double click on the message to be viewed, this will open the Edit PCO
Received Messages Information dialog.

l Message To - Automatically populatedwith the current System Name of the system receiving the message as specified
in the Communications Configuration topic.

l Message From - Sender of the message.
l Message - Message text.

Click on the ellipses to view the entire message if part of it is obscured.

Setting up the Address Book for each networked system
The Communications Object (PCO) allows several scheduling systems to be used on a single machine. Consequently each
networked Viewer or MSS must have a unique system name which identifies the particular system to the network.

In order to send and receive messages, each system should have one "Inbound Address" and an "Outbound Address" for each
system it will communicate with. See Address Book for further details in integration.

To set up the Address Books for all systems:

1. Firstly make sure that entries for the current system have been entered into the Address Book.

2. Select:

Configuration ►Communications ►Configuration.

The Edit PCO Configuration Information dialog is displayed.
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3. Select a System Name for each Preactor system.
4. Click OK to save the changes.

Each system on the network now has a unique identity. It now remains to set up the Address Books for each system.

4. Go to the MSS and set up the Address Book to enable it to communicate with each of the Viewers.
5. When this is complete take the Viewers in turn and complete their Address Book entries.

When selecting the UNC Folder for each address, use the browse button to locate the Network Place you previously
established if this folder is on a remote machine.

Testing the System
Sending messages between Viewers, and between Viewers and the MSS, tests the communications system.

To check the system:

On each machine that is remote from the UNC Folder or License Site check the network.

1. In Windows go to Start ►My Network Places ►View Network Connections.
2. Check that all required connections are connected or enabled.

If any of these are not connected, right click on the icon and select Connect.

3. Under 'Other Places', clickMy Computer.
4. Check that the Network Places established for the UNC Folder and License Site are connected.

If these are not connected, right click on the icon and select Open.

5. Select a system, e.g. MSS.
6. Select:

Configuration ►Communications ► Send Message.

The Edit PCO Sent Text Information dialog is displayed.

7. In the Message To field select an outbound address from the drop down list, enter a message and click OK.
8. Go to the system that the message was sent to and select :

Configuration ►Communications ►Read Messages.

If the message is present then the communication set- up is working.

Database

Database Schemas
The SQL database is partitioned into a number of areas called schemas. Each schema contains tables that can be considered
similar in nature.

'UserData' Schema
The tables, fields and constraints in the 'UserData' schema are inferred from the .prtdf file.

These tables contain user maintained data and Preactor makes few assumptions about their structure or content.

'Integration' Schema
These tables are usedmy the Data Providers module and any associated plug-ins.
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'SystemData' Schema
Tables defined in the SystemData schema should not be amended in any way.

Note: The structure and content of these tables may change between releases.

Fixed Schema Views
A number of views have been introduced to the 'SystemData' schemas that map consistently onto fields within the 'UserData'
tables. Although the scope for this type of view is limited given the inherent flexibility of Preactor, these views can be very
useful, and go some way towards providing a mechanism that will allow common tasks to be performed across a variety of
different configurations.

Inferred Database Schema
While some elements of the database schema are fixed (most notable of these is the Calendar schema) for the main part the
tables within the database are inferred from the Preactor Table Definition (.prtdf) file. Tables inferred from the .prtdf file are
defined in the 'UserData' schema. The configuration file can be amended to add new tables and fields, or to change an existing
field.

Referential Integrity
Although not currently enabled, foreign key constraints exist in the database for all of the relationships inferred from the
Preactor Table Definition File.

These constraints can be used by reporting tools and query generators to show the relationships between tables.

In future versions of Preactor, these constraints may become enabledwithin the database.

This is currently not practical because of the absence of any referential integrity checks at the core of Preactor. Future versions
will probably perform per-row commits, and therefore per-row integrity checks.

System Tables
A collection of tables referred to as "System DB" tables are included into example configurations.

This gives Preactor a place to store the tables used routinely across a number of configurations, and the opportunity to amend
and update these tables with new releases of the software. System tables are defined in the database in the 'SystemData'
schema.
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Planning

Planning Concepts

Introduction
The Preactor AP (Advanced Planner) planner module is the core component in the Preactor AP product.

Preactor AP imports current stocks levels, actual sales and forecast sales. It then considers pack forward figures, target days of
stock cover, manufacturing preferences, minimum/maximum re-order quantities, re-order multiples, etc. and accounts for the
shelf life of stock to propose a future production plan.

Preactor AP is an interactive capacity constrainedMPS generator that can feed its results into the users ERP system and/or
their Preactor Ultimate scheduling system. The production plan can be scheduled in Preactor AS (Advanced Scheduler) and
then fed back into Preactor AP to show the implication of the actual schedule on the subsequent planning periods. These
periods can be re-planned automatically or manually using the grid or via the stock/loading graphs depending on the user’s
preference.

The planning BoM is also exploded by Preactor AP and the production plan for the lower levels items is calculated in the same
way. Based on the BoM explosion and the production plan the proposedmaterial purchase requirements can be exported to
e.g. Excel, for action.

Capacity Management
Capacity Management is the function of establishing, measuring, monitoring, and adjusting limits or levels of capacity in order
to execute all manufacturing schedules; e.g. the production plan, master production schedule, material requirements plan,
and dispatch list. Capacity management is executed at four levels: Resource Requirements Planning, Rough-cut Capacity
Planning, Capacity Requirements Planning, and Input/Output Control.

Resource Requirements Planning (RRP) is the most highly aggregated and longest range capacity planning decision.
Constraints, changeovers or other fine detail can not be considered at this level.

Rough Cut Capacity Planning (RCCP) verifies that sufficient capacity is available to meet the capacity requirements of the
Master Production Schedule.

Capacity Requirements Planning (CRP) utilizes time phasedmaterial plan information produced by MRP, including
information on batch sizes, lead times, receipts and planned orders. It takes into account production capacity in the form of
assembly and component inventory and, because Shop Floor Data Collection will typically provide current status for work in
progress, work center capacity for current orders needs only to be calculated for the work yet to be completed. CRP links
directly into MRP systems and is therefore much more detailed than either RRP or RCCP.

Operating Environment
There follows a typical environment in which Preactor may be located, but Preactor can in fact fit into any manufacturing
environment as it is able to take data from existing systems or from the User Interface.
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Operating Environment

Typical ERP Architecture

Preactor AS Position
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Operating Environment

Preactor AP Position
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Planning Resource Groups and Planning Resources

Typical Data Flow

Planning Resource Groups and Planning
Resources
Planning Resource Groups are used to groups Planning Resources together. For instance a Planning Resource Groupmay be a
whole factory while a Planning Resource will be one area of the factory. Each Planning Resource can have its own capacity level
andwill contribute to the total capacity of the Planning Resource Group
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For Example:

l This Planning Resource Group could be at Company Group Level, but it could simply be a section of the factory.
l This Planning Resource Group contains 2 Planning Resources.

Each one of these could be an individual factory or an individual production line.
l The capacity of a Planning Resource could be made up of the capacity available over a number of production lines in the
factory or could be the capacity of an individual production line.

l The total available capacity is the total of the capacity available from each Planning Resource.

If Planning Resource 1 requires additional capacity and Planning Resource 2 has not used the available capacity, Planning
Resource 1 can use the remaining available capacity in the Planning Resource Group.

In the below example, consider

l The capacity for each Planning Resource is 6.
l The capacity for the total Planning Resource Group is therefore 12.
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MPS Calculation

Make to Stock
Make to stock items are planned forwards. For these items Preactor will calculate an MPS value on the opening date of each
planning period from the beginning to the end of the planning horizon.

The trigger for an MPS value to be generated is illustratedwith the following pseudo code:

If (Opening stock- demand) < Min stock Then
     Volume should be made.
     MPS = Target Stock level - Opening stock + Demand
Else
     No MPS volume is required.
     MPS =0

The MPS Value
There are two primary factors that influence the MPS value. These are the minimum and the target stock levels. The basics of
the calculation are that if the closing stock for a given item would fall to less than the minimum stock level (assuming no
more is produced) then the aim will be to close that bucket with a stock level which is at target.

The target and the minimum stock level are both calculated from the minimum days of cover and the target days of cover
fields. These can be either decimal values or whole numbers. The main rule of both of these fields is that neither can be less
than zero. However, a value of zero is completely valid for either the minimum or the target days of cover.

There is an option that allows the user to enter absolute values for both the minimum and the target stock level. This is
instead of a calculated number.

When the conditions are such that an MPS value is required to maintain an item's stock level, Preactor will generate an MPS
value while respecting the minimum order and reorder multiples for the given item. If the trigger happens on a non-make day
(as defined in the calendar) then Preactor will test to see if an MPS value of zero will cause the item to go into a negative stock
position. The system may be configured to either generate an MPS value that returns the item's stock level to its target stock,
or to allow the shortage. See GMPSENABLEMAKEDAYOVERRIDE for further information.
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If there are no priorities applied to any stock, then the MPS calculation will not order stock in a specific way, essentially all stock
will be sorted in the order in which they appear in the Items table. Essentially, the display of items will appear random.

Make Days
The system is able to use make day and non-make day flags, and so there could be a scenario where there is enough stock to
cover the current day but subsequent days which are non-make days will not be covered. There are multiple ways to handle
this scenario.

Example 1
Suppose we have day one set as a make day and are making enough stock to stay above the minimum level. This would
typically not trigger a make, but if day 2, 3 and 4 are all set as non-make days, and they have sufficient demand on each day to
take it into a negative stock position, then the system will automatically search forward and calculate howmuch additional
volume will be required to cover these days. This is only ever going to be enough volume (taking into account order multiples)
to cover these days and not enough volume to get you to the target stock level beyond this point (day 4).

Example 2
In this example the make and non-make days are the same as example 1, but we do not have enough stock to cover day 1.
This again will search forward add the additional MPS value to the current day but also adding it to the current MPS value
required for this period. This will take into account the closing stock position of this period, but again the aim of this is to come
out of the other side (when we have another make day) with enough stock to cover that demand. There is no limit to the
number of periods forward Preactor will search. It is possible to have four days in a rowwhich are non-make days but the life of
the item is only three days. In this scenario the system will not check the item life when generating volume. The make day and
non-make days ought to be re-considered to cover this scenario better, as there is a non-make period longer defined that is
longer than the item life.

Example 3
Again, the make and non-make days are the same as example 1, but the demand shortages flag is enabled. This means that
when the system calculates the MPS value, it will not search forward looking at the subsequent days, andwill most probably
(due to reorder multiples) close the day with a low stock position. Each subsequent day which is flagged as a non-make day will
have an MPS value of zero. The negative closing stock position which results will be reset to 0 each planning period, and the
volume missedwill be recorded in a column called 'demand shortage'. This is to allow for cases where missed sales cannot be
recovered.

Order Multiples
Each time the MPS is calculated the required volume for that periodwill be validated against the minimum and reorder multiple
quantities. Preactor first checks the volume is greater than the minimum, then it will look at the reorder multiples and validate
the batch size. There is a relationship between the minimum and the re-order multiple, this means that the minimum re-order
quantity has to be a multiple of the re-order multiple value.

Preactor will validate the quantity in these batch sizes and then check to see if by removing a single re-order multiple the
closing stock position is still greater than the minimum stock level. This is to prevent constantly rounding up reorder multiples
which would take the item over its target level each time. If, by rounding down, the item falls below its minimum stock level,
the volume is rounded up.

Decimal places are also taken into consideration when the MPS calculation is made. This is driven from the parameter sets
allowing the volume required to be calculated as an integer value for one item and a decimal value for another, in the same
plan.

Decimal places are adjusted typically on the lower level items when calculating the MPS. This is due to the finished product level
requirement of a lower level item not being a whole value. This is true when, for example, a finished product is made in cases
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but the lower level item is made in kilograms. The demand then at this lower level is a decimal value, which is valid because the
site wouldwant to know a true number. However, when the calculation is finalized the re-order multiples are still respected to
avoid small batches.

Parameter Sets
All the options that are mentioned above specified at item parameter set level.

Make to Order
Make to order items are planned backwards. Preactor will try to keep the lowest stock holding possible while adhering to
reorder multiple. The MPS value will be calculated backwards from the end of the planning horizon andwill look for demand
values. When it finds a value it checks the reorder multiple andworks out when it needs to start to produce volume in order to
cover the demand. It may be that the reorder multiple is greater than the demand value so Preactor will start to move
backwards and check what other demand can be covered by this volume. If Preactor can make the same volume but earlier
and cover off additional demand then it will, but will take into account the days of life for that item.

During the process the planning logic will also look at the lead time specified at item level. This means that when adding item
life and also lead time, it is important to remember that both will start from the demand date.

Successive MPS Calculation Issue
When the MPS calculation is repeated several times in succession, the set ofMPS values that are created from one calculation
iteration could sometimes be different from a set produced by previous operations. Despite this rarely occurring, the
discrepancies can still happen, for logical reasons, between the first and second iterations of calculating MPS values.

This only occurs when the 'Dynamic BoM' setting is true, and only with any of the following planner modes:

l 'Move',
l 'Move Then Constrain',
l 'Constrain Then Move'.

The main reason for the discrepancy between the first and second calculation iterations is because the second iteration has to
take into account the existing MPS, from the first calculation, and how it has been distributed between planning resources.
The first iteration calculates the MPS that will generate the MAXIMUM permissible level of closing stock. The second iteration
has to take into account that there is existing MPS values, and if there is enough to generate the MINIMUM permissible level of
closing stock, no changes to that item will be made. However, if the level falls below the minimum level of closing stock, the
calculation will increase the production needed to generate the minimum permissible level of closing stock.

If the 'Infinite Capacity' mode is used, the MPS value is left unchanged between the first and second iterations of
MPS calculation, as it will still be the value needed to calculate the maximum closing stock. However, when using a
'Move'/'Move Then Constrain'/'Constrain Then Move' planner mode, some production may be shifted from the primary
planning resource to a secondary resource, that can be used to make that item.

With one of the 'Move' planning modes, it can be possible to shift enough production to a secondary resource (or
resources) to produce more than the minimum permissible closing stock. If this is the case, in the second iteration the MPS for
the main resource is provisionally set to zero, but the MPS for the secondary resource(s) is left unchanged. During the second
calculation, the total MPS is checked to see whether it meets the minimum permissible closing stock or not. If this requirement
is met, no increase to the MPS is made and the MPS values are left as they are.

Planning Modes
Planning modes alter the way in which capacity is consumed and consequently the make periods for the planned items.
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Planning Modes

There are five different planning modes:

l Infinite Capacity
l Constrain
l Move
l Move Then Constrain
l Constrain Then Move

The behavior of each planning mode is explained below.

Infinite Capacity
Infinite Capacity planning mode will create plan using only an item's primary planning resource. MPS volumes are not
constrained, regardless of available capacity. This can lead to overloading the capacity of a primary resource for any item. Any
secondary planning resource will not be considered in this planning mode.

Infinite Capacity is typically usedwhen needing to assess the capacity requirements of the primary planning resource for each
item. This mode is the basis for all planning modes in Preactor AP, as all other modes perform subsequent processes based on
the data generated from this process.

In Make to Stock (MTS) mode, each item will be planned to meet it's target stock level. In Make to Order (MTO), AP will look to
make the order as late as possible, with late being determined as demand date minus lead time.

Preactor AP has a trigger that is used for determining whether a production of an item is to be created. This trigger is:

If (Opening Stock minus demand) < Minimum stock, then an item should be made.
Item volume MPS = Target Stock level - Opening Stock + Demand
If MPS = 0, no item production is required.

Constrain
Constrain planning mode, like Infinite Capacity, will only plan using an item's primary planning resource andwill not utilize any
secondary planning resources.. It will attempt to "squeeze" down MPS volumes based on the resource's capacity.

Items are ranked by their Days of Cover (DOC), which is calculated for the end of each period or time bucket. Make quantities
for items with the longest DOC value will be reduced by one reorder multiple quantity.The DOC value for the item will be
decreased each time it is reduced. This process is repeated across all items, until the capacity constraint is satisfied. Items that
end into a negative stock position based on a reorder multiple will not be reduced any further. This can lead to the capacity
being exceeded, even though the plan is constrained.

There are also other reasons why a planning resource could be overloaded:

l The item cannot be made any later (MTS only).
l Making it earlier (MTO mode only) would cause the item to go out of life.
l Item profile is too tight for the demand requirements.
l MTO mode has run out of earlier buckets to plan into.

Move
When using theMove planning mode, Preactor will look to spread production over all available resources, based on the
capacity constraint. If the total requirement for an item is larger than the capacity of a resource, in a time bucket, then the
item will be moved to another planning resource that has available capacity. If required, items can be split over multiple
resources to satisfy production.
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Similarly to Constrain mode, the items are ranked based on the Days of Cover value calculated for the end of the current
period. Preactor will then look at items that have additional resources it can use, andmove any overload to the secondary
resources. If splitting item production is required, reorder multiple values are considered.

The capacity value of a planning resource is only used to determine if an overloadwill occur. If there are no other planning
resources that an item couldmove to, due to the fact they are overloaded, then no adjustment will be made to this planning
resource.

In summary, no lines will be constrained, but any overload that can be moved for the same bucket will be moved to alternative
lines for a ‘better’ fit in batch order-multiples.

Move Then Constrain
When planning using theMove Then Constrainmode, Preactor will look to move production around the available resources
(within the same bucket) of the item before it looks to constrain. Production could occur on multiple resources to keep the
MPS value as required. If too much production is required across all items and resources then Preactor will look to reduce the
MPS value using the constraint logic described earlier.

An item will not be moved to another planning resource if its move is going to cause an overload. This means that when a
plan is completed, you may have additional choice planning resources that have a small amount of capacity remaining.

This mode would typically be usedwhen the aim is to spread the MPS value within all the available planning resources, but
while trying to make it in the same bucket, e.g. where all the planning choices are within the current factory.

Any overloadwill be moved over first, and then the line will be constrained so that the capacity consumed fits the available
capacity.

Constrain Then Move
When planning using Constrain The Movemode, Preactor will look to produce items, mainly on the item's primary resource.
If there is not enough capacity to make the required volume after constraining, Preactor will look to use the Move option. If
the secondary resource is full it will move to the next resource. If there is no secondary resources that production can move
to, because it will become overloaded, then no adjustment will be made.

This is again a combination of the Constrain andMove planning modes. This mode would typically be usedwhen the additional
planning resources are at a different location, and therefore the preferredmethod is to make it in an additional bucket.

The resource will be constrained first and any overloadwill be moved over to alternative lines.

Flexibility on Dates
Preactor AP can present planning information in such a way to give a long term viewwhile retaining finer 'granularity' for the
more immediate dates (Set Planning Horizon). When a plan is generated, an increasingly courser view can be specified for any
future date.

This can be illustrated thus:
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Alternate Capacity Availability Level and Con-
sumption

Percentage Split
Percentage Split is where the available capacity is specified at the Capacity Group level, and then each planning group has to
specify (as a percentage) howmuch of the available capacity it has available has as a starting point.

The example below has a capacity groupwith 4 planning groups associatedwith it, total capacity 500.

Capacity Group: The capacity available is specified at this level: Capacity available = 500

l Planning Group 1: Capacity available is 20% so therefore the available capacity to this planning group is 20% of 500 =
100

l Planning Group 2: Capacity available is 30% so therefore the available capacity to this planning group is 30% of 500 =
150

l Planning Group 3: Capacity available is 10% so therefore the available capacity to this planning group is 10% of 500 =
50

l Planning Group 4: Capacity available is 40% so therefore the available capacity to this planning group is 40% of 500 =
200

Note: It is important to remember that no test is made to verify that the percentage quantities that are entered do add up to
100%. This is entirely the responsibility of the user entering the data. This would typically be usedwhere the user is happy to
define/edit the available capacity at a single point.

Total of Planning Groups
This is where the capacity available is specified at the ‘Planning Group’ level.

The example below has a capacity groupwith 4 planning groups associatedwith it.

Capacity Group: No capacity is specified at this level:

l Planning Group 1 capacity available: 100
l Planning Group 2 capacity available: 150
l Planning Group 3 capacity available: 50
l Planning Group 4 capacity available: 200

The total capacity available to the entire group Capacity Group:

Capacity available: 100 + 150 + 50 + 200 = 500

How the Capacity is Consumed
Where the Capacity Measure level is specified as ‘Percentage Split’ or ‘Total of Planning Groups’ the capacity is used in the
following way.

Each planning group has an ‘Allocation Sequence’ that the user is able to specify a numeric value against. This is then used to
rank the planning groups into an order in which the following logic will then be applied. Planning groups must have different
numbers or the planning levels logic will apply (see ‘How the capacity is consumed – Continued’).

In the following example the planning groups allocation sequence fields have the following values:
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l Planning Group 1 allocation sequence = 10, Capacity available 100
l Planning Group 2 allocation sequence = 20, Capacity available 150
l Planning Group 3 allocation sequence = 30, Capacity available 50
l Planning Group 4 allocation sequence = 40, Capacity available 400

In these modes the planning groups are processed in the following way. The first planning group is loaded until there are no
more requirements for that bucket. If the capacity available is not exceeded then the remaining capacity is made available to all
planning groups that follow. But it is important to realize that the next planning group in the sequence has first choice against
any available capacity that remained unused from the previous group.

If more capacity than is specified for a planning group is required, then a post process is performed on the items in the
planning group.

Planning
Groups

Allocation
Sequence

Capacity
First Pass
– allocated
to PG 1

Free for
subsequent
passes

Second Pass
- allocated to
PG2

Free for
subsequent
passes

1 10 100 75 25 25 0

2 20 150 0 150 145 5

3 30 50 0 50 0 50

4 40 200 0 200 0 200

Note: It is important to note that the planning groupwith the lowest sequence number is processed first. Due to the way spare
capacity is re-allocated, it should be the planning group that normally has the most spare capacity to be set to be processed first,
i.e. that have the lowest allocation sequence number. The allocation sequence field is classification driven -
GMPSPLANNINGGROUPLEVEL

The allocation sequence value can also be used to create levels within a capacity group. When used in this way the each level is
processedwithout sharing it’s capacity with another member of the level and any spare is only made available to the next
level.

In the following example the planning groups allocation sequence fields have the following values:

l Planning Group 1 allocation sequence = 10 – Level 1
l Planning Group 2 allocation sequence = 10 – Level 1
l Planning Group 3 allocation sequence = 20 – Level 2
l Planning Group 4 allocation sequence = 30 – Level 3

In this mode the planning groups are processed in the following way. The planning groups are sorted into ascending sequence
based on allocation sequence number. The first planning group is loaded until there are no more requirements for that bucket.
A check is then made to see if the next planning group is the same level. If it is then any available capacity from the previous
planning group is saved and not made available to this planning.

If the next planning group is not the same level then any spare capacity is made available to this new level.

There are also flags specified against each planning group to specify if spare capacity can be utilized by another planning group
or if spare capacity can be utilized by this planning group. This will allow the planning groups to be setup in more complicated
structure.

In the following example the planning groups allocation sequence fields have the following values:

l Planning Group 1 – Level 1,
can share spare production = true,
    can use spare production = true

l Planning Group 2 – Level 1,
can share spare production = true,
    can use spare production = true
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l Planning Group 3 – Level 1,
can share spare production = false,
    can use spare production = true

l Planning Group 4 – Level 2,
can share spare production = true,
    can use spare production = true

l Planning Group 5 – Level 3,
can share spare production = true,
    can use spare production = false

l Planning Group 6 – Level 4,
can share spare production = true,
    can use spare production = true

With the data setup in this way, the 3 planning groups on level 1 will all be processed independently. Planning Groups 1 and 2
will then allow any spare capacity to be utilized, but Planning Group 3 will not allow any spare capacity to be utilized.

Planning Group 4 is at level 2. It is allowed to utilize any unused capacity from lower levels. It also allows any unused capacity
from either its self or subsidiaries to be utilized.

Planning Group 5 is at level 3. It is not allowed to utilize any spare capacity that is remaining from any lower levels. But any
spare capacity that is remaining can be utilized by any further groups.

Planning Group 6 is at level 4. It is allowed to utilize any spare capacity that has been made available. This will include the
capacity from Planning Group 4 (level 2) and Planning Group 5 (level 3).

Individually Constrained
This is where the capacity available can be specified at both the ‘Capacity Group’ level and the ‘Planning Group’ level. Setup this
way, the system will constrain first by each individual planning group and then by the total of all planning groups by the
capacity specified at the capacity group level.

The example below has a capacity groupwith 4 planning groups associatedwith it.

Capacity Group The capacity available is specified at this level: Capacity available = 400

l Planning Group 1:-Capacity available: 150
l Planning Group 2:-Capacity available: 200
l Planning Group 3:-Capacity available: 250
l Planning Group 4:-Capacity available: 300

Note: When using this method, the capacity available for the planning groups could be more individually, or in total, than the
capacity group.

How Individual Capacity is Consumed
Where the Capacity Measure level is specified as ‘Individually Constrained’ the capacity is used in the following way. Each
planning group is first processed as if it were completely independent. Once all the planning groups have been processed (see
‘How Planning Groups are Processed’) they are then re-processed as a single group.

Note: The allocation sequence value is not used during this process.

First the Planning Groups are processedwithin their own limits

Then the Capacity Group is processed in the same way.
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Group Capacity Usage
Spare/
Excess

Planning Group 1 150 120 30

Planning Group 2 200 150 50

Planning Group 3 250 150 100

Planning Group 4 300 210 90

Capacity Group 400 630 -230

Planner Data

Items
The Items table holds information such as Min/Max reorder quantities, Days Life, Rate per Hour and Product Level (e.g.
Finished Product, RawMaterial etc) for each item. Only items that are marked as 'Include in Planning' are used in the plan.

The Items display in the work pane is like this:

When an item is selected for Edit, the following dialog is opened for provisioning the entry:
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Planning Resources

Fields of particular note are:

l Item Level - this is set with a custom action Set BoM Levels defined from the BoM structure.
l Item Display Data - plot color and Capacity Sort Order (the order the bars are stacked on the capacity charts).
l Include in Planning - if checked, item will be included in the Planner and all calculations.
l Make to Stock - if checked, Target Days of Cover specifies the capacity constraint process MTS or MTO.
l Planning details, which opens another dialog:

And note here:
l Item Setup Time - time to setup between different products.
l Parameter Set - held against the Parameters Table, associated against the item.

The Capacity Details dialog contains a field of importance, the Labour Hours field. This field is used to calculate the Labour
required in the Planner record. Labour Required is Labour Hours multiplied by Rate Per Item.

Planning Resources
Planning Resources are assigned to Items so that their capacity can be calculated in smaller areas. Planning Resources need to
be set up in the Planning Resources table.

Each Planning Resource is assigned to a Planning Resource Group andwill have its own capacity level. To constrain the
Planning Resource, check the box 'Enable Constraint'.

- 153 -



Planning Resource Groups

The screen shot below is of the Provisioning Planning Resource display in the work pane, with an entry open for edit.

The Planning Resource color can be changed if required. This is the background color that will be used in the Capacity Usage
charts.

Total Labour determines the height of the horizontal line in the Labour chart. It isn't affected by Planner calculations.

Planning Resource Groups
As Preactor AP is about capacity planning, some thought needs to be given to how capacity is measured and how it is grouped.
"Planning Resource Groups and Planning Resources" on page 142 for guidance.

The screen shot below is of the Provision Planning Resource Group display in the work-pane, with an entry open for edit.

Each Planning Resource Group can be either constrained or unconstrained. To constrain the Planning Resource Group, check
the box 'Enable Constraint'. This will also set the Initial Process Group to Make to Order therefore any demand for Make to
Order items will be processedwithin the available capacity first before processing demand for Make to Stock items. The % of
capacity available to the Initial Order Group can also be set.

The Field Ranking dialog is available in both the Planning Resources and Planning Resource Groups tables. If there are field
rankings enabled for both a Planning Resource and a Planning Resource Groupwhich contains that Planning Resource, then
both field ranking are consideredwhen performing Planner calculations. Preactor does not consider the rankings based on
priority of them, but instead the order in which the constrain operations are carried out. If, for example, Cost Per Item is set as
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the Lowest Value First (LVF) field ranking on a Resource (A), and then as the Highest Value First (HVF) field ranking on a
Resource Group that contains Resource (A), Preactor will perform the following:

l An operation is performed on each bucket in turn, so two constrain operations are performed for each bucket. One for
each field ranking.

l On the first operation, items that are to be processed on Resource (A) will be ranked by Cost Per Item in ascending order
(LVF).

l On the second operation, items that are to be processed on any resources within the Resource Groupwill be ranked by
Cost Per Item in descending order (HVF).

l The results of both operations (the newMPS value and capacity usage at Resource and Resource Group level) are then
combined and a check is done to ensure that capacity isn't exceeded.

Transaction Data
Preactor AP considers the following as transaction data:

l Stocks
l Sales
l Forecasts
l Capacity Levels
l Variable Days Cover

Below is the Preactor Desktop showing Transaction Data, with Imported Stock information open:

Capacity Levels are set for individual weekdays so that levels can vary throughout the week if required.

The Variable Days of Cover table can be used to override the global settings defined in the Items table for information relating
to Minimum Stock, Target Days Cover etc. This is useful in cases where it may be necessary to have different values on a
particular date e.g. for promotions etc. This table is usedwhen calculating stock levels. The distinction between Make to Stock
andMake to Order items is only significant when production is calculated from these levels.
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Bill of Materials (BoM)
The Bill of Materials (BoM) tells Preactor AP the different levels of product and quantities of product required for each Finished
Product. Using Parent Code and Child Code relationships the material requirement for each order can be calculated and
planned by Preactor AP to meet demand dates.

The screen shot below is of the BoM display in the work pane, with an entry open for edit.

Each record shows the Parent Code, Child Code (the next level down), Qty per (howmuch Child per each Parent) and From and
To Dates (when the item is valid for use). There will then be a similar record for the Child Code but the Child Code becomes the
Parent Code as in screen shot below.

Products and Routings
The Products data table includes details of the process route, including each operational step to make the product, the times
for each operation, setup times, display information etc.

This information is readwhen you enter an order for a product in the schedule.

If your system is to be integratedwith an MRP/ERP system then it is likely that you will not have this local data table because
this information is imported (so called Full Order File Downloadmethod).
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Parameter Sets
The screen shot below is of the Parameters Sets display in the work-pane, with an entry open for edit.

The following options are available:

ENABLE
SHELF LIFE

States if the item is to use shelf life to calculate out of life stock and out of life production. If enabled, this field
takes the Days Life field into consideration, which unless specified, is considered to be infinite. This affects pro-
duction calculations and closing stock values.

PARAMETERS
TABLE

Identifies if the parameters table exists in the current configuration.

USE
VARIABLE
DAYS COVER
BY DATE/DAY

States if the item is to use variable days of cover with a date or day specified. These determine howDays of
Cover records are matchedwith Planner Records. If DAY is set, the match is between the Planner DAY field and
the Variable Days Cover field set in the Variable Days Cover table. If DATE is set, then the match is between the
Demand Date specified in the Planner record and the Required Date specified in the Variable Days Cover table.

CALCULATE
DAYS
COVERED

States if the item is to calculate the total days covered based on the opening or closing stock position.

USE DAY
VARIATION

Cover profile specific to day variation.

CREATE MRP
RESULTS LOG Option to create an MRP results log.

LOG NOT
PLANNING
ITEMS

Option to create the log with non planned items.

USE
PRODUCTION
MAKE DAY

Use SKU Calendars for production make day planning period.

USE SALES
MAKE DAY

Use SKU Calendars for Sales day periods in the planning period.
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MPS ROUND States if the MPS Result is to be rounded to the nearest re-order multiple.

USE
ADVANCED
MAKESTOCK

Use Frozen stock functions in Preactor AP.

VARIABLE
DAYS LIFE

Use Variable days of life for the out of life stock calculation.

ENABLE
PRODUCTION
SHORTAGES

States if production shortages are to be flaggedwhen re-importing scheduled data.

TOTAL DOC
REF

States when the total days of cover calculation should start from opening / closing stock.

RESET
OPENING
FOR FROZEN

Reset opening when adding a frozen stock batch.

USE STATIC
STOCK
LEVELS

Use static stock levels instead of days of cover.

Selecting Edit against Stock Plot Options produces the plot color selection window:
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Planning Parameters

Capacity Colors

Planner Thresholds
Colors are used in the Planner to indicate different levels of cover e.g. 'Closing Stock' with a value greater than 'Min Stock' AND
less than 'Target Stock' will be colored yellow.

Custom rules can be written in the 'Expression' field. This logic is based on the Demand and Parameters table.
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Set Planning Horizon
Preactor AP can present planning information in such a way as to give a long term viewwhile retaining finer granularity for
the more immediate dates. This is done by provisioning the Planning Horizon.

When a plan is generated, an increasingly courser view can be specified for any future date. A view finer than that for the
immediately preceding columns cannot be requested.

If a change in view is required, the whole plan must be re-calculated.

It is of course possible to save different scenarios as different Datasets so as to allow rapid recall of different views.

A number of set Planning Horizons can be created for use within the Planner:

The following fields are of particular note:

l Belongs to Settings - defines the parent Settings, or defines this as a Parent.
l From Date
No. Of Days
First Day OfWeek
No. Weeks
No. Months - These fields define how far in advance to plan.

l Remove Excluded Items - removes items that are unchecked from the planning if amend cycle is selected
l Append to Current Cycle - adds additional records to an existing plan with amend plan option
l Run Process - specifies the function to run controlled from the drop down
l Repair All - repair all rows in planner or select specific row filtering
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If NOT SET, Filter Repair By becomes selectable.
l Planning History Rows - the number of rows from day zero to exclude from the stock calculation

From within the Planner, the particular Planning Horizon to use can be selected, and can be adjusted as required.

Repair Plan Run Sets
The Repair Plan allows the operator to define repair scripts, which can be manually executed from within the Planner from the
Repair toolbar option. A repair may be instigated for example if stocks fall below a certain predefined level.

The screenshot below is of the Repair Plan and its Edit window:

The Repair Plan table contains Rule Sets that can have one or more rules in them. When repairing a plan, Preactor will process
the records that fall into the bucket range set against each rule in a Rule Set.

The following fields are of particular note:

l Belongs to Rule Set - name of the Parent Rule Set, or indicates this is a Parent Rule Set.
l From Day Number - day zero is the first day of the plan.
l Re-Calculate MPS - allows the user to make changes without recalculating.
l Re-Calculate BoM Explosion - permits changes in quantity produced based on closing stock levels.
If not set, then Reduce Volume and Increase Volume options become available.

A brief example of how rules in a Rule Set would interact with each other would be:

l If the demand date for a record lies within the date range of a rule, the recalculate flags are consulted, and if either has
been checked in the Repair Plan dialog, then MPS is recalculated and/or the BoM is exploded.

l If these two options are not checked, then a more refined correction is applied instead, which may result in a small
adjustment to the MPD.

l If the Increase Volume checkbox is checked, then an Increase If True Expression is required to be evaluated for the
Planner record. If this expression returns true, then an Increase expression is evaluated to obtain a newMPS value.

l The same is said for the Reduce Volume checkbox and Reduce If True and Reduction Expressions.
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Preactor Planner

Introduction
This chapter assumes that all data has already been imported into the interim tables.

The Planner is the main grid that all data such as Sales, Stocks and Forecasts will be imported into. When Preactor has
calculatedwhat product is required to meet demand, the MPS values will also be shown. MPS values can be changedmanually,
if necessary, in the Planner.

From the Preactor DesktopWorkspace Menu, select Generate Plan. When the plan is first opened it will be empty. Either open
an existing Dataset (plan) or create a new one.

Planner Main Windows

Introduction
The Viewmenu option provides the following screen:

From this menu option:

l Demand Data provides access to results of the planning, and some associated configuration data.
l Chart Data provides useful information in chart from, the charts being able to be manipulated.
l Calendar Data can be viewed and edited.
Calendars can be setup for:

l Planning Resources

l Planning Resource Groups

l Items

Calendar templates can be built and can be assigned to Planning Resource Groups and/or Planning Resources to define
capacity levels.

l Reports can be generated.
The reports list is displayed on the right-hand side of the planner window.
The report settings, e.g. file path, can be set in Settings – Report Options from within the Planner.

Tool Bars
For general Toolbar management and usage, see the section in the Preactor Tour.

The following tool bars can be enabled/disabled:

l Standard Toolbar
l Global Filter Toolbar
l Repair Plan Toolbar
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The Standard Toolbar
The Standard toolbar will have different options depending upon which window is active.

The following are the common set offered on all windows (prior to any user modification of the toolbar customization):

Button Name Description

New Create a newDataset

Open... Opens an existing Dataset.

Save Saves a Dataset

Amend Plan
Re-runs the Planner, to take into account changes to plan data (e.g. planning hori-
zon)

Print Print

Undo Undo the last change

Redo Redo the last Undo

Auto Update MPS
Enables automatic value refresh for subsequent records following a manual
change

Calculate Stock Populates the opening stock column

Calculate MPS Populates the MPS results column with the proposed value for the plan.

Enable Capacity Con-
straints

Switches on or off the Capacity Constraint if Planning Resource Groups have been
setup.

BoM Exploder
Explodes the records for each SKU to show lower level items as long as they are
marked as 'include in planning'.

Static/Dynamic
When set to Dynamic, the BoM expansion step is executedwhen Calculate All is
performed.
When set to Static, no BoM expansion will occur.

Repair Provides access to the Repair Plan scripts.

Hide Child Records Hide all child records present in the plan.

In addition to the common set, when the Stock Profile Viewer (graph) window (prior to any user modification of the toolbar
customization) is open, the following is available:

Button Name Description

Code Select from the drop down list which Item to view in the graph.

Series Select from the drop down which sets of data to include in the graph.

Zoom In Allows the user to zoom In on graph

Zoom Out Allows the user to zoom Out on graph

Reset Zoom Resets the view to default after Zoom In or Zoom Out has been used.

Disable Demand Inter-
action

Enable/Disable the ability to dynamically change stock or orders by dragging the
columns of the graph

Disable All Interactions
Allows/prevents user from using mouse to drag/dropMPS results thus changing
the overall calculations.

Select Features
Select from the drop down list which features to enable in the graph, e.g.
Port Labels, Alert Colors, User Zoom and Disable Interactions.

The following is offered, in addition to the common set, when the Calendar Templateswindow (graph) is open:
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Button Name Description

Undo Undo Calendar Template changes

Redo Redo Calendar Template undo actions.

Add Period Opens the dialog to add a period to the Calendar Template

Snap Period To Allows the user to define the Snap value.

Global Filters
When the Global Filters toolbar (prior to any user modification of the toolbar customization) is enabled, the following is
available:

Button Name Description

Sync Views
Syncs any filters applied in the Editor windowwith any other openedwindow. It
has no impact on the Stock Profile Viewer and the Capacity Alerts.

Bulk Lock Rows Lock multiple rows prior to recalculating

Bulk Unlock Rows Unlock multiple rows

Repair Plan
The following is offeredwhen enabling the Repair Plan toolbar (prior to any user modification of the toolbar customization):

Button Name Description

Repair Drop Down Select from the drop down list which Repair Script to run a repair with.

Run Repair Script Runs the Repair Script.

Repair Rule Set Select from the drop down list a Rule Set available to run a repair with.

Repair Plan from Rule Runs the Repair Plan according to rule selected.

Configuration

Planner Specific Configuration
Application Settings
The Application Settings window allows various settings can changed or enabled, including:

l Fonts
l Message Displays
l Colors

Planner ► Settings ►Application Settings
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Planning Horizon
The Planning Horizons to use for charts is selected from:

Planner ► Settings ► Set Planning Horizons

From here, a predefined set of values can be selected under the Script List, and individual values adjusted.

The predefined sets of values are provisioned from the Preactor Desktop.
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Planning Data

Introduction

Most Provisioning and Transaction data can be viewed and edited from within the Preactor AP Desktop Data Maintenance
Pane, or imported. Data is in a read-only format if the Planner is open, and can only be editedwhen the Planner is closed.

Managing the Plan

Amend Plan
Amend Plan performs an update or refresh of the plan after changes are made to provisioning or configuration data within the
Planner. It is the same effect as closing and re-opening the planner.

Amend Plan is initiated from either the toolbar icon, or from the menu item:

Planner ► File ►Amend Plan

Lock Rows
Within the Planner, it is possible to lock records (rows) prior to running any recalculations, allowing for records to retain any
MPS value set. Locking rows can be done in one of two ways.
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The first is by using the Global Filter toolbar. This toolbar is enabled by navigating to Edit ►Global Filter. "Tool Bars" on
page 162 provides information about the toolbar.

The lock and unlock buttons, when used, will lock all the records in the plan, or if editor filtering has been applied, the records
that are displayed as a result of the filtering will be affected.

In order to lock/unlock individual records, the row that is to be lockedmust be right-clicked on, and then navigating to Row
Optionswill display these options.

If the option Sync Window with Planner Window is enabled from the Sync Views drop down in the Global Filter toolbar,
then the Planner Alerts windowwill be updated to showwhich records have been locked.

Repair Plan

Description
Repair plan scripts can be used to adjust production figures. The rules can be setup to adjust production figures on specified
planning buckets with specified filter criteria. Repair results should always round to the nearest re-order multiple for the item
repaired.

Repair Plan Options (Data Maintenance ► Repair Plan Run Sets).

Field Descriptions
Field Name Description

Belongs to Rule set Specifies if the record is a parent or child record.

Rule Set The name of the rule set.

Rule The name of the individual rule for this record.

Enabled Specifies if the record is enabled as part of the repair rule script.

From Day Number From bucket that the rule should start to make the repair from.

To Day Number To bucket that the rule should repair to.

Re-Calculate MPS Specifies if the production figure should be recalculated for the bucket(s) specified.

Re-Calculate BoM Explo-
sion

Specifies if the bill of material needs to be re-calculated.

Unlock Row Range Specifies if a records that fall between To and From bucket range need to be unlocked.

Reduce Volume Specifies if the record should reduce production volumes if the reduce if true expression is met.

Reduce If True Expression
Specifies a preactor evaluate expression that should return true or false in order to reduce pro-
duction.

Reduction Expression
Uses a preactor evaluate expression to calculate howmuch the production needs to be reduced
by.

Increase Volume Specifies if the record should increase production figures if the increase if true expression is met.

Increase If True Expres-
sion

Specifies a preactor evaluate expression that should return true or false in order to increase pro-
duction.

Increase Expression Uses a preactor evaluate expression to calculate howmuch the production needs to be increased
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Field Name Description

by.

All examples will use the make to stock example configuration that is shippedwith Preactor.

The repair definition called ‘Repair Test’ will be used in this example.

Reduction Expressions
A reduction expression can be used to reduce the production figure based on the Reduce If True Expression field. The following
example highlights how the logic could be applied.

Navigate to the repair plan format (Data Maintenance ► Repair Plan Run Sets):

Double click the first record ‘Repair Closing Stock to Target Stock’ to display the reduction logic.

The dialog will display the repair reduction rules and in this example if the closing stock is greater than the target stock then
the production figure will be reduced for the first planning bucket.

Testing the result
Open the live plan dataset andmanually change the production for SKU1001 11/06/2012 to be 5000.

This will increase the closing stock to be over the target stock of 143.
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Use the repair plan option to reduce the volume to be equal to or under the target stock.

Repair ► Repair Script ListC:\Users\wf0fun\Desktop\Captured_Images\Repair Plan 4.png

Select the Repair Test rule from the drop down list:

Click ‘Repair Plan from Rule’.

The following result will highlight how the reduction process has repaired the first bucket for SKU1001.

The production figure has been adjusted to 110 and the closing stock recalculated. In this example the closing stock of 146
has exceeded the target stock of 143 this is down to re-order multiple for this item being made in batches of 5 cases.

Increase Expressions
An increase expression can be used to increase the production figure based on the Increase If True Expression field. The
following example highlights how the logic could be applied.

Using the Repair Test rule, double click the ‘Increase Closing Stock to Target Stock’ record:

Buckets 2 to 3 should be re-calculated if the closing stock value is less than the target stock for the bucket based on the
Increase If True Expression field.

- 169 -



Repair Plan

To test this logic open the LivePlan dataset and change the production figure on 11/06/2012 to zero. This will cause
12/06/2012 closing stock to fall negative as no production is made to cover those orders.

Use the repair plan option to increase the volume to be on target stock (Repair ► Repair Script List).

Select the Repair Test rule from the drop down list:

The production figure on the 12/06/2012 will now be increased to meet the target stock. Closing stock is now 102 again
exceeding the target stock by 3 cases due to the re-order multiple of 5 for this item.

These examples highlight how to use the reduction and increase expression logic independently on separate planning
buckets. It is possible to have a combination of a reduction and increase expression on the same bucket to adjust the
production figures.

Re-calculate MPS and Re-calculate BoM Explosion Options
The repair rule can also specify MPS and Bill of Material calculations. For example the user could specify that the MPS
calculation will only need to run from planning bucket 5 onwards and buckets 1 to 5 shouldn’t be re-calculated. If production
figures should not be re-calculated those records should be locked using either the right click lock record option or the global
filter lock tool (Edit ►Global Filter ► Lock Records in View).

Creating Planning Horizon Repair Script
It is possible to run more than one process using the planning horizon. The following instructions will explain the Entire
Process script defined against the planning cycle format. The script runs the following processes:

1. Create a new plan.

2. Calculate Stocks.

3. Calculate Production.

4. Repair the plan using the Repair Test script.

5. Explode Bill of material requirements.

Navigate to Data Maintenance ► Set Planning Horizon:
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In the view of information the ‘Run Process’ field specifies which process to run as part of the script.

If Repair Plan is selected for the Run Process then a Repair Plan Script will need to be selected:

In this example the Repair Test rule will run after production figures have been calculated.

Using these scripts it is possible to run several repair plan scripts in succession. For example the user might have an AM
Planning horizon of rules that need to be completed in the morning and a PM Planning script for actions that need to be
completed in the evening.

It is also possible to use a Preactor evaluate expression to filter the planner format so that only the filtered records will be
repaired.

It is then possible to set which script needs to run in the planner (Settings ► Set Planning Horizon).
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Using the script option:

Clicking the New Plan button will then run all associated processes for the ‘Entire Process’ script.

The planning horizon script ‘Entire Process’ can also run using Run Repair Script button.

Summary
If a single repair script needs to run for the entire planning board then the ‘Repair Plan from Rule’ button should be used –
highlighted as ‘Repair Test’ above.

A single or several repair plan scripts need to run in succession with or without filtering then the ‘Run Repair Script’ button
should be used to run the rule.

Datasets

Introduction
The set of data being managed by Preactor AP are stored in Datasets.

Datasets can be stored and opened, and Preactor AP can be configured to open the last worked on Dataset when entering the
Planner.

Open Existing Dataset
To Open a Dataset, select:

File ►Open

Select a Dataset from the drop down list and select Open to load the plan.
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Create a New Dataset
When a new plan is generated, Preactor will adhere to the date range and bucket size defined in the Set Planning Horizon
window. This can be seen in:

Settings ► Set Planning Horizon

In the example shown above the selection begins with Plan From Today. Preactor will create a plan for a period of 14 days, with
daily records, starting with today’s date.

A predefined set of Planning Horizons can be accessed from the Script drop-down.

Set the Custom Start Date as required. If 'Append to Cycle' is checked the dates will be added to any existing dates (use when
updating existing plan). State the Number of Days to be included in the period. If the date range is to include weekly dates,
select the First Day ofWeek from the drop down list and state the Number ofWeeks to be created. Select the Green Check
Mark to continue.

To generate the structure of the Dataset, go to:

File ► New
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A recordwill be created for each item marked as 'Include in Planning', for each of the dates in the range selected.

Click on Calculate Stock ( - Planning Data ►Calculate Stock - or default shortcut F2).
This will bring in all imported stock data into the planner andwill show values in the Opening Stocks column.

Before calculating the MPS values decide whether to constrain the plan or not.

If a Constrained plan is required then click on Enable Constraint before clicking on Calculate MPS .
Preactor AP takes into account the planning cycle, the opening stock, the pack forward %, the target days cover, the forecast
and the make day for each item andwill propose production volume. Calculated values will be displayed in the MPS Results
column.

The plan will now display colors depending upon the settings in Set Planner Threshold (View ►Demand Data ► Set Planner
Threshold).

It is possible to manually edit values in the plan. Click in a cell and type the new value. If the 'Auto Update MPS' icon is selected
prior to making any manual changes, Preactor AP will automatically refresh values on screen following each change.

Click on BoM Exploder if lower levels items are also needed to be displayed in the plan.
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Any values shown in the Out of Life column indicate that stock of that item will be not be included in calculations from that
date. This is based on Days Life values held in the Items table or Out of Life Date as held in the Imported Stocks table.

Save the Dataset (  - File ►New - or default shortcut Ctrl+S)

Saving Datasets
Demand results can be saved to the Preactor Database by clicking on the Save icon on the topmenu. A pop-up form will
display, enter a name for the dataset and click on Save to commit the results to the database. It is possible to save over an
existing result set. Select the result set name from the list displayed and click on Save.

Open Last Dataset on Start Up
If the planner should always open up the last plan worked on it is possible to set this up in the Application Settings.

Go to Settings ►Application Settings and select Open Planning Results on Application Start by checking the box.

Save the changes and the next time the planner is started the last plan savedwill open automatically.

Demand Data

Introduction
The Planner offers a number of outputs to assist in monitoring production, from:

View ►Demand Data ► ...

This includes:

l View Plan
l View Alerts
l Set Planner Threshold
l MRP Results

Advance options allow Advance Pivot Grid and Day Offset Grid to be selected.

Alerts
Preactor AP has an Alerts window (View ►Demand Data ►View Alerts) that opens by default on the right-hand side of the
planner window and allows the user to filter results. The Alerts window can be docked elsewhere if required.

Data can be filtered by Item Code, Demand Date, and Case Type e.g. Above Max stock, Within Limits etc.
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Alerts Filtering - Capacity and Demand
To start filtering, click on the text box below the column name. Type in a value required to match on. Click on Tick:

Records in the Alerts windowwill be filtered to match the criteria.

The Alerts can be filtered further, by e.g. Date. Click on the filter box below the Date column header and either type in a value
or select a value from the drop down menu to match on.
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To deselect filters, click on the filter-remove button. Do this for all filters. The Alerts windowwill display all records once again.

Please see Filtering Data / Column Filters for full explanation of filter conditions.

Total Stock Holding
Total stock can be listed in terms of value, pallets, cases etc. These can be used to assess storage volume and value.

Right clicking on an item, chart data, or View Stock profile in the Planner allows the user to see the stock chart for that item.
MRP results can be adjusted from here.

Use of Calendars

Introduction
Calendars are used by the Planner and the Sequencer in different ways. This information related specifically to how they are
used in the Planner.

Calendars in the Planner define:

l Capacity level of Planning Resource Groups and Planning Resources.
l Sales and Production Periods for Items.

Planning Resource Groups
The list of Planning Resource Groups is opened by:

Planner ►View ►Calendars ► Planning Resource Groups ► Planning Resource Group
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The example above shows the planning resource group UK Plants. The calendar window shows that the template ‘Market
Harborough 7 day’ is assigned to this planning resource group.

Planning Resource Groups - Templates
Planning Resource Groups Templates can be viewed and edited from:

Planner ►View ►Calendars ► Planning Resource Groups ► Planning Resource Group Templates

Planning Resource Groups templates are assigned to Planning Resource Groups to define capacity levels.

Planning Resource Groups - New Templates
A new Planning Resource Groups template can be created from:

Planner ►View ►Calendars ► Planning Resource Groups ►New Planning Resource Group Template

Planning Resource Groups templates are assigned to Planning Resource Groups to define capacity levels.

Planning Resources
The list of Planning Resource Groups is opened by:
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Planner ►View ►Calendars ► Planning Resource Groups ► Planning Resource Group

Double clicking on one of the Planning Resources will open a window for that resource's calendar.

Planning Resource - Templates
Planning Resource Templates can be viewed and edited from:

Planner ►View ►Calendars ► Planning Resource ► Planning Resource Templates

Changes made to existing templates will affect all Planning Resources that have the template assigned to them.

Planning Resource templates are assigned to Planning Resource to define capacity levels.

Planning Resource - New Templates
A new Planning Resource Groups template can be created from:

Planner ►View ►Calendars ► Planning Resource ►New Planning Resource Template

Planning Resource templates are assigned to Planning Resource Groups to define capacity levels.
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Item Resources
The list of Planning Resource Groups is opened by:

Planner ►View ►Calendars ► Items ► Item Resources

Double clicking on one of the Item Resources will open a window for that resource's calendar.

Item Resource Templates
Item Resource Templates can be viewed and edited from:

Planner ►View ►Calendars ► Items ► Item Templates

Changes made to existing templates will affect all Items that have the template assigned to them.

Item Resource templates are assigned to items to define their sales and production periods.

Item Resource - New Templates
A new Item Resource template can be created from:
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Planner ►View ►Calendars ► Items ►New Item Templates

Item Resource templates are assigned to Items to define their sales and production periods.

Charts

Capacity Usage
Capacity Usage can be shown by:

l Planning Resources Plot
l Planning Resource Group Plot
l Planning Resource Multi Plot.

To open the window, select:

View ►Chart Data ►Capacity Usage ► [selected display type].

The capacity chart illustrates the production volumes, over available capacity.
Capacity is represented by the colored background area and the production volumes are represented by the colored blocks in
the upright columns.

Production values can be modified by left clicking on a colored block and dragging that block up or down. The actual value will
be displayed during the process. Production can also be dragged from one date to another by left clicking on a colored block
and dragging the block to another date. Any changes made to production date or value in the chart will automatically update
the Planner.

To view a different Capacity Group, select it from the drop down menu.

Capacity Colors

To open the Capacity Colors window, select:

View ►Chart Data ►Capacity Usage ►Capacity Colors

This displays the Capacity Colors table as described in Provisioning Data – Planner Data – Planning Parameters – Capacity
Colors. Only the colors selection can be edited from here. Double click a record to open the color edit window.
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Capacity Alerts

To open the Capacity Colors window, select:

View ►Chart Data ►Capacity Usage ►Capacity Alerts

This displays the Capacity Alerts Window on the right-hand side of the planner.

Use the column filters to filter the records in the Capacity Alerts Window that match the criteria.

BoM Pie Chart
This shows items in the top level BoM.

Charts - Analyzing the Plan
Introduction
The Planner offers a number of outputs for analyzing the plan, from:

View ►Chart Data ► ...
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This includes:

l Capacity Usage
l Stock Profile Viewer
l Total Stock Holding
l BoM Pie Chart

Stock Profile Viewer
All Demand Results are represented on the Stock Profile Viewer. This can be accessed by:

View ►Chart Data ► Stock Profile Viewer
- select an Item from the Drop Down box in the Toolbar

or

From the Demandwindow, right-click on a record and select Chart Data ►View Stock Profile.

The Stock Profile can display a number of possible series, selectable from the Toolbar):

l MPS Result
The proposed production required for the specific day. A zero MPS Value is represented by an upward arrow.

l Projected Stock
The Projected Stock Level of the item for each day.

l Forecast
The total quantity for forecasts for the date

l Orders
The total quantity for orders for the date.

l Min Stock
The Minimum Stock Holding required for the item for each day

l Target Stock
The ideal stock holding required for the item for each day

The plan can be modified by dragging the MPS Result columns in the chart to a different value. Right click on one of the purple
columns and hold and drag the column up or down to the new value. Switch on Point Labels to see the actual value. Any
changes made in the Stock Profile chart will automatically modify the corresponding value in the Planner.
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The MPS Result value can be adjusted from a zero value by left clicking on the Point Label (0) and dragging upwards.

It is possible to switch to a chart for another item by using the Stock Profile drop down list. As soon as another item is selected
the graph will change to display relevant data for that item.

Once there is valid data for a graph of stock profile (calculate stock, then calculate MPS, then look at stock profile), the ability
to dynamically change stock or orders by dragging the columns of the graph can be disabled.

Reports

Planner Reports
See also Report Generation for help in generating the reports, and Report Reading on how to read and navigate the report
output. Note - many reports have Drill Down reports available.

Planner Reports generally include the following:

l BelowMinimum Stock
For each item, shows description, demand date; closing andminimum stocks.

l Greater than Maximum Stock
For each item and demand date, shows: closing andmaximum stocks.

l All Capacity
For each capacity group, gives capacity used and% by date.

l Capacity by Planning Group by Date
For each date, lists capacity used and% for each PG.

l Demand
l Items
For each Item -

l Unit ofmeasure,

l Item level,

l Include in planning?,

l Maximum and target days of cover,

l Minimum andmaximum reorder quantity,

l Reorder multiple,

l Capacity and planning group names,

l Out of Life
For each item, demand date, out of life stock, product and total.

l Plan Comparison
Side-by-side comparison of production and total days cover by date for two selectable saved Datasets.

l Imported Sales
For each item, shows order date and quantity.

l Imported Stocks
For each item, shows; quantity, production and out of life dates.

l All Orders
l Days Cover by Item
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l total days Cover Outside Limits
l Total Days Cover

Quick Reference
What How

Item Plot Color in Planner Capacity Plot

From the Preactor Desktop:
Data Maintenance ► Items
►Double click Item
► Item Display Data

Item Sort Order in Planner Capacity Plot
Preactor Desktop: ►Data Maintenance
► Items (Double click Item)
► Item Display Data

Columns
Within the Planner it is possible to hide/unhide columns to achieve a different
view of the data.

Toolbar icon

Demand Color Enable/Disable Toolbar icon

Planner Threshold Provisioning
- Which colors to/are used to indicate different stock levels

To provision/view:
Preactor Desktop:
    Data Maintenance ► Set Planner
Threshold

To View: from within the Planner:
  View ►Demand Data

► Set Planner Threshold.

Messages - Completed Tasks, Enable/Disable
Settings ►Application Settings
- ShowMessages for Completed Tasks.

Messages - Show Last Task Enable/Disable
It puts a message on bottom left hand side of planner window after updates etc
and gives time to run that action.

Settings ►Application Settings
► Show Last Task Done

Planning Group Colors
Preactor Desktop: ►Data Maintenance
► Items (Double click Item)
► Item Display Data

Stock Profile Chart - Enable/Disable Data Selection
Toolbar Icon and select the required
data to be displayed.

Stock Profile Chart Colors
The colors have to be defined, then the colors have to be enabled

To Define the Colors:
From the Preactor Desktop:
Data Maintenance ► Parameters
- Edit the Stock Plot Options for that Para-
meter.
To Enable The colors
Within the Planner:
Settings ►Application Settings
  - Check 'Use Custom Color For Stock Plot

Toolbar - Toolbar ScreenTips Enable/Disable
Right click on Toolbar Area, select Cus-
tomize.
► Select Options
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Scheduling

Preactor Sequencer

Introduction
The Sequencer is the heart of the scheduling system and contains the Calendar Editor, Schedule Gantt Chart, Editor, Plots,
Trace Chart, and Utilization windows. It establishes the shift calendar patterns for both primary and secondary resources,
provides automatic andmanual scheduling functions and carries out all finite capacity calculations.

To enter the Sequencer

l From the Workspace Navigation pane in the Preactor Desktop, select General (in the Active Pane) and select the Gen-
erate Schedule button. The Sequencer opens displaying its Gantt Chart window:

To open additional tabbedwindows in the Sequencer

l Select a window from the Viewmenu option (Gantt Chart, Overview, Plot, Trace Chart, Utilization, or Material Explorer
windows)

l Select the window from the toolbar

Menu Bars and Toolbars

Selecting any Menu Bar commands displays a submenu showing the options available under each one. The options available
under each menu are context sensitive, based on which of the sequencer windows is focused.

Toolbars too are context sensitive, depending on the view that has focus. Here the Standard toolbar is displayed but you can
right click on the bar to activate other toolbars.

WindowDisplay
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The Sequencer uses two types of window display, "Docking" windows and "Tabbed" windows.

Calendars and Reports are presented at the edges of the screen as hidden docking windows that are displayedwhen the
appropriate tab is clicked. Unscheduled Operations appear in a docked panel on the left of the screen.

To provide more screen area for the sequencer display the Unscheduled Operations panel can also be presented as a hidden
window, by clicking on the Auto Hide pin in the top right of the panel.

Tabbedwindows are only presented if the "Tabbed" option is selected in Windowmenu bar command.

Window Layout

l The Sequencer's window display (workspace) can be rearranged to suit your own requirements, and is normally lost
when exiting the Sequencer.

l The workspace can be saved (as a namedworkspace) and loaded for future use, or set to be saved on exit of the sequen-
cer and re-usedwhen entering the sequencer in future - using the Window ►Workspaces menu options.

Window Fonts

l The fonts for the text in a number of windows (Gantt Chart, Plots, Trace Chart) can be modified from the menu item:
    Tools ►Options ► Environment.

Concepts

Scheduling Algorithms
Production Scheduling Algorithms
All Preactor scheduling products can use the sequential or order at a time scheduling method, found in FCS systems. Here,
each order, is loaded in sequence, dependent on due date, priority etc and operations are loaded forward, backward or bi-
directionally.

Additionally, APS allows you to use the parallel loading method, where, as each resource becomes free, operations are selected
from the queues of work waiting to be processed, using industry standard dispatching rules.

For example, you may want to minimize setup times by selecting operations in a particular color sequence. A look-ahead
period can be defined to decide which operations should be pulled forward in order to minimize setups when generating the
schedule.

An example of sequence dependant changeovers can be seen on the Preactor web site.

Algorithmic Sequencing
The sequencer uses an algorithm to select an order and places each operation for that order on the planning board. It repeats
this process until all orders (and therefore, all operations) have been loaded.

Each operation is loaded on its specified resource at the first available time slot that satisfies the constraints for that operation.
The order-at-a-time construction process, sometimes called Order BasedMethod or Sequential Loading, is shown in the
following diagrams. In this example, we first load Order A, then Order B, and finally, Order C.
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Step 1: Load Order A

 Step 2: Load Order B

Step 3: Load Order C

In an order-at-a-time sequencer, selecting the sequence in which the orders are loaded onto the planning board controls the
schedule. Once an order is selected, all of its operations are loaded in a straightforward, unalterable way.

Hence, the key to the quality of the schedule that is generated by the algorithmic sequencer is the dispatching rule - i.e. rule
that is used for selecting the order-loading order.

There are a number of very simple heuristic rules that can be used to select the sequence for loading the orders on the
planning board. One rule that can be used for selecting the order sequence is to sort the orders by a priority value that has
been assigned to each order. Other possible sorting criteria are earliest due date, earliest release date, and smallest remaining
slack time. None of these rules are optimal in a mathematical sense. Each rule represents a different strategy and focus in
planning the orders. For example, the due date-related rules (earliest due date, least remaining slack) focus on reducing the
number of late orders, whereas the priority-based rule strives to complete the most important orders as soon as possible.

In some applications, a given operation can be performed on two or more different resources. For example, a drilling operation
might be performed on either of two drills. In such cases, the schedule in an algorithmic sequencer is first determined by the
sequence of orders, then by the rule that is used to determine to which resource a given operation is assigned during the
loading process. Again, simple heuristic rules (e.g., assign the operation to the resource that will complete the operation first)
can be used to determine the schedule.

Backward Sequencing
Although an order-at-a-time sequencer typically loads each order working forward in time by starting with the first operation
and continuing through to the last operation, (forward sequencing), it is also possible to use this same sequencing scheme
but reverse the procedure to work backward in time (backward sequencing).

In this case, the sequencer begins by loading the last operation for the order to finish at its due date. It then continues by
loading the order's preceding operation to finish at the start time of the last operation. This process is continued, working
backward in time, until the first operation for the order is loaded. At this point, the sequencer then selects a new order to load
and repeats the entire process, again starting with the last operation andworking backward in time. It continues in this
fashion until all orders are loaded.

The following diagram shows a schedule generated by backward sequencing Orders A, B, and C, where the vertical line on the
right denotes the due date for all three orders.
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Backward Sequencing Chart for Orders A, B, and C

The advantage of a backward algorithmic sequencer is that it always generates a schedule that has no late orders. However,
the schedule may require start times that are infeasible; that is, the orders must start before the current time.

In essence, a forward order-at-a-time sequencer fixes the start times for an order and determines the end times (which may
violate the due dates), whereas a backward order-at-a-time sequencer fixes the end times and determines the start times.
Although the idea of constructing a schedule that has no late orders is appealing, backward sequencing has some practical
limitations, even in cases where a feasible solution is generated.

Backward scheduling shifts all orders to the right on the planning board so that they start as late as possible while still meeting
the due date. This means that there is no time buffer in the system and any disruptions that occur; (machine breakdowns, late
material arrivals, etc.) will typically create late orders. In addition, by postponing the use of our available capacity andwaiting
until the last minute to start each order, we give up the opportunity to consider additional orders that may arrive later and
need to be added to the schedule. For these reasons, many schedulers prefer a forward sequencing. There is also a tendency
for backward sequencing to produce lower resource utilization. If you consider the Backward Sequencing Chart, a gap has been
left between operations A-10 and B-20 on Resource 1. It is likely that the gap is too small to be filled by operations loaded later
in the sequencing process, resulting in lower utilization. If the work had been forward sequenced the gapwould have been at
the end of B-20 (i.e. added to the as yet unused pool of capacity), making it available to other operations of any duration. It is
also possible to use an algorithmic sequencer in a bidirectional mode. In this case, we select an operation somewhere in the
middle of the order and schedule the remaining operations using forward sequencing and the preceding operations using
backward sequencing. This is useful in cases where we have an available time slot on a critical, highly utilized resource andwe
want to assign an operation to this critical resource and then load its upstream and downstream operations around this
operation. We can accomplish this by fixing the operation on the critical resource and bidirectional sequencing the remaining
operations for this order. In summary, an algorithmic sequencer is a simple and fast method for loading a set of orders on the
planning board. The schedule is completely determined by specifying the sequence of orders and a rule for selecting between
resources.

Simulation-Based Sequencing
Simulation-based sequencing provides an attractive alternative to algorithmic sequencing by providing a simple, yet very
flexible method for constructing a schedule. In general, a simulation-based sequencer can also produce any schedule that is
produced by an algorithmic sequencer. However, a simulation-based sequencer can also consider many schedules that cannot
be considered by an algorithmic sequencer. Hence, the simulation-based sequencing approach, sometimes referred to as a
Resource BasedMethod or Parallel Loading, can create better schedules than an algorithmic sequencer, but this would depend
very much on what you consider to be a 'better' schedule.

In contrast to the algorithmic sequencer, the simulation-based sequencer selects and loads an operation at a time. By loading
individual operations rather than entire orders, the simulation-based sequencer has finer control over the way the operations
are loaded onto the planning board. This operation-at-a-time loading is the key to the added flexibility in schedule generation
using the simulation-based sequencer.

A second fundamental difference between the algorithmic and simulation-based sequencer is that the simulation-based
sequencer constructs the schedule in a single time pass by moving forward from one event time to the next. The simulation-
based sequencer begins at the current time and loads all operations that can start now. Note that these operations do not
come from a single order as in the case of the order-at-a-time sequencer, but can be taken from the entire set of orders. Once
all operations that can start at this event time have been loaded, the simulation-based sequencer advances time to the next
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event e.g., the first completion time for any operation on the planning board. In this case, a busy resource has just changed to
idle; hence, the simulation-based sequencer attempts to load additional operations at this new event time. The simulation-
based sequencer continues in this fashion, advancing time forward to the next event time and loading additional operations as
resources become idle until all operations have been loaded.

The following set of figures illustrates steps in the simulation-based construction process. In each of the figures, the vertical
line denotes the current value of simulated time. The first step in the simulation-based sequencer is to load all operations that
can begin at the current time.

In this example:

l Step 1: Operation 10 for Order A (A-10) can be loaded on Resource 1 andOperation 10 for Order B (B-10) can be loaded
on Resource 2.

Step 1: Load Operation A-10 and B-10

l Step 2: The simulated time is advanced to the ending time of Operation A-10, and Operation C-10 is then loaded on
Resource 1.

Step 2: Load Operation C-10

l Step 3: Simulated time is advanced to the end of Operation B-10, and Operation A-20 is loaded on Resource 2.

Step 3: Load Operation A-20

l Step 4: Simulated time is advanced to the end of Operation C-10, and Operation B-20 is loaded on Resource 1.

Step 4: Load Operation B-20
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l Step 5: Simulated time is advanced to the end of Operation B-20. Since no further operations remain to be loaded on
Resource 1, simulated time is advanced to the end of Operation A-20 where the final operation, C-20, is loaded on
Resource 2.

Step 5: Load Operation C-20

In contrast to the algorithmic sequencer, the simulation-based sequencer only moves time forward. It only advances time
forward once all operations that are to be loaded at that time have been loaded. Hence, the simulation-based sequencer
temporarily stops time and examines the entire order set, advancing to the next event time once all operations have been
loaded. The algorithmic sequencer, on the other hand, is constantly moving back and forth in time as it loads all operations for
each order. It starts at the current time and goes forward in time loading all operations for this first order. It then goes back
again to the current time and again moves forward in time loading all operations for the second order. It continues in this
fashion, moving forward and backward in time, until all orders are fully loaded on the planning board. Hence, the algorithmic
sequencer fixes an order andworks across time, advancing to the next order once all operations have been loaded.

In the Preactor 400 APS simulation-based sequencer, we control the schedule using dispatching rules that select the next
operation to load.

Typical rules select the next operation

l with the shortest setup time
l with the shortest processing time
l with the earliest due date
l with the lowest value of critical ratio
l in a preferred sequence etc

Although the loading concepts employed by the Simulation Based Sequencer provide great flexibility in schedule generation,
the effective use of this flexibility is influenced by the dispatching rules chosen to select the next operation for the resource
from the queue of work waiting to be processed. Preactor 400 APS employs both standard and customized dispatching rules
and this is discussed further in the section dedicated to Preactor 400 APS.

There are disadvantages in using a simulation-based sequencer too. An example would be use a dispatching rule which
minimizes lateness, such as 'critical ratio', where selection of operations would be based on the remaining operation time
compared to the delivery time. In this situation, if capacity is a problem, a simulation-based sequencer would tend to minimize
total lateness of all the orders but you would have a higher number of late orders (i.e. a large number of slightly late orders).
An algorithmic sequencer using the due date priority option would produce fewer late orders (i.e. a small number of very late
orders). In this situation the user could focus attention more easily on those orders that are predicted to be late.

An algorithmic sequencer can also control some process parameters more effectively than a simulation based sequencer. For
example in many food and process industries it is often a requirement to control the amount of time that work waits between
process steps (food can spoil). Because an algorithmic sequencer loads a complete order at a time it can easily check if the
intervals between the operations are correct, and adjust them if required.

The simulation-based sequencer has less control because when it loads the first operation it does not knowwhen the next
operation will be loaded. Later, when the next operation is loaded, it may not be possible to move the first operation because
other work has been loaded in between.
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In general, a simulation based sequencer using First In First Out (FIFO) as the dispatching rule, will generate a schedule with
higher resource utilization and a shorter overall schedule span than an algorithmic sequencer, but at the expense of higher
work in progress.

In-built Scheduling Rules
APS scheduling systems are equippedwith in-built scheduling rules.

Examples of these are:

l Preferred Sequence (by order attribute, setup time, process time, critical ratio)
l Minimize Work In Process (WIP) Forwards
l Minimize WIP Backwards
l Selective Bottleneck (TOC)
l Dynamic Bottleneck
l Minimize Overall Setup
l Campaigning
l Parallel Loading

The Preferred Sequence rule is data driven. You can select the criteria by which the preferred sequence is created. Critical ratio
is used, for example, to minimize late orders by dynamically changing the priority of orders based on a comparison of
remaining process time with time to due date.

TheMinimize WIP rules are sequential rules that endeavor to minimize the make-span for each order. Min WIP forward loads
each order forward from the current time, locks the last operation and backward sequences from there. Min WIP backward
loads each order from its due date, locks the first operation and forward sequences from there.

The Selective Bottleneck rule is based on the Theory of Constraints (TOC) philosophy. It works by the user selecting the
'Bottleneck Resource' or 'Bottleneck Resource Group'. Each order is then backward scheduled from the Due Date (less Delivery
Buffer). Any operations loaded onto a bottleneck resource are offset by the Bottleneck Buffer time (defined in the Resource
data table for each resource) which is designed to give some 'slack' such that any delays to operations before the bottleneck
resource will not result in it being 'starved' of work. Preactor then detects whether any operations in that order must start
before current time. If so then these operations are re-scheduled forwards using up some or the entire bottleneck buffer. If this
is consumed then some or the entire delivery buffer may also be used up and the 'At Risk' or 'Late' flag is set.

The Dynamic Bottleneck rule is an improvement over the classical selective bottleneck scheduling where the bottleneck will
'wander' depending on the current product mix that is scheduled. Rather than pre-processing your orders to determine a single
bottleneck, the Dynamic Bottleneck Rule calculates the bottleneck individually for each order. Operations 'upstream' of the
bottleneck are then backward sequenced inserting a resource buffer like the Selective Bottleneck rule.

TheMinimize Overall Setup rule is similar in some respects to the Preferred Sequence rule. However it is focused purely on
minimizing the setup or changeover time on resources. In the Preferred Sequence rule, as each resource becomes idle it
selects the next operation to load based on the preferred sequence criteria in the resource database without any consideration
of other resources that could also be used. Thus, provided one or more operations can be run on the resource and they lay
within the 'Look AheadWindow' one of them will be scheduled based on the preferred sequence. In the Minimize Overall Setup
rule, consideration is made across all resources able to run the operation even if they are still busy. The rule does not use the
preferred sequence criteria in the Resource table. It does however use the 'Look AheadWindow' to decide whether an operation
should be available to be scheduled in the same way as the Preferred Sequence rule.

The Campaigning rule is usedwhen a production schedule is to be created in waves and uses a PESP script. When the rule
runs, a dialog box asking the user to enter a Reference Date, Campaign Period and Number of Campaigns appears. The first
pass of the rule locates all orders where the reference time entered is greater or equal to the due date of the order, these
orders are then forward scheduled. The Reference Date is then incremented by the Campaign Period, the Number of
Campaigns decremented. The second pass of the rule will again locate all orders where the reference time entered is greater or
equal to the due date of the order. The number of passes of the rule will be the same as the number entered into the Number
of Campaigns field.
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The Parallel Loading rule is resource specific. Operations that are ready to load are put in one or more queues which can be
ranked according to the rule assigned to the resource. As a resource becomes free, it looks at the queue of waiting operations
and selects the best operation to process next.

Version Availability
Below is a table listing which scheduling rules are available in the Standard, Professional and Ultimate versions of Preactor AS.

Scheduling Rule AS Standard AS Professional AS Ultimate AS Ultimate Viewer

Preferred Sequence N Y Y Y

Minimize WIP Forwards N N Y Y

Minimize WIP Backwards N N Y Y

Selective Bottleneck N N Y Y

Dynamic Bottleneck N N Y Y

Minimize Overall Setup N N Y Y

Campaigning N Y Y Y

Parallel Loading N Y Y Y

Sequential and Parallel Loading of Operations
There is an alternative scheduling engine to FCS (Finite Capacity Scheduling) available in Preactor Professional and Ultimate.

With the FCS scheduling engine all operations for an order are loaded onto the schedule before another order is considered.

In APS you can also elect to load one operation at a time and use so called dispatching rules to select which operation to load
next.

Parallel Loading rules are resource specific. Operations that are ready to load are put in one or more queues which can be
ranked according to the rule assigned to the resource. As a resource becomes free it looks at the queue of waiting operations
and selects the best one to process next.

The standard Preferred Sequence Rule uses this logic. It also has a Look AheadWindow, which defines a time period that is used
to determine whether an operation should be allowed into a queue for a specific resource. When a resource becomes free the
rule determines what its look aheadwindow is from the current time. If an operation from an order has a due date within that
window then it is allowed into the dispatching rule queue.

There is also the ability to enable Campaigns when using the Preferred Sequence Rule. This is done via the Options in the
window Toolsmenu. Enabling Campaigns within the Preferred Sequence Rule will change the way that the Look Ahead
Window is used. When not using Campaigns, the start of the Look AheadWindowwill move to the end of the last completed
operation. When Campaigns are enabled, the start of the Look AheadWindow is calculated from the Reference Date in steps of
the Look AheadWindow size.
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Order & Operation Relationships
Sequencing Orders using Operation Numbers
When operation numbers are used to define the sequence of operations within an order the Preactor Sequencer assumes that
lower operation numbers must be performed before higher operation numbers and that operations with the same operation
number may be performed in parallel.

Defining operation relationships in this way is quite easy and has the advantage that you can easily insert or remove
operations without the need to redefine the parameters of previous or subsequent operations. All operations of the Order are
considered as a whole and sequenced in one action.

However, there are significant limitations in the way that operation numbers can be used to model assembly and dis-assembly
within the order.

For example, consider the assembly in the following order:

Using operation number relationships only, the two operation 10s would have to be performed before either of the operations
20s and both operation 20s would have to be performed before either of the operation 30s.

Often, with assembly of this type, operations 10a, 20a and 30a could be performed independently of operations 10b, 20b and
30b. The only point at which dependency is required is at operation 40.

Sequencing Orders Using MADE FROM
Defining operation sequences using MADE FROM overcomes the limitations of implying the relationship using operation
numbers. However setting up the relationship is more complex.

In the above example the MADE FROM table would look like this:

Op 10a – No Dependencies
Op 20a – Depends on Op 10a
Op 30a – Depends on Op 20a
Op 10b – No Dependencies
Op 20b – Depends on Op 10a
Op 30b – Depends on Op 20b
Op 40 – Depends on Op 30a and Op 30b
Op 50 – Depends on Op 40
Op 60 – Depends on Op 50

When sequencing the operations of the order, Preactor creates internal virtual orders for sequencing. The virtual order is
made up of the previous and subsequent operations plus, iteratively, any operations that have no more than one previous
operation and no more than one subsequent operation.

Looking at the order above, this would result in the following virtual orders:
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Virtual Order 1: 10a, 20a, 30a.
Virtual Order 2: 10b, 20b, 30b.
Virtual Order 3: 30a, 30b, 40, 50, 60.

Preactor then treats these virtual orders in the same way as orders defined using operation numbers. The virtual orders
become available for sequencing when there are no unallocated dependents of the first operation. So in this example, Virtual
Orders 1 and 2 are considered immediately, Virtual Order 3 is only considered once both Virtual Orders 1 and 2 have been
sequenced.

It can be seen that Virtual Order 3 contains both operations 30a and 30b; these operations will have been already sequenced
before Virtual Order 3 is considered, so there will be no relationship between them, other than operation 40 requiring that
they have both been processed.

When using the operation relationships can include operations that are not part of the same actual Order, however, internally
the same Virtual Order concept is used.

Operations With Complex Relationships
Certain features of Preactor can create more complex relationships between operations than just there previous and
subsequent operations. These features are:

• Maximum time between operations – INTER OPERATION INTERVAL

• Subsequent resource constraints – SUBSEQUENT RESOURCE CONSTRAINT and RESET SUBSEQUENT RESOURCE

• Secondary constraint usage types that can affect secondary constraints outside of the span of the operation, for example
“Increment From Start”, “Decrement To End” etc.

Use of these features must be carefully consideredwhen using MADE FROM and assembly or dis-assembly. The above features
are only consideredwithin each order, when using MADE FROM this means the Virtual orders created internally. If any of these
features are usedwithin an order constructed using MADE FROMwhere multiple Virtual orders are then created, unexpected
results may be obtained.

Outlined below are scenarios where problems may arise.

INTER OPERATION INTERVAL
If only one pair of operations in an order have and INTER OPERATION INTERVAL it will not cause a problem, however if there is a
chain of INTER OPERATION INTERVAL values between contiguous operations, this creates a complex operation relationship.

In the above example, say the following INTER OPERATION INTERVAL relationships were specified, the actual duration of the
intervals is not a determining factor:
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First, Virtual Order 1 will be sequenced, Op 10a, 20a and 30a. If Op 30a cannot be sequencedwithin the required time, Op 20a
will be moved forwards. Moving Op 20a may then violate the interval between Op 10a and 20a, this will cause Op 10a to be
moved. Eventually operations 10a, 20a, and 30a will be scheduled so that the intervals will be respected, assuming there is
available capacity.

Virtual Order 2 will now be sequenced independently.

Finally Virtual Order 3 can be sequencedwhich includes Operations 30a and 40, these two operations have an INTER
OPERATION INTERVAL constraint. If this interval is violated, Op 30a will be moved, however, as Op 20a is not part of Virtual
Order 3 it will not be considered andwill not be moved even if the INTER OPERATION INTERVAL between it and Op 30a is
violated. It will thus be possible for the final schedule to violate the INTER OPERATION INTERVAL specified between Op 20a and
Op 30a.

SUBSEQUENT RESOURCE CONSTRAINT
In the order above, say Op 50 can be performed on either the Lathe or Mill. Op 10a sets the SUBSEQUENT RESOURCE
CONSTRAINT to Lathe. The Lathe will be set as a required resource, for all subsequent operations in Virtual Order 1, Op20a and
Op 30a. However, for Virtual Oder 3 which contains Op 50, no SUBSEQUENT RESOURCE CONSTRAINT will have been set and
the operation will be free to be placed on the Lathe or Mill.

Secondary Constraints
When operations require secondary constraints, the sequencing engine checks that the usage of the constraint is within the
required limits for the duration of the use of the constraint, Setup time, Operation time or the entire process time. If the
constraint is affected outside of the operation duration then an additional check is performed after the entire order (Virtual
order) is scheduled. If the constraint is, say, incremented by one operation and decremented by another in equal quantities,
the constraint will be verified between the two operations. If the constraint is not incremented and decremented by equal
quantities then the constraint is checked out into the future indefinitely.

If in our example, Op 10a increments a constraint and Op 50 decrements the constraint by the same amount unexpected
results may be given as Op 10a andOp 50 are not within the same Virtual Order. Virtual Order 1 will be scheduled, but as no
operation in the Virtual order decrements the constraint, it will be checked indefinitely into the future. If there is no other
usage of the constraint and there are no capacity changes caused by calendars that would cause the constraint to be violated,
then the order will be sequenced. However, if at any point in the future the constraint is violated, the Op 10a will be either
scheduled after the violation or left unallocated if it is not possible to place the operation without violating the constraint. If Op
10a is not sequenced, Virtual Order 3 will never be a candidate for sequencing as Op 30a will never be sequenced.
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Auto Expand
Preactor will build the details of an order from a routing (typically described in a Products table), BoM& Co-Products table. This
is called 'Auto Expand' and is a function of Preactor that can be performed on import or while manually entering data. In fact,
the auto expand functionality is flexible and can expand from n source tables into n target tables. The process and the
relationships through which this is achieved are described below. For Standard and Professional editions of Preactor AS these
relationships are fixed, but for Ultimate editions the relationshipmay be defined in any valid way for any number of tables.

Auto Expand in AS Standard & Professional
Standard & Professional editions of Preactor AS have a fixed auto expand relationship which can be described as follows.

The Orders table is expanded from the Products table using the 'Part No.' field as an identifier to link the order and the product
information. In addition, the Order BOM table is expanded from the Products BOM table and in Professional the Order Co-
Products table is expanded from the Co-Products table.

Auto Expand Configuration (Ultimate Only)
The Ultimate configuration that ships with Preactor is configured to work as described above for the Standard & Professional
editions. However, configurations migrated from earlier versions of Preactor, or customized configurations, may have auto
expand configured in a number of different ways, as described below.

In order to automatically expand a parent operation for an order into all its individual operations a link to a source table that
contains the operation data is required. This link is createdwith the AUTO EXPAND classification, which defines the field that is
used as a reference into the table that is to be used for creating a complete set of operations for a given order type, the order
type is most commonly defined by the Product.

Expand from Parent / Child relationship
In this case individual operations are specified as children of the referenced parent record via a DATABASE reference. EXPAND
UPDATE fields are populated using this relationship.

The creation of individual operation records can be controlled using the CONTROL AUTO EXPAND classification on a TOGGLE
type field.

After expand AUTO INCREMENT and UNIQUE fields are updated, default values are set and EXPAND UPDATE, ALWAYS UPDATE
and UPDATE REFERENCE fields are set.

Expand from Matrix
Individual operations may be specified in an AUTO LIST of data, used is operations are common to multiple products. One
record is created in the target table for each entry in the source AUTO LIST.

After expand AUTO INCREMENT and UNIQUE fields are updated. Default values are set. EXPAND UPDATE and UPDATE
REFERENCE fields are set.

Note: This method of expansion is rarely used and, while still possible, expansion from a parent / child relationship is the
preferred technique. Standard and Professional editions of Preactor AS use parent / child relationships.

Disconnected Expand
In the situation where a product may or may not exist in a referenced table, a 'disconnected' expand is required. A disconnected
expand is one where it is possible to either select a product from an existing list or to create ad hoc orders by specifying each
operation step. This means that when importing orders, those orders can include a full description of the process, order
header information only, or a mix of both. The auto expand relationships in Standard & Professional are disconnected in this
way.
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Individual field relationships are specified using the LOOKUP SOURCE classification on the AUTO EXPAND field and LOOKUP
UPDATE rather than DATABASE references, further LOOKUP SOURCE fields may be specified to aidmanual product selection in a
similar way to an ADDITIONAL REFERENCE field.

LOOKUP SOURCE fields are FREE FORMAT String fields that can contain either matching strings that define a unique reference
into the source table or ad hoc data not present in the source table. EXPAND UPDATE fields are also updatedwhen a matching
reference is found.

When importing header only records that need to be expanded, the LOOKUP SOURCE field that is a reference to the field
specified as the FAMILY in the source table must be populated for the expand to succeed. For example, if both ‘Part No.’ and
‘Product’ are specified as LOOKUP SOURCE fields in the ‘Products’ table and the FAMILY field in the ‘Products’ table is defined as
FAMILY(Part No.), then the 'Part No.' fieldmust be populated in the import data.

Expand of associated tables
Operations in associated tables are also updated using the EXPAND REFERENCE, ORDER MATCH and EXPAND MATCH
classifications via a LOOKUP SOURCE table reference. LOOKUP UPDATE fields are also updated.

A typical use would be creation of BOM data for Orders expanded using a Products table from a Product BOM table. Aminimum
of 4 tables are involved in this expansion type, but more table pairs can be used if required.

For example:

Orders table expanded from a Products table.

Order BOM table expanded from a Products BOM table.

Order Co-Products table expanded from a Co-Products table.

Only the tables that are to be expanded need to be associated to the main target table, Order BOM andOrder Co-Products
tables are associated to the Orders table in the above example. Tables containing the expansion data do not need to be
associated, they are linked indirectly by the use of the LOOKUP SOURCE classification.

When the records have been created in the main target table, all associate tables are searched for an EXPAND REFERENCE field.
The expand reference is used to create a unique FREE FORMAT string reference to the main target table, if an EXPAND
REFERENCE field is present then an attempt is made to expand the associated table, any records created in the associated table
will have the EXPAND REFERENCE field assigned to the related records field value.

When expanding associated tables, a search is made in the associate table for any records where all ORDER MATCH fields are
equal. If they exist then expansion is assumed to have been performed already and no further action is taken.

If no records match in the associated table, then the EXPAND MATCH fields are used to create records in the associated table
from the table defined by LOOKUP SOURCE.

Sequence Dependant Setup Times
Instead of using a fixed setup time you can define sequence dependent setup or changeover times based on the attributes of
one operation to another operation on a resource.

For example the sequence of product A to product B on a resource could incur a 30 minute changeover time but product B to
product A would incur a 3 hour changeover time.

Where limited data is available this can be achieved by using the Like to Like Setup Time and Like to Like Match fields in the
Products table.

Where more comprehensive data is available, go to the Resources table and use the Sequence Dependant Setup Time
pushbutton in the Edit Resources Information dialog to establish a matrix of setup times. Refer to these values in the Products
table using the Setup Group field.

- 198 -



Concepts

Infinite Capacity Resources
In most cases the user will want to define resources as having 'finite' capacity, however in some circumstances 'infinite'
capacity resources may be chosen to model certain processes. For example a sub-contract operation may always have a 2 day
lead time no matter howmany batches are sent and in this case an infinite resource called Sub-Contract might be used to
model the delay.

An alternative status to Infinite capacity is Infinite with Shift Patterns. This may be used, for example, if our sub-contractor did
not work at weekends so that the 2 day lead time would be extended if sent on a Friday.

Note: If you wish to be able to break down or change the calendar state of an infinite capacity resource you must use the
'Infinite with Shift patterns’ option.

To establish an infinite capacity resource:

1. From the Data Maintenance category, click on the Resources data table.

The Resources Data Table is displayed.

2. Double click on the record you wish to have infinite capacity.
3. Click on the 'drop down' arrow against the Finite or Infinite field and select Infinite or Infinite with Shift Patterns.

Order Enquiry
Preactor AS allows order enquiries within the sequencer. This can be used to give estimated delivery dates and facilitate various
'what-if' scenarios. An order generated using the order enquiry feature can later be discarded.

Scheduling an order enquiry requires availability not only of the resources and other constraints on the process steps, but also
availability ofmaterials. Fulfilling the material requirement can be as simple or as complex as is required, though
accommodating more complex scenarios does requires a PESP script.

To perform an order enquiry, select Tools ► Order Enquiry from the sequencer menus. You will be presentedwith a blank
order dialog. As a minimum it is necessary to assign an order number, select a product and enter the quantity required.

Order enquiry can only be used to expand a predefined product and its materials. Ad-hoc routings should be enteredmanually
as order enquiry does not support entering this type of information.

Materials & Order Enquiry
No Materials
Where a process has no bill of materials, order enquiry will sequence the operations regardless of howmaterial control is
configured.

Schedule Despite Shortages
The simplest approach to materials for order enquiry is to ignore the material requirement all together. This is achieved using
the 'Schedule Despite Shortages' feature in the sequencer. This can either be enabled prior to performing an order enquiry or
order enquiry can be used to expand the order after which 'Schedule Despite Shortages' can be enabled and the order
sequenced using whatever rules are required.

Capable-To-Promise Order Enquiry
By using a PESP script on the ‘On Order Enquiry Expanded’, it is possible to run material control on order enquiry after the order
has been expanded but before it schedules on the planning board. The extent to which materials are re-evaluated is driven by
the PESP script and limited by the edition of Preactor. A PESP Action called 'Run SMC on Order Enquiry' exists for light-touch
material linking on order enquiry. This action will always filter the producing and consuming queues to the order in question.
For AS standard the rule set parameter is ignored.
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AS Professional and AS Ultimate allow the selection of a ruleset with the 'Run SMC on Order Enquiry' action, or you can fully re-
consider all materials using the 'Run SMC' action. Consideration should be given to the fact that this is a potentially destructive
operation.

If the defined SMC Rule Set leaves the enquiry order with material shortages then Preactor swill attempt to satisfy these by
creating Work Orders or Supply Orders. Where an Item is represented both in the Products table and the Purchased Items table
the system will default to using the produced part. The specified Pegging Rule is then re-run to assess the Works Orders
createdwith respect to the Parts they require and the process repeats.

This continues until no shortages exist or no further shortages can be resolved. The set of Orders is then Sequenced to
determine whether the Enquiry Order can be met andwhen by.

Pegging Rules
The Pegging Rule set for use by the Order Enquiry impacts how the Order Enquiry process is performed.

If ‘Retain Partial and Complete Allocations’ and ‘Retain Complete Allocations’ are both unselected the Order Links are only
created if all the shortages can be satisfied; i.e. if any of the shortages cannot be resolved then none of the shortages shall be
resolved. Where any shortage cannot be resolved this will result in the process being unable to ever satisfy the Order and as
such the expansion halts at this point.

This is the case in earlier versions of the Preactor configurations (Professional and Ultimate). To fully enable the Order Enquiry
BOM expansion a Purchased Items table is required detailing how to process the creation of the supply records.

This can be constructed using the entry in the currently shipping MaterialControl_prtdf.inc file as a template. The table can be
exposed in the application for editing through adding to the Preactor.prmdf file (the entry can be copied from the v16.4
version of this file).

Extending Order Enquiry
In Preactor AS Ultimate it is possible to extend the way that the Order Enquiry system satisfies material shortages identified
during the pegging. The “On Order Enquiry Shortages Calculated” event gives system implementers the opportunity to
interact with the shortage data and override the default behaviour when creating Work Orders and Purchase Orders.
"Scripting" on page 121 for more information.

Managing Order Enquiries
When entering an order enquiry Preactor will mark the order using the 'Order Enquiry' toggle field. While useful to be able to
perform such actions within Preactor, it is likely that any firming of those enquiries will be completed in an upstream order
management system and therefore these order enquiries should be easily identified so that they can be removed from the
schedule or otherwise handled appropriately.

Materials
Material Control
Overview
Preactor AS allows the modeling ofmaterials using a feature calledMaterial Control. Given a Bill of Materials for an order,
material control will link the requiredmaterials for each of the operation steps within that order by applying pegging rules. For
more information on building pegging rules "Building Pegging Rules" on the next page.

Materials usage is tracked across three tables:

l The supply table, in which items that supply material are defined.
l The orders table, in which items that both consume and supply materials are defined.
l The demand table, in which items that demandmaterial are defined.
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Supplies are usually stock records, purchase orders or purchase recommendations. When we refer to the orders table, we are
usually referring to works orders. Demand orders are usually sales orders. A given material may be linked from any source. For
example, a sales order that demands a quantity of a material may be linked to a stock record or a works order, depending on
the material pegging rule defined and the availability ofmaterials.

Supply & demand orders are represented in the sequencer on the Gantt Chart as milestones. Relationship lines can be drawn
between supply orders, works orders and demand orders to show the material relationships. Further analysis ofmaterial
consumption is allowed in Professional and Ultimate editions of Preactor AS using the Material Explorer included in the
Sequencer "Material Explorer" on page 268. A number ofmaterial centric reports are included in the Standard edition.

Material Control in AS Standard
AS Standard allows the pegging ofmaterials using a single built-in material control rule. This rule has the following behavior:

l All unlocked links are cleared from all demand orders and unscheduledworks orders.
l Consuming queue contains all demand orders and unallocatedworks orders that have BoM data.
l Producing queue contains all supply orders and all works orders that produce material.
l Both queues are ranked by date then priority.
l Materials are allocated on a FIFO (First In First Out) basis.
l Materials will be allocated as found in the appropriate Queue. Quantities will not be compared.
l Linking to materials with future availability is allowed (backward links)

Note: Demand and supply orders cannot be multi-line orders in the Standard edition of Preactor AS. For cases where multi-line
sales orders or purchase orders are required, it is necessary to suffix the order identifier with a line item number or similar. This
is best achieved at import time.

Material Control in AS Professional & Ultimate
In AS Professional and Ultimate editions, user defined pegging rules are allowed. These rules are fully flexible and can be
defined as rule sets, which can then be applied on an elective basis. In addition, Professional and Ultimate allow the linking of
materials at operation steps other then the first and last operation step. The production of additional materials may be
specified in a co-products table.

Building Pegging Rules
The Pegging Rules table is used to define rules for howmaterial links should be created between demand and supply orders. It
can be accessed by going to:

Configuration ► Pegging Rules

These rules are fully customizable and can have several passes to them. There are built in standard rules such as Production
Qty=Consuming Qty, Production Qty>=Consuming Qty and FIFO. If the standard rules are not explicit enough, then a User
Defined rule, or a rule which runs via a PESP (Preactor Event Script Processor) script can be used.

Rule Creation
A StandardMaterial Control (SMC) Rule will typically consist of several passes, each pass of the rule is represented by a separate
record entry for that rule set. The Pegging Rules table in the Material Control example configuration includes a Default rule set
which has two rule passes. The first rule pass is always the parent record and is where the name of the Rule Set is entered.
Child records of that rule set are subsequent rule passes that will run after the first pass of the rule is completed.
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Double-clicking on a rule will open the Pegging Rules dialog. Field names can be right-clicked on to provide additional
information about that field.
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In the case of the Default rule set included in the Material Control example:

l The first rule pass will clear any links that currently exist between orders. The Internal and External Queue Filter fields
are available for use. These queues can be used if there are certain links to demand orders that do not need to be
cleared.

l The second rule pass will then allocate materials on a FIFO basis. It will Retain Partial and Complete Allocations. This
option allows for linked to be created on BoM lines where the BoM line quantity doesn't need to be completely satisfied
for the link to be made. In turn, any items that are short will then be highlighted as a shortage. It will allowAllow Back-
wards Links, meaning that the default behavior for material control is overridden, by allowing for backwards links to be
createdwhen production occurs after consumption.

Filtering and Ranking Queues
Filter expressions can be entered in the supply and demand filter fields to restrict the orders that are to be included in that
particular rule pass. The Internal Supply Queue Filter field refers to supply records present in the Orders table. The External
Supply Queue Filter field refers to records present in the Supply table.
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The Internal DemandQueue Filter field refers to demand records present in the Orders table. The External DemandQueue
Filter refers to records in the Demand table.

Expression syntax for these fields should follow the regular EVALUATE expression syntax. An example of where a filter may be
needed could be where links need to be made to initial stock records first before other records are considered. In this case the
expression might be:

(~{$Order Type}~==~Stock~)

which would be entered in the External Supply Queue Filter field on a rule pass that precedes other rule passes.

If all supply records are present in the Orders table only, then the Internal Supply Only toggle can be checkedwhich will enable
the Supply Queue Ranking field. In this setup, queues can be ranked by certain criteria such as Due Date, Earliest Start Date and
Priority with either lowest value first or highest value first. The same applies if all demand records are present in the Orders
table only, the Internal DemandOnly toggle can be checked, enabling the DemandQueue Ranking field. An example of how
you may use ranking may be if you wanted your rule to link to orders with a lower due date first, you would select Due Date
and press the Add L.V.F button for the DemandQueue Ranking field.

If Supply records are present in both the Supply as well as the Orders table the queue ranking will be lowest value first on Due
Date and then Priority. The same applies to the Demand records, if they are held in both the Demand andOrders table, then
the ranking will be lowest value first on Due Date and then Priority.

Include Scheduled Orders in Demand Queue
When the Include Scheduled Orders in DemandQueue toggle is checked, demand orders that are already scheduled can be re-
linked. If the Include Scheduled Orders in DemandQueue toggle is checked on the first pass of the rule and the Clear Current
Links toggle is checked, all links will be cleared.

Inheriting Values
Values of certain fields can be passed down to orders with a lower BoM level that are related to that order, this can be applied to
both supply and demand orders. An example might be where the value of an attribute of a sales order is inherited by the orders
which are consumed by the sales order, in this case the Inherit From Demand field should be checked on the relevant passes of
the pegging rule where it is desired for this value to be applied. The field that is to be inherited should be defined in the Orders
data table in the Preactor.prtdf file.

Rules
Production Qty=Consuming Qty, Production Qty >=Consuming Qty or FIFO are standard pegging rules which can be selected
as the standard rule that is to run on a particular pass of a rule.

The Production Qty=Consuming Qty rule will only allow orders to be linked together where the producing quantity is equal to
the consuming quantity.

The Production Qty>=Consuming Qty rule will only allow orders to be linked together where the producing quantity is greater
than or equal to the consuming quantity.

The FIFO rule imposes no restrictions on what orders can be linked together, orders will be linked together in the order that
they are positioned in the consuming and producing order queues.

If these rules do not meet the necessary linking criteria, a User Defined or PESP Script value can be selected in the Rule Type
field.

If a rule is user defined, an expression needs to be entered in the Selection Rule field. The expression should follow the regular
syntax rules that apply to the EVALUATE field classification, apart from using + and - to identify producing and consuming
records respectively.
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If production records are present in both the Supply andOrders tables, the field name used in the expression must be a field
that is present in both tables. The same applies to consumption records, if they are present in both the Orders and Demand
tables the field name used in the expression must be a field that is present in both tables.

An example expression might look like this:

(~{+:$Product Attribute 1}~==~{-:$Product Attribute 1}~)

This expression ensures that this rule pass will only allow producing and consuming orders to be linked if they have the same
value.

There is one special keyword that can be used in this user defined selection expression:

{SMCQTY} or {SMCQUANTITY}

This represents the unused quantity in a producing record or the required quantity in a consuming record. These values are
not available in any one field with a record during SMC processing. The unused quantity is not written to the record until SMC
finishes and the required quantity is quantity multiplied by the BoM quantity. e.g. if you wanted to create an expression
equivalent to the standard ‘Production Qty=Consuming Qty’ it would be

‘{+:SMCQTY}=={-:SMCQTY}’

If the PESP Script option is selected in the Rule Type field, then the name of the PESP script should be entered in the PESP Script
field which should become visible.

Allocation
If the Retain Partial and Complete Allocations and Retain Complete Allocations options are both unchecked, one single
rule pass has to allocate all materials to the order, if all materials cannot be allocated, nothing will get linked.

If the Retain Complete Allocations option is checked, each BoM line is treated individually. The full quantity of the BoM Line
must still be satisfied, but if one of the BoM Lines cannot be satisfied, it doesn't prevent the other BoM Lines of the order from
being allocated if their requirements have been met. For example, if the requirement of an order was for 5 frames, 10 wheels
and 5 saddles but only the 5 frames and 10 wheels were available, then these would be allocated. But a shortage would exist
for the saddles.

If the Retain Partial and Complete Allocations option is checked, anything that can be allocatedwill be, regardless of
whether the exact quantity of a BoM Line is available. For example, if the requirement was for 5 frames, 10 wheels and 5
saddles but only 1 frame, 2 wheels and 1 saddle were available, these materials would be allocated, but the order would have
shortages.

The Allocate Multiples Only field when checkedwill allow the quantity of a link created to be allocated in specific multiples.
This multiple is specified in the BoMData.

If the Allow Backward Links option is checked the default behavior of SMC is overridden by allowing backward links to be
createdwhen production occurs after consumption.

SIMATIC IT MES Integration
Available only for Ultimate editions of AS, Preactor integrates with SIMATIC IT (SIT) MES using a combination of standard
import techniques andweb services accessed through PESP Actions as well as an Alerts window available from within the
Sequencer module.
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Overview
Preactor AS can generate viable, realistic schedules of work while meeting over-arching objectives (e.g. minimizedWIP) to be
consumed by production. Manufacturing Execution Systems do not necessarily adhere to such a schedule. By combining
Preactor with SIT MES, you can leverage the power of Preactor AS, while ensuring that all your execution objectives are met.

While adherence to a schedule is something that ought to be a primary concern, often, real-world issues mean that at
execution time it is necessary to deviate from the published schedule. For this reason, integration with SIT MES means not
only publishing a schedule from Preactor, but also maintaining an on-going dialog between Preactor and SIT MES, such that
the planners and production supervisors are better informed of the impact of their actions.

In the case of Preactor, this means ensuring an up-to-date view of the execution status of operations. This is achieved in a
number of ways. Firstly, using Preactor's standard import facilities, to always capture the latest execution state from SIT MES
before generating any plan. At this point, SIT MES is made aware that the operations imported into Preactor are under
consideration andmarked as 'In Planning'. This means that production staff are immediately aware that the plan is under
revision. While in this state, any alterations to the properties of those operations are recorded, and presented by Preactor in
the Sequencer AlertsWindow, keeping the planner informed of execution events. This means that the planner can respond
quickly to these alerts, taking appropriate action. Depending on the nature of the alert, this may mean abandoning the
current planning session and starting again. In less severe cases, it may only be necessary to alter the availability of a resource
to represent a breakdown or similar.

PESP Actions
A number of PESP actions exist to facilitate this integration. Refer to the reference material for PESP Actions for full details and
the actions and their function. The actions specific to SIMATIC IT MES are:

l SetExitState
l GetExitState
l SetInScheduled
l SetInScheduling

The 'SetInScheduling' action plays a role in the batch process for retrieving the latest execution state from MES. This typically
happens prior to opening the sequencer module. 'SetInScheduled' is usedwhen a schedule is published in order to push
suggested resources, start and end times to MES.

A custom action using the SetInScheduled action can be created using the Preactor Software Development Kit (SDK).

Alerts
Within the Sequencer module, an Alerts Window is available that shows any alteration to the properties of all items under
consideration by the Planner. This gives immediate visibility of any disruptive operational issues, as well as keeping the Planner
informed of current status. The Alerts Window is linked to the Alerts Table, which is a memory-only table. Upon closing
Preactor, the table will be cleared of all data within it. When viewing the Alerts Window in the Sequencer module, there is the
functionality to save and print the data held in the table.

A PESP action is available, called Refresh Alerts, where the user is able to define a event that can be used to refresh the data
populated in the Alerts Window. If this PESP action is not enabled, a custom integration method between Preactor and
UAF services must be specified.

With Alerts enabled, the Refresh Frequency can be set, in seconds, to determine when the table is to be refreshed.

Settings
The SIMATIC IT MES integration settings are administered from Configuration ► Settings ► SIMATIC IT Settings.
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l Alerts Enabled - When checked, the Alerts Window is enabled in the Sequencer. A valid service URI must be entered. If
unchecked, the Alerts Window is unavailable.

l Refresh Frequency - The time between each refresh of the Alerts Window, specified in seconds.
l Target Platform - Selects the service to be used. In the shipped configuration, ifUAF is selected, then the Certificate
andOData Command/Query Timeout fields are available for use.

l Publish Dataset - When configured as part of a PESP script, this field is used to control whether schedule information
should be communicatedwith another system. For example, a user may want to send changes to an upstream MES,
but only when adjusting their live or confirmed orders. The name of that live dataset can be specified here. If the value
in this field does not match the currently edited dataset, then changes to data can be ignored.

l Service URI - The Web Service URI is used for communicating between Preactor and SIMATIC IT MES, primarily for the pur-
pose of populating the Alerts Table.

Note: To ensure integrity between the client Preactor application and the MES Web service, HTTPS should be used as the
transport mechanism when configuring the MES service address.

l Certificate - Specifies the X.509 Certificate to use to confirm the client identity when communicating with the service
URI. Typically this certificate will be issued by the MES system implementer, andmust be imported into the Preactor cer-
tificates table, which can be found in Configuration ► Security ►Certificates.

l OData Command/Query Timeout - The time, in seconds, that can elapse before a request for new data will timeout.
This field is usedwhen querying for order changes that will be displayed in the Alerts Window. If the request times out,
then an error message is displayed.

Resources and Resource Groups
Critical to any Preactor scheduling system is the resource data. The items entered in to the resources table will form the
entries on the vertical axis of the Gantt chart within Preactor’s sequencer and are the primary constraint on the processing of
the orders and operations in the system. Which constraints are defined as primary resources will depend on the environment
and should be discussedwith the system implementer. In the majority of cases machines are modeled as the primary
resources but in different environments it may be more appropriate to model other constraints, such as labor.

A resource can be configured in one of two main modes:

Finite
This means that the resource can only process one operation at any time. Additional work for that resource will be queued and
placed on the resource when it becomes available.

Infinite
This means that the resource can process multiple operations at the same time. In most cases this mode is combinedwith an
additional constraint on the resource which determines howmany operations can be processed concurrently. Infinite mode
resources can be configured to either consider shift patterns or ignore them.

By default the Preactor sequencer runs in Finite Mode so these are the settings that should be configured for day to day usage.
There is also an Infinite Mode that allows the planner to identify areas of over-utilization and bottlenecks.

As well as containing the resources themselves their scheduling attributes are defined in the resources table. These include:
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1. Any additional constraints associatedwith the resources. Details of how these are set up can be found in the Secondary
Constraints documentation.

2. Which setup and changeover time settings are associatedwith that resource andwhether they are to be applied con-
currently or cumulatively.

3. The cost of utilization andwhether this cost should take in to account efficiency information from the resource cal-
endars

The way that the resources are represented in the Sequencer is also controlled from the resources table. The Gantt Separator
field specifies whether a line is drawn underneath the resource on the Gantt chart to help distinguish between individual
resources or groups. The Preactor Display Order defines the order that the resources are shown in, this field is used by setting
relative values and then sorting the records in the editor grid by it. The Resource Display Option field determines when the
resource is shown in the Gantt chart and the Resource Display Style field allows the user to determine whether the operations
on the resource are shown in a stacked or cascadedmode. The Usage Plot Display Settings determine how the resource usage
is represented in the Multi Plot window.

Resource Groups are a way of assigning primary resources in to groups. There are two main purposes within Preactor for
these Groups

1. If these groups are set against an operation the limit the valid resources for that operation to the times contained
within the group. These groups are usually defined in an upstream system and imported in to Preactor.

2. Groups can also be set up that are not assigned to any operations directly but are used for display purposes. For
instance a groupmay be set up that relates to a particular area of the factor but contains resource of different types.
This would enable quick filtering of the of the Gantt chart down to just that area.

The Resource Groups table also contains the Display Options for the Resource Groups plots.

Preactor AS Professional
In Preactor AS Professional it is possible to set up complex resource constraints. These take two forms dependent on whether
the resource is set up as an infinite resource or a finite resource. For both types of resource the Match Field can be used to
define rules about the usage of other resources when an operation is placed on this resource. Details about how to construct
Match Field expressions can be found in the MATCH FIELD help. For infinite resources it is also possible to set upmatch criteria
in the ‘Match Required’ field. This allows the limiting of operations that can be placed on the resource at the same time to only
those with a matching value in the selected field

The criteria for ranking the queued operations in the Preferred Sequence rule can also be defined against each resource. One
or several criteria can be used for the ranking.

Secondary Constraints and Secondary Con-
straint Groups

Secondary Constraints
Secondary Constraints are used to model any other constraints there are on the scheduling process which are not modeled by
the primary resources. In a common setup, where the Primary Resources are machines, this would include items such as labor
and tooling. When used in conjunction with infinite capacity resources they can also be used to model resource capacity.

The two criteria which control the behavior of any constraints are set using the Use as a Constraint and Calendar Effect fields.

Use as a Constraint determines whether the constraint has any effect on the scheduling process. If this field is not selected the
constraint can be used for information purposes, for example to give an indication of required labor levels.
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The Calendar effect field specifies how the constraint interacts with primary resource calendar. Details of the options and the
effect they have are containedwith the tool tip that is available for each one.

These values can be set for constraints when Preactor’s sequencer is running in both finite mode and infinite mode. The
default setting for infinite mode is for the resource to be not set as a constraint.

In addition to the fields which set the scheduling behavior of the constraints there is also the opportunity to set the display
option of the constraint plots, how they affect the cost of the operation and any additional attributes that may be associated
with them.

Once constraints have been created in the secondary constraints table there is some additional setup needed to configure the
usage of them. Constraints can be assigned to:

1. Resources
2. Operations
3. Attributes of Operations
4. Specific Resource/operation combinations

In all of these cases the same three pieces of information are needed. These are the constraint name, its usage and the
Quantity that is used. The Constraint usage defines how the constraint is used during the operation, for example there may
be have a skilled operator type which is only used during the setup portion of an operation or a tool which is used from the
start of the operation but is not released again until several operations later. The constraint Quantity can be a straight
numerical value or can be tied to the value within several other fields in the operation in question. An example of this would be
linking the constraint usage to the quantity field or a dimension value of the constraint in question is modeling resource
capacity.

Secondary Constraint Groups
In addition to using Secondary Constraints, it is possible to create groups of constraints that can be applied to either a
Resource or an Operation. Creating Secondary Constraint Groups allows for Preactor to make selections from a list of
Secondary Constraints, in a similar way to how Primary Resource selection is made.

There is also the ability to model scenarios where individual operators, for example, have multiple skills, and therefore the use
of single Secondary Constraints could lead to over utilization, if modeled incorrectly.

In Secondary Constraint Groups, any constraint within that group can be ranked. This is beneficial when it comes to ensuring
that there is no shortages in resource.

When a schedule is generated, any record that has been assigned a Secondary Constraint Group, Preactor will auto-populate
the assigned Secondary Constraint that has been chosen from the group. If this constraint needs to be changed, it can be
done so manually. If the schedule is cleared, Preactor will clear the selected Secondary Constraint field. This does not occur if
manually dragging and dropping operations onto the Planning Board.

If trying to manually drag and drop operations onto the Planning Board, a warning message will be shown. An example is
shown below.

In AS Standard, there is only one Secondary Constraint Group field. In AS Professional and Ultimate, there are two fields.
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Products, BoM, Co-Products and Purchased
Items
Preactor can be used to store templates of item routing and bill of material data. These are held in the Product and Products Bill
of Materials tables. There is also functionality to store information about Purchased Items in the Purchased Items table. Often
when used in conjunction with other business system there is no requirement to store this data in Preactor so usage of these
tables is optional. In instances where Preactor AS is not linked to a business system where scheduling specific data is available
or order enquiry facilities are needed then these tables can be used to expand details ofmanually entered data or order header
information which has been imported.

Products
The data in the Products table can be set up to represent multi-operation routings using a parent child relationship. This
means that the first operation of any routing is set as a parent and all subsequent operations have the parent part set to
match the Part No of the parent. The Op. No. assigned to the operations determines the order that they are processed in and
the Operation Name must be a unique value within the product routing.

Once the basic operation details have been assigned then the scheduling attributes of that operation can be set up.

Operation Times
This includes setting the standard setup time and process time of the operation. The process time can either be set as an
operation time per item, a rate per hour or a batch time. Alternatively a resource specific version of these types can be set to
enable the consideration of the times set against each individual resource in the Resource Data list. It is also possible to set a
slack time to be applied between this and the previous operation. There is also the possibility to set a delivery buffer against
each operation which when backwards forwardwill give information about when the operations are falling within the delivery
buffer. When scheduling backwards the delivery buffer will prevent the operation being scheduledwithin the specified amount
of time before the due date.

Professional & Ultimate
Professional and Ultimate editions can consider some additional advanced inter-operation constraints in the
scheduling process. These can be defined against the operations in the products table

Slack Time Before Next Operation – is a slack time between the end of this operation and the next which must be
adhered to.

Max Time Before Next Op + Interval Type – The combination of these fields define the time in which the
subsequent operation must be processed. The Max Time Before Next Op field contains the time and the Interval
type defines whether the time specified is a relationship between the start or the ends of the operations. This
feature is useful in situations where the state ofmaterial alters over time such as something that becomes less
workable as it cools or warms

Maximum Operation Span Increase % - defines the percentage that it is acceptable for the operation length to
increase by. Setting this to a low value could prevent the operation from being extended over off shift and low
efficiency calendar periods.

Productivity Multiplier – is a value that can be set to alter the speed of processing for a specific operation.
Changing the value of this field from the default value of 1 to 2 will half the operation time, enabling the
modeling of concepts such as variable manning levels.
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Resource Information
The value in the Resource Group field determines which resources are valid for this operation; therefore it determines the list
of resources to choose a required resource from and the list of resources in the Resource Data dialog.

Editing the records in the resource data list allows the input of resource specific information for the operation including
costing, setup time, process time and resource specific constraint usage. It is also possible to determine, using the Automatic
Sequencing toggle, whether Preactor’s automatic sequencing rules will include this resource for consideration. The set
subsequent resource group field allows the setting of the resources that are valid for all subsequent operations. This is useful
in a situation where there are assembly lines set up and orders should not switch between them during processing.

The Secondary Constraints list allows the definition of constraints which are specific to this operation, regardless of which
resource it is processed on.

The Secondary Constraint Group fields allows for the definition of Secondary Constraint Groups which are specific to this
operation, and can be used as an alternative to applying an individual list of constraints.

In AS Standard, there is only one Secondary Constraint Group field. In AS Professional and Ultimate, there are two fields.

Attributes
The Attributes dialog allows the setting of any additional attributes that are associatedwith the product or operation. As well
as a set of spare attribute fields of varying data types, the functionality of which is described in the attributes section, this
dialog enables the setting of:

Transfer quantity, which determines howmany pieces need to be processed before an order can move on to the next
operation.

The Operation Icon

Costing information – The material cost and user defined operation cost can be set.

Notes and a related Document can be assigned to the operation.

Independent Lots, which determines whether the operation can be linked to a single previous step to retrieve its material or
needs to be linked to all previous operations. This means that when this option is selected one lot of an order for this product
can continue to be processed before the other lots have begun.

Products BoM
The products BoM holds information about the BoM requirements of the products which are held in the products table. It is a
part to part BoMwhich is usedwhen an order is expanded from a product routing to generate an order specific instance of the
BoM.

The Product Bill of Materials table has a family relationship in the same way as the Products table. The Part No. field relates to
the product that is consuming the material. In the case of Preactor AS Standard the operation name and op. no. fields must
always relate to the first operation of the product routing. The Required Part No and Required Quantity related to the material
that is required. Unlike the Part No field the value held in the Required Part No field does not have to have to be an item that is
also represented in the Products table, enabling the modeling ofmaterials that are not manufactured items.

Multiply by order quantity determines whether the required quantity defined is an absolute value unrelated to the order
quantity or should be

Ignore shortages determines whether any shortages of this material should affect the ability to schedule orders for the
product that requires it. This may useful in instances when the user wishes to be notified of potential material issues by the
scheduling system but the material has a short lead time so should not influence the scheduling results.

The Multiple Quantity allows the modeling of situations where the material should always be consumed in set quantities.
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Professional & Ultimate
Preactor AS Professional and Ultimate sees the introduction of the ability to consume and produce materials at
any operation of the product. This means that the Operation Name and number defined in the Products Bill of
materials can be for any valid operation in the routing and the Product Co-Products table is introduced. This table
is set up in the same way as the Product Bill of Materials table except the material produced instead of consumed
at an operation step is detailed.

Purchased Items Table
The Purchased Items table is used to support and enhance the Order Enquiry functionality, for when purchased goods need to
be considered. Users are able to input lead times, minimum reorder quantities and reorder multiples against a purchased item.
The lead time information for an item will be added to the terminator time.

If an item exists in both the Purchased Items and Products table, by default, Preactor will prefer the Products data before the
Purchased Items data. This functionality can be changed by using the On Order Enquiry Shortages Calculated PESP event,
and by manipulating the Order Enquiry Shortages data.

Attributes
The Preactor AS Standard configuration has been set up so that much of the scheduling related functionality is applied to
operations using attributes. There are a set of attribute fields assigned to each operation of a variety of different data types to
enable the addition of different attribute types. The data type of the attribute also has an effect on the scheduling functions
that can be controlled from that attribute.

Table Attributes
The table attributes have data sourced from a set of tables within Preactor which must be populated, manually or via import,
before they can be used. Having the data held in this way means that these attributes can be used to assign a variety of
scheduling functions including:

1. Bar Color, which will determine the color assigned on the Gantt chart to operations with a matching attribute value

2. Secondary Constraints, can be assigned to the attributes which will then be used by every operation that has that attribute
set

3. A ranking which is used in the weighting rule to allow the attributes of the operation to affect the prioritization of works
orders and operations

4. Setup times, details of which can be found in the Changeover Groups section.

String, Numerical, Date and Duration Attributes fields can be used for information purposes and related tasks such as coloring
and locating the bars on the Gantt chart. Additionally Numerical, Duration and Date Attributes have the role of use in the
Weighting rule. Numerical Attributes can also set the quantity of secondary constraint that is used by an operation, as
described in the Secondary Constraints section.

Professional and Ultimate
1. Preferred Sequence; the ranking associatedwith the attribute can be used by the resource based advanced
scheduling rule to group like operations and schedule them in a preferred order. This is useful in scenarios such
as printing operations where moving from a light to a dark color is preferable. This is available for table based,
numerical, date and duration attributes

2. Resource Validity; Resources can be marked as invalid for operations of a particular table based attribute. This
can be used to model a scenario where there are several orders based on the same base routing, using the same
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resource group, but with varying attributes which have an effect on which of those resources in the group is
valid. If these rules are not represented in the data sent from upstream business systems they can be easily
represented against the attributes.

Setups and Changeovers
There are three locations within the configuration where setup and changeover times can be modeled. These are:

1. Against an operation in the products and orders tables.
2. In the operation specific resource data in the products and orders tables.
3. In the Changeover Groups table.

The Changeover groups table gives the opportunity to use operation attributes to apply sequence dependent setup times.
When creating a record in the table it is possible to record a changeover time that only occurs when there is a change in value
for each of the table based attributes against the operation. The group that is created can then be applied to as many or as few
resources as is requiredwithin the resources table. Using this setup it is possible to model compound changeover times which
can be applied differently to different resources or groups of resources.

Preactor AS Professional
In Preactor AS Professional it is possible to also model more complex setup changeover times against each of the
table based attributes. This is represented by a matrix of ‘to’ and ‘from’ values for each attribute which allows
different changeovers dependent on which specific values the operations in question have for that attribute.

Calendars

Calendars
Preactor Calendars provide the user with an intuitive approach to the development of both primary and secondary resource
shift patterns. It simplifies the definition of standard shifts and allows for the use of arbitrary repeating shift patterns. Default
shift patterns can easily be assigned to either resources or groups of resources. Resources, both primary and secondary, may
operate under different shift patterns. Complex working practices built up in this manner may be saved for future use. It is
simple to switch resources from one shift pattern to an alternative for a short period of time, e.g. overtime working.

There is a hierarchy in how resource calendars are made up. Each resource has a calendar. This calendar defines what calendar
template(s) are assigned to a resource. A calendar template is made up of a number of periods. Each period has a calendar
state. The creating or editing of calendar states, calendar templates and the assignment of templates to resources is done
within the Sequencer.

Use of Calendars
Preactor Calendars provide the user with an intuitive approach to the development of both Primary and Secondary Resource
shift patterns. It simplifies the definition of standard shifts and allows for the use of non seven day repeating shift patterns.
Default shift patterns can easily be assigned to either Resources or groups of Resources.

Resources, both Primary and Secondary, may operate under different shift patterns.

Complex working practices built up in this manner may be saved for future use. It is a simple matter to switch Resources from
one shift pattern to an alternative for a short period of time, e.g. overtime working.

Primary Resource Calendars Panel
By default Primary Resource Calendars are contained in a hidden dockedwindow.
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When you click on the Primary Calendars tab a window appears in the top left of the Sequencer's main window. It lists all the
primary resources.

Double-clicking on a resource in the list opens the primary resource's calendar in the main window.

Resource Calendars
Primary and Secondary Resource Calendars are generated by applying one or more Calendar Templates to a resource.

Initially they are generated automatically, as soon as a resource is created, by the application of the Default Template.

The Default Template is established in Calendar Settings and can be changed using the Calendar Period dialog,(see Default
Template).

Resource Calendars are displayed in the Sequencer's main screen by double clicking on a resource
in either the Primary Resource Calendar or Secondary Resource Calendar panels.

Calendar Exceptions
Amendments to the default calendar can be made by adding exceptions in the Resource Calendar.
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To add a new exception to the Calendar:

1. Double click in a blank space in the calendar.

The Calendar Period dialog is presented.

2. Select the template to be used for the exception.
3. Enter a start and an end date and time for the exception.
4. By default when creating a new exception the start time will be set to 8:00 am on the day you double clicked on.

If you are editing a default period you have the option to set these dates to “No Limit”.

This can be done clicking the “No Limit” button on the date dialog. The amendment will then appear below the default calendar
on the days you defined. You can edit an amendment by double clicking on it in the calendar.

5. Set the appropriate Reference Date

The date time within the template in which to start the cycle. i.e. if you have a week long template (Monday – Friday) and you
wanted to use this template but you where already half way through the week you could set the reference date to reflect this,
and your periodwill start the cycle as if it had been running since Monday. 

Template Reference Date1

1This will use the reference date set in the template, the default for the "Default" period.
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Start Time Reference Date1

Custom Reference Date2

6. Select the resources to which the changes will apply. To select all resources, simply right click on the first resource and
choose the 'Select All' option from the pop upmenu. Multiple resources can also be selected by highlighting the first
resource that is to be included (left click on the resource name) and hold down the shift key and left click on the last
resource name that is to be included, right click on the highlighted resources and choose the 'Check' option.

7. Apply Changes to Resources3

8. Click OK.

9. Save the changes to the calendar.

You can edit an existing exception by double clicking on it in the calendar.

Viewing/Editing Multiple Resource Calendars
Although individual Resource calendars can be opened under a tab in the Sequencer's Main Window, it is also possible to open
several resources under a single tab.

To viewmultiple resource calendars under a single tab:

1. Use shift click or control click to select multiple resources in the resource Calendars panel.
2. Right click on the selected resources and choose the "Edit" option.

The resource calendars are displayed in the main window.

1Uses the current start time as reference date. This is the default for exceptions.
2Allows you to specify a reference date in which the exception will use.
3Displays the resources which the exception applies to. In the multiple resource view this will display the list of resources in
which to apply the period to. The resource selection also allows you to select and deselect resources in which to apply the cur-
rent amendment.
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In this case two default resource calendars are shown as the default for one resource differs from the others.

In addition, there are two calendar exceptions, the one shown as a solid color applies to all resources in the group, while the
one displayedwith a transparent bar only applies to some of the resources. The names of the relevant resources are displayed
on the bars of the calendar.

Editing

Resource calendars can be edited in the multiple view just as easily as they can when viewing a single resource.

Editing common exceptions or a common default template will result in the changes being applied to all selected resources.
Any non common exceptions will result in the changes only being applied to the resources it applies to.

Adding new exceptions

All exceptions added in the multi-resource viewwill be applied to all the displayed resources.

Deleting Exceptions

Right clicking on a period in the Resource calendar viewwill display a context menu which will give you the option to delete.

Amending Primary Resource Calendars in the Gantt Chart
Primary Resource calendars may be modified directly from within the Gantt Chart, facilitating short term changes to working
patterns.

To modify a Primary Resource Calendar:

1. Select 'Calendar Edit Mode' from 'View' ► 'Edit Mode', or using the 'Edit Mode' toggle on the 'Standard' tool bar.
2. Double-click on a primary resource calendar at the point where you would like to alter the calendar state.

The Calendar Period dialog is opened:

3. Select the revised template, set the start and end times, change the details if necessary and set any other resources to
which this change is to be applied.

Note: When editing calendars in this way, the list of resources that appears under 'Apply Changes to Resources' is limited to
resources with the same calendar period at the same time prior to opening the edit dialog.

Amending Secondary Resource Calendars in the Plots win-
dow
If secondary resources are defined, it is possible to alter the resource calendar from the Plots window.
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To accommodate short term changes, Secondary Resource Calendars can be modified from the Plots window.

To modify Secondary Resource Calendars:

1. With the Sequencer open, select the Plots Window from the Viewmenu bar command.
2. Right click with the mouse on the secondary plot you wish to modify.

The Calendar Period dialog is displayed.

4. Select the required template.
5. Enter a Start Time and End time for the period being modified.
6. Complete the remaining details.
7. If necessary select the secondary resources to which the changes are to be applied.
8. Click OK.

Drag and Drop Templates into Calendars
Resource Calendar Editor
Templates can be dragged and dropped into individual and groups of resources calendars.

On drop, if the selected template can successfully be added, it will be inserted into the calendar.

In “Day” view the template will be addedwith a start time set to the start of the time slot it was dropped and set for a duration
of 15 minutes.

In all other views the template will be added on the day it was dropped starting at midnight and running for 24 hours.

Similar to the Resource Templates a Ø (no entry) will be displayed if a period already exists in the location you are trying to
drop and the status text “A period already exists at this location, Periods cannot overlap” will be displayed in the parent window.

Resource Calendar Printing
Several different views of the primary and secondaryresource calendars may be previewed and printed.

To print resource calendars:

1. In the Sequencer open the docked Primary or Secondary Calendar windows by selecting the appropriate tab to the left of
the main window.

2. Select the required resource or resources (using Click with the Shift or CTRL keys).
3. Right click on a selected resource and select the "Edit" button that is presented.

The calendars are opened in the main window.
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4. From the File menu bar command, select Print Resource Calendar.

The Print Options dialog is displayed.

Print Style

Print Style options provide a Monthly, Weekly or Daily view of the Resource calendars and allow you to select the
date range involved.

A further option 'Calendar Details' prints a detailed breakdown of templates and exceptions on a daily basis.

Include Header and Footer

If the "Include Header & Footer" check box is checked the Resource Calendar name(s) and current date are
printed.

Include Date Header

If the "Include Date Header" check box is checked, date and calendar information is added to the printed output.

5. Click the "Preview" button.

The Print Preview dialog is displayed. Here options allow you to control the page set up and the way in which calendars are
viewed

6. Once you are satisfiedwith the options chosen select the print option from the File menu bar command.

Calendar Options
Calendar
Default settings for Calendars are established in the Sequencer. These settings are accessed from the menu Tools ►Options.
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The Undo Redo Options section allows the specification of aMax Undo Count. This is the maximum number of times the
Undo or Redo toolbar buttons may be consecutively clicked.

The Default Template section has drop down lists where selection of which default template will be usedwhen creating
Primary or Secondary Resources. The template can then be changed during editing of the created resource.

The Calendar Period Creation section has a drop down list where a period can be selected, which will be used to fill gaps within
a calendar. The Combine Like Periods check box, when enabled, will combine any calendar periods into one periodwhen they
are the same. For example, a 3 hour On Shift period followed by a 2.5 hour On Shift will be combined into a singular 5.5 hour
On Shift.

The Save Options section allows for the enablement of resource calendars, both Primary and Secondary, to be savedwhen
the schedule dataset is saved. If these check boxes are not ticked, then any changes made to the resource calendars will not be
saved and loadedwhen the schedule is saved/loaded.

Default Template
Whenever a new Primary or Secondary resource is created, a default template is assigned to it using the values established in
the Calendar Editor Settings dialog.

To replace the existing default template:

1. Double click on a Primary or secondary Sesource in either of the Resource Calendar panels.

This displays the resource calendar in the Sequencer's main screen.
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2. Double click on the Default: template in the gray bar, which in the image is On Shift.

The Calendar Period dialog is opened.

3. Select the required template from the options available.
4. If you wish to change the default template for a specific period of time enter a start and end time.

This would allow you to introduce a different work pattern during the summer months for example.

5. Click OK.

6. Save the changes to the Resource Calendar.

Calendar States
Calendar states allow you to define the properties applicable to resources for a given condition. Typical states used are: Off
Shift, On Shift, Breakdown andOvertime. Each state is identifiedwithin the sequencer Gantt Chart by the color and pattern
assigned to it.

To access the Calendar States data table select 'Calendar States' from 'Calendars' in the 'View' menu.

Add/Edit Calendar States
Existing calendar states can be modified by opening the existing record, and new states added by double-clicking on a blank
row or selecting 'New Calendar State' ( ) from the calendar states toolbar.

The Calendar State dialog has a number of fields to be completed.
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Name
This serves only as an identifier and is used to identify a state when used in a calendar template or any other case where states
may be referencedwithin the Preactor sequencer. It is typical to use names such as 'On Shift' to convey a meaning. It is
possible to define states that only differ by name, which can be useful if identification of calendar states is important (e.g. 'Early
Shift' / 'Late Shift').

Color
The color assigned to a shift state is then used to identify period of that state in the sequencer Gantt Chart.

Hatch Style
The hatch style may be selected from a list of available styles. This then forms the repeated pattern that is used to fill calendar
periods of this state. It is a good idea to use styles that differentiate calendars from operations in order that one cannot be
confusedwith another when looking at a busy Gantt Chart.

Note: The visibility of a calendar state is not only affected by the color and hatch style selections, but also the calendar view
option selected. By default Preactor will show off shift (i.e. 0% efficiency) calendar periods only.

Efficiency
The efficiency of a resource affects the rate at which operations are processedwhile a resource has this state applied. Often
this value will be set to either 100% or 0% to indicate an active or inactive state. There are times though where other
efficiencies may be appropriate. Any positive efficiency value may be used. For example, if a resource with two operators can
run twice as fast, you may want to define a '2 Operator' state for that resource, with an efficiency of 200%. Another common
case is where optimistic or pessimistic operation times have been defined. A way to globally affect these operation times would
be to set your resource efficiency to say 90% or 110% to compensate.

Cost Factor
The cost factor is applied to a resource's 'Cost per Hour'. This can be used to indicate elevated costs when processing
operations against a resource in a particular state. For example additional overhead, overtime costs etc.

Setup Allowed
Setup allowed defines whether setup can proceedwhile a resource is in this state. A calendar state where setup is not allowed
will never allow the setup portion of an operation to commence. Although an operation may have zero setup time, Preactor
considers that all operations have a setup portion. This means that even operations with zero setup cannot start on a
resource where there is no calendar period that allows setup. Once an operation has been allowed to start, calendar periods
that do not allow setup are treated as 0% efficiency with respect to the setup portion of an operation. Generally calendar
states allow setup times and the commencement of setup is controlled through operation relationships, but disallowing
setups on a calendar state may be appropriate in some cases. For example, you have a class of unattended resource where
setup operations can occur only during a manned shift period, but once set up, the resource can continue processing the
operation through unmanned shift periods.

Primary Resource Templates
Primary Resource Templates are accessed by selecting a Primary Template in the templates panel and double clicking on it. 

This opens the Primary Resource Template in the Sequencer's main screen.
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A Template is simply a named set of calendar periods and each period has an associated Calendar State.

The length of the template defines the repeating cycle. For example, if the template length is seven days then a resource with
this template will repeat this cycle every seven days.

To create a new template: 

1. In the Sequencer, select Primary Calendar Template from the File command's 'New' option.
2. Enter a name for the template.
3. In the Length field enter the template length, the time period over which the shift cycle is completed.

The Reference Date, the date on which the template is applied and the identifying Color, displayed in the Gantt Chart, are only
required for Higher Level Templates.

4. Enter the Template Periods required in the new template (see Modifying Templates).

5. Save the Template.

Saving the template adds it to the primary template panel.

To Edit or Delete an existing Primary Calendar Template:

1. Right click on a name in the Primary Template Panel.

2. Select Edit or Delete Period from the options presented.

Primary Templates Panel
By default the Primary Templates panel is located to the lower left of the Sequencer's main window. It lists all the calendar
templates that you have created for primary resources.
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Double clicking on an item in the list opens its Primary Calendar Template in the main window.

Modifying Templates
We can amend all aspects of existing Primary and Secondary Resource Templates by performing any or all of the following
operations.

l Add period
l Delete period
l Edit period
l Move period (drag with mouse)
l Change template length
l Change start offset / end offset (drag with mouse)

Once modifications have taken place, templates must be saved to retain the changes.

If the Template's Tab contains a star (*) next to the tab name, it has changes that have yet to be saved.

Add Period
The Calendar Editor allows you to add periods to existing primary or secondary resource templates.

To "add" a Resource Period to an existing template:

1. Open the required template in the Sequencer's main window.

2. From the Edit toolbar select the" Add Period" option or right click on a blank line beneath any existing entries.

The Template Period dialog is displayed.

By default the calendar period edit dialog will appear with the end offset of the latest period and the same length as the latest
period.

Periods may be added anywhere in the template as long as there is no conflict with an existing period.
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3. Insert values for "Start Offset" and period "Length".
4. Select the "Calendar State" to be applied.

When a Calendar State is selected, the 'Efficiency %' and 'Cost Factor %' fields display default values established in the Calendar
States data table. These may be overwritten by checking the adjacent check boxes and entering a new value in these fields.
This will effectively lock these values whatever happens to the underlying default values of the Calendar State.

Delete Period
The Calendar Editor allows you to delete periods from existing primary and secondary resource templates.

To delete a period:

1. Open the template to be modified.
2. Right click on the period record you wish to delete.

A pop up selection menu is presented.

3. Select Delete Period.

Edit Period
In the Calendar Editor you can edit periods from existing primary and secondary resource templates.

To edit a period: 

1. Open the resource template to be modified in the Calendar Editor's main window.

 Right click on the period record you wish to modify.

A pop up selection menu is presented.

2. Select "Edit".

A Template Period dialog is displayed.

3. Modify the details as required and select OK

Move Period
Periods can be movedwithin an existing template.

Note: Only if collisions with other existing periods are avoided.

To move a period:
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1. Hover the mouse pointer over the center of the period in the template's calendar view.

A central node appears, accompanied by direction arrows.

2. Click and drag the node to left or right.
3. Release in the required position.

Change Template Length
All time periods assigned to a resource template occur within its overall template length.

To change the template length of an existing resource template:

1. Open the existing template.
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2. In the "Length" field at the top-right of the form, modify the overall length of the template.

Change start offset / end offset
In the Calendar Editor, Start and EndOffset values specify the relationship of a period to the Resource Template in which it is
allocated.

To change the start offset or end offset of a period:

1. Open the Resource Template to be modified.
2. Hover the mouse over either of the select nodes at each end of the period to be modified. Click and drag the node to

move the start offset or end offset to a new time.
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Snap Periods To
When moving calendar periods, or amending the start offset / end offset in the calendar template view, the “Snap Periods To”
option is obeyed.

Opened from the View command, you can select from a number of predefined values what you would like your snap value to
be.

Editing calendar periods manually still allows any other values to be entered.

Building Higher Level Templates
Higher level templates, representing a working day, week or month, for example can be constructed using existing lower level
templates.

To build a higher level template:

1. Open the Calendar Editor.
2. Select the "New" option from the File menu bar command, and select Primary Calendar Template.

You could also select Secondary Template at this point.

3. Enter a name and overall length for the template.
4. If this is a top level template, i.e. which will be used directly by a Resource Calendar, enter a Reference Date and Color.

The reference date fixes the starting point for the template's application.

We can now enter work periods by double clicking on the first blank line and completing the Template Period dialog or we can
drag and drop existing lower level templates from the list of Primary Templates into this new one.

5. Click and drag the Working Day template from the primary Templates panel and drop it anywhere in the lower half of
the new template.

6. Select this template again (or any other) and add that to the new one, and so on.

As they are added, the time periods are represented graphically against a timescale in the new template.
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If for example an "Off Shift" period that has been addedwas not long enough to fill a particular time period, this could be
extended by clicking on its graphical representation and dragging its finishing time to a new position.

This position can be influenced by the setting of the "Snap Periods To" tool bar command.

It is advisable not to leave any time gaps in your template, ensuring that the whole of the template length is filledwith either
"On Shift" or "Off Shift" periods.

7. Once the template is complete, save the file.

Saving the template adds it to the Primary Templates panel.

Secondary Calendar Templates
Secondary calendar templates are, in most regards, the same as primary calendar templates. The difference is that rather than
setting the calendar state, efficiency and cost factor of a primary resource over the duration of the template, instead you
control the minimum andmaximum values for a secondary constraint.

Orders
Much of the data in the orders table can be populated from the products table where Preactor is using this as the source of the
routing information. Otherwise this data can be imported directly. The details of the usage of the fields on the Resources,
Operation Times and Attributes dialogs can be found in the documentation for the Products table. "Products, BoM, Co-
Products and Purchased Items" on page 210.

Order Datasets
A data set is a collection of operations that make a schedule and (optionally) the calendars that are valid in producing that
schedule.

Data sets are storedwith unique names. The data set named ‘Schedule’ is the one that is typically openedwhen entering the
Sequencer.

For more information on storing calendars and datasets, "Calendar Options" on page 219.

Management options for datasets are available from File menu:

The options are:

l Open allows a saved Dataset to be opened and used, restoring both the Schedule and Calendars.
l Save allows the Dataset to be saved in the standard location (Schedule).
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l Save Schedule Copy creates a newDataset with the name provided.
The working Dataset continues to be used and updatedwith future changes to the schedule.
Some admin housekeeping of the stored Datasets is also possible from this window.

l Save Schedule As creates a newDataset with the name provided.
The newDataset becomes the working copy, the previous working Dataset now becoming unchanged.
Some admin housekeeping of the stored Datasets is also possible from this window.

l Load Calendars From Dataset: If the configuration option Save Calendars with Schedule Dataset checked, this allows
the Calendars but not the Schedule to be loaded.
Some admin housekeeping of the stored Datasets is also possible from this window.

l Manage Datasets allows some admin housekeeping of the Datasets.

When selecting any of the above options which allow admin housekeeping , a window similar to the following is opened:

From this window, the user can:

l Identify existing saved Datasets with associated information.
l Use the icons at the top of the window to select a Schedule to be deleted, or for the saved schedules to be shown in list
or icon format.

l Right click on a Dataset to Rename or Delete it
l For Save Schedule Copy... and Save Schedule As... options, enter a name to save the current schedule as.
l For Open and Load Calendars From Dataset options, select a saved Dataset to open from..

When exiting the sequencer, the user is prompted to save changes to the schedule in the current Active Dataset, i.e. the last
Dataset opened, or the Dataset last saved to.

When entering the Sequencer, the Dataset named Schedule is always set as the Active Dataset.

If it is required to make a Saved Dataset the one opened automatically when entering the Sequencer, that Dataset should be
opened, then Saved As the Schedule Dataset.

Datasets for tables can also be managed outside the Sequencer, if Preactor has been so customized.
However, the orders table is most commonly the table managed.

Above we see the ability to edit Orders added to the Workspace,
With Dataset Management enabled, the user is offered the options to Save as... andManage Datasets under More Actions,
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and to Open Datasets. Windows similar to those described above for the sequencer are opened.

Configuration

Sequencer Configuration Settings
The Sequencer has a number of date offsets, periods, and other settings whose defaults need to be defined.

These defaults can be configured via:

Configuration ► Sequencer Configuration

The configurable items are:

For the Gantt Chart Window:

l Historical Planning Horizon.

This determines how far back from the current date (or Fixed date) the sequencer will show calendars for, and how far
back in history the Terminator line can be taken.

l Future Planning Horizon.

This determines how far forward the Sequencer is allowed to plan for. Operations that would fall outside this horizon
will not be placed onto the planning board.

l Set Sequence Overview Range.

What the range of the Gantt Chart will be, in the Sequencer.

The Sequence Overview Range can be set to:

l Fit to Items – The range will show all objects currently on the planning board.

l Full Range – The Gantt Chart range will show from the current date minus the Historic Planning Horizon, to the
current date plus the Future Planning Horizon.

l Custom – The user can define the number of days offset from the current date to start and end the Gantt Chart
range (-ve numbers for dates before the current date).

l Progress Control Color – See the Product Based Feature Lists for Mid-batch Update andOperation Progress Indicator.
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l Default Terminator Offset.

When opening the Gantt Chart, the Terminator line is shown at this offset past the current time.

l Set Sequencer Operation Thumb

This enables a small icon to appear on the Planning Board just at the start of the operation, to enable the user to hover
the mouse over and get details about the operation and to easily drag and drop the operation. This is useful when the
operation is so short it is difficult to see on the Gantt Chart – the thumbnail is never reduced in size.

For the Order Editor

l Default Earliest Start Date Offset.
l Default Due Date Offset.
l Default Terminator Offset.

Sequencer Configuration
The 'Sequencer Configuration' option is accessed by selecting the 'Configuration' category and then clicking on the 'Sequencer
Configuration' option in the 'Settings' work flow area. This displays the 'Edit Sequencer Configuration Information' dialog.

Historical Planning Horizon (Days) - defines how far you can scroll backwards in time in the Sequence Gantt Chart.

Future Planning Horizon (Days) - The time period that Preactor will allow jobs to be sequenced into the future, the Schedule
Horizon. When the sequencer initializes, it creates all the shift patterns for all resources up to the end of the schedule horizon.
If the horizon is very long then it will take longer to initialize the sequencer.

Set Sequence Overview Range - opens a dialog which customizes the period displayed in the Sequence Gantt Chart.

Set Sequence Operation Thumb - toggles a small black triangle displayed against each operation in the Sequencer, making it
easier to drag operations displayed on the planning board.

Set Progress Control Color - sets the color that displays an operation's progress in the Sequence Gantt Chart when mid-batch
quantities and times have been recorded.

Default Earliest Start Date Offset - When new orders are entered in the Editor, they will automatically be assigned an ‘Earliest
Start Date’, that is the time before which the first operation of the order cannot be scheduled. The ‘Default Earliest Start Date
Offset’ uses the time of entry of the order and the offset time to assign the value. Set to 0 will mean that the first operation
will be loaded as soon as possible. An offset of 1 (1 Day) will mean that the first operation will be loaded as soon as possible
after the current time + 1 day.

Default Due Date Offset - similar to the Default Earliest Start Date Offset except that this defines the offset that will used to
set the delivery date for the order. For example, if set to 11, the due date will be set to current time + 11 days.

Default Terminator Offset - The terminator is the current time and is used in the sequencer when removing operations from
the planning board. Any operations that cross the terminator are not usually removed. By default the terminator is at the
current time. Specifying an offset here allows you to move the terminator relative to the current time.

Calculate Cost - establishes options defining when cost calculations take place - During Sequence, After Sequence or Never.

Choose Default Event Scripts - displays a dialog which allows default PESP Event Scripts to be assigned to various actions.

Gauge Lines
Gauge lines are used in any windowwith a time line. This includes the Gantt Chart, Trace Chart and Plots window. Gauge lines
can be toggled on or off by choosing View ►Gauge Lines. To configure gauge lines, double click on the time line of the Gantt
Chart. This will show the following dialog:

- 232 -



Menus And Toolbars

All windows with a time line follow the same settings.

Gauge Line Parameters
Increment
Choose from the available options. You can specify an increment along with a unit type. Using 'Best Fit', Preactor will decide
the appropriate interval at which to display a gauge line.

Mode
When using any 'Increment' option other than 'Best Fit' , determines the frequency with which labels in the horizontal axis are
drawn. When 'Gauge Lines Only' is selected, the increment pertains to the gauge lines and not to the horizontal axis labels.
When 'Gauge Lines and Time' is selected, Preactor will attempt to display labels in the horizontal axis at the increment specified.
Where is it not possible to display a label, 'Bet Fit' will prevail.

Options
The final set of options are as described below:

l Bold Lines between days - Any gauge line that falls between one day and the next will be made bold.
l Include day names on Horizontal axis - Display the day of the week alongside the date/time in the horizontal axis.
l Include Week Numbers on Horizontal axis - Displays the week number along with the date/time in the horizontal
axis.

Menus And Toolbars

Menu Bar Commands
The Sequencer's Menu Bar Command options and associated Toolbar Buttons are described in the following section:

File - The available command options vary with the view currently displayed in the Sequencer's main window.

Edit - Most options are applicable only to the Editor window.

View - Used to select the Windows displayed in the Sequencer and to control the way in which information is
displayed.

Sequence - Provides the Sequencer's principal scheduling functions.

Tools - Provides tools to be used in conjunction with the schedule.

Window - Provides options to change the Sequencer's workspace layout.

Help - lists the available user help facilities.

Toolbars in the Sequencer
For general Toolbar management and usage, see the section in the Preactor Tour.
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The Sequencer has a number of toolbars:

l Standard - available at any time.
l Workspace - available at any time.
l Sequence - available at any time.
l User Tools - available at any time.
l Zoom and Scale - available at any time.
l Overview - available when the Gantt Chart window is focused.
l Editor - available when the Editor window is focused.
l Trace- available when the Trace window is focused.
l Calendar States- available when the Calendar States window is focused.

See Menu Bar Commands for details of toolbar button functions. 

File Menu Bar Command
The File Menu Bar Command options and associated toolbar buttons are listed here.

Button Name Description

New Allows new Calendar Templates to be generated.

Clear Sched-
ule

Deletes all operations (orders) from the current schedule, and clears the schedule.

Open... Opens previously stored Dataset.

Open Com-
parative
Schedule

Opens a second file for comparison with the first.

Close Com-
parative
Schedule

Closes the comparison file.

Import from
Disk...

Imports data from an external source.

Save Saves the current Dataset.

Save Sched-
ule Copy...

Saves a snapshot of the working Dataset to a different name. This differs from ‘Save Schedule As’ in that
the schedule you originally loaded remains the current schedule; any subsequent saves will still be per-
formed against the originally loaded schedule rather than the copy. See also the Manage Sequencer
Datasets.

Save Sched-
ule As...

Saves the current Dataset under a user defined name. The newly named Dataset becomes the current
Dataset. See also Manage Sequencer Datasets.

Save Util-
ization
Data...

Configures and saves the utilization report.

Export... Export the schedule to a file/location as defined by the PESP script For Event Export Button Press.

Load Cal-
endars From
Dataset

Loads just the Calendars from the named Dataset to overwrite the current working copy of the Cal-
endars. The Schedule and Transaction data are not restored.

Manage
Datasets.

Opens the Manage Datasets dialog where Datasets can be renamed or deleted. See also Manage
Sequencer Datasets.

Print... Prints the contents of the current window. e.g. Print Gantt Chart, Plots etc.

Print Pre-
view

Provides a preview of the printed output.
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Button Name Description

Exit
Exits from the sequencer saving the current schedule and calendar.

(This can also be achieved by clicking on the cross at the top right hand corner off the screen.)

Edit Menu Bar Command
The Edit Menu Bar Command options and associated toolbar buttons are listed below:

Button Name Description

Undo Undo previous listed actions.

Redo Redo previous listed actions.

Edit...
Edit the selected record or add a new record, if you select the row beneath the last
record in the Schedule.

Insert... Insert a new record before the selected record.

Delete... Delete the selected record. 

Duplicate Copy the selected record.

Repeat Order...
Allows you to repeat an existing order or split an order into a number of production
batches.

Auto Expand Enables automatic record expansion.

ExpandOrders Expands all orders in the Schedule.

Set Earliest Start Date for
all records

Sets the Earliest Start Date, using the offset established in the Configuration Data
menu.

 Set Due Date for all
records

Sets the Due Date using the offset established in the Configuration Data menu.

Global Assign

Allows you to set the Earliest Start Date, Due Date or Priority for all records. (Editor
Window only.)
The Global Assign option of the Sequencer Edit menu bar command displays the fol-
lowing fields for modification:

View Menu Bar Command
View commands are context sensitive and are dependent on the Sequencer window that is in focus.

Button Name Description

OverviewWindow Displays the OverviewWindow.

Gantt Chart Displays the Gantt Chart Window.

Editor Window Displays the Editor Window.

Plot Window Displays the Plot Window. This feature is not available in Preactor Express.

Trace Chart Window Displays the Trace Chart Window.

Utilization Window Displays the Utilization Window.

Material Explorer Displays the Material Explorer Window.

Unscheduled Oper-
ations

Displays the Unscheduled Operations window.
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Button Name Description

Calendars
Displays Primary and Secondary, Resource Calendars, Templates and Calendar States. This will
not operate if the required display is already open as a hidden window.

Reports Opens the Reports window if this is not already open as a hidden window.

Highlight Options Displays the operation Highlight Options options.

Gauge Lines Enables the gauge lines for all windows, except the Editor andMaterial Explorer windows.

Animate Sequencing Enables animation of Automatic Sequencing.

Disable Workspace
Tooltips

Disables the tooltips which appear when you hover the mouse over an operation.

Hide Children Hides child records in the Editor window. (Editor window only.)

Highlight Selected
Records

Highlights the currently selected record(s).(Editor window only.)

Show Inherited
Items

Shows more information for child records. (Editor window only.)

Field Chooser
Opens the Field Chooser dialog, allowing for more columns to be displayed in the Editor. (Editor
window only.)

Reset Layout Resets all layout modifications, including size and positions of columns. (Editor window only.)

Save Customization
on Exit

If enabled, will save any customization made to the layout. (Editor window only.)

Zoom and Scale
Provides options to control how Plots and Charts are displayed. (Gantt Chart, Trace Chart and
Plots Windows only.)

Edit Mode
Allows you to use the Gantt Chart to modify operations or calendars using:

Operation Edit mode or Calendar Edit mode.

Display Priority
Allows the Gantt Chart display to show:

Operations On Top or Calendar On Top.

ShowOperation
Relationships

Displays flow lines between related operations in an order. (Gantt Chart and Trace Chart Win-
dows only.)

 ShowHighlighted
Operation Rela-
tionships

Displays flow lines between related operations when orders are highlighted. (Gantt Chart and
Trace Chart Windows only.)

Compress Gantt Hides Resources with no highlighted operations in the Gantt Chart. (Gantt Chart window only.)

OverviewGroups
Allows you to select a group of resources to view in the Gantt Chart. (Gantt Chart window
only.)

Bar Text
Allows you to enable three different options for the text in an operational bar: outline
description text, small description text, rotate description text. (Gantt Chart and Trace Chart
Windows only.)

Normalize Trace
Chart

Displays the Trace Chart normalized relative to the Due Date of the operation. (Trace Chart win-
dow only.) 

ShowDemarcation
Between Rows

Enables more visible lines between operation lines. (Trace Chart window only.) 

Vertical Axis
Enables the subject of the X (vertical) axis of the Order Trace Chart to be selected. (Trace Chart
window only.) 

Configure Plots
Opens the Select User plot dialog allowing the plots displayed in the plots window to be chosen.
(Plots window only.)
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Button Name Description

Configure Utilization
Opens the Utilization dialog, allowing for enabling and disabling of items shown. (Utilization win-
dow only.)

Bucket Settings
Opens the Bucket Setting dialog for configuration of utilization buckets. (Utilization window
only.)

Set Utilization Mode Enables the Utilization window to be set in either percent or hours. (Utilization window only.)

Sequence Menu Bar Command
The Sequence Menu Bar Command options and associated toolbar buttons are listed below:

Button Name Description 

Forward Sequence
Sets the sequencing mode to forward and presents the available forward sequen-
cing options.

Backward Sequence
Sets the sequencing mode to backward and presents the available backward sequen-
cing options.

Bi-Directional Sequence For All
Locked Operations

Sets the sequencing mode to bi-directional around locked operations and presents
the available bi-directional sequencing options.

Set Weight Displays the Set Weight Window.

APS Rules
Sets the sequencing mode to use "APS rules" and presents a dialog from where an
APS rule can be selected from the available options.

Remove Operations from
Schedule

Removes all operations from the planning board that are not locked.

Lock History Locks all operations that have already started.

Lock Started Orders Locks all operations in an order that has already started.

Ignore Locked Operations When selected operation locking is ignored.

Disable Secondary Constraints Disables checking of secondary constraints.

Schedule Despite Shortages Enables the sequencing of operations when constraining materials are unavailable.

Tools Menu Bar Command
The Tools Menu Bar Command options and associated toolbar buttons are listed below:

Button Name Description

Peg Mater-
ials

Runs StandardMaterial Control (SMC) using the 'Pegging Rule' that has been set as the default to use,
to create links between orders.

Infinite
Capacity
Sequence

Sets the Sequencer into Infinite Capacity mode.

Validate
Schedule

Validates the current schedule.

Repair
Schedule

Repairs the schedule keeping operations on the same primary resource where possible.

Schedule
Statistics...

Displays the Schedule Statistics.

Order
Enquiry...

Opens the Order Enquiry dialog, allowing a promise date against an order enquiry to be calculated
without reorganizing other operations that have already been scheduled.

Operation Opens the "Operation Properties Window" on page 256.
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Button Name Description

Properties

Window Menu Bar Command
The WindowMenu Bar Command options and associated toolbar buttons are listed below:

Button  Name  Description 

Save Workspace Saves the current workspace as a .prwpi file.

Restore Workspace Prompts user to select a previously savedWorkspace to open

PredefinedWorkspace Allows the user to edit the Predefinedworkspace buttons. See: PredefinedWorkspace Toolbar

Workspace Options Provides two options - "Save Workspace on Exit" and "Save Toolbars with Workspace".

Close All windows Closes all visible windows.

Minimize All windows Minimizes all visible windows.

1 Overview Name of a window that is currently open in the Sequencer.

2 Plots Name of a window that is currently open in the Sequencer andwhich has focus.

Highlight Options Menu Bar Commands
Operations andOrders can be located and highlighted based on common criteria (late, early, etc), and highlighted operations
locked or unlocked. Multiple criteria can be used, e.g. highlighting Actual (complete) operations and those within the Delivery
Buffer. Each highlight criteria selection is a toggle switch, so can be enabled or disabled, with a Cancel All Highlights capability
present also.

The Highlight Options Menu Bar Command options and associated toolbar buttons are listed below, and can also be accessed
from the dropdown from the Highlight Options on the standard toolbar:

Button Name Description

Cancel All Highlights Cancels all highlighting. Returns all operations to their normal state.

ShowOutline

Continues to show unhighlighted operations as an outline on the Gantt Chart, Editor and
Trace Chart windows.
This applies when the highlighting is done by options outside the Locate capabilities (e.g. tool-
bar).

Highlight Locked Oper-
ations

Highlights locked operations in the Gantt Chart, Editor and Trace Chart windows.

Highlight Actual Oper-
ations

Highlights actual and partly completed operations in the Gantt Chart, Editor and Trace Chart
windows (those operations using Actual Times rather than Preactor Generated times).

Highlight Early Oper-
ations

Highlights operations sequenced before the earliest start time in the Gantt Chart, Editor and
Trace chart windows.

Highlight Operations
Within Delivery Buffer

Highlights operations that are Scheduled to finish within the delivery buffer period.

Highlight Orders
Within Delivery Buffer

Highlights all operations of orders that have operations scheduled to finish within the delivery
buffer.

Highlight Late Oper-
ations

Highlights operations scheduled after their Due Date.
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Button Name Description

Highlight Late Orders Highlights all operations of orders that have operations due to finish after the Due Date.

Highlight Delayed
Operations

Highlights all operations that are delayed due to resource availability.

Highlight Bottleneck
Operations

Highlights the operation that is delayed most due to resource availability in each order.

Lock Highlighted Oper-
ations

Locks all highlighted operations.

Unlock Highlighted
Operations

Unlocks all highlighted operations.

Highlight Sequence
Errors

Highlights operations failing the sequence check in the Gantt Chart, Editor and Trace chart
windows.

Calendar States Menu Bar Commands
The Calendar States Menu Bar Command options and associated toolbar buttons are listed below:

Button Name Description

NewCalendar State Opens the Calendar State dialog allowing a new state to be created.

Delete Calendar State Deletes an existing Calendar State, unless this is currently used by an existing Resource.

Zoom and Scale
These options allow you to control the way in which charts are displayed in the Sequencer.

Button Name Description

Zoom Timeline In Decreases the scale of the X (horizontal) axis.

Zoom Timeline Out Increases the scale of the X (vertical) axis.

Reset Timeline Reset to the default value.

Increase Bar Height Increases the scale of the Y axis.

Reduce Bar Height Decreases the scale of the Y axis

Increase Plot Height Increases the scale of the Y axis.

Reduce Plot Height Decreases the scale of the Y axis

Reset Bar Height Reset to the default value.

Reset All Resets both the X and Y axis to the default values.

Scroll Lock

When selected this performs two functions :

Prevents arrow keys from causing scrolling1, you can still scroll by clicking on the scroll bars
with the mouse.

Prevents the Gantt Chart from scrolling while dragging an operation outside of the Gantt Chart
window.

Set Range Opens the "Set Overview Range" dialog to allow the horizontal range of the chart to be set.

Gauge Lines Toggles the display of Gauge Lines on and off in Gantt Chart, Plots and Trace Charts.

Configure Gauge Opens the "Gauge line Parameters" dialog allowing you to configure chart Gauge Lines .

1The main use of this is to prevent scrolling of the Overviewwhen it is zoomed in and you are using the Mouse Click and arrow
keys to highlight operations.
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Button Name Description

Lines

Global Assign
The Global Assign option of the Sequencer Edit menu bar command displays the following fields for modification:

Undo/Redo

Undo Redo

Preactor remembers your activities in the Gantt Chart. The user can undo or redo these activities using the buttons provided.
So, for example, if you drag and drop an operation then decide to return it, the Undo button can be used.

Workspaces

Predefined Windows Workspaces
From here, a user can configure which savedWorkspaces to assign to a button, and also to ‘tear off’ the buttons to place on
the toolbar to make switching between Workspaces quicker.

PredefinedWorkspaces menu Tear off buttons

PredefinedWindows Workspace Configuration

Window Workspace Management
Management of the WindowWorkspace in the Sequencer is from the WindowWorkspace menu item:
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From here a user can:

l Save the Windows Workspace.
l Restore a previously savedWindows Workspace.
l Configure the Workspace options to:

l Store the toolbars as part of the Windows workspace.
l To Save the Windows Workspace (as the Default) when exiting Preactor.

l Define, and Switch between PredefinedWorkspaces.

Saving the Configuration - Sequencer
Changes to the Workspace and Toolbar settings can be saved for re-use between sessions in a number of ways.

Workspace

The workspace is, by default in the shipped configurations, not saved for re-use between Sequencing sessions.
The user has a number of options:

l The user can save a Workspace, and restore it during a later Sequencing session:

l The user can elect to have the Workspace saved automatically when exiting, and restored automatically when entering
the Sequencer:

Toolbars

Toolbar settings are maintained across Sequencer sessions.

Toolbars settings can be storedwith savedWorkspaces.

Toolbar setting configuration is language dependent. That is, the Toolbar Setting is associatedwith the Language that
configuration was done in. Change the running language from say English to German, and any Toolbar configuration will be
lost until the Language they were created is again set as the run-time language.

Orders Editor

Highlight Selected Records
When using the editor in the sequencer any selected operation records can be highlighted in the Gantt Chart by selecting
Selected Records from the Highlight Optionsmenu on the editor context menu. The same function may be accessed from
the Viewmenu by selecting Highlight Selected Records or by pressing the shortcut key F7.

Insert an Operation in a Started Order
You may need to insert a temporary operation into an order's production process, e.g. a rectification task may be required
after operation 10 has been completed but before operation 20 starts.
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Note: This facility is not enabled in systems that are integratedwith an ERP system, as amendments to the process route should
be undertaken within the ERP system.

To insert a temporary operation into a process route:

1. With the Editor window open in the Sequencer, click on the second operation (Op. 20) of the scheduled order that is to
be modified.

2. From the 'Edit' menu bar command select the 'Insert' option.

A record is inserted between operations 10 and 20 and the Edit Orders Information dialog is displayed.

3. Against 'Operation Name' select 'Extra Operation' from the drop down list.

The operation number changes to 2000.

4. Change the 'Op. No'. to 15.
5. Click on the 'Resources' Edit pushbutton and select the 'Required Resource'.
6. Set the operation time etc. and close the dialog.

An icon is placed in the Unscheduled Operations window

You can also change the quantity and add additional constraints to the inserted operation in Preactor 300 FCS products and
above.

7. Right click on the record and from the 'Remove from Planning Board' options choose 'All Subsequent Operations'.

The unscheduled operations appear as icons in the Unscheduled Operations window.

8. Right click on the record again and from the 'Place on Planning Board' options select 'Forward, All Operations'.

The unscheduled operations are rescheduled and the impact of the change seen in the Gantt Chart.

Changing Order Due Dates, Priorities etc.
You may interactively change the due date, earliest start date or priority of an order. You can then reschedule to see the
impact on the overall schedule and the effect on delivery compliance across all orders.

To see the impact of changing an order's priority:

1. Double click on the first operation of the selected order.

This can be carried out in the Sequence's Gantt Chart or Editor windows.

The Edit Order Information dialog is displayed.

2. Enter the new value in the 'Priority' field.

A lower value increases priority.

3. Close the dialog.
4. Remove all orders from the Schedule.
5. Forward sequence all orders by priority.

Use the and toolbar buttons.

6. Examine the effect of the changes.

At Risk Orders
Any order where the last operation will finish within the period of the delivery buffer is considered to be potentially ‘At Risk’.

- 242 -



Orders Editor

At Risk orders are indicated:

l On the Gantt Chart and Trace windows, by an yellow bar over the operation.

l In the Order Editor, by coloring the status indicator yellow.

Highlighting
At Risk orders can also be highlighted by use of the Highlight Options Toolbar or menu options:

l Highlight Operations within the Delivery Buffer.
l Highlight Orders within the Delivery Buffer.

Similar capability is available for Late Orders and other operation statuses.

Order Call off
You can enter an order and then arrange to call off sub-orders in defined quantities and time interval.

For example you could enter an order for 100 of product ‘A’, then use the call off order tool to create 5 sub orders of 20 at 1
week intervals. Each sub-order would then have the Earliest Start Date and Due Date set, taking into account the call off
quantity and time interval.

To create a Call off sequence:

1. With the Editor window displayed in the Sequencer, either create a new order or select the parent of an existing order
from which you wish to call off sub-orders.

2. From the Edit menu bar command, select the 'Repeat Order' option.

A Repeat Orders dialog is displayed.

3. Under 'Repeat Mode' select 'Call off'.
4. Under 'Creation Mode' select 'Create standard operations for this order'.

If the selected order uses a modified routing you may choose to use this rather than the standard operations.

5. Enter the interval at which you wish the sub-orders to be repeated in 'Repeat Interval'.
6. Enter the call off quantity for each sub-order in 'Repeat Quantity'.

Repeat Orders
You may enter an order and then define a repeat interval.

For example you could enter an order for 100 of product ‘A’ then use the repeat order tool to create 5 sub-orders of 100 offset
by 1 week. The Earliest Start Date and Due Date of each sub-order would then be set taking into account the repeat interval.

To create a repeat order:
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1. With the Editor window displayed in the Sequencer, either create a new order or select the parent of an existing order
from which you wish to repeat.

2. From the Edit menu bar command, select the 'Repeat Order' option.

A Repeat Orders dialog is displayed.

3. Under 'Repeat Mode' select 'Duplicate'.
4. Under 'Creation Mode' select 'Create standard operations for this order'.

If the selected order uses a modified routing you may choose to use this rather than the standard operations.

5. Enter the interval at which you wish the order to be repeated in 'Repeat Interval'.
6. Enter the number of times the order is to be repeated in 'Repeat Count'.

Please note; a 'Repeat Count' of 2 provides 1 additional order, a 'Repeat Count' of 3 provides 2 additional orders etc.

Gantt and Trace Chart

Gantt Window

The Gantt chart displays the planning board.

l The vertical axis depicts the available primary resources on which operations are loaded.
l The horizontal axis shows the time range over which they are scheduled.
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The duration of scheduled operations are represented by the length of the colored Gantt bars. You can click and drag these
bars to a new position on the planning board (via the operation preview icons in the Editor window). If a new position violates
existing scheduling constraints, a warning message is displayed.

Resting the mouse pointer over a Gantt bar activates a tool tip display providing information about the operation. Further
information can be obtained by double clicking on the Gantt bar to display the Edit Order Information dialog, which allows data
to be updated or modified.

The relationship between operations can be shown using by choosing View ► Show Operation Relationships, which displays
arrows linking related operations. These relationships can also be displayed by holding down the ALT key and clicking on an
operation. Unrelated operations are grayed out.

Shift patterns can be displayed in the Gantt chart. The operator can switch between different Calendar Display Modes using a
toolbar option. Calendars may be modified from the Gantt chart, through the introduction of overtime working or machine
breakdown periods etc.

Late, Early and At Risk orders can be highlighted.

Display Option - Zoom and Navigation

You can zoom in on both axis using the Zoom and Scale option from the View command and the toolbar.
Quick zoom and navigation is possible using :

l Mouse Wheel to scroll up/down
l Shift + Mouse Wheel to scroll left/right
l Ctrl + Mouse Wheel to zoom in/out on the horizontal axis
l Ctrl + Shift + Mouse Wheel to zoom in/out on the vertical axis
l Ctrl + Left Mouse Button to Pan (drag by moving the cursor).

Display Option - Stacked or Cascaded Display

The Sequencer's Gantt chart window can be changed to display Resources in a Stacked (default) or Cascaded format, as
illustrated here (Lathe with Stacked display, Mill with Cascaded display):

;

Right click on the resource name in the Gantt chart and select Stack Operations or Cascade Operations to change the format
for that resource from the pop upmenu.

The settings for this display format do not persist across sequencer sessions, however the default display format for each
resource can be configured in a field in the Resources table.

Drag and Drop Operations
Operations can be dragged and dropped onto the Sequencer's Gantt Chart window from the Unscheduled Operations window,
and from the Editor window using the Traffic Light. Operations already on the planning boardmay also be dragged and
dropped onto alternate resources or on the same resource in a different sequence.
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To Drag and Drop an Operation:

1. Left click on an operation icon in the Unscheduled Operations window or a Bar in the Gantt Chart, or on the status icon
of an operation in the Editor; hold the mouse button down; drag it to the required position in the Sequence Gantt
Chart; and release the button.

While dragging an operation, the length of the bar will change if shift patterns or efficiency vary across the process and/or
setup times.

The Sequencer will not allow the user to drop it onto a resource that is not in the resource group for the operation.

Operation Progress Indicator
This feature provides a convenient and visual way of tracking the progress of an operation.

As a mid-batch quantity and time is entered for an operation, a bar will be displayed in the operation on the Gantt Chart,
equivalent to the percentage progress made.

The default progress control color is 'silver' but this can be modified in the 'Progress Control Color' field located in the 'Edit
Configuration Set Up Information' dialog, accessed via the 'Configuration Data' pushbutton in the Configuration Menu.

Please note, there is no link between the 'Operation Progress Indicator' and the 'Operation Completion' routine, completing an
operation will not set the progress indicator bar to 100%. 

This can only be accomplished by the Mid-Batch update routine.

Trace Chart Window
This window provides a convenient way of viewing schedule data in different ways to the Gantt Chart.

The Trace Chart can be opened from the Viewmenu, or from the toolbar icon:

1. The Trace Chart for the current schedule is displayed and is similar to that seen in the Gantt Chart, but now it allows you
to compare previous schedules you have saved, one with another.

2. Use the File/Open... option, or the equivalent toolbar button, to display the selected reference file as a Gantt chart.
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3. Select File/Open Comparative File option from the menu bar or equivalent toolbar button, to display the selected com-
parative file as a second Gantt chart. Each order now displays two loading patterns, one above the other.

This feature is particularly useful if you wish to check the consequences, for example, of increasing the priority of one order on
all the other orders.

Once the Trace chart has been opened, the viewmenu bar command contains a context sensitive Normalize Trace Chart
option. When selected this displays the Trace Chart normalized to the Due Date of each order, which is useful when checking
for late/early orders.

Using the drop down selection against the Vertical Axis toolbar option, the subject of the vertical axis can be changed.

You can also zoom in on the vertical and horizontal axis of the chart, using the Zoom and Scale option from the View
command.

Late, Early and At Risk orders can be highlighted.

Display Option - General

The chart uses a number of display enhancements, selected from the Viewmenu bar command:

l Set Range - controls the start and extent of the Gantt chart.
l Configure Gauge Lines - sets the interval between Gauge Lines and controls their appearance.
l Gauge Lines - toggles the Gauge Lines on and off.
l Disable Workspace Tool tips - toggles the tool tip display on and off.

Display Option - Zoom and Navigation

You can zoom in on both axis using the Zoom and Scale option from the View command and the toolbar.
Quick zoom and navigation is possible using :

l Mouse Wheel to scroll up/down
l Shift + Mouse Wheel to scroll left/right
l Ctrl + Mouse Wheel to zoom in/out on the horizontal axis
l Ctrl + Shift + Mouse Wheel to zoom in/out on the vertical axis
l Ctrl + Left Mouse Button to Pan

Comparing Actual Operation Times with Scheduled Times
The Trace Chart can be used to compare the original scheduled start and finish times for operations and the actual times, once
the data is available.

To do this the user should save a ‘reference schedule’ say at the start of a scheduling period.

Once there are some operation completions (the Use Actual Times checkbox has been checked and start and finish times
entered) the Schedule can be saved and compared to the reference schedule saved before.

To make this comparison:

1. Access the Sequencer and open the Trace Chart window.

2. Click on the Open button to open a Dataset and select the reference schedule .
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3. Click on the Open Actual Comparative Schedule button and select the current schedule (with completed operations)

Only operations that have been completedwill be displayed in the green area below the reference schedule so comparisons
can be made.

Printing the Gantt Chart or Order Trace Chart
Various settings exist to customize how the Gantt Chart or Order Trace Chart can be printed. The Set Print Properties dialog
can be accessed by selecting Print from the Filemenu (within the Sequencer) when the Gantt Chart tab is the focus.

Operation Lines Per Page
Name Description

One Page Prints all of the Gantt Chart lines on one page.

Total Pages
Spreads the Gantt Chart lines across the number of pages specified
in the 'Total Pages:' field, which becomes visible when this option is
selected.

Lines Per Page
Specifies the number of Gantt Chart lines that are to be included
per page.
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Time Span
Name Description

Start Time
Allows a start time to be entered to specify the beginning of a time
span to be printed.

End Time

Specifies the last time that is to be included in the printout. The
actual end time may be later, based on the time span that has
been selected. For example, if a start time of January 1st 2000 and
an end time of February 10th 2000 has been entered, and the
time span is one month per page, then the end time of the prin-
tout will be March 1st 2000, the last page will include the specified
end time.

Time Span Per Page
Name Description

All Displays the whole time span on one page.

Minutes
Enables the Page Span field, allowing the number ofminutes to be
specified per page.

Hours
Enables the Page Span field, allowing the number of hours to be
specified per page.

Days
Enables the Page Span field, allowing the number of days to be spe-
cified per page.

Weeks
Enables the Page Span field, allowing the number of weeks to be
specified per page.

Months
Enables the Page Span field, allowing the number ofmonths to be
specified per page.

Years
Enables the Page Span field, allowing the number of years to be
specified per page.

Page Orientation
Name Description

Landscape Specifies that the schedule should be printed as landscape.

Portrait Specifies that the schedule should be printed as portrait.

Time Axis Increments
Name Description

As Display Prints the time axis lines as currently displayed in the Gantt Chart.

Seconds

This option is only available if the Include Seconds feature has been
switched on in the Command File Editor. It specifies the interval at
which a time axis line should appear in the printed output. AQuant-
ity field becomes visible allowing the number of seconds to be spe-
cified.

Minutes
Specifies the interval at which a time axis line should appear in the
printed output. AQuantity field becomes visible allowing the num-
ber ofminutes to be specified.

Hours
Specifies the interval at which a time axis line should appear in the
printed output. AQuantity field becomes visible allowing the num-
ber of hours to be specified.

Days Specifies the interval at which a time axis line should appear in the
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Name Description

printed output. AQuantity field becomes visible allowing the num-
ber of days to be specified.

Weeks
Specifies the interval at which a time axis line should appear in the
printed output. AQuantity field becomes visible allowing the num-
ber of weeks to be specified.

Reference Date
This option is available when either seconds, minutes, hours, days
or weeks options have been selected. The reference date allows a
starting point at which the time axis lines can be applied.

Gauge Line Increments
Name Description

As Display Prints gauge lines as currently displayed in the Gantt Chart.

Seconds

This option is only available if the Include Seconds feature has been
switched on in the Command File Editor. It specifies the interval at
which a gauge line should appear in the printed output. AQuantity
field becomes visible allowing the number of seconds to be spe-
cified.

Minutes
Specifies the interval at which a gauge line should appear in the
printed output. AQuantity field becomes visible allowing the num-
ber ofminutes to be specified.

Hours
Specifies the interval at which a gauge line should appear in the
printed output. AQuantity field becomes visible allowing the num-
ber of hours to be specified. 

Days
Specifies the interval at which a gauge line should appear in the
printed output. AQuantity field becomes visible allowing the num-
ber of days to be specified. 

Weeks
Specifies the interval at which a gauge line should appear in the
printed output. AQuantity field becomes visible allowing the num-
ber of weeks to be specified. 

Reference Date
This option is available when either minutes, hours, days or weeks
options have been selected. The reference date allows a starting
point at which the gauge lines can be applied.

Other Appearance Settings
Name Description

Bold Lines between days Prints a bold line to divide the days.

Include day names on Horizontal axis Prints the day names on the time axis.

Include Week Numbers on Horizontal axis Prints the week numbers on the time axis.

Overview Window
The OverviewWindow is a window that enables the user to view a combination of the Gantt Chart, Plots Window and
Utilization Window together. It is possible to have numerous panes open, and these will work in unison with each other.

Opening the OverviewWindow is done by navigating to View ►Overview Window.
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Upon opening, the default view of the OverviewWindow is to display the Gantt Chart. The Overviewmenu button, , (which is
available, separately, for each pane open in the Overview) can be used to change the view of the current Overview pane, add
another pane to the OverviewWindow, or close a pane. Clicking Add Pane... will add a new pane at the bottom of the
OverviewWindow. Closing panes can be done to any pane in the window, except the one at the very top. This is to ensure that
the OverviewWindow is populatedwith a form of information.

Clicking Gantt Chart, Utilization or Plotswill then be displayedwithin that pane. It is possible to have multiple panes displaying
the same information.
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Panes within the window can be resized, and resizing one pane will impact all panes. There is a single timeline used across all
panes within the OverviewWindow. Zooming in or out (horizontally or vertically) within a pane will affect all panes within the
window, allowing for finer detail viewing when needed.

Using the shortcut key for vertical zooming, Ctrl+Shift+Scrolling of Mouse, will allow for vertical zooming of a single pane.

The OverviewWindow is a dockable window, though the panes within the Overview can only be displayed in a horizontal
manner. This is due to the use of a single timeline.

If there is a need to drag and drop operations into a Gantt Chart pane within the Overview, then the Sequencer will auto
refresh to display the data in any other windows that are open, like the Gantt Chart itself. The same is true for scheduling and
unscheduling operations.
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Highlighting operations within a Gantt Chart pane in the OverviewWindowwill have a global effect, and if a stand alone Gantt
Chart Window is open, any highlighting functionality chosen will be displayed in both the OverviewWindow and Gantt Chart.

Using the Compress Gantt Chart option from the Viewmenu will only affect the Gantt chart that is in focus. In the image
below, the OverviewWindowwas the focusedwindow, so the Gantt Chart pane was compressed, leaving the Gantt Chart
Window to display the entire planning board.

While there is no limit to the amount of panes available for displaying within the OverviewWindow, it's recommended to limit
the amount to less than 5, otherwise the display can appear cluttered.

The OverviewWindowwill be saved "as is" when using the Save Workspace function. Upon opening a savedworkspace, all of
the options, pane sizing and zooming will be restored.
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Highlighting and Filtering

Highlight an Order's Process Flow
The sequence in which an order's operations are performed, the time span and the resources on which they are carried out can
be seen by highlighting the process flow.

To highlight an order's process flow:

1. In the Gantt Chart click on one of the order's operations, while holding down the ALT key.

All related orders and operations and flow lines are added to the display. Solid lines link operations within an order and dotted
lines link related orders.

2. Where the whole process cannot be seen, use the Compress Gantt toolbar button to shrink the Gantt Chart to include
only those resources with highlighted operations.

3. Click anywhere in the Gantt Chart to return to the normal (or compressed) display.

Late and Early Order Highlighting
The operations and orders that are late or early are indicated and highlighted on the Gantt Chart, Trace, and Order Editor
windows.

Late orders are indicated:

l On the Gantt Chart and Trace windows, by a red bar over the operation

l In the Order Editor, by setting the status indicator red, with an emphasis on the right side.

Early orders (those whose start date is before the Earliest Start Date specified) are indicated:

l On the Gantt Chart and Trace windows, by a green bar over the operation

l In the Order Editor, by setting the status indicator red, with an emphasis on the left side.

Highlighting
Late and early orders can be highlighted by use of the Highlight Options Toolbar or menu option.

Other conditions can also be highlighted from this toolbar, e.g. Locked Operations, Bottleneck Operations, etc.

Similar capability is available for At Risk Orders.

Highlighting Options
From View ►Highlight Options, a number of highlighting options are available:
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Below is a table explaining all the buttons.

Button Name Description

Cancel All Highlights Cancels all highlighting. Returns all operations to their normal state.

ShowOutline

Continues to show unhighlighted operations as an outline on the Gantt Chart, Editor and
Trace Chart windows.
This applies when the highlighting is done by options outside the Locate capabilities (e.g. tool-
bar).

Highlight Locked Oper-
ations

Highlights locked operations in the Gantt Chart, Editor and Trace Chart windows.

Highlight Actual Oper-
ations

Highlights actual and partly completed operations in the Gantt Chart, Editor and Trace Chart
windows (those operations using Actual Times rather than Preactor Generated times).

Highlight Early Oper-
ations

Highlights operations sequenced before the earliest start time in the Gantt Chart, Editor and
Trace chart windows.

Highlight Operations
Within Delivery Buffer

Highlights operations that are Scheduled to finish within the delivery buffer period.

Highlight Orders
Within Delivery Buffer

Highlights all operations of orders that have operations scheduled to finish within the delivery
buffer.

Highlight Late Oper-
ations

Highlights operations scheduled after their Due Date.

Highlight Late Orders Highlights all operations of orders that have operations due to finish after the Due Date.

Highlight Delayed
Operations

Highlights all operations that are delayed due to resource availability.

Highlight Bottleneck
Operations

Highlights the operation that is delayed most due to resource availability in each order.

Lock Highlighted Oper-
ations

Locks all highlighted operations.

Unlock Highlighted
Operations

Unlocks all highlighted operations.

Highlight Sequence
Errors

Highlights operations failing the sequence check in the Gantt Chart, Editor and Trace chart
windows.

When operations are highlighted, only those operations will be placed or removed from the planning boardwhen sequencing
or unallocating operations using the toolbar or menu options, or Preactor OPB API methods.

Clearing Highlighting in the Sequencer
There are numerous ways to clear any highlighting:

- 255 -



Highlighting and Filtering

l The Cancel All Highlights button exists three times within the Sequencer.
1. Once in the Highlight Options toolbar.
2. Once in the Standard toolbar.
3. Once in the Viewmenu.

l Clearing any highlighting in the Trace Chart and Gantt Chart Windows can be done by clicking on empty space within
the respective window.

l Use of the ESC key, which will remove any highlighting in the Trace, Gantt Chart and/or Editor windows, along with any
selected filters. However, using this shortcut will not reset the highlight mode selected.

Highlighting Sequence Errors
When editing an already generated schedule, it is possible that sequence errors will occur. If the Highlight Sequence Errors
button is toggled on, errors in the sequence will be displayed. However, due to Preactor not continuously refreshing, if
operations are moved in the Gantt Chart windowwhile this button is toggled on, Preactor will not display any changes in
sequence errors. To refresh the highlighting of errors, after all changes have been made, the Highlight Sequence Errors
button must be deselected, then reselected to view any changes made.

Operation Properties Window
The Operations Properties Window allows the user to design the operation bars that are shown in the Gantt Chart, Trace
Chart, Editor and Unscheduled Operations windows. This is only available in AS. The window allows for three aspects of the bar
to be edited:

l Color
l Pattern
l Text

This window is accessed from the Tools Menu, the Operation Properties Window.

Color
There are a number ofmodes available for the color of the operation bar. The ellipses button is used to change these.
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l Default is the default coloring mode for that section of the operation bar:
l For the main bar, this will be black.
l For the low bar, this will be the same as the main bar.
l For the low right bar, this will be the same as the low bar.
l For the progress color, this will be gray.

l Fixed Color allows the user to set a fixed color for that section of the operation bar.
l Color Field allows the user to select a color field that will be used as the color for the section of the operation bar. Select-
ing this mode will provide the user with a drop down list of all the available themes for the operations bar.

l Color Theme allows the user to select a field and a theme for that section of the operation bar. The bar will be con-
sistently colored, based on the value of the field and the selected theme. Selecting this mode will provide the user with
an additional dialog box which contains all of the colors available for the theme.

l Auto Mode will cause the bar to be consistently colored, based on the value of the field. The color of the bar can be
selected from the entire spectrum of colors available in the software.

l Color Range will cause the color of the bar to be based on where the value of the selected field fits within the start and
end colors. When 'Apply Color to Default Values' is ticked, the values from the selected field would be considered in the
range, otherwise the operation bars will be coloredwhite when the record value matches the default value.

Pattern
There are three modes available to apply a pattern to an operation bar.

l Default will apply the default pattern to the operation bar.
l The bar pattern will be solid.
l Late patterns will be 60% fill, unless the bar pattern has a Static or Pattern field.
l Progress will be solid.

l Staticwill set the operation part to use the selected pattern.
l Pattern Fieldwill set the operation part to use the pattern value from the selected field.

Text
The user is able to add up to four lines of text to an operation bar. The text line will be fetched from the value of the selected
field.

Filtering Within the Sequencer
Filtering is available in the Viewers, though no filters will be saved upon closing the Viewers.
Filtering is not available in the Planner.

Preactor's filtering feature within the Sequencer is extensive and allows the user to filter items/records. Users are able to use
filters already existing in Preactor, or by creating custom filters. There are two types of filters available for creation in the
Sequencer, Expression Filters and Composite Filters. See Creating andManaging Expression Filters and Creating andManaging
Composite Filters for information on how to create andmanage filters.
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Creating Composite Filters
Composite Filters are only available within the Preactor Sequencer.

Creating Composite Filters
Composite Filters are made from two or more filters, Expression and/or Composite Filters, and uses AND/OR logic to create a
composite filter. Adding a Composite Filter is done by clicking the Add Composite button in theManage Filters dialog.

This will open the Composite Filter Builder dialog. A Composite Filter requires a minimum of two child filters, which can be a
combination of child Composite Filters and Expression Filters. If the requirement(s) are not met, there will be a red outline
around the section that is not fulfilling it.

The buttons in the Composite Filter Builder are:

l

This drop down menu can be set as AND or OR for that composite tree.
l

These two buttons are used for editing or deleting a child filter. However, only Expression Filters can be edited.
l

These three buttons are used for choosing what the child filter should be, either by using an existing filter, creating a
new filter, or adding a Composite Filter.

There is no limit to howmany filters, Composite and Expression, can be used to create a Composite Filter. Though it is
preferable to keep a composite as limited as possible, because if the filters are to be usedwith large configurations, a system's
memory can be impacted on.
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Composite Filter Logic
Preactor calculates the outcome of a Composite Filter by analyzing the first child filter it can find. In an instance where there
may be numerous children composite filters, Preactor may take some time to compute the filtering results. When creating a
Composite filter, it is recommend to try and put any filters that will remove the most items first. For example, Due Date or
Customer. Building a Composite Filter in this way will help to minimize the amount of time Preactor spends calculating the
filter results.

Applying Composite Filters
With a filter created, it will be available in the toolbar drop down menu.

It is possible to select multiple filters to apply, which is done by clicking on the checkbox. To remove the selection of filter(s),
either uncheck the checkboxes, or use the Esc Key. Any filters created are saved to the database and are only removedwhen
clicking the Delete button in theManage Expressions dialog.

Utilization View
The Utilization View provides a bucketed summary view of resource group, primary and secondary resource utilization. The
utilization view can be opened by selecting 'Utilization Window' from the 'View' menu, or using the toolbar icon:

By default, utilization data is shown for all resource groups, primary resources and secondary resources. This selection can be
changed by choosing 'Configure Utilization' from the 'View' menu.
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Time Buckets
The utilization view is divided into buckets of time, as specified in the 'Bucket Settings' dialog. To open this dialog, with the
Utilization view selected, choose 'Bucket Settings' from the 'View' menu.

Buckets can be a number of hours, days or weeks long or, when 'As Display' is selected, they can follow the gauge line
increment. "Gauge Lines" on page 232 for more information.

Utilization Values
Utilization can be expressed either as a percentage of the available time in a bucket (by default), or as a number of hours and
minutes. To switch between the two options choose either 'Percent' or 'Hours' from 'View', 'Set Utilization Mode' while the
Utilization window is selected.

Unavailable
Unavailable time is characterized by calendar periods of 0% efficiency on primary resources. For example, when a primary
resource is off-shift over a weekend.

Setup
Setup shows the time spent on the setup portion of an operation. Where setups are performed in parallel, setup time can
cause a period to go beyond 100% utilization, even on finite capacity resources.

Working
Working time considers only the process portion of operations. For infinite capacity resources this can, of course, be greater
than 100%.

Idle
Idle time is identified as time when a resource could be utilized but it is not. For infinite capacity resources this is difficult to
express in a consistent manner, so the nominal capacity of the infinite resource is used (see below).

Over
Over is used to display when there is no time available on the resource to process the operation, but it has work forced upon
it. In percentage mode, if the Over value covers a whole time bucket, the infinity symbol is displayed.

100% Marker
It is possible to 'overload' resources. For example - when sequencing operations on an infinite capacity resource (or using
infinite capacity mode) or against a secondary resource which is unconstrained. For this reason, when a resource is loaded
above its nominal capacity, the 100% point in the bucket is markedwith a dashed red line. For infinite capacity resources this
line represents where the resource would be fully utilizedwere it a finite resource, and for overloaded secondary resources the
point at which the resource would be fully utilizedwere the constraint in effect. Resource groups can also be overloaded in this
way, where the sum of the nominal capacity available within that group is considered.

Note: When a period of time is defined as having zero availability on a resource, that time bucket will be shown as
100% unavailable. This is displayedwith the warning symbol on a red background.
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Utilization Data
It is possible to extract the underlying utilization data that is the basis for the utilization view. This can be achieved in a few
different ways. To extract the data for a single row (i.e. a primary resource, secondary resource or resource group), select
'Copy' from the context menu for that row. To extract all data for all rows in the view, select 'Copy all' from the same menu.
When you copy data for all rows, the name of the row is included. When you copy data for a single row, it is not.

The copied utilization data is formatted such that it will paste easily into a spread sheet where further analysis can be done.

Plots

Plot Window
Not available in Preactor Express.

The window is displayed by selecting the Plot Window option from the Viewmenu bar command. It displays Secondary
Constraint, Resource Group and Primary Resource usage. It allows you to view plots of capacity utilization or to examine the
work in progress waiting to be processed at a resource at any point in time, i.e. 'Resource Workload Queues'.

You can zoom in on both the vertical and horizontal axis of these plots, using the Zoom and Scale option from the View
command
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The plots viewed can be chosen using the 'Configure plots...' option from the Viewmenu or by right clicking in a primary
resource plot.

If you right click in a secondary resource plot the following options are presented:

Option Description

Print Provides a print out of the plot selected.

Save Data to Disk Saves details of the selected plot as a .csv file.

Enable/Disable Check
When disabled, it prevents a warning message appearing if the usage of the secondary resource
exceeds its maximum value, while operations are being dragged and dropped in the Gantt
Chart.

Enable/Disable Constraint When disabled, the secondary constraints maximum value may be exceededwhile sequencing.

Edit Calendar Presents the Calendar Period dialog, allowing the calendar values to be modified.

Using the Zoom option from the View menu, you can zoom in/out on both the vertical and horizontal axes of the plots.

If a workspace is saved, with the Save Workspace option from the Windowmenu bar command, the current configuration and
zoom settings will be retained.

Data Stored in the .csv File
Below is an example of what data is stored in the .csv file:
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Metalwork Operator Usage (Min 0: Max 2)
02-01-2000 00:00,3.65270000000000000e+004,0.00000000000,0.00000000000,2.00000000000
03-01-2000 00:00,3.65280000000000000e+004,0.00000000000,0.00000000000,2.00000000000
12-01-2000 06:00,3.65372500000000000e+004,2.00000000000,0.00000000000,2.00000000000
12-01-2000 22:15,3.65379270833680640e+004,1.00000000000,0.00000000000,2.00000000000
12-01-2000 22:45,3.65379479167129760e+004,2.00000000000,0.00000000000,2.00000000000
13-01-2000 00:00,3.65380000000000000e+004,0.00000000000,0.00000000000,2.00000000000
13-01-2000 06:00,3.65382500000000000e+004,2.00000000000,0.00000000000,2.00000000000
13-01-2000 07:35,3.65383159722916750e+004,1.00000000000,0.00000000000,2.00000000000
13-01-2000 09:05,3.65383784723032510e+004,2.00000000000,0.00000000000,2.00000000000
13-01-2000 09:45,3.65384062500463110e+004,1.00000000000,0.00000000000,2.00000000000
13-01-2000 10:45,3.65384479167476970e+004,0.00000000000,0.00000000000,2.00000000000
09-02-2000 02:00,3.65650833333333360e+004,0.00000000000,0.00000000000,2.00000000000
09-01-2001 09:00,3.69003750000000000e+004,0.00000000000,0.00000000000,0.00000000000

No headers will be included, and in total there are 5 columns per line of data.

Column Description

Column 1
Time at which the data point occurs, except for start and end lines, which are extra points used
internally by Preactor. The data point will occur whenever the min or max usage values change.
Will be displayed as a DD-MM-YYYY HH:MM:SS value.

Column 2
Numeric representation of the time, as it can be necessary to show small difference in time that
would not be shown by the Column 1 value.

Column 3 Numerical value of the Constraint Usage.

Column 4 Numerical value of the Constraint Minimum Value.

Column 5 Numerical value of the Constraint Maximum Value.

Secondary Constraint Usage
You may define a number of secondary constraints (resources) to be used by a primary resource and/or product. For example
a machine may require an operator or a tool to carry out an operation.

In the Sequencer's Plots window a plot for each secondary resource is available. You can define the color of the plot and a color
change when the usage exceeds a defined level. In Preactor 200 FCS secondary constraints have infinite capacity and
therefore plots are used to show excessive demand for the constraint.

It is also possible to define different secondary constraint usages for each resource that can perform an operation within a
work center or resource group. For example two resources A & Bmay do the same process. Resource Amay require an
operator but resource B does not.

In addition to using Secondary Constraints, it is possible to create groups of constraints that can be applied to either a
Resource or an Operation. Creating Secondary Constraint Groups allows for Preactor to make selections from a list of
Secondary Constraints, in a similar way to how Primary Resource selection is made. Using Groups is beneficial when there is a
requirement to model a system where operators, for example, are multi-skilled.

Usage Plot Display Settings
Are applied to plots in the Sequencer's Multi Plot window:

Plot Color - the color of the Usage Plot displayed in the Sequencer's Multi Plot window.

Plot Fill Pattern - sets the Usage Plot's fill pattern.
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Usage Max. Hours - a value entered in this field defines the level at which the plot color changes to that specified in the 'Plot
Color Above Max. Hours' field. If left as 'Unspecified' a line will be drawn to display the maximum number of hours available.

Plot Color Above Max. Hours - this color is used to define those areas of a Usage Plot, displayed in the Sequencer's Multi Plot
window, that exceed the value specified in the 'Usage Max. Hours' field.

Set Up Time Line Color - this color is used to define line in a Usage Plot, displayed in the Sequencer's Multi Plot window, that
represents set up time.

Materials

Pegging Materials
Links between orders need to be established first before operations in the 'Unscheduled Operations' window can be scheduled.
Select the 'Peg Materials' option from the 'Tools' menu in the Preactor Sequencer, this will run the StandardMaterial Control
module (SMC) and create the links between the orders.

SMC will run using whatever 'Pegging Rule' has been set as the default in the 'Material Control Configuration' table. Please read
the 'Building Pegging Rules' section for more information on how to create material control rules.

The orders can be scheduled, once the order links have been created. Orders that have shortages will not be scheduled unless
the shortage has been ignored.

Supply, Demand and Works Orders
Importing Orders into Preactor

Order data can be imported by choosing the Import Orders from ERP option:
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When this option is selected, a PESP script is run that will import the data from some import files into Preactor, populating the
Supply, Demand, Works Orders and Bill of Materials tables.

The Supply, Demand andWorks Orders tables can be accessed by going toMaintain Database.

The tables are listed under the Orders sub category. The Bill of Materials table is listed under theMaterial Control sub
category.

Supply Orders Table

The Supply table holds orders for current or future production that do not utilize resources. These will be orders such as
purchase orders where parts have been ordered from a different factory, or stock orders using parts that have already been
made. A field called Supply Date is used to define when the materials become available for consumption. Records in this table
are referred to as 'supply orders' and are shown in the Supply area of the Preactor Sequencer Gantt Chart positioned at the
point specified in the supply date field.

DemandOrders Table

The DemandOrders table holds the orders for final consumption. These will be orders such as sales or make to stock orders;
again these orders do not utilize resources, they are the orders for finished products. A field called Demand Date is used to
define when the materials are required by. Records in this table are referred to as 'demand orders' and are shown in the
Demand area of the Preactor Sequencer Gantt Chart.

Works Orders Table

The Works Orders table contains the orders that are to be scheduled on the resources area on the Sequencer Gantt Chart.
Typically these will be orders for parts that when combined together produce the final product to be consumed by orders in the
demand orders table.

Supply, Demand andWorks Orders in the Preactor Sequencer.
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In the Preactor sequencer, the Gantt Chart is divided up into three different areas, the first area is for supply orders, the second
is for works orders and third is for demand orders.

The Supply Orders area is used to visually showwhen the supply order is available to be consumed. The Demand orders area is
used to visually showwhen the demand orders require the material to satisfy the Demand Date. The milestones on the Gantt
Chart provide an access point to these supply or demand orders in their respective areas.

To access supply or demand orders, right click on a milestone on the sequence Gantt Chart. A list of orders applicable at that
point in time will be displayed. Hover the mouse pointer over an order of interest, the following options will be displayed: Open
in Material Explorer, Edit Record, Highlight All Related, Highlight Subsequent Operation(s) and Highlight All Subsequent
Operations.

Open in Material Explorer

This will open the 'Material Explorer' window and display the selected order and any orders it is linked to.

Edit Record

This will load up an 'Edit' dialog allowing details of that order to be modified.
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Highlight All Related

This option will highlight all orders related to the selected order.

Highlight Subsequent Operation(s)

This option will highlight all immediate subsequent operations related to this order.

Highlight All Subsequent Operations

This option will highlight all subsequent operations related to this order.

Works orders can be edited by either double clicking on an operation on the Gantt Chart or opening the Editor Window from
the Viewmenu. The Editor Window displays works orders only.

Operation Relationship Lines in the Preactor Sequencer Gantt Chart

Relationship lines can be displayed in the Preactor Sequencer Gantt Chart after orders have been pegged and scheduled, by
selecting the Show Operation Relationships option from the Viewmenu. Lines will be drawn to show relationships between
all orders and operations, including demand and supply orders. The solid lines show links between operations of the same
order, dotted lines show links between different orders and red dotted lines show that a demand order is receiving its materials
past the Demand Date.

The highlighting features can be used to improve the visibility of the lines drawn in the Gantt Chart. If the ShowOperations
Relationships is toggled on in the Viewmenu, only lines pertaining to a (set of) record(s) will be shown.
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The image below shows all the subsequent orders for A104. This was done by right clicking on the first A104 operation, going
to Highlight Options and selecting All Subsequent Orders.

Material Explorer
The material explorer is available in SMC enabled configurations. It provides an interactive graphical representation of links
between orders, it accommodates easy access to orders and related orders using its drill down navigational facilities, it can be
used to lock or unlock links between orders, highlight shortages and report unused quantities. Material plots relating to the
selected order will also be displayed.

Accessing the Material Explorer

The material explorer can be accessed in a variety of ways:
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l From the 'View' menu in the Preactor Sequencer select the 'Material Explorer' option.
l Select the toolbar button on the 'Standard' toolbar.
l Right click on an operation and select the 'Show in Material Explorer' option that appears on the popupmenu.
l Right click on any diamond image on the Sequencer Gantt Chart, hover the mouse over any of the listed orders and
select the 'Open in Material Explorer' option from the pop upmenu.

Material Explorer Features

The main portion of the 'Material Explorer' window provides an interactive graphical diagram of the order that is being viewed
and the operations that the order comprises of. It also displays any immediate supply or demand orders that relate to that
order. It shows the amount of each item required to fulfill the order, and the amount that the order itself produces, if the
operations have been scheduled the times that materials become available is also displayed. The supply orders are displayed on
the left hand side of the order being viewed and the demand orders are displayed on the right hand side. It is possible to double
click on any of the 'supply' or 'demand' orders to drill down to the orders that relate immediately to them.

Any shortages of an item are shown as a red triangle with a white exclamation mark:

Any unused items are displayed as a stock pile:

The magnifying glass in the bottom left hand corner of the graphical order display screen can be used to zoom in or zoom out.

Locking/Unlocking of PeggedMaterials

Links can be locked after running the 'Peg Materials' option from the 'View' menu. When a link has been locked, it will not be
deletedwhen the 'Peg Materials' option is selected again. To lock a link, follow these steps:

In order to lock a link, orders must already be pegged together (to peg orders select the 'Peg Materials' option from the 'Tools'
menu).

1. Open the 'Material Explorer' window by selecting 'Material Explorer' from the 'View' menu in the Preactor Sequencer or
using any of the other methods described previously for accessing the 'Material Explorer'.

2. Rest the mouse pointer over the beginning or end of a link to a specific item. A padlock icon will be displayed.
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3. Click the mouse button once to lock the link; a padlock will appear on the link that is locked.

To unlock the link, again follow the same steps and click once on the padlock to unlock the link, the padlock image will
disappear.

Scheduling Despite Shortages

Preactor by default will not allow orders with shortages to be scheduled. See also Schedule Despite Shortages feature
description. This behavior can be overridden by ignoring the shortage. To ignore a shortage, follow these steps:

1. Open the 'Material Explorer' window by selecting 'Material Explorer' from the 'View' menu in the Preactor Sequencer or
using any of the other methods described previously for accessing the 'Material Explorer'.

2. On the 'Issues' panel, expand the shortages area by clicking on the arrow next to the 'Shortages' text to display all short-
ages.

3. Double click on one of the orders listed that has shortages. The graphical view of the order will be displayed.

4. In the graphical view of the order, double click on the red triangle that represents the shortage that you wish to ignore.

The red triangle will turn gray, and the shortage will now be ignoredwhen scheduling the operations.

Order Description
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The first panel on the right hand side of the Material Explorer provides information about the order currently being viewed.
This panel includes back and next buttons for easy navigation when exploring different orders and a refresh button to redraw
the screen when changes have been made to any orders.

Search Facility

A search facility is available in the second panel displayed on the right hand side of the Material Explorer. This search feature
will locate order numbers that match the search text. The search option is case sensitive andwill perform sub string searches if
the entire text has not been entered. Double clicking on the located order will alter the order displayed in the main window of
the 'Material Explorer' so that the order displayed is the located one.

Issues Panel

The 'Issues' panel can be used to display orders that have shortages or unusedmaterial. Clicking on the arrow next to either
the 'Shortages' or 'UnusedMaterials' sections expands the dialog to display any items that are short or unused. You can double
click on any order shown in the 'Shortages' or 'UnusedMaterials' area to display it in the main 'Material Explorer' window.

Material Plots

The material plot in the lower left portion of the 'Material Explorer' displays a graph showing the quantities of an item over
time, and how the quantity varies as the item is produced and consumed.

If the order currently being viewed in the graphical area relates to several other materials, a plot for each material will be drawn
and tabs to switch between each plot will be visible in the plot window.

The plot will show both positive and negative quantities. A circular icon is displayed at a point on the graph where a change has
occurred in the quantity. If the mouse is hovered over the circle, a tip display pops up detailing the exact time that the change
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in quantity occurred, the current stock level, the order(s) that caused the change and the quantity produced or used by that
order. It is possible to navigate to the order(s) displayed on the tip display by resting the mouse pointer over the order and
clicking on the hyperlink when it appears.

The pale blue and amber vertical lines drawn on the plot represent stock movements (operations must be scheduled to see the
amber line). The amber line is the currently selected item in the graphical diagram of the order, and is drawn at the time when
the selected order consumes the material it is linked to. The pale blue vertical line is drawn at the time when the supply order
feeds the currently selected order.

A zoom facility in the lower left corner of the material plot is available to enhance visibility.

Static Stock Line
Preactor can be customized to enable the indication on the Material Explorer stock plot of a line representing a stock level for
each part, at a value supplied by the user.

The line is labeled using a tooltip with the name of the field in which the value is specified, and its provisioned value.
The indicator is visible at all zoom levels.

The use of this field would typically be used to show the minimum stock level.

The Customization Help (Index: Static Stock Level Indicators) provides details of the activation of this field.

Sequencing

Unscheduled Operations Window
A view of the currently unscheduled operations can be obtained from the Sequencer menu option:

View ► Unscheduled Operations
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From here:

l All operations can be sequenced (using the Sequence menu option or the appropriate toolbar icon).

l The operations for a single order can be sequenced. Right click on an operation for that order and select Place on
Planning Board:

l Change an order to split the batch – See Manual Batch Splitting for details.

l Highlight the order in a number of different ways.

l Find out why an operation has not been scheduled. Right click on an operation that was left in the Unscheduled
Operations Window after a scheduling run and choose the Reason Not Allocated option.
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Amessage will be displayed explaining why the operation was not scheduled on the planning board.

Orders that are already on the Planning Board can be removed from it and placed in the Unscheduled Operations window by:

l For all operations, use the Sequence menu option to Remove Operations from the Schedule or the appropriate toolbar
icon.

l From the Gantt Chart window, select an operation and right click to remove the whole order, or subsets thereof.

Automatic Sequencing
Preactor Express uses sequential or order at a time scheduling method, which allows you to work with rules such as 'priority',
'due date', etc to decide the ranking of orders. Many production schedules can be tried and compared before being released to
the shop floor for execution.

Automatic sequencing of the schedule file is accomplished in the Sequencer using options under the Sequence menu bar
command, or the equivalent toolbar buttons.

When sequencing orders the user must consider the manner in which orders are loaded to the Planning Board, e.g. Forward,
Backward etc. and how the sequence of loading will be organized, e.g. by priority, due date or schedule sort order.

To sequence all orders lying in the Unscheduled Operations Window:

1. Determine the scheduling criteria you wish to use.

You may wish to forward sequence in due date order.

2. Under the 'Sequence' menu bar command select 'Forward Sequence'.

A submenu displays the options: 'Forward By Priority', 'Forward By Reverse Priority', 'Forward By Due Date' and 'Forward By
Schedule Sort Order'.
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3. Select the 'Forward By Due Date' option.

All orders are forward sequenced by Due Date in the Gantt Chart window.

Forward Sequencing
Forward Sequencing is accessed from the Sequencer's Sequence command and provides the following sequencing options:

Backward Sequencing
Backward Sequence is accessed from the Sequencer's Sequence command and provides the following sequencing options:

Bi-Directional Sequencing
In bi-directional sequencing one operation is locked, e.g. a bottleneck operation or one that is performed on a critical resource.
Operations upstream of the locked operation are sequenced backwards from its start time, while downstream operations are
forward sequenced from the locked operation's end time.

One example of its use is shown here.

To sequence bi-directionally:

1. Starting with a blank schedule, click the Generate Schedule button .
This places the orders on the Planning Board.

2. Click the Highlight Bottleneck Operations button , either by going to View, Highlight Options, or by enabling the
Highlight Options Toolbar.

If more operations than the bottleneck one are highlighted, click the Highlight Filter Mode button , , on the Advanced

Filters Toolbar, and from the subsequentmenu, select Filtered Operations, .

3. Click the Lock Highlighted Operations button, , from the Highlight Options Toolbar.

4. Remove all the highlighting and filtering by clicking the Cancel All Highlights button, ,from the Highlight Options
Toolbar.

5. Unschedule the unlocked operations using the Remove Operations from Schedule button, .

This will leave the operations that were not highlighted on the schedule.

6. With the Sequence Toolbar enabled, click the Sequencing Direction button and select Sequence Bi-directionally, .
7. Forward sequence any operations remaining in the unscheduled operations window.

This approach would give orders using bottleneck facilities priority on resources upstream of the bottleneck.
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Bi-Directional Sequencing
Bi-Directional Sequencing For All Locked Operations, is accessed from the Sequencer's Sequence command and provides the
following sequencing options:

Sequencing by Weight
Deciding which operation to sequence can be dependent on normal rules (e.g. forward sequencing, backward sequencing, bi-
directional sequencing) as dictated by the common attributes of Priority, Reverse Priority, Due Date or File Order.

It is also possible to sequence operations based on the consideration of a list of attributes, with the relative weighting given to
each attribute controlled by the user.

Modifying the Weighting
When enabled, the Set Weight option is available in the 'Sequence' menu:

Selecting Set Weight opens the window allowing the relative weighting to be provisioned.

The user simply selects Highest Value First or Lowest Value First and adjusts the sliders for each attribute, then hits OK to
apply the desiredweighting to the scheduling.

The icon at the top of each attribute indicates the type of value that attribute is:

is for a Duration

is for Date/Time

is for a toggle or Boolean
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is for a Number.

Sequence by Weight
To sequence using the provisionedweights for the attributes, the Sequence Menu has a ‘… By Weight’ option for the Forward ,
Backward and Bi-Directional sequencing options:

Sequence by weight at the next sequence can be set from the Sequencing Order toolbar:

The Weighting Rule
Preactor applies a calculation to the values of the weighted attributes to effect the order the operations are sequenced.

Consider the following:

Attribute A
Range of values
for all operations

Attribute B
Range of values
for all operations

Attribute C
Range of values
for all operations

Weighting
with Highest Value
First setting

Min Value 0 12 Jan 1st 2012 0

1

20 14 2

3

4

Mid Value 50 17 Jan 6th 2012 5

6

7

20 Jan 9th 2012 8

9

Max Value 100 22 Jan 11th 2012 10
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Here we see how the weighting of the values of an attribute is normalized across the range of values that attribute has with
the operations being scheduled. Note:

l A value of 20 for Attribute A will not have the same weighting as the same value for Attribute B.
l A value of 20 for Attribute A has the same weighting as a value of 14 for Attribute B.
l A value of 20 for Attribute B has the same weighting as a value of Jan 9th 2012 for Attribute C.

The overall weighting of an operation is a product of all that operation's weighted attributes.

Customization Classifications:

l WEIGHTED
l SEQ WEIGHT

Manual Sequencing
In the Sequencer's Gantt Chart, icons in the Unscheduled Operations window represent operation of any unscheduled orders.
Icons can be treated as the electronic equivalent of the cards that you would place in slots on a manual planning board.

The data associatedwith each operation can be viewed and edited by double-clicking on the icon itself, or on its associated
Gantt bar in the Sequence Gantt Chart.

Preactor allows you to drag and drop operations onto resources in the Gantt Chart window from the Unscheduled Operations
window.

To load the icons/operations onto the resources:

1. Under the Schedule sub category select the Generate Schedule action.

The Sequencer is displayed.

2. Select the required icon in the Unscheduled Operations window by clicking on it with the mouse and holding down the left
mouse button.

3. Drag the icon with the mouse to a suitable resource on the planning board.

When you move the icon over a suitable resource a Gantt bar is displayed.

4. Release the mouse button to drop the operation onto the resource, at a selected point in time.

Similarly, the schedule can be edited by picking up and dropping the Gantt bars in the Gantt Chart. Notice that the size of the
bar changes as you move over the chart. This is because the Preactor continually re-calculates the process time and takes into
account the shift patterns of a resource over which the bar or icon is placed.

Loading/Unloading Operations Using Filtering and High-
lighting
The Highlight Options Toolbar andAdvanced Filters Toolbar can be used together to load/unload operations with specific
attributes in the following windows:

l Unscheduled Operations.
l Gantt Chart.
l Editor Window.
l Trace Chart Window.

The following will provide an example of how to sequence operations (using APS rules) around bottleneck operations.

- 278 -



Sequencing

1. Starting with a blank schedule, click the Generate Schedule button .

2. Click the Highlight Late Orders button , either by going to View, Highlight Options, or by enabling the Highlight
Options Toolbar.

3. Click the Highlight Filter Mode button , , on the Advanced Filters Toolbar, and from the subsequent menu, select

All Previous Operations, .

4. With the operations highlighted, unschedule them, using the Remove Operations from Schedule button, .
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This will leave the operations that were not highlighted on the schedule.

5. Remove all the highlighting and filtering by clicking the Cancel All Highlights button, ,from the Highlight Options
Toolbar.

6. Click the Highlight Enablement button, , on the Advanced Filters Toolbar.

7. Click the Lock Highlighted Operations button, , from the Highlight Options Toolbar.

The operations currently on the schedule are now locked and cannot be unscheduled until they are unlocked.
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8. From the Sequencemenu, select Backwards Sequence, then Backwards By Due Date.

The outcome of performing the above is that there are no late orders, and only one early operation. Further highlighting,
filtering and sequencing manipulation can be carried out until the schedule fits with a manufacturing requirement.

Operation Locking
Once scheduled, individual operations can be locked onto the planning board (they will not be removedwhen a reschedule
occurs) in a number of ways.

Individual Operations
Single operations may be locked, one at a time in the Gantt Chart, by double clicking on an operation to open the Edit Orders
Information dialog and checking the Lock Operation check box. Similarly operations can be unlocked one at a time.

By Order
All of an order's operations can be locked together. To highlight and lock the required order, use the Highlight Options from
the Viewmenu. In the Highlight Optionsmenu, select the order to be locked.

Select the Lock Highlighted Operations button to lock all the order's operations. Similarly an order's operations can all be
unlocked this way.

By Attribute
An alternate method of locking or unlocking multiple operations uses attributes.

Use the Viewmenu to select an appropriate attribute and use the Lock Highlighted Operations button to lock or unlock all
operations with the same attribute value.
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By Resource
Another method of locking and unlocking multiple operations at a time is to right click on a resource name in the Sequencer
and use the lock/unlock options to lock all operations that are currently assigned to that resource.

By Time
A further method of locking multiple operations at a time is, in Calendar Edit mode, to drag the terminator time to some time
in the future. Operations that lie within or across the terminator will not be removed from the schedule.

Shortcuts
There are a number of shortcuts to facilitate locking. These include:

l Keyboard Shortcuts can be setup to Lock (and unlock) operations.
l When in Locate ► Highlight Locked Operations, using shift + left mouse button on an operation will toggle the lock
operation parameter for that operation.

In the Editor Window, a field can be placed from the Field Chooser dialog called Lock Operation, which displays whether an
operation is locked or not. This field can be filtered on to display only locked or unlocked operations, or both.

Schedule Despite Shortages
By default Preactor will not schedule orders that are affected due to the shortages ofmaterials. This default behavior can be
overridden by the Schedule Despite Shortages feature. There are two different ways that shortages can be ignored.

l Globally by choosing the Sequence ► Schedule Despite Shortages option.

l Individually by marking items as short in Material Explorer.

Globally Applying Schedule Despite Shortages
Follow these steps to globally schedule despite shortages:

1. Run SMC by choosing the Tools ► Peg Materials option.
2. Schedule the operations.
3. Select the Sequence ► Schedule Despite Shortages option.
4. Schedule the operations again. Any operations that were unscheduled due to shortages will be placed on the planning

board.

Individually Ignoring Shortages
Shortages can be ignored on an individual basis using Material Explorer. Please view the Material Explorer section for more
information on this feature.

Infinite Capacity Sequencer Mode
Sequencing can be performedwith resources constrained as provisioned, or in Infinite Capacity mode where Primary and
Secondary resources/constraints are removed or adjusted. Infinite Capacity sequencing may be used to help determine where
additional resources can be placed to meet demand.

Infinite Capacity Sequencer mode is enabled/disabled by toggling the toolbar icon or on the Tools menu.

Datasets include the state of the Infinite Capacity Sequence mode when saved and opened, to allow any over-utilization of
resources to be maintained.
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The scope of which resources are set to Infinite Capacity when this mode is enabled can be modified.
Here you see the fields where this Alternate Behavior is defined for a Resource:

Here you see the settings for the Secondary Constraint:

By default (or when Alternate values are not configured to be part of the configuration), the following behavior is exhibited
when enabling this mode:

l All primary resources become ‘Infinite with shift pattern’.
l All secondary constraints become ‘unconstrained’.
l All secondary constraints are no longer checked as part of the sequence validation.

Turning off this mode, after creating a schedule when in Infinite Capacity Sequencer mode that produces a schedule that over-
utilizes a resource, will result in the schedule being changed to remove the over utilization.

An example use of this capability could be as follows:

l Sequence normally to identify orders not meeting their due dates.
l Un-sequence orders not being met.
l Enable Infinite Capacity
l Sequence Backwards by Due Date.
l The Utilization Window shows resource over-utilization, providing an insight into where additional resources can be
placed to meet targets. "Utilization View" on page 259 for more information.

Order Status
An order can be given a status such as Suggested, Released or Confirmed etc.

The Order Status option accesses the Order States table where criteria can be defined for a given Order Status Category, e.g. a
name, operation bar pattern and a description of the status category.
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The Operation Bar Pattern is displayed in the Gantt bar on the Planning Boardwhen the operation is set to a specific order
status in the Sequencer.

Order Enquiry Process
Where there is an inbuilt table of routing information, a (possible) multi-level BoM and sub-assemblies, the user can use the
Order Enquiry button to find the earliest delivery date for a batch of product. Where a multi-level BoM and sub-assemblies exist,
Preactor will leverage the routing and BoM explosion features, allowing for orders to be created for all of the required items
which are currently in a shortage state.

To make an Order Enquiry:

1. Click the Order Enquiry button from the Sequence toolbar, or by going to Tools ►Order Enquiry. This will open the
Order Enquiry dialog.

2. Enter the enquiry details in the dialog, and then click OK to start the enquiry.
3. Once the enquiry is complete, the following dialog will be displayed.

Yeswill confirm, sequence and highlight on the planning board the proposed sequence of operations. No will revert the
sequencer back to it's "pre-enquiry" state. Change will allow the user to edit the enquiry details.

In order for an Order Enquiry to work as intended, the Run SMC on Order Enquiry event script must be enabled.

Schedule Repair
The user has access to a schedule repair button.

Schedule repair can be used to correct a schedule where small alterations to actual start and finish times for an operation have
caused operations within an order to overlap (assuming transfer batching has not been defined as allowed). Schedule repair
will keep operations on the same resource (where possible) but adjust the start and finish times for un-started operations to
maintain the correct operation sequence within an order.
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The Schedule repair facility is intended for use in simple scheduling environments. If you have a more complex scheduling
environment using, for example, secondary constraints, material control (pegging), inter-operation constraints, APS
scheduling rules, etc. you may find that you have to unschedule and reschedule instead.

To use the schedule repair facility:

1. In the Sequencer's Tool command, click on the Schedule Repair button.
A Schedule Repair Parameters dialog is opened.

2. Check the check box if you are prepared to allow operations to be scheduled earlier.
The options are:

l Allow Sequence Change
This allows the operations for an Order being worked on a resource to be sequenced in a different order - e.g. Order 2
may be processed before Order 1.

l Maintain Sequence when Possible
This option allows the sequence of operations scheduled on a resource to differ from the sequence in which they were
originally placed. The operation sequence within an order will be maintained but operations may be placed in a different
sequence relative to operations from a different order. The Resource on which an operation is placedwill be maintained
unless this is impossible due to sequence violations, in which case the operation will be unallocated.

l Prevent any Sequence Change.
No sequence change is allowed. If a single operation cannot be placed in the same sequence then EVERYTHING that was
sequenced after that operation will be unallocated – because the sequence could not be maintained..

3. Choose a preferred sequencing option by highlighting the appropriate radio button.

Amessage is receivedwhen the repair has been complete.

Parallel Operations
Each operation in a process route has a number, say 10, 20, 30 and so on. If two operations are defined as number 10, both of
these operations must be scheduled to finish before sequencing operation 20. In effect the two operations 10 will be
processed in parallel providing, of course, that the required resources are available for use.

Transfer Batching
You can define transfer batching between operations. For example a batch of 100 could have a transfer quantity of 20. Then
as soon as the first 20 parts have been completed the next operation can be scheduled for the subsequent operation.

To define transfer batching between operations:

1. In the Products table, open the recordwhere you wish to split the batch.

The 'Edit Products Information' dialog is displayed.

2. Click 'Operation Attributes'.
3. In the Attributes dialog, input a value into the Transfer Type dialog.
4. Click 'OK' to close the dialog.

Manual Batch Splitting
The quantity scheduled for production or batches in production may be broken down into smaller lots.
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To split a batch manually:

1. In the Sequencer's Unscheduled Operations or the Gantt Chart window, right click with mouse on an operation where
the batch quantity is to be split.

2. From the pop-upmenu, select the Split Batch option.

A dialog headed Total Quantity is... is displayed.

3. Edit the 'Quantity' field to the smaller batch quantity and click 'OK'

The original quantity is written down and a new smaller batch created. This is represented by an icon in the Unscheduled
Operations window or a bar in the Gantt Chart.

4. Either, load this batch manually in the Gantt Chart or place it in the Unscheduled Operations window.

To sequence the split batch from the Unscheduled Operations window, right click on the record and select 'Place on Planning
Board' and then the forward or backward sequencing options.

Lot Splitting
You can specify at an operation that a batch is split into smaller lots. For example a batch of 20 may be split into lots of 10.

To define lot splitting at an operation:

1. In the Products Data Table open the recordwhere you wish to split the batch.

The 'Edit Products Information' dialog is displayed.

2. Click on the 'Operation Attributes' pushbutton.
3. In the subsequent dialog, set the 'Batching Method' field to 'Split'.

A 'Lot Size' fields is displayed in the dialog.

4. Define the lot size you require the batch to be split into in this field.
5. In a Preactor 300 FCS you can check the 'Independent Lots' check box to allow the split lots to proceed independently1.
6. Click on the 'Previous' pushbutton and then click 'OK" to close the dialogs.

Cost Calculation
Cost calculation by operation and schedule.

A User can define a number of data fields associatedwith costs. For example you can define the cost per hour for resources,
whether these are multiplied depending on calendar state (e.g. on-shift and overtime variations), andmaterial cost for each
operation. The cost for each operation may be displayed in a tool tip in the sequencer Gantt Chart. As an operation is dragged
and dropped to an alternative resource or is rescheduled or overtime added, so the operation cost is recalculated.

Additional order cost report.

Where cost information has been added then a standard report is available which displays the cost for each operation for an
order and a total cost for the order.

1This is used for example to allow the batch to be processed across more than one resource in a resource group or work cen-
ter.
It is also usedwhere a resource can only process a smaller lot at a time e.g. an oven can only take 10 parts at a time.
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Mid-batch Update
Available in Preactor 300 FCS systems and above, this feature enables you to apply a mid-batch update for a batch at an
operation, e.g. you may wish to enter the quantity complete and time for part of a batch.

Preactor uses this information to calculate the 'Effective Operation Time'.

To apply a mid-batch update:

1. Open the record you wish to amend in the Sequencer's Gantt Chart or Editor windows.

The 'Edit Orders Information' dialog is displayed.

2. Select the 'Operation Status' pushbutton.

The 'Edit Orders Operation Status Information' dialog is opened.

3. Complete the 'Mid Batch Time' and 'Mid Batch Quantity' fields.
4. Click on the 'Previous' pushbutton and then the 'OK' button to close all dialogs.

When these dialogs are closed Preactor calculates the 'Effective Operation Time' to date. The operation bar is adjusted in the
Sequencer and the portion of the operation bar representing the progress of the operations is now shaded on the operation
(the default color is Silver, this can be changed in the Preactor Desktop under Configuration ► Sequencer Configuration ► Set
Progress Control Color)

If the 'Edit Orders Operation Status Information' dialog is reopened, it will be seen that the 'Effective Op Time' field now shows
the calculated value.

Operation Completion
When an operation is finished it can be set as 'Complete' in the Sequencer's Gantt Chart. Setting an operation as 'Complete'
sets the current start and end times as 'actual' values, unless these are overwritten. In addition the operation can no longer be
removed from the schedule, it is locked to the planning board.

To set an operation as 'Complete':

1. In the Sequencer, double click on the particular operation, in either the Editor or the Gantt Chart.

The Edit Orders Information dialog is displayed.

2. Left click on the 'Complete' check box to lock the operation.
3. Click 'OK' to close the dialog.

Bear in mind that the Start and End Times may not be the original times, these values may be changed if the operation's Gantt
bar is moved, or in a Preactor 300 FCS system, or greater, if a 'Mid Batch' time and quantity have been entered.

Inter-Operation Relationships
In the Sequencer, during scheduling, an error message can appear when using inter-operation constraints with operations
that have multiple previous or subsequent relationships. The following classifications define the inter-operation constraints:

l INTER OPERATION INTERVAL
l START OFFSET
l END OFFSET
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A multiple relationship is defined as either:

l A single operation that is the dependency for multiple subsequent operations.

l An operation that is linked to a future operation, that itself has multiple operations.

If any of the three classifications are used in the configuration, and have a value set in the data for one (or more) operations,
then an error message will be displayed. There are two main types of error messages that can be displayed, one for multiple
subsequent operations and one for multiple previous operations. The error message for multiple subsequent operations will
specify where the issue is arising from (e.g. the INTER OPERATION INTERVAL classification having a value that is not "No Limit")
and stating that the operation has more than one subsequent operations linked to it. The error message for the multiple
previous will specify which operation is causing the issue and that the operation has more than one previous operation linked
to it.

There are three options available to close the error dialog, which are:

Yes Continues to schedule operations displaying the errors.

No Continues to schedule operations without displaying errors.

Cancel Stops sequencing operations, and "rolls back" the schedule to it's previous state.

There are a number of preventative measures that can be taken in order to avoid the inter-operations issue from arising. The
first would be to not use the INTER OPERATION INTERVAL classification in the configuration. The secondwould be to set values
for the data so that the classification is not used for specific operation(s), if the classification needs to be used. Then this would
be to ensure that operation(s) that use the classification do not have any multiple operation dependencies.

Export Schedule Data to Excel
You can export user defined schedule data to an Excel spreadsheet, with either of the following options:
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l Selecting File ► Export
l Selection the Export icon in the Standard toolbar .

The current schedule data is exported to file/location defined by the PESP script For Event Export Button Press.

Suppressing Warnings in the Sequencer
Within Preactor, there are a number of command line switches that can be used to turn warnings on and off in the Sequencer.
If using these switches, Preactor needs to be restarted in order for the changes to the PRMDF to take place. If any of the
following command line switches have been defined in the PRMDF, they will be used to define the default state of whether the
warnings will be displayed:

l /NoManualMovementConstraintCheck

l /DisableFeatureWarning

l /NoExitSequenceWarning

l /SkipDataConsistencyCheck

In conjunction with the command line switches, within the Sequencer, the Optionswindow (accessible from the Toolsmenu)
contains aWarnings section where warning suppression is available.

In a scenario where none of the above command line switches are listed in the PRMDF, then the warnings will be displayed by
default in the Sequencer. When any of the check boxes have been ticked in the Options window, then warnings will then be
suppressed.

In a scenario where at least one of the command line switches has been listed in the PRMDF, the switch will define the default
state for whether the warning is displayed. The Warnings section can then be used to override any of the command line
switches.

The selections made in theWarnings section of the Options dialog are database specific, as is the use of the command line
switches in the PRMDF. The selections made in the Options dialog will be saved upon clicking OK, andwill be retained upon
closing and restarting Preactor.

Reports

Displaying Reports
The Sequencer is equippedwith a selection of standard reports.
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To access the available reports:

1. Select the Reports option from the Viewmenu bar command.

By default the Reports Panel is displayed to the right of the main window, displaying a list of available reports. Local reports will
be listed under the 'Local Reports' node.

2. Select the required report by double clicking on it with the left mouse button.

The report opens in the Sequencer's main window.

You can generate reports on different schedules that have been saved using the 'Select Dataset' facility to identify the data to
be used and 'View Report' to generate the new report on the dataset.

Shortages Report
Preactor 400 APS provides a shortage report that allows you to check whether sufficient orders have been raised to satisfy the
demands generated by the current production schedule.

To view the Shortages Report:

1. In the Sequencer click on the 'Reports' tab.

The 'Reports' panel is displayed.

2. Select 'BoM Shortages' report from the options available.

The BoM Shortages report is generated, listing orders with shortages, the shortage reference and the quantity outstanding.

Schedule Statistics
For any schedule the user may look at a standard set of statistics.

To display these statistics, with the Sequencer open select the 'Schedule Statistics...' option from the Tools menu bar
command.
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OR

Select icon:

The Schedule Statistics dialog is displayed, showing data for the currently loaded schedule:

Order Count Data

Early The number or percentage of orders for which the last operation ends before its due date.

Late
The number or percentage of the total number of orders in the schedule file for which the last operation
ends before its due date.

Incomplete The total number or percentage of incomplete orders; i.e., the number of orders for which there is one or
more operation that is not scheduled.

Started
The total number or percentage of orders that have already started, i.e., the number of orders that have
operations that start before the terminator.

Order Completion Data

Early Time

Total
The total early time for all fully scheduled orders; i.e., the sum, for all orders, of time between the end of
the last operation and the due date for that order. The calculation does NOT include data for orders for
which this value is negative as these orders are deemed to be late.

Minimum
The minimum early time; i.e., the smallest time between the end of the last operation and the due date
for that order. The calculation does NOT include data for orders for which this value is negative as these
orders are deemed to be late.

Average
The average early time; i.e., the average time between the end of the last operation and the due date for
that order. The calculation does NOT include data for orders for which this value is negative as these
orders are deemed to be late.

Maximum
The maximum early time; i.e., the maximum time between the end of the last operation and the due
date for that order. The calculation does NOT include data for orders for which this value is negative as
these orders are deemed to be late.
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Late Time

Total
The total late time for all fully scheduled orders; i.e., the sum, for all orders, of time between the due date
and the end time of the last operation of the order. The calculation does NOT include data for orders for
which this value is negative as these orders are deemed to be early.

Minimum
The minimum late time; i.e., the minimum time between the due date and the end of the last operation
for that order. The calculation does NOT include data for orders for which this value is negative as these
orders are deemed to be early.

Average
The average late time; i.e., the average time between the due date and the end of the last operation for
that order. The calculation does NOT include data for orders for which this value is negative as these
orders are deemed to be early.

Maximum
The maximum late time; i.e., the maximum time between the due date and the end of the last operation
for that order. The calculation does NOT include data for orders for which this value is negative as these
orders are deemed to be early.

Setup Time

Total The total amount of setup time for all fully scheduled orders.

Minimum The minimum amount of setup time for an order.

Average The average amount of setup time for an order.

Maximum The maximum amount of setup time for an order.

Lead Time

Total
The total lead time of all fully scheduled orders. i.e., the sum, for all orders, of the times between the
setup start of the first operation of the order to the end time of the last operation of the order.

Minimum The shortest lead time of all fully scheduled orders.

Average The average lead time of all fully scheduled orders.

Maximum The maximum lead time of all fully scheduled orders.

Added Value Percentage

Minimum

The minimum value of the added value for all fully scheduled orders. Added value for an order is the sum
of the process times for all operations divided by the lead time. Both process time and lead time are adjus-
ted by resource efficiency and capacity. Hence, if all operations in an order do not have to wait for the
resource at all and there is no setup time, the result will be 100%.

Average The average value for the added value calculation for all fully scheduled orders.

Maximum The maximum value for the added value calculation for all fully scheduled orders.

Resource Data

Working Percentage

Minimum
The minimum value, over all resources, of the working percentage calculation. The working percentage
calculation is the amount of resource capacity spent in processing jobs (not setups) expressed as a per-
centage of the total time span.

Average The average value, over all resources, of the working percentage calculation.
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Maximum The maximum value, over all resources, of the working percentage.

Setup Percentage

Minimum
The minimum value, over all resources, of the setup percentage calculation. The setup percentage cal-
culation is the amount of capacity that the resource has which is used for setup expressed as a per-
centage of the total time span.

Average The average value, over all resources, of the setup percentage calculation.

Maximum The maximum value, over all resources, of the setup percentage calculation.

Unavailable Percentage

Minimum
The minimum value, over all resources, of the unavailable percentage calculation. The unavailable per-
centage calculation is the amount of capacity that the resource has which is unavailable due to reduced
or zero efficiency expressed as a percentage of the total time span.

Average The average value, over all resources, of the unavailable percentage calculation.

Maximum The maximum value, over all resources, of the unavailable percentage calculation.

Idle Percentage

Minimum
The minimum value, over all resources, of the idle percentage calculation. The idle percentage calculation
is the amount of capacity that the resource has which is available but not used expressed as a percentage
of the total time span.

Average The average value, over all resources, of the idle percentage calculation.

Maximum The maximum value, over all resources, of the idle percentage calculation.

Utilization Percentage

Mini

mum

The minimum value, over all resources, of the utilization percentage calculation. The utilization per-
centage calculation is the amount of resource capacity spent in processing jobs (not setups) expressed as
a percentage of the total time span minus the unavailable time.

Average The average value, over all resources, of the utilization percentage calculation.

Maximum The maximum value, over all resources, of the utilization percentage calculation.

Schedule Span

The time span and duration from the start of the performance data calculation to the end of the performance data cal-
culation. The start time will be the start of setup of the earliest starting fully scheduled order for which no operations
are scheduled before the terminator. The end time will be the end time of the latest ending order.
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Web Publishing

Web Publishing
Introduction
The web publishing facility runs with Microsoft's Internet Explorer 6.0 or higher. It allows Gantt charts or Order Trace charts to
be saved as HTML files that can be placed in a local directory or a remote directory in a shared computer.

A web server can be used to expose this location, enabling a browser to view the files over an intranet or the Internet. In this
mode Preactor becomes "browser enabled". Gantt charts that are placed on a web site are not just pictures or bitmaps, each
individual bar is an object. Resting the mouse pointer on a bar reveals Tool Tips, clicking on a bar displays its dialog box. The
chart has pan, zoom and scroll capabilities and uses gauge lines, dates and times.

There are three ways of using the Preactor to release charts to be published on the web:

l Option 1 - The ' Release Schedule' option from the Workspace General or Data Transfer menus on the Preactor Desktop.
The default setting for the Release Schedule option does not generate HTML files, but this can be achieved by simply
checking the 'Action Enabled' toggle on the 'Web Publish' action in the 'Release Schedule' event script located in the PESP
Event Scripts Data Table. (Not available with Preactor Express).

l Option 2 - From inside the Sequencer, using the Using the Tools ►Web Publish menu selection.

l Option 3 - Using the Web Publisher (PWP)

Viewing HTML Files
To view the HTML files through Internet Explorer:

1. Select the Configuration option from the Navigation Pane.
2. Click on the Web Publisher option from the Active Pane.
3. Click on the ViewGantt Chart option in the Work Pane.

Microsoft Internet Explorer is opened showing the Gantt Chart.

Note that the path to the Gantt chart (gantt.html) is shown in the 'Address' field.

4. Rest the mouse over one of the Gantt bars.

Tool tips giving details of the order pop up.

5. Click on one of the Gantt bars.

Dialogs display more comprehensive information, allowing the schedule to be examined in detail.

6. Click on the icons in the bottom left hand corner of the chart to zoom in, zoom out and reset the display.

The View Custom Chart can be used in a similar manner.

Note: If Internet Explorer displays an Information Bar, (just below the Address Bar), and blocks the active content of the file you
are viewing, right click in the Information Bar and select 'Allow Blocked Content'.

Web Publisher (PWP)
Before using this facility you should ensure that the Web Publisher is configured to meet your requirements.

To use the Web Publisher:
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1. Select the Configuration option from the Navigation Pane.
2. Click on the Web Publisher option from the Active Pane.

Various options applicable to the Web Publisher are displayed.

3. Select either the Publish Gantt Chart or Publish Custom Chart to publish information for the Web.

Information will only be published if a schedule has already been generated.

The information to be published can be observed using the equivalent View options.

Web Publisher Configuration
The Web Publisher allows standard and customized Gantt Charts (HTML Charts) to be published. Some of the configuration
settings can be altered to meet your requirements. Changes made in the Web Publisher only apply when using the Publish
Gantt Chart and Publish Custom Chart options available from Configuration ►Web Publisher. They do not apply when
publishing from the Sequencer or any user definedwork flow (such as a 'Release Schedule' work flow).

To Configure a Gantt Chart publication:

1. Select the Configuration option from the Navigation Pane.
2. Click on the Web Publisher option from the Active Pane.
3. Choose the Configuration option listed on the Work Pane.

This displays the Edit PWP Configuration Information Web dialog.

4. Set the source file, output path and the dimensions for the display.

The 'Gantt Exclude Expression' field can be used to control the data displayed.

Right click on the individual field names for more information.

5. Click OK to save any changes.

To Configure a Custom Chart publication:

The lower portion of the dialog allows a custom chart to be defined.

1. Set the source file, output path and the dimensions for the display as you did for the Gantt chart but also define the
fields to be used as the axes of the chart.

2. Click OK to save the changes.

Web Publishing from Within the Sequencer
Using this method the only option available to the user is the selection of the folder to which the data will be exported.

To use this option:

1. Selecting this option is from the Sequencer ► Tools ►Web Publish.
Selecting this option opens the Browse dialog enabling the destination folder to be selected.

2. Select the required destination folder.
In this example the default Gantt folder has been used but this could be any folder on a shared networked computer.
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3. Once the OK button is selected a Web Publishing dialog depicts a progress bar showing files being copied to their
destination.
When the Web Publish icon is used only the current chart is transferred as an HTML file and no sizing options etc. are
available to the user

Web Publishing
In Ultimate editions of Preactor the user can automatically create reports and Gantt charts, to be viewedwith Microsoft
Internet Explorer.

To publish a Gantt chart:

1. In the 'Preactor Sequencer' select the Web publish toolbar button.

A 'Browse For Folder' dialog is displayed.

2. Select a destination folder for the Web Page you will create.
3. Click the 'OK' button.

You can now open the Web Page in the destination folder using Internet Explorer.

Web Publisher in Sequencer
To pass specific command line parameters to the Web Publisher from the sequencer, any command line parameter beginning
with /PWP will be passed over when the web publisher is run.

; -----------------------------------------------------------------------
; Edit Production Sequence
; -----------------------------------------------------------------------
;
S_SEQ : PRS.EXE,
"/FMT:Orders" /AS "SCHEDULE" /GF
/GL /GZC /FO
"/HideExp:Hide Route:1:({#Belongs to Order No.}!=-1)&&({Show}==0)"
"/HideExp:Hide Alternate Routes:1:({Disable Op}==1)"
"/PWP_GANTTHEIGHT:300"
"/PWP_GANTTWIDTH:700",
Sequence Jobs,

Preactor Sequencer,
Maximize,
ALWAYS:MainMenu;

;

Web Publish with PESP
The web publisher may be run from a PESP script using the 'Web Publish' action.

A list of the different command line parameters that can be entered in the 'Parameters' section of the 'Web Publish' action, can
be found in the reference section.

Here is an example:
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The PESP script could run from a shell menu button, (defined in the .prmdf file) for example:

MENU_Web_Publish : {DIALOG},
Select Option from Menu,

Publish Menu:
PUSHBUTTON | HELPPOPUPID (59100),Publish to Web,Web_Publish:
DEFPUSHBUTTON | HELPPOPUPID (53170),Return to Previous Menu,{RETURN};

;
Web_Publish: MANIP.EXE,
/RunEventScript Web Publish Event Script,

Run Event Script,
Web Publish,
Foreground,

ALWAYS:{RETURN};

Or perhaps from a toolbar button (this can be added to a PRS.dll or PREDIT.dll call in .prmdf file):

"/ActiveX:Publish:PESP.EventHandler:RunScriptByName:Web Publish Event Script"

Quick Reference

Quick Reference Configuration Guide - Sequencer
What How

Attribute Display - Color
Preactor Desktop ►Data Maintenance
►Attribute (Select Attribute)
► Select parameter

Bar Text style - for Gantt Chart and Trace
- Outline
- Small
- Rotated

View ► Bar Text

Calendars
- Display Mode:
- Hidden;
- ShowAll
- Show Zero Efficiency.
- Display Priority: Calendar on Top / Operations on Top.

View ►Calendars

Calendars - Save Calendars with Datasets Tools ►Options ►Calendar ►General

Calendars - State Hatch Style
View ►Calendars ►Calendar States
Default shortcut: Ctrl + Shift + S
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What How

Due Date Offset
Preactor Desktop: ►Configuration
► Settings

► Sequencer Settings

Earliest Start Date Offset
Preactor Desktop: ►Configuration
► Settings

► Sequencer Settings

Future Planning Horizon
Preactor Desktop: ►Configuration
► Settings

► Sequencer Settings

Gauge Lines in Gantt Chart, Trace and Plot
- Period Increment (Days, Hours etc)
- Display times, days, dates
- Weight of line between days (normal/bold)

in Zoom and Scale toolbar

Gauge Lines Show/Hide in Gantt Chart, Trace and Plot
View ►Gauge Lines (toggle)

Also in Zoom and Scale toolbar

Historical Planning Horizon
Preactor Desktop: ►Configuration
► Settings

► Sequencer Settings

Operation Thumb
Preactor Desktop: ►Configuration
► Settings

► Sequencer Settings

Gantt Chart - Resource Display Style (Stacked or Cascaded)

For a Resource:
 Temporary change - in the Sequencer:
     Right click over the resource

  Change Default: - from the Preactor Desktop
    For 1 Resource
Data Maintenance  ► Resources

►Display Options.
    For all Resources:
      Data Maintenance ► Resources

► Edit (Top ofWorkpane)
►Global Assign

               ► Resource Display Style

Gantt Chart Range
Preactor Desktop: ►Configuration
► Settings

► Sequencer Settings

Product Display
- Icon
- Display Color
- Plot setup time line color

Preactor Desktop: ►Data Maintenance
► Product  ►Double click on Product

► Product Display Data

Progress Control Color
Preactor Desktop: ►Configuration
► Settings

► SequencerSettings

Resource Display
- Display Options
- Gantt Separator

Preactor Desktop: ►Data Maintenance
► Resources ►Double click on resource

►Display Options
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- Order
- Plot color
- Plot fill pattern
- Plot setup time line color
- Style

Resource Group Display
- Plot color
- Plot fill pattern
- Plot setup time line color

Preactor Desktop: ►Data Maintenance
► Resource Groups

►Double click on resource group
►Display Options

Scaling and Zoom
- Set Range for Timeline
- Zoom In Timeline
- Zoom Out Timeline
- Zoom in Bar Height
- Zoom out Bar Height

View ► Zoom and Scale
Zoom In Timeline - Ctrl + scroll up
Zoom Out Timeline - Ctrl + scroll down
Zoom in Bar Height - Ctrl + shift + scroll up
Zoom out Bar Height - Ctrl + shift + scroll down

Secondary Constraint Display
- Display Usage Plot
- Effect in Infinite Capacity Mode
- Effect - Use 100% if greater than 0%
- Effect - Start of job efficiency
- Effect - Follow efficiency changes
- Max Value Color
- Min Value Color
- Plot color
- Plot fill pattern
- Plot setup time line color

Preactor Desktop: ►Data Maintenance
► Secondary Constraints

►Double click on constraint

Start Date Offset
Preactor Desktop: ►Configuration
► Settings

► Sequencer Settings

Terminator Offset
Preactor Desktop: ►Configuration
► Settings

► Sequencer Settings

Trace - Vertical Axis
- Customer
- Order Number
- Part Number
- Product
- Resource
- Resource Group

View ►Vertical Axis

Workspace Tooltips,
Expands info on bars in Gantt Chart, Trace and Unscheduled operations

View ►Disable Tooltips

Zoom and Scaling in Gantt Chart, Trace, and Plots
- Set Range for Timeline
- Zoom In Timeline
- Zoom Out Timeline
- Zoom in Bar Height
- Zoom out Bar Height

View ► Zoom and Scale
Zoom In Timeline - Ctrl + scroll up
Zoom Out Timeline - Ctrl + scroll down
Zoom in Bar Height - Ctrl + shift + scroll up
Zoom out Bar Height - Ctrl + shift + scroll down
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Ultimate Configurability

Ultimate Configuration
Whether you are using an Advanced Planner or an Advanced Scheduler product, the Ultimate editions of both allow extensive
configuration options and extensibility through the Preactor configuration files and APIs.

The following topics will talk you through getting the most out of the Ultimate editions of Preactor.

Some knowledge of computer programming paradigms is assumed for the majority of this content. For support or assistance
in configuring Preactor, a number of accredited Preactor Resellers are listed on the Preactor website at www.preactor.com.

Configuration File Access Control
Editing Preactor configuration files may alter the behavior of the application such that controls put in place to prevent access
or limit functionality for a user may be circumvented, or malicious or unverified extensions may be included in the application
without the user’s knowledge. For this reason, only authorized users should be granted permission to edit these files.
Configuration files implicated include, but are not limited to:

l Preactor Configuration Definition Files (.prcdf)
(Express, Standard, Professional and Ultimate editions)

l Preactor Menu Definition Files (.prmdf)
l Preactor Table Definition Files (.prtdf)
(Ultimate editions only)

Other files may be included in a configuration file (using the #include directive). These files typically have a .inc extension.

Further controls preventing modification of configuration files may be employed, for example by compiling a configuration.
"Compiling Preactor Configurations" on page 328 for more information on compiling configurations.

The Table and Menu Definition Files
Preactor's menus and dialogs can be modified to reflect the process being modeled, your organization, and your working
practices for example. Fields or features not used can be removed, new fields added, andmany other items can be customized.

Preactor Command Definition File
Most users start Preactor by double clicking on the relevant icon or by using the Windows program menu system. Under these
circumstances Preactor will use the .prmdf and .prtdf files that are contained in the working directory, and if you wish to
invoke any of the Preactor.exe command parameters you will have to modify the properties of the Windows shortcut (icon).
The Preactor Command Definition File (.prcdf) gives you an alternative way of invoking the command parameters and it allows
you to start a Preactor system directly from Windows Explorer.

The .prcdf file simply contains a set of Preactor command parameters that can specify the working directory, the .prmdf and
.prtdf files to use, the Preactor mode, etc. Preactor will automatically register the .prcdf extension with Windows so simply
double clicking on the .prcdf file in Windows Explorer will run the required Preactor configuration. If you have several different
versions of Preactor installed. Double clicking on the .prcdf file will result in running the last version of Preactor that was
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installed on your computer. If you need to run using a different version, right click on the .prcdf file and choose the appropriate
'Open With' option.

Here is an example of a .prcdf file opened in a text editor

"/DbConnect:Data Source=.\SQLEXPRESS;Initial Catalog=\"Preactor AS Ultimate\";Integrated
Security=True;"
"/MDF:Preactor.prmdf"
"/TDF:Preactor.prtdf"
"/PCO"

The Preactor Command File Editor program provides a user interface allowing the most common options to be set against the
.prcdf file. To run the Command File Editor program, right click on the .prcdf file and select the ‘Modify’ option from the Pop Up
Menu, this will load up the Preactor Command File Editor program. "Preactor Command File Editor" on page 48 for a full
description on the different features that the Preactor Command File Editor program provides.

See the reference documentation for a full explanation of the available Preactor Desktop command parameters that can be
applied.

Menu Definition File

The Preactor Menu Definition File
Overview 
The Preactor menu definition file (Preactor.prmdf) is a human-readable ASCII command file, it controls the way that the user
interacts with the system and the order in which Preactor modules are executed. It can be likened to an operating system
batch command file, but it allows the user to configure navigational menus andwork flows to manipulate complex command
parameters to personalize the Preactor configuration.

The Preactor Desktopmodule reads the Preactor.prmdf file and creates categories, sub categories, category and sub category
content items, action groups andwork flow items to organize the Preactor Desktop. The layout of these items will be seen
when Preactor is loaded, based on the definitions present in this file.

The flow of execution through the Preactor.prmdf file is controlled by labels (for example, when a workflow item is selected, go
to a given label) and by the return codes generated by the programs that are run. In this way, the flow of execution can be set
by special exit conditions or allowed to continue as normal.

Any executable program supported by the underlying operating system can be run from the Preactor.prmdf file. This allows
you to use Preactor to integrate a number of different applications to provide an integrated solution to your problem.

In order to configure Preactor, it is necessary to understand all of the syntax and parameter definitions. This section starts
with a top-level description and ultimately defines all items.

The Preactor.prmdf file has the following sections:

1. Directives

[SHELL] indicates the section of the file to be used by the Preactor Desktop program

/RunEventScript Runs specified event script defined in the 'Event Scripts' table.

#include allows other definition files to be included.

#define allows variables to be defined and conditions to be applied based on the existence of the variable.
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#label image allows an image to be joined to a program.

{MESSAGEBOX}

2. Constructs

PROGRAMS launches any of the Preactor executable modules

 or any other DOS or Windows-based program

MESSAGES defines customizedmessages for display to the user

DIALOGS defines menu options

CONDITIONAL BRANCHING controls program flow

Note: The Preactor tags, user variables, key words, labels, etc., in the Preactor.prmdf file are all case-sensitive.

Comments may be placed in the Preactor.prmdf by use of a semicolon character (;) at the beginning of the line. It should be
noted, however, that comments may NOT be placed in the middle of the definitions for program execution unless specifically
stated in the syntax for the particular construct.

Constructs
The menu definition file has four constructs: Programs, Dialogs, Conditional Branching and Application Information. All of the
structures can be called from any other structure since Preactor uses a label mechanism for determining which item is next
and all are defined between the PROGRAMS and PROGRAMS_END directives.

Strict Parsing
With strict parsing on (#define PARSE_STRICT placed in the .prmdf file) Preactor will not accept any invalid syntax in the menu
structure. Without it Preactor will try to omit invalid syntax or mark invalid workflow items as broken in the Preactor Desktop.

The rules that apply are as follows:

l Only one instance of each workflow label definition.
l Menus must be calledwhen defined.
l Workflow definitions should include a calling label.
l All target labels defined in the menu definition should exist elsewhere in the .prmdf file.

The table below describes the error messages that will appear when any of the above rules are broken.

Message Reason

The label <label name> is called but not defined.
A dialog contains a button that calls a label that does not
exist.

The message box '<label name>' at label '<label name>' con-
tains a syntax error.

The message box contains something other than TEXT or
BUTTON.

The dialog '<label name>' at label '<label name>' contains an
ENTRYFIELD. This is no longer supported.

Dialogs with ENTRYFIELD on them are no longer supported.

The message box '<label name>' at label '<label name>' con-
tains invalid buttons.

The buttons defined on a {MESSAGEBOX} are not a valid com-
bination; refer to the documentation.

The message box '<label name>' at label '<label name>' con-
tains an unknown icon type.

The icon defined on a {MESSAGEBOX} is not a valid icon; refer
to the documentation for a valid icon type.

The Uri at label '<label name>' is invalid.
The form of the URI for the specified label is not valid. Refer to
Microsoft Pack URI documentation for more information.

The menu '<label name>' at label '<label name>' does not form
part of the navigation structure. Menus of this type are no

Preactor does not allowmenus to be definedwithout being
called from another menu.
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longer supported.

The workflow label '<label name>' is definedmultiple times. Duplicate labels are not permitted.

System Include Error: More than one default system category
was found. This is not supported.

More than one default system category was found. Check
that the system includes is included correctly and you are not
defining your own.

System Include Error: The default system category was not
found.

The default system category was not found, ensure you have
included the system includes.

Could not find label '<label name>' as defined using #set
MAIN_MENU.

The label specified on the main menu syntax was not found.

Commands and Return Codes (Operand Parameters)
When you run the Preactor modules from the Preactor.prmdf file, the calling conventions assume that the module is a
separate executable file, although in later versions of Preactor they are in fact Dynamic Link Libraries (dll's). The Preactor.prmdf
calling procedures allow commands to be passed to the Preactor modules or to any other actual executable program. The
commands obey normal DOS command line conventions, and the switches are space delimited. This means that if you require
a space within your command (e.g., you are using a field name that contains spaces as part of the command), then you must
enclose the complete command in double quotes (").

For example:

"/EXC:{Start Time}<0"

See Also:

Passing Time Expressions with a Command

Conditional Branching
FUNCTION

Although it is possible to control program execution flow by using the combination of program return codes and the optional
offset user variable, there are many cases where this method cannot provide sufficient control. The Preactor conditional
branching construct allows a much more comprehensive mechanism for controlling program flow.

SYNTAX

[Label]:{CONDITIONAL},
Expression: Target Label[, Assignment User Variable = Value]:
repeats...;

PARAMETERS

Label (optional)

Label is an optional alphanumeric string that is terminatedwith a colon (:) character and is used to jump to the conditional
from another program or menu option.

{CONDITIONAL}

case-sensitive key word

Expression
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Expression is the logical condition that is to be evaluated. This may contain any Preactor tags or variables that have previously
been defined in the Preactor.prmdf file.

A condition may also be the reservedword "ELSE," in which case the program flowwill be directed to the associated target
label. If there is no "ELSE" option and none of the defined conditions are true, then the program flowwill proceed to the first
defined item (i.e., the {START} label).

Target Label

If the condition is true (i.e., non-zero), then the target label associatedwith the condition is selected.

A condition may also be the reservedword "ELSE," in which case the program flowwill be directed to the associated target
label. If there is no "ELSE" option and none of the defined conditions are true, then the program flowwill proceed to the first
defined item (i.e., the {START} label).

Assignment User Variable = Value (optional)

An optional user variable assignment statement.

EXAMPLE

Test: {CONDITIONAL} ,
{From_Date} <= {To_Date}: More_Files:
ELSE: Finished;

The above example will test the two variables From_Date and To_Date and proceed to the label More_Files if From_Date is less
than or equal to To_Date. Otherwise, program flowwill proceed to the label Finished.

Dialogs
FUNCTION
The dialog construct defines Preactor push-button menus.

SYNTAX

[Label:]{DIALOG},
Description,
Dialog Title,
Item Type, Parameters:
repeats...;

PARAMETERS 
Label (optional)

Label is the optional alphanumeric string that is terminatedwith a colon (:) character and is used to jump to a dialog from
another program or menu option.

{DIALOG}

The {DIALOG} key word is used to indicate that this section is a dialog definition.

Description

Description text to guide the user.
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Dialog Title

Dialog Title is the title given to the dialog.

Can be set to the special value {HIDDEN}

Item Type

PUSHBUTTON A push button.

PUSHBUTTON The default push button.

REMARKS 
The item type syntax is in the next sections.

EXAMPLE

MENU_Maintenance : {DIALOG},
,
Data Maintenance:
PUSHBUTTON | HELPPOPUPID (53040),Resources,EDIT_Resources:
PUSHBUTTON | HELPPOPUPID (53030),Resource Groups,EDIT_Groups:
PUSHBUTTON | HELPPOPUPID (53050),Secondary Constraints,EDIT_Const:
PUSHBUTTON | HELPPOPUPID (53010),Products,EDIT_Products:
PUSHBUTTON | HELPPOPUPID (53150),Product Attributes,MENU_Product_Attributes:
PUSHBUTTON | HELPPOPUPID (53150),Operation Attributes,MENU_Operation_Attributes:
PUSHBUTTON | HELPPOPUPID (53110),Customers,EDIT_Customers;

The label "MENU_Maintenance" marks the start of the dialog box structure, there is no description text in this example. The
dialog title is "Data Maintenance"

Seven push buttons are also defined. The HELPPOPUPID text provides a reference to the language include popup_prmdf.inc file
which contains a description of the action the item performs. The HELPPOPUPID text will be displayed as a tool tip when
hovering the mouse over elements such as categories, sub categories and content items in the Preactor Desktop. For work-
flow items the pop up text is displayed directly underneath the name of the work-flow item. The target label defines the name
of the label that the Preactor Desktopwill jump to when the item is selected, for example in the above the 'Resources' table will
be displayedwhen the category content item 'Resource' is selected as defined by the 'EDIT_Resources' target label.

PUSHBUTTON
FUNCTION
Defines an item that can be selected in the Preactor Desktop.

SYNTAX

PUSHBUTTON [Help Popup Reference] [Position], Item Text, [User Variable = Value], Target
Label, [Assignment User Variable = Value]:

PARAMETERS
Name Description

PUSHBUTTON Defines the Item Type.

Help Popup The HELPPOPUPID(x) reference that determines what help pop up text is associatedwith the item. The pop
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Name Description

Reference
(optional)

up text itself is defined in popup include files in the working directory's Language folder.

Positioning of
Sub Categories
(optional)

By default subcategories on the Preactor Desktop are placed above content (Editors or Feeds) to improve
loading speed. To override this behavior the POSITION(x) classification can be added, where x is a number
defining the positioning. All subcategories andmenus are given a default order of 100.

Item Text The text that will be displayed for the item

User Variable =
Value
(optional)

An optional conditional test. If the condition is true, i.e., the User variable is equal to the value, then the item
is displayed. Otherwise, it is not.

Target Label The label to which Preactor will go when this item is selected.

Assignment
User Variable =
Value
(optional)

Assigns a value to a user variable.

EXAMPLE 1

PUSHBUTTON | HELPPOPUPID (50100),Data Transfer,MENU_ImpExp:
PUSHBUTTON | HELPPOPUPID (50030),Generate Schedule,SEQ_Main:
PUSHBUTTON | HELPPOPUPID (50100) | POSITION(0),Start Page,FEED_StartPage:

The above example demonstrates the POSITION feature, in the case of the above the Start Page category content item will
appear above the sub categories General and Data Transfer on the Preactor Desktop.without the POSITION defined, the Start
Page option would appear below the General and Data Transfer sub categories because it loads an RSS feedwhich by default is
placed below sub categories since it is a content item.

EXAMPLE 2

{CONDITIONAL},
{MODE} == 100,{NEXT},PMODE=100:
{MODE} == 200,{NEXT},PMODE=200:
{MODE} == 300,{NEXT},PMODE=300:
{MODE} == 400,{NEXT},PMODE=400:
{MODE} == 500,{NEXT},PMODE=400:
ELSE,{NEXT},PMODE=0;
...
PUSHBUTTON | HELPPOPUPID (53060),Routes,PMODE = 300,EDIT_Routes:
PUSHBUTTON | HELPPOPUPID (53060),Routes,PMODE = 400,EDIT_Routes:

The conditional ({CONDITIONAL}) statements have assigned values to the PMODE user variable based on what mode of
Preactor is running (such as 200 FCS, 300 FCS etc). On the PUSHBUTTON definition, the value of PMODE is tested to
determine if the Routes option is to be displayed on the Preactor Desktop. In the above case, the option is only displayed if the
value of PMODE is either 300 or 400 (Preactor is running as either 300 FCS or 400 APS).

EXAMPLE 3

PUSHBUTTON | HELPPOPUPID (50030),Generate Schedule,SEQ_Main,VARIABLEX=1:
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The User Variable VARIABLEX is assigned the value of 1.

TEXT
FUNCTION
Defines a text string to be displayed in the dialog, TEXT defines left justified text.

SYNTAX
TEXT, Alpha-numeric text

PARAMETERS 
Alpha-numeric text

The text string is used as the prompt for the data entry field.

Programs
The programs construct causes a Preactor module or external program to be executed. The program name (or Preactor
module) is defined together with commands for that program. In addition, fields can be defined to prompt the user and inform
of the action of the program.

Preactor will execute only one program or process at a time. The Preactor Desktopwill then become inactive until that process
terminates. When the process does terminate, it will set a return code to a numeric value (usually between 0 and 255) to
indicate how the process ended. This allows the user to select a different branch of execution depending upon the return code
of the process.

It should be noted that if an exit code is returned for which there is no label defined, an error would occur.

FUNCTION
Used to launch any of the Preactor executable modules, any other DOS or Windows-based program or to call an entry point in
your ActiveX server.

SYNTAX

[Label:]Program Executable Name, 
Operands,  

; With Comments within the Operand if Desired
Screen Prompt,
Program Title,
Run Mode,

  Return Code [- User Variable],Target Label,
[Assignment User Variable = Expression]:

Return Code repeats...;

PARAMETERS 

l Label (optional)
Label is an optional alphanumeric string that is terminatedwith a colon (:) character and is used to jump to the program
from another program or menu option.

l Program Executable Name
Program Executable Name is the name of the program that you want to run; for example, NOTEPAD.exe. The Preactor
modules use a .exe extension even though they are in fact dynamic link libraries (dll's)., i.e. PRS.exe.
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If the first character is "@", Preactor will try to find the Windows program that is associatedwith the file given as the
executable. For example, if you want to load the program that can edit README.wri (WORDPAD.exe under Windows
95), you could use
@README.wri as the Program name. Note that you must still specify any command line parameters that will probably
include the file name again. It should also be noted that the file must exist.

The keyword ActiveX is used to tell Preactor that you want to call an ActiveX Server, and this is followed by the entry
point of your method. You cannot pass any parameters to your method, but Preactor will automatically pass the
'handle' to the Preactor database object. You cannot use the Open Planning Board object in this way, because the Pre-
actor sequencer will not be running.

The return code for your method can simply be assigned in your code and then tested in Preactor.

For example this .prmdf file construct: -

Your_Label: ActiveX MyProject.MyServer MyFunc,
,
Running Your Method,
Method,
Foreground,
0:{START}:
1:Error_Message

Will call this method: -

Public Function MyFunc(db As PreactorObj)
'Your code for the method goes here.
'It will use the db variable as the
'prefix to the Preactor methods, e.g
- db.ReadField("Orders", "Priority", 5)

'You can assign the function name 0 or 1
'to set the return code, e.g.
MyFunc = 0
End Function

Refer to the Preactor SDK documentation for more information.

l Operands
A list of operands that will be passed to the program that is run. Operands that can be passed to Preactor modules are
explained in the Preactor Reference Guide section.

l Comments within the Operand
After the Program Executable Name, you must specify the operands that are passed to the program.
Most of the Preactor modules are controlled extensively by the use of command switches to determine the way in
which they work. The parameters may be entered on as many lines as you like; the Preactor Desktop program will
remove spaces that are not required. Comment lines may be placed between operands. Operands that require spaces
within them must be enclosed in double quotes to prevent them from being interpreted as multiple operands. The final
operand is terminatedwith a comma (,).
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For example, to pass the following operands to PREdit:

 /FMT:Orders /AS /PS

The following construct including the comments could be used instead:

 ; Specify format to use.
 ;

/FMT:Orders
 ;
 ; Auto Save on exit.
 ;

/AS
 ;
 ; Sort the records so that all children of a parent are
 ; displayed underneath the parent.
 ;

/PS,

l Screen Prompt
Screen Prompt is the string of text that is displayed in yellow at the bottom of the Preactor Desktopwhile the command
is executing.

l Program Title
Program Title is the string of text that is used to describe the application by Windows; this string will appear in both the
task manager and in the title bar of any window that is created unless the program that is run specifically changes that
title.

l Run Mode
The Run Mode facility has been included for future use to determine the mode of execution for a program. This may be
specified using the following key words:

l Foreground - The program is run in the foreground.
l Background - The program is run in the background.
l Iconized - The program is run in the iconized (minimized) state.
l Maximized - The program is run in the maximized state.
l Clock - The program is run in the backgroundwith a clock display to indicate that the program is running.
l Detached - Preactor will not wait for the program to end.

Due to limitations in the display functions in the current versions ofMicrosoft® Windows®, it is not possible to
set the Foreground/ Backgroundmode for a spawned program. The running mode will be determined by the
program itself. In future versions ofWindows, this feature may be enabled.

The run mode may also specify the key word "Minimize Shell", this causes the main Preactor window to minimize
while the program is running.

l Return Code
The Return Code is the numeric return value from the program. It can be used to determine the next action that is
taken.
For example, a return code of 0 typically means that the program execution ended successfully and the next logical
step should be taken. Another return code of 5 could indicate an error that requires a message to be displayed.
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There is no limit on the number of return code values. Preactor will select the label that corresponds to the actual
return code.

If a program returns a value that is not specified, then Preactor will give an error message indicating the
command line and return code that caused the error.

The reservedword ALWAYS can be used to select a default label, this must be the last Return Code specified.

l User Variable
The User Variable is optional, and it allows the next action to be determined by a combination of the pro-
gram return codes and the value of user variables. If, for example, you wish the next action to be the one
identified by Label A only if the program executed successfully and a previous menu option had been selec-
ted, then when the previous menu option was selected, we assigned the user variable a value of 10. When
the program exits with a return code of 2 (all OK), we actually test for a return code of 12 (two plus the
user variable value).

User variables are definedwhen they are used andmay be set to a value or used in an expression. If
used in an expression, the name of the user variable should be enclosed in curly brackets ({}).

The end of this section contains an example of the use of a user variable to control the exit branch
that is taken.

l Target Label
Target Label is the label to which Preactor goes when the specified return value is passed back from the
running program. Target label has three reserved names:

l {NEXT} goes to the next item in the Preactor.prmdf file
l {START} goes to the first item defined in the Preactor.prmdf file
l {END} exits from the Preactor Desktop
l {RETURN} valid from programs and conditionals only. It will return to the last menu that was dis-
played. This enables the ShellExecute routine to return to whatever menu was displayedwhen the
methodwas called

l Assignment User Variable
Assignment User Variable is optional and is the name of the user variable that is to be assigned if this
return value is the selected exit branch.

l Expression
Expression is only required if an Assignment User Variable has been specified and is an expression that is
to be evaluatedwith the result assigned to the user variable specified.

l DELIMITERS

: (colon) - used after [Label] or between repeated parameters
; (semicolon) - defines a comment line if in column 1 or is the last character of a construct
, (comma) - separates operands
@ (at) - defines a call to a program associatedwith a specified file type
{ } (braces) - defines a variable. label, or directive
" " (double quotes) - defines strings with spaces in them

NOTES

This section is closely coupledwith items in the Preactor.prtdf file, and there is no automatic cross checking. This must be done
administratively.
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Passing Time Expressions with a Command
TimeExp is a word that is used to indicate that the command takes a time and date parameter. These times and dates can
either be hard coded or, more typically, calculated by Preactor tags.

TimeExpmay be specified in MM-DD-YY HH:MM or DD-MM-YY HH:MM depending on the date format settings in your Microsoft
Windows® configuration. Alternatively, you could enter Julian dates/times directly (e.g., 34700.5 = 1 Jan 1995 12:00 noon).
The Preactor tags will typically evaluate directly to Julian dates/times (e.g., {JDATE} returns today's Julian date).

Menu Structure Logic
The following steps describe the parsing logic that is used to create the layout of the Preactor Desktop navigational structure:

l Stage 1: Build simple menu structure from MDF
l Stage 2: Restructure and flatten categories and child items
l Stage 3: Introduce content groups and create navigation structure

Menu Structure Logic - Stage 1
Stage 1: Build simple menu structure from MDF

This stage involves reading the MDF contents, creating a simple menu structure and validating the results.

1. Parse all of the MDF contents

Preactor will parse all of the menus.

2. Find the first menu

[SHELL]
#define PARSE_STRICT
#set MAIN_MENU TheLabel
.
.
.

TheLabel : {DIALOG},
,
PUSHBUTTON | HELPPOPUPID (50100),Data Transfer,MENU_ImpExp:
...

3. Create hierarchical menu structure

From the first menu, Preactor will create a hierarchical menu structure following links to other menus

The result is attached to the Workspace category

The process is repeated from other system categories

4. Mark up special items in the structure

A further pass is made to find special content items and identify them as content.

Currently this is expressed as:

Must be an editor

All labels return

Does not have the Edit Record command line switch
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Does not have the Auto Exit command line switch

5. Check for orphanedmenus

These are menus that are not called from another menu.

Menu Structure Logic - Stage 2
Stage 2: Restructure and flatten categories and child items

At this stage the menus are turned into categories and the whole hierarchical structure is flattened to four levels deep.

1. Promote any eligible sub categories of the default Workspace category

An eligible sub category is one that contains content actions such as editors.

These categories are moved up to the top level.

2. Restructure top level categories

If the category contains actions, these are moved into a default sub category called General.

3. Restructure sub categories and flatten the hierarchy

Move any nested categories up until the structure is only three levels deep.

4. Remove empty categories

Remove any empty categories from the structure

Menu Structure Logic - Stage 3
Stage 3: Introduce content groups and create navigation structure

This last stage introduces content groups and creates the final navigation structure.

1. Take each top level category

a. Add a group to the category and add content workflow items to it.

b. For action workflow items, create a default sub category and add the action workflow items to a group in the
default sub category.

2. Take each second level category

a. Take content workflow items and add them to embedded item groups and add these groups to the sub
category.

b. Take action workflow items, and add them to action item groups and add these to the sub category.

Table Definition File

Field Types
Field Types
The Field Type defines the type of data that is in the field. The field types supported by the Preactor database are listed below.

DURATION
INTEGER
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MATRIX
STRING
REAL
TIME
TOGGLE
DIALOG

Database
Data Integrity
All the Preactor modules expect the SQL database tables to match their respective formats in the Preactor.prtdf file, and if a
mismatch is found, the file will not be read past that point. If it is necessary to add or delete fields in a particular format, the
relevant data table must also be changed to maintain the database integrity.

Adding a field to a table definition will also cause tasks to be created on start-up. In the simplest case this will be a FREE FORMAT
string field, and a single task will be created to add the field to the relevant SQL data table. Other field additions will cause
incidental foreign key additions or alterations. Adding a field of the MATRIX type will cause slightly different behavior, "Adding
Auto List andMatrix Fields" on page 327.

If records are simply added to a table that contains MATRIX or AUTO LIST fields, then these fields should also be updated. If they
are not updated, PREdit will report that the MATRIX field is the wrong size when it is accessed for editing andwill automatically
correct the size, if requested, using default values.

Calendars Schema
Calendar data is stored in its own fixed schema. The calendar table structure and fields are not defined in the Preactor.prtdf file
this includes all calendar data (including vacations and other exceptions), calendar states andminimum andmaximum
secondary resource values.

SQL Database File

Preactor data is held in an SQL Database. The SQL database is partitioned into four schemas:

- User Data

- System Data

- Calendars

- Schedule Analysis

The data in the User Data schema are the tables and fields that are defined in the Preactor.prtdf file. A Preactor 'format' is
transformed into one or more tables in the SQL database. AUTO LIST andMATRIX data are held in separate tables with
relationship links to the table that the AUTO LIST or MATRIX classifications are defined in.

For information about the other schemas please view this page: SQL Database Schema

Schedule Analysis Schema
The data in this schema is formatted in such a way as to allow you to create your own reports. A set of views are provided that
simplifies reports based on simple roll ups (such as daily or weekly, single resource or resource group, etc.). User driven
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analysis can be performed using pivot tables. The schema is optimized for use with pivot tables allowing you to analyze your
schedule metrics in chart or table form, controlling how the data is sliced and summarized. 

SQL Database Schema
The database is partitioned into four schemas:

l Calendars Schema
l Schedule Analysis Schema
l System Data Schema
l SQL User Data Schema

Referential Integrity

Although not enforced, foreign key constraints exist in the database for all of the relationships inferred from the Table
Definition file. These constraints can be used by reporting tools and query generators to show the relationships between
tables. In future versions, these constraints may be enforced.

"Changes to the Inferred Database Schema" on page 325 for specific information about adding and removing tables etc.

System Data Schema
System data tables are defined in their own schema called 'SystemData'.

Changes should not be made to the data and structure of these tables, any changes made are not supported.

The data held in these system data tables are supplied in all supported languages.

A number of fixed schema views have been introduced to the 'SystemData' schema that will map consistently onto fields
within the 'UserData' tables. Although the scope for this type of view is limited given the inherent flexibility of Preactor, these
views can be very useful, and go some way towards providing a mechanism that will allow common tasks to be performed
across a variety of different configurations.

SQL User Data Schema
The tables and fields in the user data schema vary by configuration and are defined in the Preactor.prtdf file.

A Preactor 'format' is transformed into one or more tables in the SQL database; one SQL table will contain the majority of the
format’s data. A further table will be created for each auto-list field; this table will also contain columns for each field associated
with the auto-list. An additional table will also be created for each matrix field in the format. A parent-child relationship is
formed between the main table and it’s auto-list andmatrix tables.

Data held in the SQL database can easily be accessed by third party applications such as Crystal Reports®, Microsoft® Access
and Microsoft® Excel.

Classification Overview
Classifications (Locating Data)
Preactor must have access to certain data that is relevant to the finite-capacity calculations. To maintain complete flexibility in
the structure and use of the database, Preactor makes no assumptions about the names of fields or the formats (tables) in
which particular data are contained. For example, naming a field Quantity is not sufficient to indicate its function; use of the
classification flag QUANTITY is required.
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Classifications are used to define the use of particular fields and how they should be displayed for editing. The classifications are
simply added to each field definition, which allows a particular piece of data to be contained in any format. For example, Setup
Time could be contained in the Product Format, the Operations Format, the Resource Groups Format or the Resources
Format. Multiple classifications can be added to the same field to produce the desired effect in the overall database structure.
There are seven basic groups of classifications.

Data Source Classifications that indicate the source of the data. For
example, is the data to be retrieved from another table, or is
it a free-format string?

Display Control Classifications that indicate how the field is to be used by
Preactor to control the display of items like the Gantt chart
or the Sequencer windows.

Field Display
Control

Classifications that indicate how the individual field is
displayedwhen a user is prompted to edit or view a data
record.

Job andOper-
ation Para-
meters

Classifications that determine how Preactor will control and
manipulate a job or operation of a job.

Resource
Parameters

Classifications that determine how Preactor will control and
manipulate a resource.

Miscellaneous Classifications that do not fall into any other category; for
example, those that control data record location and
sorting.

Preactor 400
APS Specific
Classifications

Classifications specific to the sequencer in Preactor 400 APS
systems.

Classification Definition
FUNCTION
Classifications are used to tell Preactor where to find and how to use particular pieces of data, how to display the data, and how
to control data entry, etc., as part of the format RECORD_FORMAT.

SYNTAX
Classification | Classification

The classification is selected from a list in the Preactor Reference section (alphabetized list) or Tables 2 through 7 (functional
lists) and follows the rules stated in the Preactor Reference manual and in the "Required Classifications" section.

DELIMITERS
| (optional)

The "|" can be used to delimit classifications when more than 1 is used. The "|" is only used to improve the readability of the text
and is not used by Preactor. Further, if the classification list requires a second line, there is no delimiter needed for the end of
line.

REMARKS
All values, except FREE FORMAT and STRING IN FILE string entries, are stored as double-precision real values in any data files
produced. If they contain fractional data they are written in exponential format with 15 digits of precision, or as integers if
there is no fractional data. FREE FORMAT string entries or STRING IN FILE entries will be stored as strings delimitedwith quotes;
e.g., "string".
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Classifications are an integral part of the configuration definition andmust be well understood. In addition to defining the
details of fields, there are also couplings where certain classifications must be used for a certain Preactor module or where one
classification must be usedwith another classification. Again, classifications are an important feature for the configuring of
Preactor.

EXAMPLE

; Format Operations
;
Operations,"OPS.prtbl",0,200:
 Number,0,INTEGER,
PRIMARY KEY | HIDDEN:

 Op Name,0,STRING,
FREE FORMAT (20) | UNIQUE:
Resource Group,1,STRING,
DATABASE(Resource Group(Name)):

 Resources,-1,MATRIX,
AUTO LIST(Resource Group(Resources)):

 Pattern,1,STRING,
DATABASE(Patterns) | PATTERN:

 Set-up time,0.006945,DURATION,
SEQ CHANGEOVER:

 Operation Time,0.006945,DURATION,
CONDITIONAL "ENTRY>0";

Classification Use in Operations Format.

Above is an example of a table format. Each field is defined as follows:

Number:

INTEGER: Data stored as an integer.

PRIMARY KEY: Makes this field unique and is used for numeric
references.

HIDDEN: Means the field is not displayed in the Preactor
Editor.

Op Name:

STRING:  Display data as a String.

FREE FORMAT (20): Defines a free format string of 20 characters.

UNIQUE:  Forces the operation names to be unique.

Resource Group:

STRING:  Display data as a String.

DATABASE (Resource Group
(Name)):

Defines the source of the Resource Group
data.

Resources:

MATRIX:  Data are stored as a single dimension matrix.

AUTO LIST (Resource Group
(Resources)):

Defines which resources from the above group
are valid.

Pattern:
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STRING:  Display data as a String.

TABLE(Patterns):  Refers to string table of patterns.

PATTERN:  Defines field as display pattern type.

Set-Up Time

DURATION:  Display data as a duration (hh:mm form).

SEQ CHANGEOVER: Tells PRS to use this value for setup/changeover
times.

Operation Time:

DURATION:  Display data as a duration (hh:mm form).

CONDITIONAL "ENTRY>0":  Prevents zero and negative entries.

Classification Tracking
Tracking is the mechanism by which classifications (conditions) can be searched for in tables, via relationships to the source
table. The result is a path which data will followwhen requested. Preactor will only track through ten tables along a path,
meaning that if the classification required is in a column within the eleventh table, Preactor will not locate it.

The process starts with a tables, and ends with another table or a column. One instance of the tracking process can produce
wither a single path or multiple paths to follow for data. Tracking is used on demand upon loading Preactor, though if there
are any modifications to be made to the .prtdf files, it cannot be done during runtime.

There are four different types tracking behavior:

l Local
l Reference
l Special, and
l Secondary Constraints.

Classifications have specific tracking behavior assigned to them, meaning that they can only be tracked in a specific manner.
For example, a classification such as MATCH PREFERRED is assignedwith the Reference tracking behavior. Meaning that
Preactor will be able to locate the condition within the limitations of the Reference tracking behavior.

Tracking is used:

l In the Sequencer, for scheduling and for assigning colors and patterns to operations.
l In the Editor, for assigning a background color and for measuring the quantity of an item.
l In the API, to copy a record, to create APS Rules and User code uses. For API, tracking does not behave as expected, as it
takes the source (table and record), classification string and occurrence (which is the occurrence of the classification
across the entire configuration) for creating a path. It will return a number which is a value, or an error code if nothing
is found.

While it is possible to have a classification present numerous times throughout a configuration, Preactor will only track to and
use one, with any other occurrences remaining unused.

Local Tracking
Local tracking behavior stops in the source table that has been called upon. The path produced is one with a single node. Using
the diagram below, and taking that the DELIVERY BUFFER classification has been assignedwith Local tracking behavior,
Preactor will only look for the condition within the source table. The source table in this example would be the Orders table.
Preactor will not track through and Database references to other tables.
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Reference Tracking
Reference tracking behavior will follow database references through tables until an instance of the classification is found. A
tracking path is constructed is the table contains matrix columns with a reference back to the source table. The diagram below
shows the path that Preactor will create upon following the Product and Operation Attribute 1 database references.

Preactor will stop at the first instance of the classification being found, as long as it is locatedwithin the limitations of Preactor
on tracking tables up to 10 times along a path. Meaning that if the classification is located at the 11th stop along the path,
Preactor will not create a path to it. If this is the case, Preactor will continue searching through tables until a classification is
found that meets the path requirements. If a classification cannot be foundwithin the Reference tracking requirements,
Preactor will react by modifying what will be displayed in the Planner or Sequencer.

Classifications

There are two classifications that can impact how reference tracking occurs:

The use of NO TRACK on a column, within a table, will cause Preactor to not track through it. Using the diagram above, if there
was NO TRACK on the Operations Attribute 1 column, Preactor wouldmove on to tracking through the Customer database
reference to find the DELIVERY BUFFER classification.

The use of ALLOW BACK TRACK allows Preactor to back track through a table for one instance. Using this classification means
that Preactor can scan through other tables, that are not the source table, to find the classification required. If the column the
required classification is in also contains ALLOW BACK TRACK, Preactor will track back once, to see if it links to the source table.
If this requirement is met, a tracking path will be created, and if not, Preactor will ignore it.

Special Cases
Special tracking behavior refers to instances where the tracking process is only applicable to certain things. For example, the
Sequence uses a special behavior to write the resource and operation is scheduled on by extending the reference behavior. It
will take the first node in the Orders table (that being the reference to the Resource table) and then will pull the information
required from the Resource table, specifically names.

Another case is the SEQ GRAPH classification, for example, which will track through AUTO LIST, ASSOCIATE or AUTO
DIMENSION classifications, if SEQ GRAPH is not initially found.
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Another classification that exhibits special behavior is the FORCE WINDOW classification. It will track all database columns that
reference the Resources table that have the FORCE WINDOW classification.

Secondary Constraints
Secondary constraints tracking behavior is unique, in that it will create a group of tracking paths. It is usually used for
classifications such as USE CAPACITY, CAPACITY TYPE, and CALENDAR EFFECT etc. The TO TRACK classification is usually
respected. If one constraint reference is found, the behavior will attempt to create and use a reference track from the Orders
table. Otherwise, the path will attempt to track from the Secondary Constraints table. If more than one constraint reference is
found, this behavior will track from the Orders table, and every subsequent track must end in the same table, for example,
Secondary Constraints.

String Tables
String Tables
FUNCTION
Defines fixed data in the file that can be viewed by the user but not changed by the user.

Most data in the database is held in tables that have been defined in the table definition (.prtdf) file. This allows the data to be
edited at will by the user. There are some classes of data that do not need to be changed by the user but would be undesirable
to hard code into the system. As an example, the time bucket units specified for each resource in the Resources Format must
be picked from Seconds, Mins, Hours, Days or Weeks.

The numeric values are actually stored in the database, but whenever the field is displayed or the pick list used, it is the text
strings that are seen by the user. The list can be changed at any time by editing the table definition (.prtdf) file.

The typical tables defined in the Preactor.prtdf file are:

CAPACITY USE Defines when to change capacity data

TIME Defines time units

COLORS (or COLOURS) Defines available colors

PATTERNS Defines cross hatch and other fill patterns

WINDOW STATE Defines allowable PRS resource window states

Any item that can be stored in a string table could also use a Preactor database table to do the same job; however, string
tables have the advantage that the amount ofmemory required to store the string table is significantly less than that required
to store the equivalent database table.

SYNTAX

STRING_TABLES
Name:
 Number , String:
  repeats;
STRING_TABLES_END

PARAMETERS
STRING_TABLES all uppercase key word
Name the name of the table
Number user-assigned number associatedwith the "String" this is used internally in the file, but not displayed to the user
String text displayed to the user for this entry
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DELIMITERS
, (comma) separates Number from String
: (colon) separates strings in the same table
; (semicolon) ends the table

EXAMPLE

Time Units:
 0, Seconds:
 1, Mins:
 2, Hours:
 3, Days:
 4, Weeks;

The string table is named "Time Units." The first item is number 0 with "Seconds" as text. The last item is number 4 with
"Weeks" as text.

Database Design
The Preactor database is highly configurable, allowing you to add or delete Formats (tables) and to move particular data items
(fields) between the tables. This flexibility allows you to change the database structure to allow simple integration with other
systems by matching their database structure and to change the meaning of the data by moving it between Formats (tables).

If you intend to add or delete Formats (tables), you should first develop a database structure diagram for your proposed
database. Designing hierarchical tables that can contain matrices and selection lists is not a simple task and you may wish to
contact your supplier for assistance.

The database structure diagram will enable you to identify the Formats (tables) and the fields that you require and the
relationship between them. You should also consider whether your structure will allow Preactor to reference all the required
data uniquely. Unfortunately, it is quite simple to design database structures that do not have unique references into
particular tables, andwith matrix data you have to ensure that Preactor has a unique key to each axis available in the Orders
table.

When developing Preactor tables, some basic rules must be adhered to:

1. The relationship flowmust be in one direction (left to right); i.e., the references cannot form loops. When using two-
dimensional matrices, however, loops can be formed by using the AUTO LIST facility to constrain the elements in the matrix
that are displayed (see note 7). This is only a display constraint; all the matrix elements exist even if they are not used.

2. For the automatic sequencing functions to work correctly, the Orders format must contain a PARENT field. Even if there is
only one operation per order (as often happens in Capacity Planning configurations), the PARENT fieldmust exist.

3. Pick lists are only constrainedwhen you have a direct pointer to the table containing the constrained list and the list itself. A
good example is the selection of resources within a Resource Group in the Products table. The Products table has a reference
to both the Resource Group and the Resources within that group.

4. There must always be a unique reference from a higher-level table to a lower-level one. In most cases, this is achieved by
default. In each example, the Part Number field in the Schedule File has a direct relationship with the unique Part Number field
in the Products table. The database will cope with references that skip levels, but you must ensure that one field in the higher-
level table has a unique reference to a record in the lower-level table. An error message will be given if this is not the case.

5. When a two-dimensional matrix is declared and one axis is a field in the current table, that fieldmust form the first axis of
the matrix. For example, if you have a Product/Resource matrix for Operation time in the Resources table, then the Resource
Name fieldmust be the first axis to be declared.
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6. With a two-dimensional matrix, if the table that is providing one of the axes also has a field that is an AUTO LIST of records in
the table containing the matrix, then the AUTO LIST will constrain the display of the matrix. For example, if you created a setup
matrix from operation to operation in the Resources table, then the matrix would be constrained by the AUTO LIST of
resources in the Products table; i.e., you would only see the data for operations that can be carried out on that resource.

Table Hierarchy
The Preactor database uses a simple definition system to describe the database tables, etc., but applies intelligence to deduce
relationships that are not explicitly specified. The data are held in tables in an SQL database.

When the Preactor data server PRSERVER reads the Preactor.prtdf table definition file, it establishes the obvious forward
relationships between the tables. For example, in the standard Preactor example, the following table hierarchy is used:

l Products Table,
l Resource Groups Table,
l Resources Table.

The Products Table lists the Operations required and specifies which Resource Group is used, and the Resource Group Table
defines which Resources are in the Group. Such a top-down hierarchy is typical of the way data are viewedwhen configuring a
finite-capacity scheduling system. It is not, however, the way in which the data are often used by the system.

In the standard Preactor example, the setup time is held in the Products Table, but the setup times are requiredwhen Preactor
is processing each Resource. There is no direct method defined in the Preactor.prtdf file by which a Resource can tell which
Operations can use it, since that is a backward relationship through the tables. To avoid the need to define explicitly all the
required backward relationships, PRSERVER automatically deduces the backward relationships when it processes the
Preactor.prtdf file, thus allowing Preactor to also view the database as though it were structured:

l Resources Table,
l Resource Groups Table,
l Products Table.

The database also automatically constrains pick lists. For example, if an operation uses the resource group "Lathes" and
subsequently a list of resources valid for that operation is requested, only the resources in the "Lathes" group are shown. The
constrained lists also extend to matrix fields if a changeover time matrix was set up in the resource groups table and
subsequently "Lathes" changeovers are picked for editing, only the changeovers for products processed on the "Lathes" will be
displayed.

Family Relationships
Preactor supports the concept of families of records within a table. The concept is primarily to form the association between
parent records and a group of child records. It is necessary to have a field with the FAMILY classification specified that will be set
to -1 for the parent records and the primary key of the parent record for all child records.

FAMILY Classification
If a Family relationship has been established, it is possible (using Classifications) to define some fields as being INHERIT FROM
PARENT, in which case changes can occur only in the Parent record. These changes will be inherited by the child records. The
Part Number field in a Products table is often defined this way, since it makes little sense to be able to change the product in
later operation records.

An example of a section of the products table is shown below.
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; Products Table definition
;
;
Products:
Parent Part,-1,STRING,
HELPPOPUPID (10)
FAMILY(Part No.)
DIALOG ONLY:

Number,0,INTEGER,
PRIMARY KEY
HIDDEN:
Part No.,"",STRING,
HELPPOPUPID (45)
FREE FORMAT
UNIQUE
INHERIT FROM PARENT
NO CHILD UPDATE:

Product,"",STRING,
HELPPOPUPID (55)
FREE FORMAT
UNIQUE
TIP DISPLAY
INHERIT FROM PARENT:

Profit,0,REAL,
HELPPOPUPID (270)
FORMAT(.2)
DIALOG ONLY
INHERIT FROM PARENT:

Tracking
The Preactor database allows fields to be moved between the tables. This flexibility allows for structuring the database in a way
that is suitable for each application and their processes. Moving the data can also change its meaning, and the overall effect
should be considered before moving a field.

Taking Setup Time as a simple example, the effect of placing it in each of the three standard process tables can be seen in the
table below.

Database Effect

Products One setup time for each operation; e.g., a widget requires 10 min.
setup on the lathe, but 15 on the mill

Resource
Groups

A single setup time for each resource group, that is independent of
the operation and product; e.g., it will always take 10 min. to setup
the lathes, 20 min. to setup the mills, etc.

Resources Each resource will have a single setup time that again is independent
of the operation and product; e.g., Lathe A always takes 10 min. to
setup, but Lathe B always takes 15 minutes.
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Table Definitions (RECORD_FORMAT)
Overview
The user can modify the database by modifying fields and classifications or adding new ones to the Preactor Table Definition
(.prtdf) file.

When Preactor starts, it finds any changes that have been made to the .prtdf file and applies changes to the SQL database.

Note: This file should only be modified after attendance at a suitable Preactor Configuration Course.

Syntax

RECORD_FORMAT
;[Comment]  
Name,[Table Type]:
[FieldName],[DefaultValue],[ FieldType],
[Classifications]:
[. . . additional field definitions];

;
[… additional format definitions]
RECORD_END

RECORD_FORMAT is the keyword that starts the record format section.

Name
The Name field is the alphanumeric name given to the table. This name is used in many places to access data stored in the
records within the table. All names must be unique. The name may contain spaces etc.

Table Type
The table type field specifies one of the following:

1. Normal table.

For a normal table the table type field is left blank. Normal tables are loaded from the database on start up and saved upon
request or on exit from the editor or sequencer. For compatibility with configurations migrated from earlier versions of
Preactor, specifying a file name in quotes has the same effect.

2. DATASET table.

Data set tables are specified using the keyword 'DATASET'. A data set table is able to load / save data from / to data sets in the
database. Data sets are loaded on demand, usually when opening a sequencer or editor. For compatibility with configurations
migrated from earlier versions of Preactor, specifying a file name or a file extension only with no quotes will have the same
effect.

3. ASSOCIATE table.

An ASSOCIATE table is definedwith the keyword 'ASSOCIATE' followed by the name of a DATASET table in parentheses. For
example ASSOCIATE (Orders). Many ASSOCIATE tables can be defined using the same DATASET table. All of the ASSOCIATE
tables and the table with which they are associatedwill be treated as a group of tables. This means that whenever a table
within this group is saved or loaded, all the other tables in the groups will also be saved or loaded.

An ASSOCIATE table can also be definedwith 'ASSOCIATE' followed by a classification string in squared brackets. For example,
ASSOCIATE [LAUNCH TIME]. With the use of this, Preactor will locate the first table and field that contains this classification
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string. If the classification string cannot be referenced, it will be excluded, and the table associatedwith the classification string
will remain a non-loadable table.

4. COMMON

The COMMON classification can be added to an ASSOCIATE table within the MaterialControl_prtdf.inc file. Enabling this will
allow the ASSOCIATE tables to load from a single, shared (common) dataset. This functionality is useful for when there is the
need to switch between multiple schedules, yet there is a desire to maintain a single Supply, Demand or Bill of Materials table,
for example.

Field Name
Field Name is an alphanumeric string used to describe the field. The Field Name is used in many places, in both the data
structures and displaying the data to the user. Field Names must be unique within the table.

Each table must have a field definedwith the PRIMARY KEY classification.

Default Value
The Default Value is used as an initial value for a field in a new record. For example, most Preactor systems use default values
of 10 for the Priority field and 1 for the Batch Size field when adding a new order to the production schedule. These values can
then be edited.

Some actions cause the default value to be overridden. For example, the Due Date can be set by the Preactor Editor by
specifying an offset from the current date.

The following rules apply to the Default Value:

l If the field is a REAL, INTEGER, or TOGGLE data type, simply supply the required default value.
l If the field is a STRING, TIME, or DURATION data type, a value of -1 will cause the word "Unspecified" to be shown as the
field value. To allow a value of -1, a fieldmust have the ALLOWUNSPECIFIED classification defined.

l For STRING data types with a FREE FORMAT classification, the default value can be specified by enclosing the text in
double quotes; e.g., "string".

Field Type
The field type defines the type of data that is in the field. "Table Definition File" on page 312.

Classifications
The classification field is where any classifications are defined against a field. Classifications are used to define the presentation,
behavior and purpose of a field. For more information on classifications and their meanings, pleases refer to the reference
section.

Comments

Comments are allowed in the Table Definition file anywhere outside of a field definition. Comments should be prefixedwith a
semi-colon (;) at the start of a line.

Remarks
1. The FieldType and Classifications parameters are defined in separate sections of this chapter.

2. To add or delete a field simply add or delete field definitions when initially configuring Preactor. If the run-time database
already contains data from the user when this file is edited, data integrity must be ensured.

3. Each table requires a field with a PRIMARY KEY classification as shown in the example.

Example
Example of a typical RECORD_FORMAT definition.
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RECORD_FORMAT
;Resource Groups Table Definition 
;
Resource Group:
Number,0,INTEGER,
PRIMARY KEY:
Name,0,STRING,
FREE FORMAT (40)
UNIQUE
SEQ GROUP:
Resources,-1,MATRIX,
AUTO LIST(Resources(Name));
;
RECORD_END

The table is named "Resource Group,".

The first field name is "Number" and is classified as the PRIMARY KEY for this tablet. Note that all table definitions must have a
field that defines the PRIMARY KEY.

The second field, "Name," is a Field Type of FREE FORMAT string 40 characters in length that is classified as UNIQUE. It is also
defined as the field used to name groups of resources in the sequencer using the SEQ GROUP classification.

The third field, "Resources," is classified as an AUTO LIST of resources, picked from the "Name" field in the "Resources" table.

Changes to the Inferred Database Schema
Preactor allows ad-hoc changes to the structure of its data storage by amending the table definition (.prtdf) file.

In order to support this, changes have to be made to the database when a change is made to the table definition file. The
detection of these changes takes place on start up.

Listed below are the types of changes that can be made to the Preactor Table Definition file (.prtdf) that have an effect on the
inferred database schema. Any number of these changes may be applied at start-up.
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Always ensure that a backup of your database is taken before applying these types of changes since many of these operations
can cause data loss and are irreversible.

Adding Fields
Adding a field to a table definition will also cause tasks to be created on start-up. In the simplest case this will be a FREE FORMAT
string field, and a single task will be created to add the field. Other field additions will cause incidental foreign key additions or
alterations. Adding a field of the MATRIX type will cause slightly different behavior, please see the Adding Auto Lists andMatrix
Field topic.

The length of table and field names is limited to 50 characters. In the case of AUTO LIST andMATRIX type fields this maximum
applies to the combined table name and field name.

Removing Fields
Removing a field will cause the inverse effect of adding a field, see the Adding Fields topic.

Renaming Fields
Fields can be renamed using the PREVIOUS NAME classification. This may cause alterations to foreign keys relevant to that
field.

The length of table and field names is limited to 50 characters. In the case of AUTO LIST andMATRIX type fields this maximum
applies to the combined table name and field name.

Field rename tasks can occur even where the name of the column in the database table does not need to change. In these
cases, the name of the field has been changed, but the net result is that the name of the column in the database is the same.
This happens because in deciding the name of a column in the table, certain characters are ignored. An example of this would
be renaming a field from 'Name' to 'Name.'. Both of these field names resolve to the column name 'name'. When these tasks
occur, all that happens is that the field definition in the database is updated to reflect the new field name.

Resizing Fields
FREE FORMAT, fields can have their length altered by the MAX LENGTH classification. Changes to the length will alter the field
definition in the database. Field lengths greater than 4000 will cause the type of the column to change to varchar(max). This
type has no limit on its length.

Altering the Length of a Field
FREE FORMAT STRING fields can have their length altered by the MAX LENGTH classification.

Changes to the length will alter the field definition in the database.

Field lengths greater than 4000 will cause the type of the column to change to varchar(max).

This type has no limit on its length.

Altering the Default Value of a Field
Changing the default value in the field definition in the table definition file will cause a corresponding task to alter the default
constraint against the corresponding column in the database.

Altering the Nullable state of a Field
The ALLOWUNSPECIFIED classification determines whether a column in the database will allow null values.

Adding or removing this classification from a field causes a task on start up to alter the column accordingly.
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Changing Null Field State
The ALLOWUNSPECIFIED classification determines whether a column in the database will allow null values. Adding or removing
this classification from a field causes a task on start up to alter the column accordingly.

Adding Auto List and Matrix Fields
Adding AUTO LIST or MATRIX fields to a table definition will cause a new table to be created in the database. This is because the
AUTO LIST or MATRIX data has been normalized. Foreign keys will be added to link the new table to its parent.

Removing Auto List and Matrix Fields
Removing an AUTO LIST or MATRIX field will cause the AUTO LIST or MATRIX table in the database to be removed, along with all
of its foreign keys.

Adding Tables
You can define a new table in your Preactor Table Definition File (.prtdf) when ever you like. When Preactor detects a change of
this type on start-up, it will create tasks to perform corresponding changes in the database. In its simplest form, this will be a
single task to add the table, but in many cases, changes to foreign keys will also take place.

Removing Tables
You can remove a table definition from your Preactor Table Definition (.prtdf) File. Preactor will create a task to remove the
table on start-up, and again this may involve changes to foreign keys.

Renaming Tables
Renaming tables requires the use of the PREVIOUS TABLE NAME classification, which must be placed on the PRIMARY KEY field
for that table. A table without a PRIMARY KEY field cannot be renamed. The name of a PRIMARY KEY column in the database is
inferred from the table name where the name of the PRIMARY KEY field in the table definition file is "Number". This means that
in most cases, a table rename will also cause the primary key column in the database to be renamed.

The name of a PRIMARY KEY column in the database is inferred from the table name where the name of the PRIMARY KEY field in
the table definition file is "Number". This means that in most cases, a table rename will also cause the primary key column in
the database to be renamed.

The name of any child tables that exist to support AUTO LIST or MATRIX fields on the renamed table will also change, as the
name of this child table is also inferred from the parent table name.

The length of table and field names is limited to 50 characters. In the case of AUTO LIST andMATRIX type fields this maximum
applies to the combined table name and field name.

Table rename tasks can occur even where the name of the table in the database does not need to change. In these cases, the
name of the table has been changed, but the net result is that the name of the table in the database is the same. This happens
because in deciding the name of a table, certain characters are ignored. An example of this would be renaming a table from
'Table' to 'Table.'. Both of these table names resolve to the column Table 'table'. When these tasks occur, all that happens is that
the table definition in the database is updated to reflect the table name in Preactor.
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SYNTAX

RECORD_FORMAT
;[Comment]  
Name,
Extension or FileName,
[MinimumRecords,]
[MaximumRecords,]
[FileMode]: 
 FieldName,
 DefaultValue,
 FieldType,
[Classifications]:
[. . . additional field definitions];

;
[… additional format definitions]
RECORD_END

User Configurable Database
The user can modify the database by modifying fields and classifications or adding new ones to the Preactor Table Definition
(.prtdf) file.

When Preactor starts, it finds any changes that have been made to the .prtdf file and applies changes to the SQL database.

Note: This file should only be modified after attendance at a suitable Preactor Configuration Course.

Compiling Preactor Configurations

Running the Configuration Compiler
The configuration compiler can be run from the command line, a batch script or through a build system such as MSBuild.

When running the compiler, a command definition file (.prcdf) must be specifiedwhich must contain:

l The license to compile the configuration.
l Any #define directives.
l The Menu and Table definition files (.prmdf and .prtdf)

As the compiler will not load any data, it will ignore the database connection string. The compiler is an executable installed
alongside Preactor called pcompile.exe.

Command Line Options
Running the compiler from the command line will provide help on each of the available switches:

Usage:

pcompile.exe <options>

Options:

Option Description
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-h or -? Provides help on the list of available options.

-c <filename> Name of the Command Definition File to run.

-oem Compile for an OEM configuration.

-l <license number> Compile for the given license number.

-r Compile for a run-time configuration.

-o <filename> or -out <filename> Override the default compiled filename.

Examples:

Compile configuration for current license:

pcompile.exe -c ..\Folder\FileName.prcdf

Compile a run-time configuration:

pcompile.exe -c "C:\Folder\File Name.prcdf" -r

Compile an OEM configuration with a target output filename:

pcompile.exe -c "File Name.prcdf" -out "filename.oem" -oem

API

The Preactor API
The API may be used to manipulate Preactor.

Custom actions can be createdwhich allow you to execute custom code during specified events. For example the OK button
on an edit dialog could execute your custom code to validate data entry in required fields.

Open Planning Board Object
A user has full access to the Open Planning Board Object, which allows access andmanipulation of schedule data directly using
the API methods provided.

For example a user can automate schedule tasks such as inserting operations under defined conditions, e.g. a clean in process
(CIP) operation in a process industry application, using a PESP Event incorporating a custom action.
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Help & Support

Field and Button Functions
Pop-Up Help is available for fields or push buttons.

To determine the function of a menu button or a dialog field:

1. Click on the field name with the right mouse button or left click on the 'What's this' tool bar button and then click on the
field or button.

A pop up helpwindow appears providing a description of the selected item.

Preactor Help and Support
The Help and Support options can be obtained from the Help and Support Pane:
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Support
It is often necessary to provide a backup of a Preactor configuration in the form of a Preactor package file in order to diagnose
issues. This can be achieved using the Generate Support File or Generate Support Email options.

When requesting support, the following information is required:

l A valid license number.
l Operating system and version.
l The full version of Preactor in use, in the form WW.XX.YY.ZZZZ.

Generate Support File
This option will create a Configuration Package (a file with the .prpkg extension) in the directory that your Preactor
configuration is running from, which includes configuration, report and database files.

Generate Support E-mail
This option is similar to the Generate Support File option, except that there is an option on the Package Management Progress
dialog to send an e-mail.

The default email address can be altered from the Edit Support Settings option.

Backup
A backup of a Preactor Configuration can be carried out from the Help and Support Pane, using Generate Support File. This will
generate a Configuration Package. See "Configuration Packages" on page 38 for more information.

View Network License Manager
When employing a Network License service, the Network License Manager shows howmany licenses are in use, who is using
them, and howmany are free.
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From here, the log can be inspected to see when more requests for licenses were requested than could be supported. The Help
function of the License Server Manager provides guidance of the management capabilities.
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Troubleshooting

Troubleshooting

Introduction
This section will provide details of a number features that will help you debug your configuration, and also details steps that
may be taken to resolve some common user queries.

FAQs
The following section details steps that may be taken to resolve some common user queries.

l Howdo I get Preactor out of Trial mode?;
l Why is Preactor running in year 2000, and how do I stop it?
l Howdo I get Preactor to run the version I purchased?
l Howdo I findwhat version or build of Preactor I am using?
l Howdo I obtain e-mail support from my supplier?
l Howdo I Create Copies of a Configuration for Training or Testing Purposes?

How do I get Preactor out of Trial mode?

Why is Preactor running in year 2000, and how do I stop it?

There are two different Run modes that Preactor can be launched in:

l Trial mode.

This allows Preactor to be tried over a trial period of 30 days. The time period begins as soon as Preactor is opened in
this mode. Preactor can be used until the 30 days have expired.

In this mode, Preactor is fully functional.

l Activatedmode.

This allows Preactor to run in a fully activated state with no time constraints. An Activation Code must be entered to set
Preactor to run in this mode.

Preactor is distributedwith a number of example configurations that facilitate the Trial of the product, and to provide you
something you can base your configuration on. These configurations are set to run in a Fixed Time (e.g. the year 2000). The
Fixed Time can be changed or removed, see Fix Time – Fixing the Current Time.

How do I get Preactor to run the version I purchased?

The product to be run (e.g. 200 FCS) is configured in the Preactor Command Definition File (.prcdf). See Specify Which Product
to Run / License.

How do I find what version or build of Preactor I am using?

Click on the Help icon in the menu bar and choose the 'About' option. The build and version will be displayed on the dialog that
loads.

How do I obtain e-mail support from my supplier?
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Support email requests can be created from the Support menu option.

How do I Create Copies of a Configuration for Training or Testing Purposes?

Backups can be done from the Help and Support menu options.

Tracing Activity
Preactor can provide a trace of all activity. This is activated from the Help button on the workspace menu bar.

Troubleshooting the Preactor Table Definition
File

It is important that when the Preactor.prtdf file is edited that the syntax is preserved and that all field names in references, etc.,
are spelled correctly. If PRSERVER finds that it cannot understand any part of the Preactor.prtdf file, it will abort loading. It is
recommended that modifications to the Preactor.prtdf file are made in small increments and that the system is tested between
each set ofmodifications.

If there is an error in the .prtdf file, a warning dialog will be displayed on start up of Preactor and then Preactor will close. In this
case, a spelling mistake was applied to the orders table.

From here, the Preactor.prtdf file can be opened in a text editor, in order to findwhere the error is and correct it.
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Debugging Preactor Menu Definition Files

The error dialog box will always display information that can be used to correct an error in the Preactor.prtdf file.

Debugging Preactor Menu Definition Files

To enable the Preactor menu definition files to be checked and especially to allow validation of the calculated tags, a Workflow
Log debug facility is provided in the Preactor Desktop. The 'Debug Window' is displayed by selecting 'Help ►Debug Window...' on
the Preactor Desktop. When a Preactor workflow action is activated, such as entering the sequencer, text will be printed in the
debug window providing information on the contents of various tags and command line parameters that are used on entry to
the sequencer.
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Security Information
Siemens provides products and solutions with industrial security functions that support the secure operation of plants,
systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is necessary to implement – and
continuously maintain – a holistic, state-of-the-art industrial security concept. Siemens’ products and solutions only form one
element of such a concept.

The customer is responsible to prevent unauthorized access to its plants, systems, machines and networks. Systems,
machines and components should only be connected to the enterprise network or the internet if and to the extent necessary
andwith appropriate security measures (e.g. use of firewalls and network segmentation) in place.

Additionally, Siemens’ guidance on appropriate security measures should be taken into account. For more information about
industrial security, please visit http://www.siemens.com/industrialsecurity.

Siemens’ products and solutions undergo continuous development to make them more secure. Siemens strongly
recommends to apply product updates as soon as available and to always use the latest product versions. Use of product
versions that are no longer supported, and failure to apply latest updates may increase customer’s exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed under http://www.siemens.-
com/industrialsecurity.

Version 4.1 – 01.06.2016- Siemens AG, I IA L CG, Nuremberg
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Glossary

- 337 -



Index: Adding Tables – Pop-Up Help

Index

A

Adding Tables 327
Address Book 132, 134, 136
Alerts 175
Algorithmic Sequencing 187
Analyzing the Plan 182
API 329
APS Rules 192
Authoring Reports 106

B

Backup 331
Batching 285-286
Bill of Materials 156, 182

C

Calendars 96, 108, 177
Instances 108
States 108, 221
Templates 108

Call Off 243
Capacity Availability Level 149
Capacity Management 139
Capacity Usage 181
Charts 182
Classification Location 317
Commands 303
Communications 130-131, 133-134, 137
Compiling Configurations 328
Composite Filters 258
Conditional Branching 303
Configuration 57, 232
Configuration Package Manager 38
Configuration Selector 44-45
Constructs 302
CSV 83, 93

D

Data Integrity 313
Data Provider 84
Database 20, 137-138, 320, 325
Dataset 172, 229
Datasets 109

Common 109
Debugging 334-335

Troubleshooting 334
Delete period 225
Demand Data 175
Dialogs 304
Dispatching rules 129, 193
Drill Down 105
Due Date 242

E

Editor 53

Editor Window 57
End Offset 227
Environment 21
Export See Import/Export
Express 12
Expression Filters 111

F

Field Types 312
Filtering 111, 258, 278

Composite Filters 258
Expression Filters 111
Sequencer 258

Flexibility on Dates 148

G

Gannt 244

H

HELPPOPUPID 305
HELPPOPUPID(x) 305
Highlighting 254, 278

Clearing 255
Errors 256
Menu 254

I

Import/Export 78-84, 87-90, 93-94, 96
Calendars 96
Data Providers 79-80, 83
Mapping Fields 88
Scripts 81, 94
Wizard 82-83, 87, 89-90, 93-94

Importing Orders 264
Infinite Capacity 199
Infinite Capacity Sequencer Mode 282
Installation 18-20, 28
Items 152

K

Keyboard Shortcuts 58, 63

L

Language Support 17
Licensing 21, 23-24, 26, 28-31

Activation 24
Trial 24

Local Reports 102
Lock Rows 166
Locking Operations 281

M

Manual Sequencing 278
Material 200
Material Control 201, 264
Material Explorer 268
Material Plots 271
Matrix 90
Menu 51
Menu Definition File (.prmdf) 300-301

Menu Definition Files 335
Menu Structure Logic 311
Menus 58, 64

Configuring 64
Move an Existing License 32

N

Network License 27, 30
Network License Manager 27-28, 32, 331

O

ODBC 80
Offline License Management 35
OLE DB 79
Open Planning Board 329
Operating Environment 139
Operation Locking 281
Operation Progress 246, 287
Operation Properties 256
Oracle 80
Order Attribute 278
Order Enquiry 284
Order States 283
Output 248
Overview 16, 250

P

Package Manager 38
Parameter Sets 157
PARSE_STRICT 302
Password 119
PCO 131
pcompile.exe 328
PESP 121

APS Scheduling Rules 129
Creating and Editing Event Scripts 122
Custom Actions 124
Discrete Events 125
Example Scripts 127
MANIP Events 125
Message Events 124
Script Variables 124, 126
Timed Events 125
Viewing Event Scripts 121

PESP Event Types 124
Pie Chart 182
Planner 162
Planner - Capacity Usage 181
Planner - Lock Rows 166
Planner Charts 182
Planner Main Windows 162
Planner Reports 184
Planner Thresholds 159
Planning 164, 166
Planning Concepts 139
Planning Data 166
Planning Horizon 160, 165
Planning Modes 146
Planning Parameters 159
Planning Resource Groups 142, 154
Planning Resources 142, 153
Pop-Up Help 330
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Index: POSITION – Workspaces

POSITION 306
POSITION(x) 306
prcdf 48
Preactor Configuration Selector 45
Preactor Control File 300
Preactor Desktop 51
Preactor Event Script Processor 121
Preactor Express 12
Preview 218
Print 248
Printing 55, 218
Priority 242
Products 10
Programs 307
Provisioning

Planner
Planning Resources 153

Provisioning Items 152
Provisioning Planner Data 152
Provisioning Planning Resource Groups 154
Provisioning Repair Plan 161
PUSHBUTTON 305

Q

Queries 84
Quick Reference 69

Planner 185
Sequencer 297

R

Read Messages 135
Referential Integrity 138
Relationships 321
Remote 137
Repair 284
Repair an Existing License 34
Repair Plan 167
Repair Plan Run Sets Provisioning 161
Repeat Orders 243
Reporting 102, 106
Reports 99-102, 104, 106, 289

Exporting Data 101
Resource Calendar 218
Resource template 222
Resources Panel 213
Return an Existing License 32
Rule Building 129
Rules 129
Running Preactor 45

S

Schedule Despite Shortages 282
Schedule Statistics 290
Scheduler 130
Scheduling 276
Secondary Constraint Groups 208-209
Secondary Constraints 208-209
Security 113, 115-117, 119
Send Message 134
Sequence Dependant Setup 198
Sequencer 289

Filtering 258

Options 289
Warning Suppression 289

Sequencer Configuration 231-232
Sequencer Configuration Settings 231
Sequencing 274-276, 278
Settings 231-232
Setup Times 198
Shortages 290
Simulation 189
Simulation Based Sequencing 189
Snap 228
Start Offset 227
Static Stock Line 272
Stock Profile Viewer 183
Strict Parsing 302
String Tables 319
Support 331
System Tables 138

T

Table Definition File (PRTDF) 300, 323, 334
Templates 223
TEXT 307
Timed Events 126
Toolbars 58-59, 74

Planner 162
Sequencer 233

Total Stock Holding 177
Trace Chart 246
Tracking 317

Classifications 317
Transaction Data 155
Troubleshooting 333-334

Debugging 334

U

Unscheduled Operations Window 272
Upgrade an Existing License 33
Upgrading 20
Utilization View 259

V

Viewers 16, 134

W

Warnings 289
Web Publisher 294-296
Weighting Rule 276
Window Management 72
Workspaces 74, 241
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